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Updates to This Guide

This guide is being reissued due to the following changes:

Exporting a Rule on page 335 has been added.
Deleting Collections and IEs on page 430 has been updated.

Editing Metadata through the Web Editor Interface on page 465 has been
updated.

You can now indicate the Preservation Type when adding publishing
profiles. For more information, see Profiles Tab on page 378.

The Collections section has been updated with a new History tab, the ability
to sort the list of collections, and updated information concerning the
Assign Collection by DC task. For more information, see Collections on
page 415.

In the Manage Scheduled Jobs page, the following changes have been made:
B the view link is now called History

B the Edit link us now called Update

B the Run Now and Duplicate row actions have been added

For more information, see Submission Jobs on page 249.

The Priority field has been added to the SIP Processing Configuration page.
For more information, see Adding a SIP Processing Configuration on
page 183.

SUBMISSION_JOB_DETAILS has been added to the list of reports. For more
information, see Reports Available in Rosetta on page 50.

You can now create derivative copy representations with a job. For more
information, see Derivative Copy Representations on page 435.
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Introduction

This part contains the following sections:
B Chapter 2: Understanding Staff Users on page 21
B Chapter 3: Searching and Reporting For All Staff on page 23

B Chapter 4: Submission Information Package (SIP) Overview on page 59
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Understanding Staff Users

Staff users are responsible for reviewing the content deposited by Producer
Agents, managing Producers and Producer Agents, and configuring the way in
which Producer Agents deposit content.

The following table describes Staff users’ roles and responsibilities:

Table 1. Staff Users’ Responsibilities

Staff Role Responsibilities

Deposit
Managers

B Configuring generic Producer profiles and material flows

Deposit Managers work with the Producers sub-menu. For more
information, see Understanding Deposit Managers on page 69.

Negotiators

B Personalizing generic Producer profiles and material flows for
the needs of specific Producers

B Managing Producers and Producer Agents

Negotiators work with the Producers sub-menu. For more
information, see Understanding Negotiators on page 201.

Assessors,
Arrangers, and
Approvers

B Reviewing the content deposited by Producer Agents and
deciding whether it should be approved, returned to the
Producer Agent, or declined

Assessors, Arrangers, and Approvers work with the Submission
sub-menu. For more information, see Understanding Assessors,
Arrangers, and Approvers on page 261.

Technical
Analysts

B Repairing technical issues that occur with the content
deposited by Producer Agents

TAs work with the Submissions sub-menu. For more
information, see Understanding Technical Analysts on page 291.

Editors

B Editing metadata of the content deposited by Producer
Agents

B Adding new representations

Editors work with areas of the Data Management sub-menu. For
more information, see Understanding Editors on page 339.
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Table 1. Staff Users’ Responsibilities

Staff Role Responsibilities

Data Managers

Scheduling and monitoring processes, managing sets, publishing
configurations, and running activities that affect multiple IEs.

Data Managers work with the Data Management sub-menu. For
more information, see Understanding Data Managers on
page 347

Preservation
Analyst

All tasks associated with risk analysis and loss prevention,
including;:

B populating Preservation libraries
B performing risk analyses on existing library collections
B creating, testing, and running plans and plan alternates

For more information, see the Rosetta Preservation Guide.

Preservation
Manager

All tasks associated with risk analysis and loss prevention,
including all the responsibilities of a Preservation Analyst plus
signing off on and rejecting preservation plans.

For more information, see the Rosetta Preservation Guide.

User roles are also associated with scope in terms of their level within a

consortium.

B Consortium - Users with this scope can view and operate on objects that
belong to all of the institutions in the consortium collectively. The following
roles can have this scope: System Administrators, Editors, Data Managers,
Preservation Analysts, and Preservation Managers.

B Institution - Users with this scope can work only on items (IEs,
configuration items) within their own institution. All roles can be assigned
an institutional scope.

B Department - Users with this scope can operate only on IEs that belong to
their department. This scope is only relevant for Editors.

All staff users are assigned and registered by a User Manager.

This guide describes staff users and their responsibilities and explains how
management staff users accomplish their tasks.

For additional information on users, role types, and administrative staff
responsibilities, see the User Management chapter of the Rosetta Configuration

Guide.

22
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Searching and Reporting For All Staff

This section contains:

®  Home Page on page 23

B Advanced Search on page 28

B Search Results Features and Options on page 33

B  Running and Viewing Reports on page 42

B Reports Available in Rosetta on page 50
Home Page

The staff home page contains a summary view of statistics impacting the user,
such as the number of SIPs at various stages, as well as the ability to search for

SIPs or IEs or to add a Deposit activity.
For details, see:
®  Home Page Summary on page 24

B Quick Search on page 25

September 2016
Ex Libris Confidential

23



Staff User’s Guide, Part |: Introduction

Chapter 3: Searching and Reporting For All Staff

Home Page Summary

FA
ExLibris Rosetta management

User: Johna Smin | InstRutlon: Demo

Producers SUbmissions Data Managemsnt Prasarvation
» Deposit 4 Submissions & Preserved
Add Deposh ATV Search by SIP 10 Bo e Fermane Bo
Quick stats Quick Stats Guilck Stats
51Ps In Process Total size MB]: 10450
Stat_us 5|P':i Status 5IFs Preserved files: 2338
Draft B . Mumber of |Es: 1328
E‘E’:.”E: ! Total 4
TI:I_‘t;JIr_d 5 Top Formats at Risk
Technical Analyst 2
Stage SIPs
walidation 1 1
= C e .
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Total 17 L0 - g4
8
20 Manual Assessment
1 Stage SIPs
" Arranger 1
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u Image
agdio
0 - Senerl
Urpuislizhed Interral  pubished cthar

Figure 1: Staff Module Home Page View

NOTE:
If you see a red bar reporting a failed system check, contact your
Administrator. For more information, see System Checks on page 227 of
the Rosetta Configuration Guide.

Items on the home page are refreshed according to the following schedule:

Table 2. Home Page Item Refresh Rates

Heading Section Refresh Time
Deposit Quick Stats Every 5 minutes
Deposits Per Producer Group Every 5 minutes
Submissions Quick Stats Every 5 minutes
Preserved Quick Stats Every 5 minutes
Files by Classifications Every 2 hours
24 September 2016
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Quick Search

Staff can search for objects using the single-field quick search provided on the

Home page.
Ex Lirb;:is RGSEHB le"lh.gél'nenl Uz, Jobn Ssith | relitubon, Desa Fethdion = Hsigs | Logoul
Prpducer s Subimissions  Data Managemen!  Presengation sk | aunch Sl Bap
» lngast . Submissiens . Preserved
Add Deposit Aclisty Saanch e S0 Saan pEETRAT
Gn G
Quick Stats:
Quick SHats Quick 54ats
Shatus 5IPs _
Drraft 11 51P In Process Total size (MO): 123
Rejected 12 Status 5IPs Proserwed liles: 175
Declined a nprocess 1 Kumher of 51Ps: oy
Taotal 74 Tatal i Top Formats at Risk
Tachnical Analyst 40
Stage SiPs 50
Walidalion G0 B
Loading 16 o 1 o
Deposi#t Per Froducer Group Earichurieng 2 Wy PTER ol JA07 e M
Eestream 2 )
T TaFParmanent 14 Files by Calmgories
450 ] Deposil 15 Files by Category
o0 Total 109
350
200 Manual Assessment
250 Slaue SlPs
200 AEGREEar 25T
150 Arranger 13 >
- ) APFTAWET 17
Sowemment  Published Total 207 v

Figure 2: Quick Search from Home Page

For the quick search under the Submissions heading, users can enter the SIP ID
number and receive information about the SIP’s status.

For the search under the Preserved heading, users can perform one of three
search types on the permanent repository —by PID, SIP ID, or text field. The
table below describes the three search types.
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Table 3. Quick Search Options

Search By @ Description

PID

When a user enters a string beginning with IExxxx, REPxxxx, or
FLxxxx, and then clicks Go, the quick search by PID is activated,
and Rosetta looks for the selected object type (IE/REP/File) based on
its PID. If the PID provided by the user is found, the user is
redirected to the Web editor to view or work on the object. If the
PID does not exist, Rosetta redirects the user to the Advanced
Search page, with the quick search criteria transformed to advanced
search criteria (PID = IExxxx) and no results displayed. This allows
the user to redefine the search criteria.

SIP ID

When a user enters a numeric string (SIP ID) into the quick search
Find box and clicks the Go button, Rosetta searches for all IEs
based on that SIP ID. The Advanced Search page opens with the
quick search criteria transformed to advanced search criteria (SIP
ID = xxxx) and results displayed on the bottom half of the page
(under the Results heading).

Text

When a user enters a text string and clicks Go, Rosetta searches for
all IEs that match the fields dc:title, dc:description, or
dc:creator. The entered text must include a minimum of three
characters and may employ an asterisk as a wildcard.

The above search options are available for the Preserved heading search only.
Rosetta activates one of the three types of searches by analyzing the string typed

by the user.

PID searches, when successful, return a single IE, Representation, or File in the
Wed Editor, as shown in Figure 3, Quick Search Results for Found PID.

26
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""-.j-\'"n lome = Submissions > File

';."__"'___.-'
Intellectiual Entity PIDEL 1082 Created on 23042071 11.41.58 Created by adrmar
Updated on 23022 11:42:22 Updated by admini SIP 1D
Version 1
= IE{ IE1060 ) Object Summary

= Preservation Master Bevision 1
| REP1981}

= Fila | FL1022 | FiD
SIP 1D
Created on
Created by
Updated on
Updated by
Entity Type
Original Hame
Crigginal Path
File Extension
File MIME type
File %ize

= Back

Figure 3: Quick Search Results for Found PID

PID searches that fail to find a match return results on an Advanced Search page
with the search terms reformatted into a query row (see Figure 4, Quick Search
(PID) to Advanced Search). All other searches, whether successful or not,
resolve to the Advanced Search page.
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Glick search from Home  Search Roseta
page or any main page;  Find FLI0E Go

FID quick search —= PID foung ——

v

FID not found

Iq.nj'-'. Home = Data Management = Advanced Search

Search Conditions Sor Humns

Search level: @  Intellectual Entity © | Representation ©  File
EI Add Conditions

Match m of the following conditions a8
Fie PID * [Equal =] * s @0%

Search

|§| Results

IR0 RESUILS aung

Figure 4: Quick Search (PID) to Advanced Search

From here, users can modify their search, add conditions for a complex query,
view thumbnails, export results, and sort and configure columns for results
displays.

Advanced Search

The advanced search provides flexibility in the degree of complexity and
specificity of a search.

See the following sections for details:
Advanced Search Page Layout on page 29
Advanced Search Conditions on page 29
Field Element Selection on page 30
Nested Search Conditions on page 31
Operators on page 32

Value Field on page 32

28
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Advanced Search Page Layout

The Advanced Search page opens following most searches conducted from a
Quick Search box (also from the Search for Objects link of the Data
Management module).

The page consists of a top portion, where users can hone their search conditions,
set sort preferences for results, and specify columns for display in the results
(ands to Excel), and a bottom portion, where results are displayed.

Gick Search (text) from
Harme or main page; ——m

Search Rosefta

Find: cit” Go

_Fr._'_,.-""r'-

B Add Conditions

Sparch Conditions

g

_r;\?ﬁl':'! Home = Adwanced Search

‘,_,,/" Opens advanced search with the three do

Sparch lovel: = Intiez e cloal I:r||i'|:'I L I~!:.~|||r,"j|_:||!..|li:_:-r|

fieldz (used in text searches) populated

#  Title Type

= Back

SIP 1D Authorative NHame |E Modification Date

Idatch Any = of the followang condiions =Ty Rt
[creator * | Contains Phrase =] * kit =T
[23=.'3c'rlpllnl1 }lilon:s ns Phrase d ! F:ll' =T+ ot
[Title * | Contains Phrase =] * fir =T ot
Search
H Results
1 - 10 of 10 Records Export te Excel

2012-02-24 0001323 Wiew Info Export
20120224 001323 Wiew Info Expon
2012-02-34 001327 Wiew Info Expor
2012-02-24 001322 Wiew Info Export

Save Query As

Figure 5: Advanced Search Page

Options for searching, saving, exporting, and displaying results are discussed

below.

Advanced Search Conditions

For each condition of a search, a row with the field element name, an operator
selection, and a value (either text-based or drop-down-list based) appear. To
add a row parallel to the existing one, click the green circle button with the plus

September 2016
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sign. To add a nested row, click the button with the upper plus sign and lower
brackets. To delete a row, click the red circle button with the minus sign.

To set the relationship between the rows, select Any (Boolean OR) or All
(Boolean AND) from the Match drop-down menu.

Field Element Selection

Users can select an element on which to search by clicking the icon to the right
of the first text field. A complete list of available search fields opens. (See
Figure 6.)

1 Home > Data Management > Search and Manage Queries > Search

Refine Results Search Conditions

*™ | Search level: c Intellectual Entity - Representation . File
[B Add Conditions

Clear Facets

Match | a1 =] of the following conditions: Clear Search

-

Search

Figure 6: Select from all available fields

Alternatively, users can type a search field name directly in the textbox, and the
system will suggest matches in a drop-down list. Matches contain the same
string as the user types but they do not necessarily begin with the same letters,
as shown in Figure 7, Auto-fill Element Field. The user can continue typing or
select a match from the dynamic list.
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Search Conditions Sort Columns

Search level: ™ Intellectual Entity © Representation © File
El Add Conditions

Match | an =] of the fellowing conditions 28 %
. aa
[datel v * | Contains Keywords =] * | @eM

IE Creaticn Date
Object - Creation Date
Object - Modified Date
IE WModification Date
File Craation Date

File Meddication Date

REP Creation Date

Figure 7: Auto-fill Element Field

Nested Search Conditions

Users can implement nested search conditions. For each block in the nested
search, the user defines (using the All or Any Ul operator) whether all the
conditions in that block must be true (equivalent to the SQL AND operand) or
whether, of the different search conditions, only one (or more) must be true
(equivalent to the SQL OR operand). The number of nested blocks is limited to
five. The operand between two (or more) rows in the same block is always
AND.

Search level: @ | Intellectual | ntity | Representation © | File
|§| Add Conditions

ons @0

| arts With j L 0%

C =T+ R

Dbject - Author | Contains Keyword =] * [andre @0%

["-t_r-.'l - Author ’ |l..‘-'.:~..‘.':.|'.f. ,"'j g E:.u':..r-' @0°F

[' able Of Contents = |i_'rt.":a ns Keyword j : |i£-::e.-=- @0%

|:‘e_-',-."|.".-.:" Contains Key 'u‘:j ¥ |stories 895%
Figure 8: Nested Conditions
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Operators

Operators are determined by their elements. The following are the most
common operators.

B Equals: exact match on word or phrase in value field (alternate: Not
Equals)

B <:less/earlier/older than the date in the value field (variants: Before and
<= for less than or equal to)

B >:greater/later/more recent than the date in the value field (variants:
After and >= for greater than or equal to)

B Contains: all of the items in the value field are present but in no
particular order (variants: Contains Keyword and Contains Phrase)

B Starts With: result begins with item(s) in the value field
B IsEmpty: field is empty.
B IsNotEmpty: field is not empty.

For more information about options you can use to make your search more
precise, see Value Field on page 32.

Value Field

To the right of each operator drop-down list is a field for entering the value that
restricts your search. The type of data that you enter in the value field is
determined by the conditions you selected. Date selections, for example,
produce date entries and/ or drop-down calendars in the value field.

To make your search more precise, you can use the following features when
defining a value in the Value field:

Table 4. Features to Improve Search Results

Feature Description
Cross-Object Search for one type of object using query criteria from another
Query type. For example, you can search for 1Es that have PDF files.
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Table 4. Features to Improve Search Results

Feature Description

Wildcard Use the following wildcard characters when the value is text and
you want to define a pattern:

B * - Use this wildcard character at the end of a value. For
example, Dan* finds all matches that start with Dan (Daniel,
Danzig, danish, etc.)

Note: This wildcard must follow a minimum of three
characters.

B ? - Use this wildcard character as a placeholder for a single
character. You can use it as many times as you want, in an
adjacent string or between alternating characters.

For example, b??n finds all matches that have a b as the first
character and an n as the fourth character (born, boon, barn,
etc.)

Search Results Features and Options

Rosetta provides several options for viewing information in the Results area of
the Search page:

B List or Thumbnail View on page 33
Sort By on page 34

Column Display on page 35

Facets on page 38

Export to Excel on page 42

List or Thumbnail View

Search results can be viewed as a detailed list or as thumbnails:
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Refine Results
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List wiew [default]-—___*

"
i
f

f‘-, Home » Data Management > Search and Manage Queries > Search

Search Conditions

™ Search level: = Intellectual Entity . Representation . File

[B] Add conditions

Match | o1 #] of the following conditions: =X+ 1
[Authoritative Name Is Mot Empty =l 0%
Search

IE Results

Export to Excel
"'\-\.\_\_\_HH*

1-3 of 3 Records

Thumbnail wiew ———" *

< Back

Save Query As

Sort By

Figure 9: Search Results List and Thumbnail Views

All single-value elements can be configured as sortable. Four sorts can be
configured in order of priority. Once an element has been selected for sorting, it
no longer appears in the list of available elements.

NOTE:

If more than one instance of an element occurs in a single record (for
example, two Creators, A and B), Rosetta uses only the first value (A) for
the sort on Creator. (Both A and B are used in a search of the Creator
element, but the results are sortable by A only.)

Users enter the elements and their sort priority on the Sort tab of the Search
page (see Figure 10).
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=12
[’\,-ff: Herme = Data Managament = Search and Manage Queries = Search

Search Conditions Sort Columns

Search level: @ Intellectual Entity © Representation © File

Sort By |E Creation Date | Desc. j
hen Sort By |id Asc 3
Then Sort By | IE Group ID = | =|
Then Sort By | CMS Record Id | El
Apply Sort 5IP ID
Usar D App ID
IE Results op
Access Rights Policy ID
P, . Ex to Excel
Granted Rights Stalement 1-3of 3 Hecords poft
#  Tile Deposit 10 __ D IE Modificatio
o e b e -
1 Lzw_TiFg| Handie (intemnal ldentiier) - 5949.02.26 21 View Info Expont
HANDLE (Object Identifier
2 Winter o = 2012-02-26 21 View Infa Export
LR (Obiect Identifier) ’J '
: | _
T Vifimbar 2142.07.25 21 Weew Infn Exnpord

Figure 10: Sort Fields Auto-complete Drop-Down Menu

To choose an element, users type the beginning of the element into the Sort By
field, then select the full element name from the auto-complete drop-down list
that opens. All elements, whether visible in the Results pane or not, are available
for sorting.

Users can select ascending or descending order for each element.

Clicking the Apply Sort button sorts the results in the priority and order
specified in the top portion of the page.

Column Display

Because all AIP elements are indexed and searchable, the Search Results page
can be configured to display any of the elements. By default, the following
elements are displayed in the search results according to the object type of the
search:

For IE s and representations:

B Title
m Type
m PID
m SIPID
B Producer
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B Creation Date
For files:

m PID

m File Format

m File Extension
B Mime Type

m File Size

To change the items displayed in the search results table:

1

Click the Columns tab at the top of the page.

Two boxes open in the top section of the page. The box on the left lists items
currently displaying in the search results. The box on the right contains a
text field and lists all items that are available

Delete any items you don’t want to view in the left box by clicking the minus
sign next to the element.

The element moves to the right-side box and will not display as a column in
the results.

To add an element for display, type the first few letters of the element in the
text field of the box on the right.
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08 i . i
Y ~|3 Herme = Data Manzozment = Search and Manage Quaries = Search

Search Conditions Sort Columns

Search level: ® Intellectual Entity © Representation © File

3 items zelected Remaove all | Cre Add all |
T Tile = | Created -+
t EPD = | Crealor -
t (E Modification Dale = | IE Creation Date 4
IE Creaior o+
|

Apply Columns Restore to Defaurlt

Bl Results

1- 3 of 3 Records Export to Excel

# litle IE P IE Modification Date

1 LA TIFF  IE1032 20120226 21:44:29 View Info Expor

2 \Winter [E10256  2012-02-26 21:42:42 View Info Expert

3 Winter [E1023  2012-02-26 21:41:56 View Info Expor
D&

= Back Save Quary As

Figure 11: Preparing Columns for Custom Results Display

The system auto-completes with matches in the rows below the text box.
4  Click the plus sign beside any element you want to add to the list.

The element moves from the right-side box to the left-side box, indicating
that it will be displayed as a column in the results.

5 Repeat moving elements from left to right and right to left until all the
elements you want to display as columns appear in the left box, and any
items you don’t want to display do not appear in the left column.

6 Click the Apply Columns button to view your search results with the
custom elements displayed. (To return to the default list of columns, click
the Restore to Default button.)

When the page refreshes, your new columns display information from the
objects returned in your search.
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Facets

Search results can be grouped and filtered using facets, which are attributes of
items returned in a search. Facets allow you to narrow results according to
shared characteristics of records.

When a search returns too many results, use the facets feature in the left column
of the page (Figure 12).

Home = Data Management *» Search and Manage Queries > Search

Refine Results $earch Conditions

Saanch e F ntslisctua EFTT.]'F Represantation r- Flla
B 204 conations

= vl of e fillowing condflons @ 0%

a
[Authoritative Mame ' [Egus x| ' [Demo Intemal Producer & 40T

Clean Facets

Baarch
B resuits
31 - 40 of 45 Recards 345
# | Thtes [OC| Ty | IE PID |30P IO | Authoritative Nams | IE Craatn Date
31 CRess E1193 50 Demontermal Producer 14052013 View _r:':—rs mio Export
lEver
32 CResE E11%8 50 Demonteral Producer 14052013 View E,I;'__.E; mio Export

Figure 12: Facets on the Search Results Page

When you click the down arrow in the Refine Results box, available facets
appear in a drop-down list (Figure 13).
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Home = Data Managem

Refine Results

Status
Orameer

Id

[IE Ertity Type

CMS System
Authoritative Nams

Sowrce Metadata Type
Event |dentifier Value
Acoess Rights Policy Id {IE)
Retention Poficy 1d

Local Azcess Rights Policy

Collections

| IE Entity Type

Figure 13: Facets List

For every facet selected, Rosetta returns a list of values and the number of
returned items that share that value (Figure 14).

Haome = Data Maragement = Search and Marege Guerkes = Search
Rafine Rasults
Szarch Conditions Sourt Columns
| - Seanch el F nislisctus El‘tf_f r Eap-rasart.at 1 r Flla
B :o4 conations
Status =1 o
Kiich of e fillowing condifions: = 1
ACTIVE (50) Al | :
SUPPRESSED (1) [Banthoritative Mame |Eu:uals - | * [Demo Internal Producsr @0
Sae Al P—
Acoess Rights Policy id [IE} =] B resutts
= EvER -
AR_EVERYONE (Z6) H-d0ofdSRecords 4 ¢ 345:n O
AR_EMEARGOED_UNT [17)
AR _IP_RANGE [16)
-7 £ | Tite (DC|Typ | IEPID |8P 10| Authorttsthve Mame | IE Crestn Date
See Al
3 CResS £33 50 Demomiemal Producer 14052013 View :Ej_f'; ni Export
Ewvent kdantifisr Valus =1 fp—.
37 O = z - =1 D = T . | ETS =
- 2 CResE Ef193 50 DemoimemzlProucsr 140SOM13 View i Egon
= 3 Cmes7  E1201 50 O ral P WosEN:  view Moo
27 61 23 CR 7 c1a % Ce=mid Intemal Producer Fail K ST 4 alp]
165 57) 3 Oz Fi24 50 D P woesznts view MR my
B . i , B
401 {14) 2 oKl c1a o Lemo imermal Finoducer ety Y iewer o
se2Al 35 CRes2 E1207 50 Demomtemal Producer 14052013 View .:;ér,e‘:; Expart
(ks n | i 3 CRes3 E1210 50 Demolmemal Producer 14052013 View 33; iy Expart
Figure 14: Search Results with Facets
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The Refine Results attributes (for example, Event Identifier Value in Figure 14)
display up to five values with an option to See All. The numbers in parentheses
indicate how many records match that attribute value. To show only those
records matching a specific value, click the check box for that value. The page
reloads showing only those items from the facet you selected (see Figure 15).

Home = Data Management > Search and Manage Queries > Search

Refine R It
eline hesults Search Conditions

Search level: = Intellectual Entity . Representation . File

[B Add Conditions
Status =

ACTIVE {28) Match| all[«| of the following conditions:

See A [futhoritative Mame Equals =| 7 |Den
Access Rights Policy Id =

v AR_IF_RANGE (15)

5

Iﬁl Results
Ewent ldentifier Value b=
1-10 of 38 Records 23
24 [15)
25 (15) # | Title (DC) Type (DC) IE FID SIP ID
2T {15)
166 {12) 1 Selenium Title Manuscripts IE1081 23
=z A 2 door IE1854 107
Clean Facats 3 Selenium Title Manusoripts IE1872 158

Figure 15: Facet 27 Selected

For a facet with more than five values, the five values with the most records
display in the Refine Results column under that facet’s heading. To see all of the
facet’s values, or to select more than one value to be returned from the group,
click See All and select the values from the light box (Figure 16).
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I- Demo Internal...l_ seleniumHum. .. F Producer for ...

F Flow Automat. .. I_ seleniumPerf...

Close

Figure 16: Facets “See All” Lightbox

Each search results page can have no more than four facets at one time. To
remove a facet from your results, click the red circle with the minus sign beside
the facet name. To remove all facets from your search results, click the Clean
Facets button.

NOTE:
The list of available attributes is currently fixed and cannot be customized.

Actions

Users can click any of the action-oriented text links in the row of the item they
want to work with.

Clicking View delivers the object using delivery rules, simulating an end-user's
delivery request.

Clicking METS Viewer makes the system open the General IE Viewer using the
default representation profile without going through the rules.

Clicking Info opens the object in the Web editor.

Clicking Export generates an export process and prompts the user for the export
path and other export task-related parameters.

NOTE:
If the enforce_ar_export general parameter is set to true, Access Rights
will be enforced during export. Certain representations, or the entire IE,
may not be exported, in accordance with the IE/REP AR policies.
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Export to Excel

Users can export search results into Excel by clicking the Export to Excel button
at the top of the Results section. The page reloads with a text message at the top
of the page:

Your IE will be exported to "/exlibris/dps/d4_1/profile/
operational_shared/staff work_area/adminl/export/ies/1E1032." This
process will complete shortly.

The exported Excel spreadsheet incudes the same columns and information that
appear on the Ul This information is configurable (see Column Display on
page 35).

Running and Viewing Reports

Staff users can run reports needed by their various positions and roles. Every
module in the system has a list of available reports accessed by clicking a link
from the module’s main page.

NOTE:
Rosetta uses BIRT for its reporting. To view reports within Rosetta, users
should have Office 2003 or higher installed on their machines. If they do
not, reports will appear in XML format.

This topic includes:

B Accessing Reports on page 42

B  Running a Report: Uploads on page 43
B Scheduling Reports on page 44

Accessing Reports

On the main menus for Producers, Submissions, and Data Management, there is
an Advanced Tools heading and, below it, a Run Reports link that takes the
user to a page of predefined reports related to the module. Staff users can also
access reports through specific related areas on the interface, such as by
following the path Producers > Manage Producers > List of Producers and
clicking the History link for the Producer Agent whose uploads they want to
view.

Rosetta integrates its reporting capabilities with those of the Business
Intelligence and Reporting Tools project (BIRT). When users select a report to
view, Rosetta opens a new window that is populated with the BIRT Report
Viewer interface and the contents of the report. Users can print, export, or re-run
the report from this page.

42
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Running a Report: Uploads

To run a report on the upload activity of depositors, click through the
Submissions menu to the Advanced Tools/Run Reports link to open the list of
available reports.

NOTE:
You can also access this report from the following paths: List of Producers
> History > Uploads Report or Administration Home > Monitoring and
Reports > Submissions > Uploads Report.

From the list of reports page, click Uploads Report. A form opens in the BIRT
interface with fields for entering parameters for the report.

The following table describes each field in the Uploads report and how it is
used.

Table 5. Parameters for the Uploads Report

Parameter Description

Start Date The date the reporting period starts. This is required.
End Date The date the reporting period ends. This is required.
Producer Name (not The Producer name. This field will be a drop-down
pictured) menu that lists all existing Producers.

Producer ID The Producer ID. This parameter is optional. By

default, the report is generated for all Producers.

Deposit activity ID The ID of one deposit activity. This field is optional. By
default, the report will be generated for all the deposit
activities in the period.

SIP ID The ID of one SIP. This field is optional. By default, the
report will be generated for all the SIPs that were
deposited within the report period.

After you enter parameters and run the report, BIRT displays the report results.
The report contains two sections:

1 The Summary Information section includes the total number of deposit
activities and the number that succeeded (were moved to the permanent
repository), how many are still being processed, and how many failed.

2 The detail of deposits will be headed by the current reporting period. For
each deposit activity, the list includes the date and time of the deposit
activity, the deposit activity ID, SIP reference ID, name of the Depositor,
name of the Producer, and status of the deposit activity.
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Possible status values are "Draft," "Submitted," "Rejected," "Declined," and
"Approved." A deposit that has been partially approved and partially declined
will have status Approved. A deposit that has been partially rejected will have
the status Rejected.

If the status of a deposit activity is Rejected or Declined, the reason will be
displayed adjacent to the status.

Scheduling Reports

You can schedule a job to email reports. This job is available under each lobby
for the reports of that lobby.

NOTE:
Reports with parameters are not supported.

Managing Scheduling Report Jobs

The Manage Scheduled Jobs page enables you to schedule report jobs. To access
this page, follow the Rosetta drop-down menu path from any lobby, for
example: Producers > Advanced Tools > Schedule Reports.

The Manage Scheduled Jobs page opens to existing scheduled report jobs:

o™
EXLibris Rosetta Management

Home Submissions Data Management Preservation

Home = Producers = Advanced Tools > Producers Reports Job = Manage Scheduled Jobs

Current Time 06/12/2015 10:39:31

Add Job
Name Previous Fire Time | Mext Fire Time Frequency State
1 PRODUCERS Sthedule 05M2/2015 23:04:.00 D6M2/2015 23:.04.00 Ewvery 1 hour/s Mormal View Edit Delete
2 Producer Schedule Reports  05M2/2015 23:41:00  08M2/2015 14:41:00 Ewvery 1 hour/s MNormal View Edit Delete
Back Refresh Restart Scheduler

Figure 17: Manage Scheduled Jobs (Scheduled Report Jobs List)
This page enables you to monitor the status of each scheduled report job and
perform the following tasks:

B Add anew job - For more information, see Adding a Scheduled Report Job
on page 46.

B View a job’s details — Click the View link next to the job you want to view.

B  Modify a job — For more information, see Modifying a Scheduled Report
Job on page 48.
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®  Execute a job — Click the Run Now link to run a job manually.

In addition, you can cancel a job. For more information, see Cancelling a
Scheduled Report Job on page 49.
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Adding a Scheduled Report Job

This task allows you to create a new scheduled report job.

To add a Scheduled Report job:

1 Click the Add job button on the Manage Scheduled Jobs page.

The Job Details page opens.

Hourly
Daity
Waskly
Maonthly
Advanced

Report Name
Mailing List

Back

O™
ExLibris Rosetta Management

Submissions Data Management Preservation

Home > Producers = Advanced Tools = Producers Reports Job = Job Details

El Job Parameters

* Name [Producer Schedule Reports
Start At
Time 10 v 53
Date 06 ¥ December ¥ 2015 v B -
Repeat
% |ndefinitely
Until
0 ¥ December ¥ 2015 v [~
Perform this task :
Every |4 v  Houris
Material Flow List ¥ Format | DOCX v
0items selected Add Remove all Add all
Wictoria Holmes +
INS00 MZ Department +
Refresh

Figure 18: Job Details (Scheduled Report Job)

2 Enter a name for the scheduled Report job in the Name field.

3  Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.
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4  To configure hourly, daily, weekly, and monthly intervals:
a  Use the following table to configure the common interval fields:
Table 6. Common Interval Fields

Section Field Description

Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely | Select this option to run the job indefinitely.

Until Select the month, day, and year from the drop-down
fields to specify the date at which to stop running the
job.

NOTE:

After this date, the state of the job will change
from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 7. Interval-Specific Fields

Type of Perform Description

Interval  this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

5 Complete the required fields in the Job Parameters pane.
6 Click the Apply button to add the job to the list of scheduled report jobs.
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Modifying a Scheduled Report Job

This task allows you to modify the details for an existing scheduled report job.

To modify a Scheduled Report job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the job that
you want to modify.

The Job Details page opens.

™
ExLibris Rosetta Management
m Submissions Data Management Preservation
Home = Producers = Advanced Tools = Preducers Reports Job = Job Details
Mame  Producer Schedule Reports Frequency  Every 1 hour/s Previous Fire Time M2/2015 23:41:00
Role Repository From Date  02/12/2015 14:41:00 Next Fire Time DEM2/2015 14:41:00
State Mormal Until Date
Hourly
Daity Start At
Weekly Time 14 ¥4 v
Monthly Date 02 ¥ | December Y 2015 v |6 -
Adwanced
Repeat
& |ndefinitety
Undil
08 ¥ | December ¥ 25 v -
Perform this task :
Every 9 v Hourls
El Job Parameters
Report Name Material Flow List ¥ Format FDF b
Mailing List 1 items selected Add  Remove all Add all
I Victoria Holmes = | IM500 MZ Department +
Back Refresh unschedule [TTTd g

Figure 19: Job Details Page (Scheduled Report Job)

2 Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.

3 To configure hourly, daily, weekly, and monthly intervals:
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a  Use the following table to configure the common interval fields:
Table 8. Common Interval Fields

Section Field Description

Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely Select this option to run the job indefinitely.

Until Select the month, day, and year from the drop-down
fields to specify the date at which to stop running the
job.

NOTE:

After this date, the state of the job will change
from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 9. Interval-Specific Fields

Type of Perform Description

Interval  this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

4 Complete the required fields in the Job Parameters pane.

5 Click the Apply button to add the job to the list of scheduled report jobs.

Cancelling a Scheduled Report Job

Cancelling a job allows you to postpone the execution of job indefinitely without
deleting it from the system.

NOTE:
The Unschedule option will not be available when the state of the job is
Not Running.
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To cancel a Scheduled Report job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the job that
you want to modify.
The Job Details page opens.

2 Click the Unschedule button.
The state of the job should change to Not Running.

Reports Available in Rosetta

Additional reports available in Rosetta may not be set up in your system. The
full list includes the following:

ALTERNATIVES_EVALUATION on page 52
APPLIBRARY on page 52
APPLICATION_LIBRARY_EVENTS on page 52
AUTO_EVALUATION on page 52
AUTO_EVALUATION_PER_REP on page 52
BIRT_GENERAL_PARAMETERS on page 52
BITSTREAM_VIEW on page 52
CLASSIFICATION_LIBRARY_EVENTS on page 52
CLASSIFICATIONPROPERTY on page 52
COMMITS_TO_PERMANENT_BY_TYPE on page 52
DELETED_IEs on page 53
DEPOSIT_ACTIVITIES_PER_MTF on page 53
DEPOSIT_ACTIVITIES_PER_MT on page 53
DEPOSIT_ACTIVITY_EVENTS on page 53
DEPOSIT_ACTIVITY_HISTORY on page 53
EVALUATION_RESULTS on page 53
EVENT_KEYS on page 53

EVENT_STATISTICS on page 53

EVENTS on page 53
EXTRACTOR_LIBRARY_EVENTS on page 53
FILE_TYPE_GROUPS_IN_PERMANENT on page 53
FORMATAPPLICATIONS on page 54
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FORMATS_BREAKDOWN on page 54
FORMATS_PER_CLASSIFICATION_GROUP on page 54
FORMATLIBRARY on page 54
FORMAT_LIBRARY_EVENTS on page 54
FORMATRISKS on page 54
HOMEPAGE_DASHBOARD on page 54

IE_EVENTS on page 55

IES_BY_SIP_ID on page 55

IES_PERMANENT_LIST on page 55
IES_TO_BE__DELETED on page 55
INTELLECTUAL_ENTITIES_DELIVERED on page 55
MANUAL_EVALUATION on page 55
MATERIAL_FLOW_LIST on page 56
METADATA_FORM_LIST on page 56
MOST_VIEWED_OBJECTS on page 56
NEW_MONOGRAPHS_IN_PERMANENT on page 56
NEW_PERIODICALS_IN_PERMANENT on page 56
PERMANENT_INDEX on page 56
PROCESS_EXECUTION_HISTORY on page 56
PRODUCER_DEPOSITS on page 56
PRODUCER_GROUP_DEPOSITS on page 56
PRODUCER_PROFILES_LIST on page 56
PRODUCERS_LIST on page 56
REPOSITORY_STATS_A on page 57
REPOSITORY_STATS_B on page 57
REPOSITORY_STATS_C on page 57
REPOSITORY_STATS_D on page 57

RISKLIBRARY on page 57
SIP_PROCESSING_STATS_PIE on page 57
SIPS_STATS on page 57
SUBMISSION_JOB_DETAILS on page 57
TOTAL_PRODUCER_GROUP_DEPOSITS on page 57
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USER_DETAILS on page 57

ALTERNATIVES_EVALUATION

Description: The list of Preservation evaluations with plan ID and alternative
1D.

APPLIBRARY
Description: Application Library information (prsv00.HPRAPPLIBRARY).

APPLICATION_LIBRARY_EVENTS
Description: All events related to the Application Library.

AUTO_EVALUATION

Description: The results of the automatic evaluations.

AUTO_EVALUATION_PER_REP

Description: The results of the automatic evaluations per representation.

BIRT_GENERAL_PARAMETERS
Description: All BIRT general parameters.

BITSTREAM_VIEW

Description: The BitStream information (rep00.HDEBITSTREAMREEF) that
allows the viewer to run reports based on this information

CLASSIFICATION_LIBRARY_EVENTS
Description: All the events related to the Classification Library.

CLASSIFICATIONPROPERTY

Description: The classification group’s significant mapping properties
(including mapping to F fields) (prsv00.HPRCLASSIFICATIONPROPERTY).

COMMITS_TO_PERMANENT BY_TYPE

Description: The number of commits to the permanent repository by object type.

52
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DELETED_IEs

Description: Lists all IEs that have been deleted or purged within a given time
frame.

DEPOSIT_ACTIVITIES_PER_MF

Description: The amount of deposit activities per material flow.

DEPOSIT_ACTIVITIES_PER_MT

Description: The number of deposit activities per material type.

DEPOSIT_ACTIVITY_EVENTS

Description: All the events for each deposit activity.

DEPOSIT_ACTIVITY_HISTORY

Description: All the deposits so far with minimal information.

EVALUATION_RESULTS

Description: The evaluation results.

EVENT_KEYS
Description: The keys for the events stored in the EVENTS view.

EVENT_STATISTICS

Description: The statistical information gathered by the statistical analyzer for
the events as listed in the events spreadsheet.

EVENTS

Description: All the events in the system.

EXTRACTOR_LIBRARY_EVENTS

Description: Events related to the Extractor Library.

FILE_TYPE_GROUPS_IN_PERMANENT

Description: The types of the various files with quantities and percentage.
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FILES_IGNORED - FILE_EXTENSION_MISMATCH

Description: Number of files per format ID that were ignored by the File
Extension Mismatch rule.

FILES_IGNORED - MD_ERROR

Description: Number of files per format ID that were ignored by the MD Error
rule.

FORMATAPPLICATIONS

Description: The Format/Application connection
(prsv00.HPRFORMATAPPLICATIONS).

FORMATS_BREAKDOWN

Description: List of file formats and their occurrence throughout the repository.

NOTE:
Refreshed every 12 hours.

FORMATS_PER_CLASSIFICATION_GROUP

Description: The association of a format to a classification group

NOTE:
Refreshed every 12 hours.

FORMATLIBRARY
Description: Format Library information (prsv00.FORMATLIBRARY).

FORMAT_LIBRARY_EVENTS

Description: Events related to Format Library.

FORMATRISKS

Description: Risks per format.

HOMEPAGE_DASHBOARD

Description: The information presented to the user on the home page:

m  SIPs Having Technical Issues
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SIPs Waiting For Approval
SIPs Waiting For Arrangement
SIPs Waiting For Assessment
Deposit Activities

Files In Permanent

Active Producers

IE_EVENTS

Description: Events for an individual intellectual entity. Parameter = IE 1D.

IES_BY_SIP_ID

Description: The intellectual entities for a given SIP.

IES_PERMANENT_LIST

Description: The list of IEs with their URLs in the permanent repository.

IES_TO_BE__ DELETED

Description: All IEs that are about to be deleted in a given time frame due to
retention policies.

INTELLECTUAL_ENTITIES_DELIVERED
Description: Lists key details about access to each digital object:
m PID
m Title
B End user ID accessing the object
B Date and time of access
u

End user ID accessing the object (quest for users that are not logged in)

NOTE:
There are two versions of this report. One contains user details, but is
hidden in Rosetta unless configured in the BIRT report mapping table to
appear, and the other is anonymized.

MANUAL_EVALUATION

Description: The manual evaluation results.
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MATERIAL_FLOW_LIST

Description: A list of the material flows currently defined in the system.

METADATA_FORM_LIST

Description: The metadata forms available in the system.

MOST_VIEWED_OBJECTS

Description: A list of viewed objects ordered by the number of views.

NEW_MONOGRAPHS_IN_PERMANENT
Description: Monographs (material type = "MON").

NEW_PERIODICALS_IN_PERMANENT
Description: Periodicals (material type = ‘PRD’).

PERMANENT_INDEX

Description: The permanent index table which lists all objects stored in the
permanent repository.

PROCESS_EXECUTION_HISTORY

Description: The history of all the existing processes in the system with their
statuses.

PRODUCER_DEPOSITS
Description: All the deposits performed so far.

PRODUCER_GROUP_DEPOSITS

Description: All the deposits with a field showing to which Producer group the
Depositor belongs.

PRODUCER_PROFILES_LIST

Description: All existing Producer profiles.

PRODUCERS_LIST

Description: All the Producers currently in the system.
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REPOSITORY_STATS_A

Description: The number of files for groups of different sizes.

REPOSITORY_STATS_B
Description: The list of MIME types and the number of files in each type.

REPOSITORY_STATS_C

Description: Information regarding quantities in the system.

REPOSITORY_STATS_D

Description: Shows numbers regarding the permanent preservation.

RISKLIBRARY
Description: The risks library (prsv00.HPRRISKLIBRARY).

SIP_PROCESSING_STATS_PIE

Description: The number of SIPs in each SIP processing stage.

SIPS_STATS

Description: All the SIPs currently in the system. This is used for the report SIPs
- Status and Events. The report shows the totals and the details for each stage in
the system.

SUBMISSION_JOB_DETAILS

Description: No OOTB report (view only). Contains submission job details
including the load directory, generated SIPs and their respective statuses.

TOTAL_PRODUCER_GROUP_DEPOSITS

Description: The counts of deposits for each Producer group.

USER_DETAILS

Description: Information about the user, roles, and roles parameters currently in
the system.
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Submission Information Package (SIP)
Overview

This section contains:

B  Understanding SIP Statuses and Stages on page 59
B System Reports on page 62

B SIP Processing Flow on page 65

Understanding SIP Statuses and Stages

A SIP’s status and stage define its orientation in the SIP Processing workflow.

B Status determines where in the Rosetta interface the SIP can be found and
which actions can be carried out on the SIP.

B Stage defines the node that the SIP has completed.

NOTE:
Stage is relevant only while the SIP is in the Repository module. There are

no different stages for a SIP in the Deposit module or in the Permanent
module (AIP).
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The following table describes the different stages and statuses of a SIP:

Module

Deposit

Stage

Status
Draft

Table 10. SIP Stages and Statuses

Description

The SIP has been created by a Producer Agent
but has not yet been submitted. (The Producer
Agent has clicked Save in the Deposit
workflow.)

Declined

The SIP has been declined by the system,
Technical Analyst, Assessor, Arranger, or
Approver, and the Producer Agent cannot re-
submit it.

Rejected

The SIP has been rejected by the system,
Technical Analyst, Assessor, Arranger, or
Approver, and the Producer Agent can re-
submit it.

Created

The SIP has been submitted by the Producer
Agent and is waiting for loading into the
Repository module.
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Module

Repository

Stage

Error Stage
(Loading,
Validation etc.)

Table 10. SIP Stages and Statuses

Status

In
Technical
Analyst

Description

The SIP has failed in one of the following
system stages in the Repository module and is
waiting to be handled manually by the
Technical Analyst:

1 Loading
2 Validation Stack:

Virus Check
Format Identification
Technical Metadata Extraction

Fixity

Risk Extraction
3 Bytestream
4 Enrichment

5 To permanent

Loading

Active

The system has completed loading the SIP
from the Deposit into the Repository stage

Validation Stack

Active

The system has completed validating the SIP
through the Validation Stack

Bytestream

Active

The system has completed extracting
bytestream(s) from the files. (Performed only
when there are container files such as ZIP files
or multiple images.)

Enrichment

Active

The system has completed enriching the SIP
with access copies (according to rules) and/or
with descriptive metadata from external
systems.

To Permanent

Active

The system has finished loading the SIP into
the permanent repository.

Assessor

In Human
Stage

The SIP is in the Assessor work area waiting
for user actions.

Arranger

In Human
Stage

The SIP is in the Arranger work area waiting
for user actions.

Approver

In Human
Stage

The SIP is in the Approver work area waiting
for user actions.
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Table 10. SIP Stages and Statuses

Module @ Stage Status Description

Permanent | - Finished The SIP is in the Permanent repository (AIP).

On the Management homepage dashboard, SIPs In Process refer to SIPs that
have all the following characteristics:

B have not reached the permanent repository
B have not been rejected/declined

B are not waiting in a work area.

System Reports

All SIP stages and statuses are kept in the database for reporting and tracking
purposes. Two system reports can be used to get this information:

m  SIPs Dashboard
B Find a SIP (by SIP ID or by Deposit Activity ID)

SIPs Dashboard

Available from Home > Submissions > Run Reports > SIPs Dashboard.
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SIPs Dashboard

Walting fod re-submission from
4

Producer dgentis]

Curranty Progesiing
Rasnber of Med. 1

Torw ses n VB D

Maduls

Total

Mumbsee of SPs

140
Eind » SIF

Deposit

Status

Mumber of 5FPs

1
[
an

Repository

SIF2 In Process
Qeakiia Miimbiar <4 SiP&
in process 2

Toral

SIPs in Techrecal Anadyst
Mumber of 5IPs

16

SIPs in Manusl Assesamant Stages

Stage Muambar of SiFs
o
Total 16
Permanent
Totnl gize in MB Hursdser of prederved files; Humber of 8iPa;
6538 4053 g8
Figure 20: SIPs Dashboard Report

The SIP dashboard displays summary information about SIPs by module.
Information includes the number of SIPs in various stages and statuses.

Find a SIP

Available from Submissions > Advanced Tools > Run Reports, the Reports List
page allows you to view reports for SIPS based on SIP ID or deposit activity ID
(see Submissions Reports List Page on page 64).
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Home = Submissions = Advanced Tools = Report

Reports List

Report Name Description
Lploads Report (confiqgurable ) Linkto the Report of Deposit Activities for a given date range

SIPs Dashboard The report displays how many SIPs are currently in each stage

Find a SIP by SIP D The report provide details for a given SIF 1D

Find a SIF by Deposit Activity [0 The report provide details for a given Deposit Activity 1D

Figure 21: Submissions Reports List Page

From the Reports List page, click Find a SIP by SIP ID to return a report of a
specific SIP. To return a report by deposit activity ID, click Find a SIP by
Deposit Activity ID. Enter the SIP ID or the deposit activity ID into the
Parameters field, and Rosetta returns the report on the Detail Report page (SIP
Detail Report on page 65)
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Figure 22: SIP Detail Report

The SIP detail report provides general information about SIP module, status,
and stage. The report also displays data about the SIP’s files, structure, content,

and history, among other things.

SIP Processing Flow

The following diagram illustrates the different statuses and stages of a SIP and
the applicable transitions between them during SIP Processing;:
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SIP Process Flow
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Figure 23: SIP Process Flow Diagram

NOTE:

The stage is updated after a process has been completed, so a SIP in the
“Loading” stage has actually completed loading and is waiting for the
validation stack.
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Part Il

Deposit Managers

This part contains the following sections:

Section 5: Understanding Deposit Managers on page 69
Section 6: Configuring Deposit Control Settings on page 71
Section 7: Configuring Metadata Forms on page 73

Section 8: Configuring Material Flow Infrastructure on page 85
Section 9: Access Rights on page 125

Section 10: Retention Policies on page 143

Section 11: Managing Generic Material Flows on page 151

Section 12: Managing Generic Producer Profiles on page 161

Section 13: Managing Material Flows Associated with a Producer Profile
on page 167

Section 14: SIP Processing, Configuration, and Routing Rules on page 173
B Section 15: OAI-PMH Harvester on page 193
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Understanding Deposit Managers

Deposit Managers are responsible for configuring generic Producer profiles and
generic material flows. (For more information on Producer profiles and material
flows, see the Rosetta Overview Guide.)

Deposit Managers accomplish their tasks by managing the following
components:

B Producer profile’s deposit control settings (For more information, see
Configuring Deposit Control Settings on page 71.)

B Metadata forms (For more information, see Configuring Metadata Forms
on page 73.)

B Material flow infrastructure (For more information, see Configuring
Material Flow Infrastructure on page 85.)

B Generic material flows (For more information, see Managing Generic
Material Flows on page 151.)

B Generic Producer profiles (For more information, see Managing Generic
Producer Profiles on page 161.)

B Material flows associated with a Producer profile (For more information, see
Managing Material Flows Associated with a Producer Profile on
page 167.)

Generic Producer profiles and material flows are automatically assigned to all
Producers when they register in the Rosetta system. The profiles can be
personalized at a later point in time by a Negotiator in order to meet the needs
of specific Producers. (For more information on Negotiators, see Understanding
Negotiators on page 201.)

Deposit Managers are assigned by a User Manager, who registers them and
defines their access. Privileges can be either Typical (without delete privileges)
or Full (with edit and delete privileges).

Deposit Managers’ scope is institutional.
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Configuring Deposit Control Settings

Deposit Managers can configure deposit control settings for generic Producer
profiles. These settings include the following parameters:

B The Producer’s deposit quotas

B  The amount of content to be reviewed by staff users

To configure deposit control settings:
1 On the Management Home page, from the main menu, select Producers.
The Producer page opens.

2 Under Deposit Arrangements, click Manage Producer Profiles. The List of
Producer Profiles is displayed.

3 Locate the Producer profile with which you want to work and click Update.
The Update Producer Profile page opens.

Home = Producers = Deposit Arrangements = Manage Producer Profiles = Update Producer Profile

Profile ID 97308 Created by admin1 Created on 02112012

Profile name Demo Internal  Updated by admin1  Updated on 02/ 02012
Producer - Default

Profile Type Personalized

Producer Profile

* Name |Elen1r:r Internal Producer - Default

Status m Status Date 021042012
* Active Deposits Quota (GB) 100000 * Disk Usage Quota (GB)[100000
* Default 5ampling rate (%) |*||}|3 Fast Track Enabled falze

Cancel Save

Figure 24: Update Producer Profile Page

4  In the Name field, enter the name of the Producer profile.
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5 In the Status drop-down list, select one of the following:

B Active, when you want to begin using the profile immediately (for
example, to associate the profile with a Producer and allow Producer
Agents to deposit content)

B Inactive, when you want to complete profile configuration and begin
using the profile later

6 Inthe Active Deposit Quotas (GB) field, enter the number of gigabytes that
the producer can deposit simultaneously. Set to 0 for no limit.

7  In the Fast Track Enabled drop-down list, select No.

8 In the Disk Usage Quota field, enter the total disk space that is available to
Producer Agents associated with the Producer.

9 In the Default Sampling Rate field, enter the percentage of the Producer
Agent’s content that needs to be reviewed by staff users as follows:

B 100% - All deposited content must be reviewed by Assessors and
Arrangers.

B Any value less than 100% - The specified percentage of content must be
reviewed by an Approver.

NOTES:

B Sampling rates for specific Producers are defined by a Negotiator. For
more information, see Personalizing Producer Profiles on page 219.

B This value takes effect only if the sampling rate on the material flow is
not set and the SIP processing rule approval is set to Approver.

10 Click Save.

Producer Agents associated with the Producer can deposit content as specified
in the deposit control settings.
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Configuring Metadata Forms

This section contains:

B About Configuring Metadata Forms on page 73
Accessing the List of Metadata Forms Page on page 74
Adding a Metadata Form on page 75

Adding Lists of Values to Metadata Forms on page 78

Working with Metadata Forms on page 82

About Configuring Metadata Forms

Deposit Managers configure metadata forms as one of the main components of a
material flow.

After these forms are configured, a Deposit Manager can use them in a material
flow in combination with additional components (such as submission formats
and access rights policies). Each form or component can be associated with
multiple material flows. (See Configuring Material Flow Infrastructure on

page 85)

Metadata forms contain fields that Producer Agents must complete when
depositing content.

Deposit Managers work with metadata forms using the List of Metadata Forms
page (see Accessing the List of Metadata Forms Page on page 74). The
following activities can be performed from this page:

B Adding a Metadata Form on page 75

B Previewing a Metadata Form on page 82

B  Duplicating a Metadata Form on page 82

B Viewing Material Flows Associated with the Metadata Form on page 84
n

Updating a Metadata Form on page 83
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B Deleting a Metadata Form on page 83

Accessing the List of Metadata Forms Page

The List of Metadata Forms page enables Deposit Managers to view the existing
metadata forms and create new metadata forms.

To access the List of Metadata Forms page, from the Rosetta drop-down menu,
click Producers > Advanced Tools > Metadata Form.

The List of Metadata Forms page opens (Figure 25).

.r':.,?."'."' Home = Producers > Advanced Tools = List of Metadata Forms

Filter Al j Find in: | Al ;I Go
Add Metadata Form 1-13 of 13 Forms
Name & Material Flow | Template Created On Updated Cn

4 A g
31/01:20 25/08:20

Wetzdsts Vs 14:13:17 15:05:22
2 Brasil Navy Generic 08/01/20 08/01/201 ew Update Preview More.
= 25434 A0 A FF i
e - = = : - . o 4 A oA A = Hmtm  Brmeis Ve
3 Copy o do Azsocisted  Generic 09/01/2012 02/01/2012 =W Upzatz Fraview More
oSS = = - - -. . b
- Material Flows 07:.58:24 07:58:24
4 Copy of Generic 20820 253008/201 =w Updste Freview Mors
Unpublished = 11-18:12 14:18:12 b
£ Copy of Mo Associated Generic 11/201 1/201 ew Update Preview More.
nipublishead S E = - - . - . v
Unpublished  paterial Flows :20:08 2008
=Back

Figure 25: List of Metadata Forms Page

The List of Metadata Forms page displays columns containing the following
information:

Table 11. List of Metadata Forms Page Columns

Column Description

Name The name of the metadata form
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Table 11. List of Metadata Forms Page Columns

Column Description

Material Flow B The name of the material flow when the
metadata form is associated with only one
material flow

B The Associated Material Flows link when
the metadata form is associated with
multiple material flows

Template The template used for the metadata form.

Created On/Update On The date on which the metadata form was
created or updated

Available action items (no heading) | ® View the form’s design and fields

Update/edit the form’s design and fields

[ ]
B Preview the form as a Producer will see it
[ ]

Delete the form

Adding a Metadata Form

Deposit Managers can add a metadata form to provide Producer Agents with
tields that they use to describe their content.

To add a metadata form:

1 On the List of Metadata Forms page (Producers > Advanced Tools >
Metadata Forms), above the list of the metadata forms, click the Add
Metadata Form button.

The Metadata Form Details page opens to the Design Information tab
(Figure 26).
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.f."-v: ~1 Home = Producers = Advanced Tools = Metadata Form = Metadata Form Details
Type Generic Created on 31/0&/2012 Created by Ex Libriz
Updated on 31/08/2012 Updated by Ex Libriz

Design Information

* Hame |

Description

Form Layout 1 Column

Cancel Preview Save Form

IILI*_I;

Figure 26: Metadata Form Details Page, Design Information Tab
2 Inthe Name field, enter a name (required) for the metadata form. Enter
additional optional information on the Design Information tab.
3 When you are finished, click the Fields Information tab.

The page refreshes with a fields/properties table for entering new elements.
No fields appear yet in the left column.
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.zE,T:'N[ } Home > Producers = Advanced Tools = Metadsts Form = Matadsts Form Detsils
Type Generic Created on 31/08:2012 Created by Ex Libris
Updated on 31/082012 Updated by Ex Libris

Design Information | Fields Information.

Select a field to view/edit: Properties for:
Add Mew Field * Field Mame * Type |T§xtF =] vI
Delete Fields | | Duplicate Field |~ OC Tag [Titi=

* Mandatory Mo Tes Validator | Mo Validstor
Single Line fs Mo ©Yes
Default Value |

Tooltip |
" Label =]
S5awe Field
Cancel Prewview Sawe Form

Figure 27: Metadata Form Details Page, Fields Information Tab

4  Enter information for the new field in the form on the right. (Required fields
are marked with an asterisk.)

NOTES:
B Field Name is for system use and is not displayed to Producer Agents.

B The Label field displays on the Producer Agent’s form. To see the form as
an Agent sees it, click the Preview button.

B The DC Tag drop-down list contains the Dublin Core and DNX tags.
Select the tag that corresponds to each label.

5 Click Save Field. The field label is displayed in the list of existing fields on
the left.

NOTE:
You can edit an existing field at any time by clicking the field label in the
list of fields on the left.

6 Click Save Form. The metadata form is saved to the Rosetta system.
7 Repeat steps 4-5 to add more fields, as needed.

The metadata form is created.
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Design Information | Fields Information

Select a field to view/edit: Properties for: Creator
A How Flaid * Field Hame rzstor * Type
10 % | Cresor Dekse | - DCTag |u'E=L
20 [= w | URL Dekie = Mandatory Mo wYes
i0 [ * | Tme Delee Single Line EMNo Yes
400 [ = * | 158N Deles Default Value |
50 [ » | I5MN  Deke Tooltip |:"EE1:E"
501 [= N Yewr Delee * Label Crestor A |
[l i Noles  Delele =1
Delele Eiclds Code Table Name Locally Defined -1
Cuplicate Field Sawve Field
< Back Prewview

Figure 28: New Metadata Form with Fields

To enable Producer Agents to use the form, Deposit Managers must associate
the metadata form with a material flow (see Associating Material Flow
Components with Material Flows on page 124).

Adding Lists of Values to Metadata Forms

When a metadata form field requires a list of several predefined values for the
user to select from, Deposit Managers can load these values from an Excel
spreadsheet rather than entering them individually.

NOTES:

B Loading these values from Excel spreadsheets is only possible for
subsystems in which creating new tables is allowed.

B The Excel spreadsheet must be formatted as two columns with the left
column containing the labels for the drop-down list and the right column
containing the code corresponding to each value.

B Before you perform the following procedure, make sure your Excel data
references fields of the type radio button, check box, and/or drop-down
list where the code table name is locally defined.
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To load a list of values from an Excel spreadsheet:

1

If you have not done so already, add a field to your metadata form that
requires the drop-down list for which you have an Excel spreadsheet with a
formatted list of values (labels and codes).

Enter properties for all required fields and any optional fields.
For the Type field, select ComboField from the drop-down menu.

The page reloads with an additional Options Fields section below the fields
section (Figure 29).

In the Code Table Name field, select Locally Defined. This tells the system
that you will be loading your own defined values for the drop-down field.

o IERL= S R S I ¥ ]

ey D |

Select a field to view/edit: Properties for: Title
Add Mew Field -
O i oy CFEldlName i Ciype [
4 SHA “OC T y RadioFiekd
0= * | Subject Delete = |T|t|a - Textirea
= * | Creato Dielets * Mandatory Olo (@ Yes Valightor |FieFicid
= * | Frequency Delete Single Line  @yMNo (e Ciat=Fickd
— i PopupFiclkd
O b=ll=1um Delete Default Value | HiddenFickd
= * | ISBN Dialsts Tooltip |Eerial Title / Chechibox
O [= = IssN Delete | Label itle Text - ReadOnly
55 elete PasswordField
O s * | Year Deleta Separator
- * | Ownar zlate Labsl
O —E Celets Code Table |L{:-“ Drefined ]
0O [= Maotes Delete Hame
Save Field

| | Fields Information

Dielete Fields Duplicate Field

El Options Fields

Import

Label Value

Add New Option

Cancel Preview

Figure 29: Metadata Form for New ComboField

5 Click the Import button.
An upload form opens (Figure 30).
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Please upload your file

" File
Language: |Eng|i3h EI

Cancel

| Browse...

Figure 30: Upload Form for Excel File

6 Browse to the Excel file containing the list of field-value pairs.

7  Click the Import button.

The system loads the data and displays it in a list for you to view and

confirm (Figure 31).

Code
ISBM
IS5
=ID
HID

Code Table Rows

Cancel

Description

Intnl Standard Book
Intnl Standard Serial
submission 1D
Metadata ID

Figure 31: Field-Value List for Confirmation

8 Click the Import button if the codes match the values you want and the
description contains the name of the value. (Otherwise, click the Cancel
button and adjust your Excel file.)

The code table field and values display in the Options Fields section of the
Update Form (Figure 32).
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El Options Fields

Export Import
Label Value
1 Intnl Standard Book 15BN Delete
2 Intnl Standard Serial |55 Delete
3 Subrmission (D =D Delete
4 Metadata ID rAID Delete
Lahel Value

Add New Option

Figure 32: Drop-Down Values Imported from Excel

NOTE:
Once you have imported Excel data, you will see an Export button beside
the Import button. You can use this to download an Excel file and edit
values on your PC, then import the file again.

9 Adjust the list as needed by deleting any rows (click the corresponding
Delete text) or by adding an option manually (enter text in the Label and
Value fields below the list and click the Add New Option button).

10 Click the Preview button to see how the field displays in the final form. Use
the Back button to return to editing the page.

11 When the form appears the way you want it, click the Save Form button.

The system implements your edits and returns you to the List of Metadata
Forms.

Generic Lists of Values

Predefined lists of values for use in drop-down fields, radio buttons, and check
boxes are available to Rosetta metadata forms as generic code tables. These
tables can be accessed from the Metadata Forms page.
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To use generic code tables for creating multi-value fields:

1

Follow the instructions for adding a list of values to a metadata form’s drop-
down list. (See Metadata Form for New ComboField on page 79).

For the Type field, enter ComboField.
The page refreshes with the Code Table Name drop-down field available.

Select one of the generic code tables from the Code Table Name drop-down
menu.

Click the Save button.

The new values are added to the metadata form and made available to the
user in the relevant drop-down field.

Working with Metadata Forms

From the List of Metadata Forms, Deposit Managers can perform the following
actions:

Previewing a Metadata Form
Duplicating a Metadata Form
Updating a Metadata Form
Deleting a Metadata Form

Viewing Material Flows Associated with the Metadata Form

Previewing a Metadata Form

Deposit Managers can preview how the metadata form is displayed to Producer
Agents.

To preview a metadata form:

On the List of Metadata Forms page (see Accessing the List of Metadata Forms
Page on page 74), locate the metadata form that you want to preview and click
Preview. The Preview Metadata Form page opens.

To return to the List of Metadata Forms page, click Save.

Duplicating a Metadata Form

Deposit Managers can duplicate a metadata form. This is especially helpful
when creating a new form. It is often faster to duplicate an existing metadata
form and modify it than to create a new metadata form.
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To duplicate a metadata form:

On the List of Metadata Forms page (see Accessing the List of Metadata Forms
Page on page 74), locate the metadata form you want to duplicate and click
Duplicate. The Rosetta system creates a copy of the form.

An exact copy of the metadata form is added to the List of Metadata Forms
page. The Rosetta system automatically labels the new metadata form with the
name Copy of followed by the name of the original metadata form.

Updating a Metadata Form

Deposit Managers can update metadata form details at any time. For example, a
Deposit Manager can add new fields or specify a mandatory field.

To update a metadata form:

1 On the List of Metadata Form page (see Accessing the List of Metadata
Forms Page on page 74), locate the metadata form that you want to update
and click Update. The Update Metadata Form Details page opens.

2 Modify the fields as required.

3 To save your changes and return to the List of Metadata Forms page, click
Save. The List of Metadata Forms page opens.

The metadata form details are updated.

Deleting a Metadata Form

A Deposit Manager can delete a metadata form when it is not being used by any
Producers and the Deposit Manager does not want to maintain the metadata
form.

Deposit Managers cannot delete a metadata form when a Producer Agent is
using it to deposit content. Deposit Managers can delete the metadata form only
after the deposit process is complete and no other Producer Agent is using the
metadata form.

To delete a metadata form:

1  On the List of Metadata Forms page (see Accessing the List of Metadata
Forms Page on page 74), locate the metadata form you want to delete and
click More. Additional options are displayed.

2 (lick Delete. The confirmation page opens.
3 Click OK. The metadata form is removed from the list.

The metadata form is removed from the Rosetta system. Producer Agents can
no longer use this metadata form when depositing content.
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Viewing Material Flows Associated with the Metadata Form

Deposit Managers can view the material flows that are associated with the
metadata form.

To view the material flows:

On the List of Metadata Forms page (see Accessing the List of Metadata Forms
Page on page 74), locate the metadata form for which you want to view the
material flows and click one of the following;:

B The Associated Material Flows link, when multiple material flows are
associated with the metadata form.

B  The name of the material flow, when a single material flow is associated
with the metadata form.

The List of Material Flows page opens. The page displays columns containing
the information described in the List of Material Flows table on page 153. You
cannot update the material flow details.

To return to the List of Metadata forms page, click Save.
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Configuring Material Flow Infrastructure

This section contains:

About Configuring Material Flow Infrastructure on page 85
Configuring Submission Formats on page 86

Configuring Content Structures on page 99

Working with Configuration Files on page 110

Configuring Metadata Profiles on page 120

Associating Material Flow Components with Material Flows on
page 124

About Configuring Material Flow Infrastructure

Deposit Managers can configure the following components of a material flow:

B  Metadata forms (see previous section, Configuring Metadata Forms on
page 73)

B Submission formats (see Configuring Submission Formats on page 86)
Content structures (see Configuring Content Structures on page 99)

®  Copyright boilerplate statements (see Configuring Copyright Boilerplate
Statements on page 113)

B Access rights policies (see Access Rights on page 125)
B Retention policies (see Retention Policies on page 143)

After these components are configured, a Deposit Manager can use them in a
material flow. Each component can be associated with multiple material flows.

Generic material flow infrastructure configured by a Deposit Manager can be
personalized by a Negotiator for the needs of specific Producers (see
Personalizing Producer Profiles on page 85).
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Configuring Submission Formats

Submission formats govern how Producer Agents upload files and what
limitations are applied to these files. Deposit Managers work with submission
formats using the List of Submission Formats page (see Accessing the List of
Submission Formats Page on page 86). The following activities can be
performed using this page:

B Adding an HTTP Load or Bulk Submission Format on page 87
B Adding a Detailed Submission Format on page 89

B Adding an Automated Submission Format for Deposit Through FTP/
SFTP on page 92

B Adding an Automated Submission Format for Deposit Through NFS on
page 94

Viewing Submission Format Details on page 97
Duplicating a Submission Format on page 97
Viewing Material Flows Associated with a Submission Format on page 98

Updating a Submission Format on page 98

Deleting a Submission Format on page 98

Accessing the List of Submission Formats Page

The List of Submission Formats page enables Deposit Managers to view,
activate, duplicate, and delete existing submission formats. In addition, Deposit
Managers can use this page to add new submission formats.

To access the List of Submission Formats page, follow the Rosetta rollover menu
path: Producers > Advanced Tools > Submission Format

The List of Submission Formats page opens (see Figure 33).
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I.-:ij'-_"' Home > Producers = Advanced Tools = List of Submission Formats

Filter: | A j Find: in: | & ;I Go
Add Submission Format | Bulk |=] | Add 1- 5 of & records
Name Material Flow | Description | File definition| Template
Published BasicHTTF Hitp Load Generic View Update Duplicate More.
e — - =
wErErE file upload
2 Unpublished Unpublished Http Load Generic Ve
CErErE HTTF load
3 Detailed CEV Cormma Detailed Generic Vi More.
Separated C5v ¥
Values
4 5taff Medisted. Associstes 'eb Apclet  Bul Generic = Update Duplicate Maore.
Baulke- copy Msterisl Flows Upload -
F orciate FTP Generic View Update Duplicate More.
>

Figure 33: List of Submission Formats Page

The page displays columns containing the following information:

Table 12. List of Submission Formats Page Columns

Column Description

Name The name of the submission format.

Material Flow B The name of the material flow, if the
submission format is associated with only one
material flow

B The Associated Material Flows link, if the
submission format is associated with multiple
material flows

Description A short description of the submission format.

File Definition The file upload method: Http Load, Detailed,
Bulk, FTP/SFTP, or NFS.

Template The submission format type: Generic or
Personalized.

Adding an HTTP Load or Bulk Submission Format

The HTTP load and bulk submission formats limit the file types as well as the
total size and number of files that Producer Agents can upload. (For more
information on submission formats, see Configuring Material Flow
Infrastructure in the Rosetta Overview Guide.)
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To allow Producer Agents to upload one file at a time, Deposit Managers must
add one of the HTTP load formats. To allow Producer Agents to perform bulk
submissions while applying the same general restrictions, Deposit Managers
must add a bulk submission format.

The user interface for configuring the submission format is almost the same for
HTTP load and bulk formats.

To add an HTTP load or bulk submission format:
1  Access the List of Submission Formats page (see Accessing the List of
Submission Formats Page on page 86).

2 Above the submission formats list, in the Add Submission Format drop-
down list, select:

B  HTTP load, when you want to add a submission format for an
individual file

B  Bulk, when you want to add a submission format for a multi-file/bulk
upload (Aurigma licensed users only)

3 Click Add. The Submission Format Editor page opens.

.-". . Home > Producers = Advanced Tools = Submission Format = Update Submission Format
Hame - [0} - Created on 21/08/2012
Created by 2dmini Definition Type HOpSubmissicnFormatBulk  Updated on 21/08/2012
Updated by admin1

IE' Submission Format Details

= Name |
Description d
Max. Humber of Files |1 Min. Number of Files|]
Max File size [MB} |1

Figure 34: HTTP Load or Bulk Submission Format Editor Page

4 Provide the information as requested.

NOTE:
Fields marked with an asterisk (*) are required.

5 Provide allowed extensions for your individual, non-bulk files.
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a In the File Extensions list box, select the file extensions of the file types
that the Producer Agents are allowed to deposit.

b  Click the Right arrow. The selected extensions moves to the Selected
File Extensions list.

¢ Repeat a) and b) until you have selected all the extensions you want.
(Alternately, to select all extensions, click the double-arrow button
between the two boxes.)

6 To save the submission format and return to the List of Submission Formats
page, click Save.

The new format is saved in the Rosetta system. It does not have associated
material flows. To enable Producer Agents to use the submission format for
uploading content, Deposit Managers must associate the submission format
with a material flow (see Associating Material Flow Components with
Material Flows on page 124).

Adding a Detailed Submission Format

The detailed submission format specifies the number and type of files that can
be uploaded as well as the maximum file size of each file type. (For more
information about submission formats, see Configuring Material Flow
Infrastructure in the Rosetta Overview Guide.)

Deposit Managers can add the detailed submission format to apply detailed
restrictions on individual files that Producer Agents upload. For example, a
Deposit Manager can specify the number of files of each type (by adding one file
of a particular type for every file the user should be able to upload of the same
type), and limit the size of the file for each addition.

To add a detailed submission format:

1  On the List of Submission Formats page (see Accessing the List of
Submission Formats Page on page 86), in the Add Submission Format
drop-down list, select Detailed.

2 Click Add. The Detailed Submission Format Editor page opens.
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(817N . L
Home = Producers » Advanced Tools > Submission Format > Update 5

Hame Test F2i l|n] 183380 Created on 21/08/2012
Created by - Definition Type HOpSubFormatDetailed Updated on 31/08/2012
Updated by -

IE' Submission Format Details

ubmissicn Format

* Hame [Test F2i

File Descriptor|Test Submissicn Format - F2i

IE' File Details

Add File
# File Details File Extensions Max File size (MB}

1 Test Submission Format - F3i ireg 100MB Update

Cancel

B

()
ﬂ
in
=
(1]

Figure 35: Detailed Submission Format Editor Page

In the General Information pane, provide the general information as

requested.

In the File Details pane, click Add File. The Add File Details page opens.
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Home = Producers = Ady

Hame
Created gn 21/08/2012
Updated on 21/08/2012

File Details

ranced Tools » Submission Format = View
Description - In}
Created by =dmin Definition Type HOpSub

Updated by =

File Descriptor |

Mandatory (FiNe Oves

omissIcn

Max File size |r-;1E|}|1

File Extensions

File Location ||_::3|

Selected File Extensions

[

(u)
(=]
_"

in

[ R R
=]

[ SR R ]

8

LTUR TUR TR T R Wh R W% R W

[ ]
0

-

Cancel

Submission Format Details

other fields.

Figure 36: Add File Details Page

the Producer Agents can deposit.

File Extensions list.

Enter a File Descriptor value and change any of the default values in the

In the File Extensions list box, select the file extensions of the file types that

Click the Right arrow. The selected extensions are displayed in the Selected

NOTE:

To select multiple extensions, hold CTRL while selecting the extensions.

8 Click Save. The Detailed Submission Format Editor page opens.

9 C(lick Save again. The detailed submission format is added to the Rosetta

system.

To enable Producer Agents to use the submission format for uploading content,

Deposit Managers must associate the submission format with a material flow
(see Associating Material Flow Components with Material Flows on

page 124).
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Adding an Automated Submission Format for Deposit
Through FTP/SFTP
Deposit Managers can configure an automated submission format to upload

files from a predefined location on a Producer Agent’s server to the Rosetta
system. The Rosetta system uploads content through FTP/SFTP.

To add an automated submission format for deposit through FTP/SFTP:

1

On the List of Submission Formats page (see Accessing the List of
Submission Formats Page on page 86), in the Add Submission Format
drop-down list, select FTP or SFTP.

Click Add. The Submission Format Editor page opens.

E\']"' Home = Froducers * Advanced Tools > Submission Format = Update Submission Format
Name - 10 - Created on 21/08/2012
Created by =zdmini Definition Type HDpSubmizssionFormatDpsFTR Updated on 21/08/2012
Updated by dmin?
El Submission Format Details
" Name |
Description =]
Max. Number of Files |1 Min. Number of Files |1
* Server | * UserMame |
* Port | * Password [
Sub-directory | Handling Method |~:.-,-5 j
Max File size (MB) |1 Allow Mavigation |T'_5 j

Figure 37: FTP/SFTP Automated Submission Format Editor Page

3 Complete the fields as described in the following table:

Table 13. FTP/SFTP Automated Submission Format Editor Page Fields

Field Description

Name The name of the submission format.

Description The description of the submission
format.

Max.number of files The maximum number of files that
associated Producer Agents can deposit.
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Table 13. FTP/SFTP Automated Submission Format Editor Page Fields

Field Description

Handling method

Determines whether the files needs to be
deleted from the server when the deposit
process is finished:

B move - The files are uploaded to the
Ex Libris Rosetta system and then
deleted from the server.

B copy - the files are uploaded to the Ex
Libris Rosetta system and are not
deleted from the server.

User name

The valid user name to access the files.

Password

The valid password to access the files.

Max.file size

The maximum file size that associated
Producer Agents can deposit.

Min.number of files

The minimum number of files that
associated Producer Agents must

deposit.

Server

The host name of the server on which the
files are located.

Port

The server port to be used to access the
files.

Subdirectory

The location of the files on the server. A
forward slash before a given path
indicates that the path is absolute, while
a path without a leading forward slash
indicates that the sub-directory is
relative to the FTP user's home directory.

NOTE:
If Deposit Managers leave this
field empty, the Rosetta system
prompts the Producer Agent
depositing content for the
location.
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Table 13. FTP/SFTP Automated Submission Format Editor Page Fields

Field Description

Allow Navigation

Indicates whether the user can navigate
to the SIP files located in the subfolders
of the specified FTP/SFTP server. The
following values are valid:

B True — Navigation to SIP files in
subfolders is allowed.

B False — Navigation is not allowed and
SIPs only in the FTP/SFTP server
folder are available for deposit.

4 Click Save. The automated submission format is added to the Rosetta

system.

To enable Producer Agents to use the submission format for uploading content,
Deposit Managers must associate the submission format with a material flow
(see Associating Material Flow Components with Material Flows on

page 124).

Adding an Automated Submission Format for Deposit

Through NFS

Deposit Managers can configure an automated submission format to upload
files from a library’s computer to the Rosetta system.

The Rosetta system uploads content through NFS.

To add an automated submission format for deposit through NFS:

1 On the List of Submission Formats page (see Accessing the List of
Submission Formats Page on page 86), in the Add Submission Format

drop-down list, select NFS.

2 Click Add. The Submission Format Editor page opens.
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Updated byadmint

Home = Producers = Advanced Tools » Submission Format » Update Submission Format
Hame Internal NF3 1D 100 Created on 18/04/2014
Created by adminf Definition Type Updated on18/04/2014

HDOpSubFormatDpsMFS

El Submission Format Details

File Extensions

* Name [Internal NFS
Description MFS Acquiring
Handling Method Oymove (@ copy Allow Navigation
MF5 Path lm Absolute/Remote streams O
Sub-directory l— Max. Number of Files IW
Min. Number of Filesi Max File size [(MB}

Selected File Extensions

Adm
Ids
Zgp

Jgpp
abd
adc

Cancel

Figure 38: NFS Automated Submission Format Editor Page

3 Complete the

Table 14

fields as described in the following table:

. The NFS Automated Submission Format Editor Page Fields

Field Description

Name

The name of the submission format.

Description

The description of the submission
format.

Handling method

Determines whether the files needs to be
deleted from the server when the deposit
process is finished:

B move - The files are uploaded to the

Ex Libris Rosetta system and then
deleted from the server.

B copy - the files are uploaded to the Ex
Libris Rosetta system and are not
deleted from the server.

NEFS Path

The path of the files to be uploaded from
a local computer.
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Table 14. The NFS Automated Submission Format Editor Page Fields

Field Description

Sub-directory The location of the files on the computer.

NOTE:
If the Deposit Managers leave this
field empty, the Rosetta system
prompts the Producer Agent
depositing content for the

location.

Min.Number of files The minimum number of files that
associated Producer Agents must
deposit.

Allow Navigation Indicates whether the user can navigate

to the SIP files located in the subfolders
of the specified NFS path. The following
values are valid:

B True — Navigation to SIP files in
subfolders is allowed.

B False — Navigation is not allowed and
SIPs only in the NFS path folder are
available for deposit.

Absolute/Remote streams Check this box if mets:FLocat
references (X1 ink:href) are linked to
files that are not located under the ./
content/streams directory.

NOTE:
File validation (number, size,
extension) will be disabled if this
box is checked.

Max.number of files The maximum number of files that
associated Producer Agents can deposit.

Max.file size (MB) The maximum file size that associated
Producer Agents can deposit.

File Extensions The list of available extensions.

Selected File Extensions The list of extensions that were selected
from the File Extensions list box.

4 In the File Extensions list box, select the file extensions of the file types that
the Producer Agents can deposit.
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5 Click the Right arrow. The selected extensions are displayed in the Selected
File Extensions list.

NOTE:
To select multiple extensions, hold CTRL while selecting the extensions.

6 Click Save. The automated submission format is added to the Rosetta
system.

To enable Producer Agents to use the submission format for uploading content,
Deposit Managers must associate the submission format with a material flow
(see Associating Material Flow Components with Material Flows on

page 124).

Viewing Submission Format Details

Deposit Managers can view the submission format details, such as the name,
description, and settings for files that Producer Agents can upload.

NOTE:
Deposit Managers cannot update the details while viewing them.

To view the submission format details:

On the List of Submission Formats page (Producers > Advanced Tools >
Submission Format), locate the submission format you want to view and click
View. The View Submission Format Details page opens.

For a description of the fields on this page, see List of Submission Formats Page
on page 87.

Duplicating a Submission Format

Deposit Managers can duplicate a submission format. This is especially helpful
when creating a new submission format. It is often faster to duplicate an existing
submission format and then modify it, than to create a new submission format.

To duplicate a submission format:

On the List of Submission Formats page (Producers > Advanced Tools >
Metadata Form), locate the submission format you want to duplicate and click
Duplicate. The Rosetta system creates a copy of the format.

An exact copy of the submission format is added to the List of Submission
Formats page. The Rosetta system automatically labels the new submission
format with the name Copy of followed by the name of the original submission
format.
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Viewing Material Flows Associated with a Submission
Format

Deposit Managers can view the material flows that are associated with a
submission format.

To view the material flows:

On the List of Submission Formats page (see Accessing the List of Submission
Formats Page on page 86), locate the submission format for which you want to
view the material flows and click the Associated Material Flows link.

The List of Material Flows Per Submission Format page opens. The page
displays columns containing the information described in Table 18. You cannot
update the material flow details.

To return to the List of Submission Formats page, click Save.

Updating a Submission Format

Deposit Managers can update submission format details at any time. For
example, a Deposit Manager can specify additional file types or change the
number of files that Producer Agents can deposit.

To update a submission format:

1  On the List of Submission Formats page (Producers > Advanced Tools) >
Submission Format.see Accessing the List of Submission Formats Page on
page 86), locate the submission format that you want to update and click
Update. The Update Submission Format Details page opens.

2 Modify the fields as required.

3 To save your changes and return to the List of Submission Formats page,
click Save. The List of Submission Formats page opens.

The submission format details are updated.

Deleting a Submission Format

A Deposit Manager can delete a submission format when it is not being used by
any Producers and the Deposit Manager does not want to maintain the
submission format.

Deposit Managers cannot delete a submission format when a Producer Agent is
using it to deposit content. Deposit Managers can delete the submission format
only after the deposit process is complete and no other Producer Agent is using
the submission format.
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To delete a submission format:

1  On the List of Submission Formats page (Producers > Advanced Tools >
Submission Format), locate the submission format you want to delete and
click More. Additional options are displayed.

2 Click Delete. The confirmation page opens.
3 Click OK. The submission format is removed from the list.

The submission format is removed from the Rosetta system. Producer Agents
can no longer use this submission format when depositing content.

Configuring Content Structures

Content structures define the structure of the package that must be delivered to
Rosetta in order to convert it to a Rosetta-compatible METS.

Deposit Managers work with content structures using the List of Content
Structures page (see Accessing the List of Content Structures Page). The
following activities can be performed using this page:

B Adding a Content Structure on page 100

B Viewing Content Structure Details on page 108
B  Duplicating a Content Structure on page 108
u

Viewing Material Flows Associated with the Content Structure on
page 109

Updating a Content Structure on page 109
Deleting a Content Structure on page 110

Accessing the List of Content Structures Page

The List of Content Structures page enables Deposit Managers to view, activate,
duplicate, and delete existing content structures. In addition, Deposit Managers
can use this page to add new content structures.

To access the List of Content Structures page:

From the Rosetta drop-down menu, select Producers > Advanced Tools >
Content Structure.

The List of Content Structures page opens.
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Home = Producers » Advanced Tools = List of Content Structures
Filter: | Al =l Find: in: &l =]l 6o
Add Content Structure | C &% Loader Ennverter;l {Add; 1- 4 of 4 Records
Narne Type M=terial Flows Crezted On
1 HoF. Simple Set Of Files Azzocigted histeral 1aogyzoqn Mew  Update Duplicate hiore.
Converter Flows 120015 T
2 SoF.Complex  Set Of Files A=zocigted higteral 1092040 ew  Update Duplicate hiore...
Converter Flaws 14:30:15 T
2 METS METS Convertar  A=ssocigted higteral 1ingrz040  ew  Update Duplicate hiore.
Flawsz 14:30:15 ¥
g CEW Comma Separated Associated higterial a0msr2041  ew  Update Duplicate hiore.
Converter Floms 10:16:18 T

Figure 39: List of Content Structures Page

NOTE:
To narrow your view to a subset of what is shown, click the Filter drop-
down arrow and select the type, class, or group you want to see. To find
an existing structure, enter its name or type in the Find field, select an in:
option, and click the Go button.

The table displays the following information:

Table 15. List of Content Structures Page Columns

Column Description

Name The name of the content structure.
Type The type of content structure.
Material Flow B The name of the material flow, if the content

structure is associated with only one material flow

B The Associated Material Flows link, if the content
structure is associated with multiple material flows

Created On The date on which the content structure was created.

Adding a Content Structure

Deposit Managers can add a new content structure to define how metadata
must be converted from its original format to one supported by Rosetta.
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To add a content structure;:

1

5

Access the List of Content Structures page (see Accessing the List of
Content Structures Page on page 99).

In the Add Content Structure drop-down list, select the content structure to
which the original format must be converted.

Click Add. The Content Structure Details page for that format converter
opens.

Enter information in the fields for the format converter you selected. See Set
of Files Converter on page 101, Dublin Core Converter on page 102, XSL
Converter on page 103, METS Converter on page 103, or CSV Content
Structure on page 104 for examples of each format.

Click Save. The content structure is saved in the Rosetta system.

To enable Producer Agents to use the content structure for uploading content,
Deposit Managers must associate the content structure with a material flow (see
Associating Material Flow Components with Material Flows on page 124).

Set of Files Converter

The Set of Files Converter is the simplest and quickest method to load content
into Rosetta. Use this content structure for Ul-based deposits and other non-
structured content.

Id 2 : B

P Creation Date 11/01/2015  Created by
Update Date 110172015 s o
Privacy Level GENERIC Updated by  admin1 Type SetOfFilesCSConverter

Home = Producers = Advanced Tools = Content Structure = Content Structure Details

El Content Structure Details

* Name [SoF.Complex * Status Artive
Create Complex | TTUg T Preservation Type | Preservation Master ¥

Figure 40: Content Structure Form: Set of Files

All fields except Name are populated with default values. Enter a name for the
converter and review and change, if necessary, the default values, using the
descriptions below.

B Name: The name of the content structure.

B Status: The status of the content structure, either Active or Inactive. If the

content structure is Inactive, it cannot be used in a Material Flow.
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B Create Complex: If set to false, Rosetta creates one IE with one
representation and one file for each file in the streams subfolder. If set to
true, Rosetta creates only one IE. Its one representation contains all of the
files in the streams subfolder.

B Preservation Type: A metadata field of the Representation. It should be set
to Preservation Master.

Dublin Core Converter

The Dublin Core Converter is similar to the Set of Files Converter but it allows
users to maintain a relation between specific metadata and filestreams. This is
useful when you want to create multiple IEs with different metadata in one SIP.

A dc.xml file may contain multiple DC records. <record> elements can be
nested in any root element (for example: <records>, <col lection>, etc.).

Home = Producers = Advanced Tools = Content Structure = Content Structure Details

Id - .

AT Creation Date  11/01/2015 Created by
Update Date 11012015 o
F’rFiI'.raI:.‘,r Level GEMERIC Updated by  admini Type  DCCSConverter

El Content Structure Details

* Name Cublin Core * Status Artive

Stream Source doidentifier ¥ Preservation Type | Preservation Master ¥

Figure 41: Content Structure Form: Dublin Core

B Name: The name of the content structure.
B Status: Should be set to active.

B Stream Source: The dc field that references files (one or more) to be ingested.
File location is relative to the SIP's streams subfolder. Absolute NFS paths
and HTTP references are also supported (URL must be a direct link to the
binary file).

NOTE:
The list of available stream source fields can be edited from the Content
Structure Stream Source code table in the administration UL

B Preservation Type: A metadata field of the Representation. It should be set
to Preservation Master.
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XSL Converter

The XSL converter allows users to upload SIPs of any source format in an
automated material flow. This is done by preparing deposits in XML format and
creating an XSL file that can convert the input XML files to DC files. This format
allows customers uploading files to Rosetta to enrich the IEs with metadata
information without the need to create a full, valid Rosetta METS (only DC
information can be provided along with the streams to be uploaded).

s~ Home = Producers = Advanced Tools = Content Structure = Content Structure Details

Id =
Update Date 18/05/2015  Creation Date 15/052015 Created by
Privacy Level GEMNERIC Updated by admini Type

El Content Structure Details

* Name | * Status
Create Complex True ¥ Stream Source

Preservation Ty pe Freservation Master v

* Upload XSL File | Choose File | Ne file chosen

Cancel

admin
XSLCSConverter

Active T
dcidentifierxs

Figure 42: XSL Content Structure Details

The XSL converter definitions are similar to the DC converter with the addition
of the following fields:

Upload XSL File: The XSL file name including full path.

Create Complex: If this field is set to False, Rosetta creates one IE with one
representation and one file for each file in the streams subfolder. If this field
is set to True, Rosetta creates only one IE. Its one representation contains all

of the files in the streams subfolder.

The file extension (.xsl) is validated by Rosetta at the time of creating the
content structure’s instance.

The system performs steps as follows:

1

Using the XSL, it converts the input XML to DC format.

2 The system uploads the DC and stream file(s) based on the information in

the converted DC.

METS Converter

The METS content structure form contains the following fields:
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Home = Producers » Advanced Teools > Content Structure = Content Structure Details
Id 3 Creation Date 20/08/2012 Created by -
Update Date 30/08/2012 Updated by admini Type METSCSConverter

Privacy Level GENERIC

El Content Structure Details

* Hame ||.1E_5 = Diata Pre Conwversion | DefaultPreConve =

" Status |;l.c¢i-.-'s ﬂ

Figure 43: METS Converter Form

B Name: The name of the content structure.

B Status: Should be set to active.

CSV Content Structure

The CSV Content Structure allows users to submit metadata in CSV format,
along with zipped file streams. Rosetta transforms each CSV row into an object
(Collection, IE, Representation, File—depending on the Object type field). The
CSV file should hold all the relevant information for creating the objects. This
can include metadata about the SIP and can also be used to create new
collections.

The CSV Content Structure can be used only in a material flow with system-
defined Detailed CSV or NFS submission format. To use NFES, place the zip file
under the streams directory and the CSV file under the content directory.

The CSV Content Structure Ul requires users to specify a CSV template, which
determines the metadata fields depositors are required to fill. These templates
are managed in the CSV Template U], in the Producers section. For more
information, see CSV Templates on page 106.
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0

Ay Home = Producers = Advanced Tools = Content Structure = Content Structure Details
Id ToEED Creation Date 11/01/2015 Created by admini
Update Date 11/01/2015 Updated by  admini Type CSWVCSConverter

Privacy Level GEMERIC
El Content Structure Details
* Name

C SV Template
Generate CSV Option

[CSV selenium
CSY _Loader_Fields ¥
Mone r
Simple (one |E per file)

Cancel Collections ( Collection per node; |E per file)
Complex (one |E per deposit)

Download C SV Template m

Figure 44: CSV Converter Update Page

The Generate CSV Option field enables staff users to allow Producer Agents to
auto-generate a full CSV file that represents the structure of the uploaded zip
file. According to the selected value, Producer Agents will be prompted to
download an auto-generated CSV file once a zip file has been uploaded. They
will then be able to save their deposit activity as a draft, conveniently edit the
CSV file, add metadata for each object, and upload and submit at a later stage.
The following options are available:

B None - no CSV auto-generation will be available.
B Simple - each file in the zip file will become one IE.

B Collections - like simple, but with each node in the zip file becoming a
collection.

B Complex - the entire zip file will become one IE.

NOTES:

B A physical structure map will be created based on the order of the files in
the CSV file. When using Complex, it may be advisable to use the
Generate Logical Structmap enrichment task to maintain the zip file
structure hierarchy.

B When using Collections, a dcterms: isPartOf field must be added to
the CSV mapping table so that sub-collections are created properly. Three
additional fields may be added with the col lection prefix:

- collection.externalSystem
- collection.externalld
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- collection.description

B The externalSystem and external Id fields must be unique as a pair.

The Download CSV Template downloads a CSV file with all the mandatory
tields defined in the selected mapping table. This can be provided to Producer
Agents when auto-generation is set to None.

CSV Templates

CSV templates include a list of mandatory metadata fields that must be part of a
deposited csv file. This list populates the CSV Template drop-down list in the
CSV Content Structure Ul From the Rosetta drop-down menu, select Producers
> Advanced Tools > CSV Templates.

Home = Producers = Advanced Tools = CSW Templates = CSW Template Details

Template Details

Name CSWVCollectionsExample
Description CSWCollectionsExample - Description
Created By:  John Smith Created on: 10/01/2015 08:13

T s |

1
1

[Te B =r]

il
Updated By:  John Smith Last Update on: 10/01/2015 08:13:19

i

Metadata Fields

SIP -
Collection Publish Collection
IE Title (DC)
Representation
File dn.generalFileCharacteristics fileOriginalPath,
dnx.generalFileCharacteristics fileCriginallams
Cancel
Figure 45: CVS Template - View
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-y ! Home = Producers = Advanced Tools = CSVW Templates = CSY Template Details
Template Details
* Name [CsvCollectionsExample
Description |CSVCD||ECNDHSEJ-!EI’TID|E - Description
Created By: John Smith Created on: 1 2015 DB:13:16
Updated By: John Smith Last Update on: 1 2015 08:13:19
Metadata Fields
sie 0 items selected Remove all Add all
Abstract (DCTERMS) +
Access Rights (DCTERMS) +
Accrual Pericdicity (DCTERMS) +
Alternative (DCTERMS ) +
Audience (MY T
Collection 1 items selected Remove all Add all | Mandatory (when generating collections):
Title (DC}, Is Part Of (DCTERMS)
* Publish Collection — | Abstract (DCTERMS) +
Access Rights (DCTERMS) +
Accrual Periedicity (DCTERMS) +
Allow Navigation +
Altarnative (DCTERMSL + 7
IE 1 items selected Remove all Add all
1 Title (DC) — | Abstract (DCTERMS) +
Access Rights (DCTERMS) +
Access Rights Policy ID (IE) +
Accrual Periedicity (DCTERMS) +
Addracs 1 T
Representation 0 items selected  Remove all Add all
Access Rights Policy ID (REP) +
Content Type +
Delivery Pricrity +
Derived From Id +
Dinital Orininal T
File 0 items selected Remove all Add all Mandatory: File Original Path,
File Original Name
Agent Signature Version +
Agent Version +
Checksum Agent +
Checksum Evaluation +
Charlesum Fualuatinn Datails . 7
Cancel m

Figure 46: CVS Template — Edit

The mandatory metadata fields include both system-level mandatory fields
(such as file original path and file original name, which determine the NFS and
HTTP location of the streams), and user-level mandatory fields, which can
include additional fields the library may require (such as an IE dc:creator field).
System mandatory fields are visible on the right and cannot be changed. To add
or remove a user-level mandatory field, simply drag and drop the requested
field in the multi-select widget.

September 2016 107
Ex Libris Confidential



Staff User’s Guide, Part Il: Deposit Managers
Chapter 8: Configuring Material Flow Infrastructure

NOTES:

B Collection-level mandatory fields are relevant only if the selected CSV
content structure is configured to use collections (Generate CSV
Option=Col lections).

B Preservation Type field default value is Preservation Master.

Viewing Content Structure Details

Deposit Managers can view the content structure details, such as the content
structure format, original format, and mapping table.

NOTE:
Deposit Managers cannot update the details while viewing them.

To view the content structure details:

On the List of Content Structures page (see Accessing the List of Content
Structures Page on page 99), locate the content structure you want to view and
click View. The View Content Structure Details page opens.

~ 1 Home * Producers = Advanced Tools = Content Structure * Content Structure Detsils
Id 104T9E0ETY  Creation Date 31/08/2012 Created by admin?
Update Date 21/08/2012 Updated by =3dmini Type CSVCSConverter

Privacy Level GENERIC

El Content Structure Details

Cancel

Figure 47: Read-Only View of Content Structure Details

For a description of the information displayed on this page, see Table 15 on
page 100.

Duplicating a Content Structure

Deposit Managers can duplicate a content structure. This is especially helpful
when creating a new content structure. It is often faster to duplicate an existing
content structure and then modify it, than to create a new content structure.
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To duplicate a content structure:

On the List of Content Structure page (see Accessing the List of Content
Structures Page on page 99), locate the content structure you want to duplicate
and click Duplicate. The Rosetta system creates a copy of the structure.

An exact copy of the content structure is added to the List of Content Structures
page. The Rosetta system automatically labels the new content structure with
the name Copy of followed by the name of the original content structure.

Viewing Material Flows Associated with the Content
Structure

Deposit Managers can view the material flows that are associated with the
content structure.

To view the material flows:

On the List of Content Structures page (see Accessing the List of Content
Structures Page on page 99), locate the content structure for which you want to
view the material flows and click one of the following:

B The Associated Material Flows link, when multiple material flows are
associated with the content structure.

B  The name of the material flow, when a single material flow is associated
with the content structure.

The List of Material Flows page opens. The page displays columns containing
the information described in Adding a Material Flow on page 153. You cannot
update the material flow details.

To return to the List of Content Structures page, click Save.

Updating a Content Structure

Deposit Managers can update content structure details at any time. For
example, a Deposit Manager can specify another content structure or change the
mapping table.

To update a content structure:

1 On the List of Content Structures page (see Accessing the List of Content
Structures Page on page 99), locate the content structure that you want to
update and click Update. The Update Content Structure Details page opens.

2 Modify the fields as needed.
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3 To save your changes and return to the List of Content Structure page, click
Save.

The system updates the content structure details.

Deleting a Content Structure

A Deposit Manager can delete a content structure when it is not being used by
any Producers and the Deposit Manager does not want to maintain the content
structure.

Deposit Managers cannot delete a content structure when a Producer Agent is
using it to deposit content. Deposit Managers can delete the content structure
only after the deposit process is complete and no other Producer Agent is using
the content structure.

To delete a content structure:

1 On the List of Content Structures page (see Accessing the List of Content
Structures Page on page 99), locate the content structure you want to delete
and click More. Additional options are displayed.

2 Click Delete. The confirmation page opens.
3 Click OK. The content structure is removed from the list.

The content structure is removed from the Rosetta system. Producer Agents can
no longer use this content structure when depositing content.

Working with Configuration Files

Configuration files are text files that enable Deposit Managers to configure
advanced settings for Producers such as metadata configuration and e-mail
formatting. Configuration files can be stored in various formats, including XML
and XSL.

Users access individual files by clicking through paths from the Rosetta
Management Home page. Figure 48 follows the path Producers > Advanced
Tools > Delivery XSL files.
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Home > Producers = Advanced Tools > Configuration Files
1 -4 of £ Files
Filename De=scription Updated Update Date
1 . haslidelivery x2| for printing a image with 25062013 View
delivery_print.xsl metadata
2 heslidigital_entity ==l for dizplaying sip 250602013 Wiew
desoriptive_doasl  descriptive do
3 file_metadata.xsl xsl for displaying file metadata 250682013 View
4 ie.xsl x&l for dizplaving ie metadata 25/06/2013
Back

Figure 48: Delivery XSL Configuration Files

To open a file for editing, click the Edit text of the file’s row. The example below
uses ie.xsl, which allows you to specify how the metadata for IEs should

appear and behave in a delivery situation.

Home = Producers = Advanced Tools = Delivery XSL files = Edit Configuration File

*Filename |ie.x5| Last Modified 25/06/2013

Description |xsl for displaying ie metadata

=7xml version="1.0" encoding="UTF-&"%>

<xzlstylesheet version="1.0"
®mins:dc="http:/'purl.org/dclelementsi1.1/7”
xminzdcterms="http:/purl.org/dciterms’™
=minsxsk="hitpfwerw. w3.org/ 19985 UIMTrans form™
xmins:a="http:/wwrw exlibrisgroup. com/dps/dnx”

<l—x=loutput method="xml" verzion="1.0" encoeding="150-2359-1" omit-xml-declarat
indent="no” media-type="text/htmr/—=
<Xl Stylesheet for generating simple Orgchart—=

=xzltemplate match="""»=
«®zlchooses
<xzlwhen test="/metadatalie_metadatalie-cms"=
«xal for-each select="/metadatalie metadatafie-dc”=

=

Cancel Save

Figure 49: ie.xsl

Once you have opened the XSL page, you can make any alterations to the XSL

and click the Save button to implement the changes.
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Delivery XSLs

Deposit Managers can define how an IE’s metadata will be displayed or printed
for other users by editing XSL files. Different XSL files can be used for IEs,
representations, and files.

For example, a Deposit Manager can edit lines of an XSL file to determine the
exact metadata to be printed with an IE image. While the default print contains
no metadata or additional information, information and additions can be made
available to a file when it prints.

Deposit Managers can configure these files using the Delivery XSLs page. To
reach this page, follow the path Producers > Advanced Tools > Delivery XSL
files.

The Configuration Files page enables you to view the list of available
configuration files and open individual files for editing.

NOTE:
The Configuration Files page differs in content based on the type of file
you select from the Producers > Advanced Tools menu.

Delivery Copyrights Statements

Delivery copyrights statements are displayed to users viewing an IE that has
such a statement associated with its Access Rights policy (see Adding an Access
Rights Policy on page 127 and Figure 61 in that section).

Deposit Managers can add new files or edit existing ones from the
Configuration Files page (Producers > Advanced Tools > Delivery Copyrights
Statements).

Home > Producers = Advanced Tools = Configuration Files

Add File 1-3 of 3 Files

Filename De=cription | Updated by | Update Date
1 copyrights.htmil View Edit Duplicate Delete
2 copyrights/copyrights1.htmil View Edit Duplicate Delete
3 copyrights/copyrights2. htmil View Edit Duplicate Delete

Figure 50: Delivery Copyright Statements List

Delivery copyright statements can be viewed, edited, copied, created anew, and
deleted. All of the options are available from the Configuration Files page for
delivery copyright statements. Deposit Managers can view the list of available
configuration files as well as open individual files for editing. Copyright files

112
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can be added to the list by clicking the Add File button and entering all new
information or by clicking the Duplicate text link of an existing statement that
resembles one you want to create, then editing it for other purposes (Figure 51).

Home = Producers = Advanced Tools = Delivery Copyrights Statements = Edit Configuration File

*Filename |C|:|.p.!||- of CDD}Tith-S-'lCDE‘:) Last Modified -
Description [

Law of the United States (Title 17, U.5. Code) governs the making of
photocopies or other reproductions of copyrighted material.

Under certain conditions specified in the law, libraries and archives

are authorized to furnizsh a photocopy or other reproduction.

One of these specified conditions iz that the photocopy or other
reproduction is not to be "used for any purpose other than private study,
scholarship, or research.”<br<br=

If a user makes a request for or later uses a photocopy or

reproduction for purposes in excess of "fair use”, that user may be liable
for copyright infringement.

Thiz institution reserves the right to refuse to accept a copying order

if, in itz judgment, fulfilment of the order would invohee viclation of

the copyright law. <br=<br=

| have read the above statement and agree to abide by itz restrictions.

Cancel Save

Figure 51: Adding a Statement by Duplicating

Configuring Copyright Boilerplate Statements

Copyright boilerplate statements contain copyright statements displayed to
Producer Agents when they deposit content. Deposit Managers can create
multiple boilerplate statements and then use them in different material flows.

Deposit Managers work with copyright boilerplate statements using the
Boilerplate Statements page (see Accessing the Boilerplate Statements Page on
page 113). The following activities can be performed using this page:

m Editing Boilerplate Statements on page 114

B Viewing Boilerplate Statements on page 114

Accessing the Boilerplate Statements Page

The Boilerplate Statements page enables Deposit Managers to view the list of
boilerplate copyright statements stored in the Rosetta system. In addition,
Deposit Managers can use this page to edit existing boilerplate statements.
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To access the Boilerplate Statements page:

From the Rosetta rollover menu, click Producers > Advanced Tools >
Boilerplate Statements.

The Configuration Files page opens to the boilerplates subgroup.

Home = Producers » Advanced Taols = Configuration Files
File Group: Deposit Configuration ;I Sub-Group: | Boilerplates ;I
1-10of1Files
Filenarne Description Updated by Update Date
1 copyrghtsiboilerplate 1 ktml G wew
Eack

Figure 52: Boilerplate Statements Page

Editing Boilerplate Statements
Deposit Managers can edit an existing boilerplate statement to modity the
copyright statement displayed to Producer Agents when they deposit content.

To edit a boilerplate statement:

1  On the Boilerplate Statements page (Producers > Advanced Tools >
Boilerplate Statements), locate the boilerplate statement you want to
modify and click Edit.

The Edit Boilerplate Statement page opens.

2 Edit the copyright statement as required and then click Save. The updated
boilerplate copyright statement is saved in the Rosetta system.

The updated statement is now displayed to Producer Agents depositing
content.

Viewing Boilerplate Statements

Deposit Managers can view copyright boilerplate statements.

NOTE:
Deposit Managers cannot modify the statements while viewing them.
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To view a boilerplate statement:

On the Boilerplate Statements page (Producers > Advanced Tools > Boilerplate
Statements), locate the boilerplate statement you want to modify and click
View. The View Boilerplate Statement page opens.

Configuring Producer Agent E-mail

Communication between Staff users who review SIP submissions and the
Producer Agents who submit them is automated in the Rosetta system. Some
communications (e-mail) are sent by default, others must be configured by a
Deposit Manager.

Default E-mail to Producer Agents

When a SIP is rejected, declined, or when a SIP is received successfully by the
staging server or accepted for deposit in the permanent repository, Rosetta
sends a confirmation e-mail to the Producer Agent. The default fields that
appear on these reports include the deposit activity ID, Title, Deposit Date, and
Status, as well as the Agent’s name and the URL where the Agent can link to
view the deposit. Further fields that appear on the e-mails:

B For IEs, the PID.

B For each file:
B The applicable identifier (such as ISBN, ISSN, or ISMN)
B  The computed checksum(s)

B The time stamp of the Rosetta activity (that is, the date and time of the
SIP status change)

E-mail notifications can make use of digital signatures if configured by a
Deposit Manager (see Digital Signature on page 77 in the Configuration Guide).

Customizing Display Fields

E-mails are drawn from an XML file defining many of the fields a user might
want to add to the e-mail. All additions and adjustments are made through the
email_to_depositor.xsl file.
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To access this file and make changes to the e-mail:

1 Access the Configuration Files page of the Management module by

following the path Producers > Advanced Tools > Email Configuration.

L

Home = Producers = Advanced Tools = Configuration Files

Filename

.Jxslideposit_activity_status_change
femail_to_depositorxsl

. Jxslideposit_activity_status_change
femail_to_depositor_body.xsl

. Jxslideposit_activity_status_change
femail_to_depositor_preview xs|

.Jxslideposit_activity_status_change
femail_to_depositor_submission.xsl

. Jxsliemails/EmaiToPlanAnahyst.xs

. Jxsliemails
[EmailtddingRepresentation.xsl

. Jxsliemails/EmailProducerReport. sl

Back

1-10 of 13 Files

Description Upd | Update Date

exl.dps.repository. email ToeDepo:
exl.dps.email ToDepositorBody
exl.dps.email ToDepositorPrevi
exl.dps.email ToDepositorSubn

exl. prese.plan.email ToPlanAna

exl.core.inailAddingRepresentat

exl.dps.ray.emailReport ToProdu

P2

25/08/2013 View Edit

25/08/2013 View Edit
25/08/2013 View Edit

23/08/2013 View Edit

25/08/2013 View Edit

25/068/2013 View Edit

Figure 53: Configuration Files for Formatting Deposit-Related E-mail

In the Filename column, find the email_to_depositor.xsl file and click
on it or on the corresponding Edit text link.
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The file opens in an editable window (Figure 54).
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Home > Producers » Advanced Tools = E-mails Configuration > Edit Configuration File

Filename LJSxsl Last Modified 25/0802013
deposit_activity_status_change
email_to_depositonxs]

Description com.exlibris. dps.repositony. email . email TeDepositor

=7xml versicon="1.0" encoding="UTF-8"7> -
=usl:stylesheet xmins:sl="http:/feweow3 . ongl/ 1 59905 L Transform™ version="2.0"
xmins:zes="http:/fwww. w3 org/2001XMLSchema™
xmins:java="com.exlibris. dps.deposit.api. DepositEmai X}SLLHII™=

<xsl:variable name="language” select="//email-data/General-Info/language” /=
=xsl:variable name="depositActivityld™ select="//email-data/General-Info/depositActivityld™ /=
=uslvariable name="css" select="//email-data/General-Info/css™ /=
=xslvariable name="status” select="/'email-data/General-Info/status™ /=
<xsl:wariable name="addressContact™ select="/'email-data/General-Info/addressContact™ />
<xsl:param name="email TeDepositBody™ /=
=usl:output methed="htm!" omitxml-declaration="yes"/>
=izl template match="">
<head>
=title=User Informaticn<title>
=style type="text/css™> LI
=uslvalue-of select="java:getCss{So=s)" /=

Back

Figure 54: Editing a Configuration File

3 Add or edit definitions for any available fields. The following information
can be transmitted if it is added to the XSL file:

®  For each IE in an approved SIP:
m [EPID
m [E title
B For each file in the IE:
B the applicable identifier (that is, ISBN, ISSN, ISMN, and so forth)
B the computed checksum (md5, SHA-256, and CRC32)
m file name
]

the time stamp of the file status change (that is, the date and time the
file status changed to Moved to Permanent)

B For each rejected or declined IE in the SIP and for each IE containing
rejected or declined files:

m theIE PID
B the IE title
B For each file in the IE:
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B the applicable identifier (that is, ISBN, ISSN, ISMN, and so forth)
B the file status (Approved, Rejected, or Declined)

m if the file status is Rejected or Declined, the time stamp of the file
status change (that is, the date and time the file status changed to
Reject or Decline)

Additional E-mail Configuration Files

In addition to the email_to_depositor.xsl file and related XSL files, the
following XSL files are available for editing:

®  EmailProducerReport.xsl: sends deposit report to the Producer

B  EmailProducerWithNoContact.xsl: sends a notification to a Producer that
there are no contacts associated with the account

B EmailUserlsPrimaryContact.xsl: notifies the user that he or she is the
primary contact

EmailUserNew.xsl: sends an acknowledgement confirming a new user
EmailUserRegister.xsl: confirms a user’s registration

EmailUserUpdate.xsl: confirms the update of a user’s information

EmaiToPlanAnalyst.xsl: sends preservation plan information to the
Preservation Analyst

B  EmailAddingRepresentation.xsl: sends an e-mail to the user when a
representation is added to an IE

B EmaillndividualProducerRegister.xsl: confirms the registration of an
individual Producer

B EmailUserDelete.xsl: notifies the user that they are being deleted from the
system

B  EmailUserNewPasswordIndProd.xsl: confirms a new password for an
individual Producer

B EmailUserassigned AsPA.xsl: sent when a user is assigned as a Producer
Agent to a Producer

Most e-mail messages can be previewed by the sender before being sent to the
recipient.

Adding an E-mail Confirmation
Rosetta can be configured to send confirmation e-mail to depositors when
B a SIP has been accepted by the staging server and is being processed or

B a SIP has been approved and its contents sent to the permanent repository.

118 September 2016
Ex Libris Confidential



Staff User’s Guide, Part IIl: Deposit Managers
Chapter 8: Configuring Material Flow Infrastructure

These confirmation emails will be sent if Email Notification is set to true in the
SIP processing configuration for this Material Flow. See SIP Routing Rules on
page 178 for further details.

Configuring Terms of Use

A Terms of Use (TOU) statement appears in the Deposit interface and in the
viewers that render objects in the Rosetta interface. Viewers display a TOU
statement for the institution that owns a displayed object.

Only one TOU file is allowed for each institution. The file can be edited but not
deleted.

To view or edit TOU text for your institution:

1

2

Open the Configuration Files page from the Rosetta menu (Producers >
Advanced Tools > Terms of Use Configuration Files).

The Configuration Files page opens.

Home = Producers = Advanced Tools = Configuration Files

1-10f1Files

Filename Description Updated by = Update Date

1 copyrightsftermsofus Default Terms of Use 141002013 View Edit

Back

Figure 55: Configuration Files Page

To view the text file or edit it, click the relevant link, View or Edit.

The View or Edit Configuration File page opens.
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Home = Producers = Advanced Tools = Terms of Use Config Files = Edit Config File

* Filename \copyrightsftermsofuse.htt  Last Modified  14/10/2013
Description |Default Terms of Use

transitional. dtd™=

=html xmins="http:fwww.w3.org/1999xhtmlI™=

=head=

=meta hifp-equiv="Content-Type™ content="text/html; charset=utf-8" /=
=fitle=Tarms of use=fitle=

=link href="./css/dps.css” rel="siylesheef” type="texticss"™ /=

=link href="_icss/style css” rel="stylesheel” type="text/css™ =
=fhead=

=pody id="popup™=
=div class="ghout\Nrap™
=div class="popHeader =
=div class="glignLeft"==span=Terms of use=/span==/div=

<div class="alignRight><a href="packpage Jsp" tile="Back" gnclick="]

false"=Close=/a==/div=

<IDOCTYPE html PUBLIC “/W3C/DTD XHTIML 1.0 Transitional/EN “hitp:l j

=/div=
=div id="header™=
=div class="aboutContainerL.ogin™> hd

=jma src="./fimages/logo-main.png” alt=""1r=

Cancel Save

3

Figure 56: Edit Configuration File Page

If you selected Edit, you can make edits to the file and click the Save button.
(If you selected View, you do not have a Save button on the page. Click
Cancel or Back to return to the Configuration Files page.)

Configuring Metadata Profiles

A metadata profile defines:

Which metadata elements are mandatory for a given IE

Which validation routines should apply for each of the IE’s metadata
elements

Whether a user can add elements or whether the list of elements that can be
associated with the IE is restricted according to a predefined list
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This section contains the following topics:

B Accessing the List of Metadata Profiles Page on page 121

B Creating a New Metadata Profile on page 122

m  Editing or Duplicating an Existing Metadata Profile on page 122
B Deleting a Profile on page 124

Accessing the List of Metadata Profiles Page

The List of Metadata Profiles page enables Deposit Managers to edit, duplicate,
and delete existing Metadata Profiles. Deposit Managers can also use this page
to add new metadata profiles.

To access the List of Metadata Profiles page:

From the Rosetta rollover menu, click Producers > Advanced Tools > List of
Metadata Profiles.

The List of Metadata Profiles page opens.

(o))
f"."“lr-‘- Horme = Producers = Advanced Tools = List of Metadata Profiles

Finad: in z |All '] Go
Add Metadata Profile 1-4aof 4 racords

Hamg o DescniMion Creaflon Date KodlfDats
1 walidationProfleOne0fF  validstionProfile OnaOH 19032010 19022010 Edd Duplicate Delete
2 wvalidatienProflePeriodic  walidzlionProfilePeriodic 19022010 19092010 Edil Duplicale Dalele
3 validationFrofileBasic  vahdztionFrofilzBasic 11022010 11092010 Edit Duplicate Dalste
4 validationProfile Digitised vzlidztionDigitisedlmage 11022010 11092010 Edit Duplicate Delste

Back

Figure 57: List of Metadata Profiles Page
You can search specifically for a profile using the Find/in search in the row
below the breadcrumb. This searches the existing list for the term you enter.

The table itself displays the profile name and description (as entered by the staff
who created the entry) and the creation and modification dates (system-
generated).

From this page, you can perform the following actions:

B Creating a New Metadata Profile on page 122

B Editing or Duplicating an Existing Metadata Profile on page 122
B Deleting a Profile on page 124
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Creating a New Metadata Profile

To create a new metadata profile:

1 From the List of Metadata Profiles page (Producers > Advanced Tools > List
of Metadata Profiles), click the Add Metadata Profile button (above the
Name column of the table).

The Metadata Profile Editor page opens.

rg:{'n Froducers = Advanced Tools = List of Metadata Frofiles =-Metadata Profile Editor

General information

*MHame: J
*Description: d

Metadata can contain only & Yes  No
listed elements:

E' Descriptive MD Elements

Add Descriptive MD Element

Mo reconds were found
E DX Elemeants

Add DNE Element

Mo recaonds were found

ack E3

Figure 58: Metadata Profile Editor page

2 Enter a name for the metadata profile and a brief description of it in the
fields provided.

3 Add elements to the profile by using the available add buttons and selecting
items from the drop-down fields on the Element Editor pages that open.

4  Click Apply to save the profile and remain on the page or Save to save it
and return to the List of Metadata Profiles page.

Editing or Duplicating an Existing Metadata Profile

Staff Managers can make changes to an existing profile by editing it or by
duplicating it. Duplicating an existing profile allows users to keep the original
profile intact while creating a new profile based on the values entered in the
original.
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To edit or duplicate an existing metadata profile:

1  Access the List of Metadata Profiles page (Producers > Advanced Tools >
List of Metadata Profiles) and find the profile you want to edit.

2 Inthe row of the profile, click the Edit text link if you want to change the
profile, click Duplicate if you want to keep a copy of the original profile and
use its values as a starting point for a new profile.

3 The Metadata Profile Editor page opens. Values for the profile selected
appear on the form. (See figure below.)

t'g:ljn Froducers = Advanced Tools = List of Metadata Profiles = -Metadata Profile Editor
General information
"Hame: [Copy of validationProfile¥abHarest
*Description: Fﬁlidatinnhn:ﬁil:ﬂn:ic =]
A
Metadata can contain ~ (~ Yes & Mo
only listed elements:
E' Descriptive MD Elements
Add Descriptive MD Element
Metadata Element Qualifier Validation Routine Mandatony
1 de:title - - es Edif Delete
2 de:dste - - Tes Edit Deleie
E DX Elements
fAdd DNX Element
DHX Section DNX Key Walidation Routine Mandatorny
1 accessRightsPolicy policyld = Tes Edit Deleie
Back Anply Ea
Figure 59: Metadata Profile Editor - Existing Profile

4 Make changes to any of the editable fields, and add, edit, or delete any of the
descriptive metadata or DNX elements.

5 Click Apply to save, Save to save and return to the previous page (the
Metadata Profile List page). To cancel changes you made and return to the
previous page, click the Back button.
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Deleting a Profile

To delete an existing profile

1 To delete a metadata profile, access the List of Metadata Profiles page
(Producers > Advanced Tools > List of Metadata Profiles) and find the
profile you want to delete.

2 Click the Delete text link of that row.
A Deletion Confirmation page opens.
3 Confirm the deletion by clicking the Confirm button.

The system deletes the profile and returns you to the List of Metadata Profiles
page.

Associating Material Flow Components with
Material Flows

After metadata forms, submission formats, access rights options, retention
policies, and content structure templates are configured, Deposit Managers can
associate these components with material flows. Each component can be
associated with multiple material flows.

For instructions on associating material flow components with a material flow
(or, creating a new material flow), see Adding a Material Flow on page 153.
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Access Rights

This section contains:
B Configuring Access Rights Policies on page 125
B Assigning an Access Rights Policy on page 132

B Access Rights Exceptions on page 134

Configuring Access Rights Policies

Access rights policies define who can view which content under what
conditions. The policies can be applied to entire IEs or to specific representations
of IEs (if, for example, you want to provide staff with access to a high-quality
Preservation Master and the public with a lower-quality, faster-loading
derivative copy). Access rights cannot currently be applied to individual files or
groups of files.

NOTE:
In order to configure access rights policies, you must be assigned either
the Deposit Manager or Data Manager role with the Edit Access Rights
Policies role parameter.

How Access Rights Work
Access rights for IEs and representations are processed as follows:
a A user requests an IE or a representation.
b The system checks the access rights policy for the IE.

¢ If the access rights requirements are not met, the system blocks the IE
and sends a message to the user.

d If the access rights requirements for the IE are met, the system grants
access to the user seeking the IE.
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For the user seeking a representation, the system checks the access rights policy
for the representation. If the access rights for the representation are not met, the
system repeats the access rights check for all additional representations until it
runs through every representation in the IE. All the representations that pass the
Access Rights are displayed. If all are blocked, the system behaves as if the IE's
access rights are not met.

Access Rights as Shared Metadata

Because access rights policies are stored as shared metadata, their configuration
can be accessed from the Metadata Search page. (They can also be accessed from
the Producers > Advanced Tools menu.) The Metadata Search page is used for
searching shared metadata across the Rosetta system.

The following activities can be performed from this page:
B Accessing the Metadata Search Page on page 126

B Adding an Access Rights Policy on page 127

m Editing an Access Rights Policy on page 130
n

Deleting an Expression from an Access Rights Policy on page 131

Accessing the Metadata Search Page

The Metadata Search page enables Deposit Managers to view and add access
rights policies.

To access the Metadata Search page:
1 From the Rosetta drop-down menu, click Producers > Advanced Tools >

Access Rights Policies. The Metadata Search page, populated with the list
of existing access rights policies, opens.
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Figure 60: Metadata Search Page
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Adding an Access Rights Policy

Deposit Managers can add a new access rights policy to the Rosetta system. This
is done through the copyright statement that displays when a user views
content to which this access rights policy applies.

After a policy is added, it can be associated with a material flow.

To add an access rights policy:

1 On the Metadata Search page (see Accessing the Metadata Search Page on
page 126), click Add Shared Metadata Record. The Edit Access Rights

Policy page opens.
Home > Producers = Advanced Too Access Right Policies » Edit Access Rights Exceptions
Copyright Template j
= Description =
When view is restricted -
show the following message =

Ldd Expression

Figure 61: Add Access Rights Policy Page

2 Inthe Copyright Template drop-down list, select the template that must be
used to display the copyright statement.

3 Click Add Expression. The Add Expression page opens.

MID Metadata Type policy : acoessnghts Descripticn
Created by Creation Date

Updated by Update Date

Mew Group i

Operator | egual vI

Valug 1 |

Figure 62: Add Expression Page
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4 In the Criteria drop-down list, select the criterion by which the Rosetta
system must compare the actual parameters of a user with the parameters
you define in the expression. Criteria values are taken from the Access
Rights Key Code Table. Table 16 defines the items you are likely to find in

the list.

Table 16. Expression Criteria

Name Access Is Granted...

User Group to users who belong to this user group, as defined in
their user group field.

User ID to the specific user with this user ID (Rosetta user ID).

IP Range for calls coming from the specified IP range.

Registered User to users who are registered and authenticated by the
PDS module. (Not to users who attempt to access from
outside the institution’s network)

Everyone to everyone.

Concurrent Users

to a certain number of users at a time (IE-level policies
only).

AR Plug-in to users of an access rights plug-in that integrates its
external interface with that of Rosetta.

LDAP User Group List to a user who belongs to the listed group defined in the
institution’s directory and whose credentials are
transferred by LDAP (Lightweight Directory Access
Protocol).

LDAP User Department to a user who belongs to the listed department defined
in the institution’s directory and whose credentials are
transferred by LDAP.

LDAP Tuples if the text string sent through LDAP meets the criterion.

LDAP Course Enrollment | if the text string sent through LDAP meets the criterion.

Moving Wall based on a specified time before/from the selected date.

Select Metadata to choose from any metadata-based IE-
level date field (dc, dcterms, DNX) or Date to specify a
fixed date. Supported time units are years, months,
weeks, and days.

Expiration Date

up until the specified date.

NOTE:

Your selection for Criteria may change the labels for the fields just below
it. Wait to see if the page refreshes before continuing.
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5

In the Operator drop-down list, select an operator (such as equals) to be
used to compare the actual parameters of a content consumer with the
parameters defined in the Value field. The values for operators are
generated by the type of data selected in the Criteria field.

NOTE:

The page reloads when you enter a value that changes the fields below the
active field. For example, IP Range as a Criteria will change the Operator
tield to within or contains; if you select contains, one blank field loads
below the operator field; if you select within, two values load. See

Figure 63 below.

Mew Group i
To Existing Group [
Select Group [3 3

Criteria |IP Range =l
Dperatnrl within E'
Value 1 |
Value 2 |

Cancel m

Figure 63: Adding an Expression to an Existing Group

Finish entering the values. If your policy includes more than one group,
make sure you have the correct group specified in the top portion of the
form.

Click Save. The expression is saved to the group specified.The Edit Access
Rights Exceptions page re-opens.

You can add groups and expressions within the groups until you have
completed a policy. The following figure shows a policy with two groups
and three expressions among them.
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Ay J Home > Producers > Advanced Tools = Access Right Policies. > Edit Acocess Rights Exceptions

________

MID AR_IP_RANGE Metadata Type policy:access Description Accessible from institution

Created by S%YSTEM Creation Date 04/0%v 2012
Updated by SvSTEM Update Date 04,08:2012

Copyright Template copyrights2. htm j
= Description |Aooessible for users from 1=
thin the institution {IP |
When view is restricted =
show the following message =
Add Expressicn
IP Range egual 178.90.1.0 178.90.1.255 Celzte
Group 1 = <
User Group egual Registered Celete
==r Broup =xus| STAFF Dielate
Group 2 el LR S

Cancel Ex

Figure 64: Access Rights Groups and Expressions

IMPORTANT:
Rosetta reads the groups as if an OR logical operator separated them.
Rosetta reads the expressions within the groups as if an AND operator
separates them. So, for the figure above, the user gains access if he or she is
both in the IP range AND a Registered user, or if he or she is in the user

group Staff. Either one of those two groups/conditions will qualify the
user for access.

9 Click Save. The Metadata Search page opens with your access rights policy
included in the list.

The access rights policy now can be associated with a material flow.

Editing an Access Rights Policy

Deposit Managers can edit an existing access rights policy by adding or deleting
expressions.
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To edit an access rights policy:

1 On the Metadata Search page (see Accessing the Metadata Search Page on
page 126), locate the access rights policy that you want to edit and click Edit.
The Access Rights Editor opens.

Hame = Producers = Advanced Tools * Acocess Rlight Policies » Edit Access Rights Exceptions
M AR_EmZalGGE0_FOR_S vZARS Metadata Type policy:accessrighis Dazseription Embargoed for 5
Craraled Iy SVETEM Creation Dale 115473
Updated k=Y STEM Update Data 1147420

Copyright Template

* Description

VWhen view is restricted show the following message

RN

ALdd Exprassion

Group 1 N el 1783

Group 2

Cancel [ 5=ve

Figure 65: Access Rights Editor

The page contains a list of expressions. Each expression defines criteria
(such as an IP address) that a content consumer must meet in order to view
the content object.

2 Do one of the following:

B Add an expression, as described in steps 3 through 8 in Adding an
Access Rights Policy on page 127.

B Delete an expression, as described in Deleting an Expression from an
Access Rights Policy on page 131.

NOTE:
When saving changes to a shared metadata record, the following warning

message appears:

Changes will affect all institutions — Continue?

Deleting an Expression from an Access Rights Policy

Deposit Managers can delete an expression from an access rights policy when
they do not want to use the criteria defined in the expression.
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To delete an expression:

1 On the Access Rights Editor page (see Editing an Access Rights Policy on
page 130), locate the expression that you want to delete and click Delete.
The confirmation page opens.

2 Click OK. The expression is removed from the list of expressions.

The group of content consumers for which the expression was defined can no
longer view the content object.

Assigning an Access Rights Policy

Data Managers can assign an access rights policy to an IE to define who can
view the content and when this content can be accessed. Data Managers can also
assign an access policy to a representation. Because only one access rights policy
can be associated with a representation, if a representation is assigned an access
policy, any existing access rights policy assigned to that representation will be
overwritten and replaced by the current one.

To assign an access rights policy:

1 Conduct a search for the object whose access you want to restrict. From the
Search Results page, click the Info link that corresponds to your object’s row.
The object opens in the Web Editor.

2 Inthe Actions drop-down menu at the bottom right of the page, click Lock
Object and then click the Go button.

The page refreshes with the notice: Locked By: Me.

3 Inthe tree pane, select the IE or representation to which you want to assign
an access rights policy.
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Hame > Submissions > Approval * Assess 51Ps » Metadata List
Intellectual Entity PIDIEZ453 Created on 23052013 Created by admini
Updated ocn 20520132 Updated by sdminT 5IF 1D 250
Version 1
O Locked By Me
= |E [ IE2455 | Metadata
= Preservation Master Revision
[ REP230D ) Add Metadata
= File [ FL2501 ,1Mb )
= File [ FLZ302 ,1Mb ) Assign AR
Name Type Mid
DNX DMX D'MN¥_REF2ED0 Edit
Mets Section Structure Map EFZ500-1 Edit
< Back Actions: |Flapraaart,atiar E‘.‘Cp\'.:ll't m

Figure 66: Representation Selected, Metadata Tab Open

4  In the main pane, click the Metadata tab.

5 From the Metadata tab, click the Assign AR Policy button. The Access
Rights Policies page opens.

Metadata Type: Access Rights Find- in:
of 13 Records
# Mid Metadata Type Format Created by Creatio
1 &  AR_E_CONCURRENT_US L policy SYSTEM BB View
20 policy SYSTEM 5
0 policy SYSTEM 5
40 policy S5Y'STEM 5
0 policy SYSTEM  E/2843 View
A

= Back

Figure 67: Access Rights List

6 Locate the access rights policy you want to assign to the IE or representation
and select its button, then click Add.

The access rights rule is assigned to the IE or representation and can be seen on
the object’s Metadata tab.
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Home > Submissions > Approval » Assess 5IPs = Metadata List
Intellectual Entity PIDIE2453 Created on 23052012 Created by =admin
Updated on Zo0s 2013 Updated by admint SIP 1D 250
Version 1
'ﬂ Loched By: Me.
= |E [ IE2453 I_ . Object Summary Metadata Services
= Preservation Master Revision
[ REP230D ) Add Metadata
= File [ FL2301 , 1Mk )
= File [ FL2302 ,1Mb ) Assign AR
Type Mid
Palicy Access Rights AR_IP_RANGE
DM OHE DMF_REr 20 Edit
Mets Section Structure Map REFP25D0-1 Ediit
< Back Actions: |Heprﬁentation Expnrt

Figure 68: New Row on the Metadata Tab

Users can now view the IE or representation under the new conditions of the

access rights policy.

NOTES:

B Because an access rights policy is not required for a representation, the
policy can be removed by clicking the Remove action (see Figure 68).

B The system generates a provenance event whenever an access rights

policy is assigned or removed.

Access Rights Exceptions

Rosetta provides the granting of specific user rights to specific materials
through the use of access rights exceptions. These rights add access for certain
users that exceed rights already granted to a general user population. Access
rights exceptions never restrict users’ access further. They are only used to
increase the specified user group’s access to certain IEs or sets of data where

they do not exist in the current active rights.
Access rights exceptions are set up in three stages:
B Setting Up Access Rights Exceptions

B Assigning an Exception to a Set

B Access Rights Exceptions in the Web Editor
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NOTE:
In order to configure access rights exceptions, you must be assigned either

the Deposit Manager or Data Manager role with the Edit Access Rights
Exceptions role parameter.

Setting Up Access Rights Exceptions
To set up an access rights exception, add an exception from the Access Rights

Exceptions List page.

To add an access rights exception:

1 From the Rosetta drop-down menu, follow the path: Data Management >
Manage Sets and Processes > List of Access Rights Exceptions List.

The Access Rights Exceptions List page opens (Figure 69). Any existing
rights exceptions display in a table with several options for actions that can

be performed on them.

Home = Data Maragement > Process » Access Aightz Exceptions List

Find = in Al | Gu

Add Access Rights Exceptions 1-2 of 2 Racords
Narme «Description Creation DateModification DateCount
11027 eollzge [P 05052009 05/08/2009 0 Edit Duplicate Delete Assign Lin
to Set Assign
21028  Tearn 05/03/2009  0548/2009 0 Edii Duplicate Delete Assign Lin
Raseatch 10 38l Assign
< Back

Figure 69: Access Rights Exceptions List

2 Click the Add Access Rights Exceptions button above the list of exceptions.
The Edit Access Rights Exceptions page opens (Figure 70).
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Home = Data Managemend = List of Access Hights Cxceptions = Cdit Access Rights Cxceptions

Copyright Template ﬂ

* Descripfinn

When view is restricted show the following message

Add Exprassian

< Back m

Figure 70: Edit Access Rights Exceptions Page

Select a Copyright Template from the existing templates in the drop-down
list.

Enter a description for the AR in the Description text field. This text
identifies the exception on the List of Access Rights Exceptions page.

Enter the message you would like users to see when they do not have access
to the object based on this particular access rights policy. If you do not enter
a custom message, a general default message appears on the user’s page.

Click the Add Expression button.

The AR Expression page opens. If this is your first expression for this
exception, New Group will be selected by default. (On subsequent
expressions, To Existing Group will also be available for selection.)
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Home = Data Management = List of fccess Hights Ceeeptions > Edit Access Rights Cxoeptions

MID Metadata Type Description
Created by Creation Date
Updated by lpdate Date

& flaw Graup

Criteria |User Group =
['J|:|:-:|'21tu[| equal ﬂ
Value 1 |

Cancel | Save |

Figure 71: Edit Access Rights Exceptions Page - Add Expression

7  For the Criteria drop-down field, select the item you want to use as a
measure for this expression.

The fields below may adjust to accomodate the Criteria selection.

8 Select an Operator to compare the Criteria selection with the value(s) you
will enter.

9 Enter a value or values in the Value 1 (and Value 2, if applicable) field
10 Click the Save button.

The AR Full View page opens with the expression you just added (Access
Rights Exception with One Expression).
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Home > Data Management > List of Access Rights Exceptions > Edit Access Rights Exceptions

RO 1572 Metadata Type local accessnghls Descriplion  undefined
Created by Creation Dale T
Updated by Update Dale T
Copyright Template Icﬂpﬁ:ghtsz.rﬂml j
" Description ussr group - LEvf

or on-Site

Wihen view is restricted show the following message [Tou must be

on=3ite to view
thiz material.

Add Expression

Group 1 [P Range within 10.011.10000 10.11.100.%8  Delate

= Back Save

Figure 72: Access Rights Exception with One Expression

11 To add another expression, click the Add Expression button and repeat that
portion of the procedure. Repeat as needed.

12 Click the Save button.

Your exception is added to the List of Access Rights Exceptions.

Assigning an Exception to a Set

Once you have created one or more rules for access rights exceptions, you need

to assign the exceptions to a set of data. Rosetta uses a wizard to help you do
this.
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To assign an exception to a set:

1 On the Access Rights Exception List page, find the AR exception you want
to assign and click the corresponding Assign to Set text link.

Home = Data Maragement » Process » Access Aightz Exceptions List

Fimd : i : | Dascription "'"l Go

fidd Accacs Rights Excoplions 1-3 073 Reconds

Hame ~Description Creation DateModification 0gte Count

11027 college [P 08022009 050852009 0 Edit Duplicate Dalsts Assign Lin
to Sat Assign
21028 Team 08022000 05082009 0 Edil Duglicate Delete Assign Un
Reszarch to Sat Assign
21020 PDE 07022009 07082009 0  Edil Duplicate Delets fse

Excaption

Figure 73: Assign Exception to Set

Step 1 of the Assign to Set wizard opens. It displays the name of the process,
which is assigned by the system and is read-only.

2 Click the Next button to move to step 2 of the wizard.

Home » Data Management > Process = Access Rights Exceptions List = Assign to Set Wizard

Ix .Eﬁ-ﬁil'jl'l to Set Wizand - SiF!Fr 2 - @ -

FiIl:-!-l:[h"-':r'EEtS ".I Find a in | Al 'i G0

<Bach Cancel m

Figure 74: Assign to Set - Wizard Step 2

3 Step 2 requires you to perform a search for the set you want to use. Do this
through the filter and find mechanisms. Click the Go button when you have
completed your query.

Your sets appear in the bottom section of the same step (2) of the wizard.
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Home » Data Management * Process = Access Rights Exceplions List =
* Bssign to Set Wizard

V) Assign to Set Wizard - Step 2 1 @

Fl'!tr:r:lﬂ-ll "I Find in | Al *| GO

| -2 0of 2 Records

« temized [termizad Intellectus| Entity adrrind S09
- Logical Lagical Imtellectusl Emity adrmind 878

Figure 75: Assign to Set - Search Results for Sets

4 Determine which set you want to apply the AR exception to and click the
radio button to the left of its name to select it, then click Next.

The third step of the wizard opens, displaying the process name and
scheduling information.

41 Assign to Set Wizand - Step 3 1 2 @l
General Information

Process Hame (Mot Editable) Aszsign LAR D080 07 OEL2008 25 2835
Scheduling Az ooon Az Possible

[ <Back | Cancel | Subriit

Figure 76: Assign to Set - Wizard Step 3

5 If the information is correct, click Next. (If it is not, click Back and return to
step 2 to correct it, if possible.)

The access rights exception will be applied to the set you identified. The
original Access Rights Exceptions List opens to complete the procedure.

NOTE:

You can repeat this procedure to assign more exceptions to more sets (or a
single exception to multiple sets).

Access Rights Exceptions in the Web Editor

Access rights exceptions can be applied to IEs from the Web Editor.
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To assign an exception to the rights for an IE:

1

Using the Search for Object or Search for Metadata page (Data Management
> Search and Manage Queries), look up the IE to which you want to assign
access rights exceptions.

Click the Info text link of the row corresponding to the IE you want.

The IE opens in the Web Editor with the Object Summary tab open. If the IE
is already locked, an exclamation point with brief text will indicate this
above the object hierarchy tree (see Assigning AR Exceptions to IEs on
page 141).

If the IE is not locked, then, in the Actions drop-down box (lower right of
page), select Lock object and click the GO button.
Click the Metadata tab in the object information box.

Metadata for the IE displays in the object information box. Above the
metadata table, several buttons, including Add AR Exceptions, are available
for this IE.

Homme = Data Management > Seaich and Sets » Search lor Objects = Metadata List

Intellzetual Entity PIDIETTIC Created on 2005-08-05 Created byfackan
Updated an 2009.053-05 Updated bysackat SlP E
Version 1

O Locked By: ie.

= IE [ IE1110} Ohject Sumimany Metadata Services Versions
- Preservation Master, Rl
(REP1111) Assign CMS Assign AR Assign AR Exceptions
- File (FL1912, 29Kb ) g g g M
Hame Iype Mind
[ ES Dipl DEs_IET710 Edit
Descriptve DO 108 Edit Remove

Palicy Access Hights  AR_S CONCUR_USERE View

IE Export =| E

< Back

Lctions:

Figure 77: Assigning AR Exceptions to IEs

5 Click the Add AR Exceptions button.

The Local Access Rights Metadata Type page opens. The system displays a
list of all access rights exceptions created from the Access Rights Exceptions
List page.
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Metadata Type: Local Access Rights Find: localaccessnghts in: Al »|  Ga

Home > Dala Management = Sgarch and Seis > Search for Objecls » Metadata Search

| -3 aof 3 Racords
# Mid  Deserpilan Metadata Type  Format Created by Creation Dalp

i 1057 college P accessrghls ezl admind BANE Wiew

20 10 Team Ressarch  accessnghts lozal atlmind STl IE] igwr

3@ 1020 PODEZ Exception accassights lncal adminl s Wiar
< Back

Figure 78: Local AR Exceptions

Click one radio button beside the exception you want, then click the Add
button.

The IE details page opens with the added exception showing under the
Metadata tab with options to view or remove the exception.

Intellectual Entity PIDIZ1 110 Created on 2002-08-03 Created bytackan
Updated on 2009-03-06 Updated bylackan SIF D [FE]
Version 1

& Lacked By: Me.

= IE {IE1110) Ohject Summany Metadata Services Versions
= Preservation Master, R1
(REP1111) Assign CMS Assign AR Assign AR Excepfi
= File (FL1112, 29K | an an lgn 2% Sxceplions

Hame Type i
Dol [ D _1IE1110 Edit
Dascrpie (0] e Edit Remove
Palicy Lrcess Bighee AR £ COMCUR “iew

LI Access Richts  10B0 > Wiew Remaoe

< Back Actions: ||E Expont ﬂ m

Figure 79: AR Exception on Metadata Tab
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Retention Policies

This section contains:
B About Retention Policies on page 143

B Creating Retention Policies on page 144

B Working With Retention Policies on page 146

About Retention Policies

Retention policies allow libraries to place limits on the length of time particular
items will be stored in a repository. Records that are required to be kept for legal
or fiscal purposes, for example, may have no value to a library after the required
retention time has elapsed. In such cases, Rosetta users can place retention limits
on items and have them sent to recycling or purged entirely from the system
after a span of time or a particular date.

Retention policies are classified as shared metadata, and, as with access rights in
Rosetta, they can be applied to multiple IEs.

Retention policies can be accessed from the following areas on the Staff
interface:

B To create and manage retention policies: Producers > Advanced Tools >
Retention Policies

B To associate a retention policy with a material flow: Producers > Deposit
Arrangements > Manage Material Flows

B To work on the retention policy of a single IE: Web editor, individual IEs,
Metadata tab

Retention policies also appear on deposit forms (in the Deposit module) and on
the list of scheduled jobs in the Administration module.
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NOTE:
In order to configure retention policies, you must be assigned either the
Deposit Manager or Data Manager role with the Edit Retention Policies
role parameter.

Creating Retention Policies

To set up retention policies, sign in to the Management module and follow the
path Producers > Advanced Tools > Retention Policies.

The Retention Policy page opens (Figure 80).

Home = Producers = Advanced Tools = CMS Metadata Search
Metadata Type: Retention Policy Find: in: Jg._";l Go
Add Shared Metadata Record 1-10of1 Records
#| Mid Description Metadata Type | Format | Created by | Creation Date
1 NO_RETENTIOM Mo Retention Policy retention policy  SYSTEM /30012 Wiew
< Back

Figure 80: Initial Retention Policy Page

By default, only one policy is preconfigured by the system: a NO_RETENTION
policy. This configuration defaults to an indefinite retention of all items in the
system that do not have a specified retention policy.

To create a retention policy limit:

1 From the Retention Policy page (Figure 80), click the Add Shared Metadata
Record button.

A blank retention policy form opens (Figure 81).
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Home = Retention Policies

* Description |

Retention Policy | After particular date
* Date oo =]
Permanently Delete r

Cancel

M =] vvvv)e] EE

[

Figure 81: Blank Retention Policy Form

By default, the retention policy uses After particular date and the impact of
the purge is not permanent (check box is cleared)—that is, all purged items
for this policy are retained in a recycle bin and can be retrieved.

2 OPTIONAL: To change the retention policy to a span of time rather than an
exact date, use the Retention Policy drop-down menu.

Date fields will change according to the type of retention policy you select.

Figure 82 shows one of each type of policy.

Home = Producers = Advanced Tools = Retention Palicies

*Description IRequired by law: 10 years
Retention Policy -
Reference Date | Date Accepted (DC ¥ |
Retention Unit |1J.'ear5 j

*Number of Units [10
Permanently

Delete

*Description |After FY 2016

*Date | I xm - Il\r_;l

Retention Policy after particular da J

Nowvember 2012

Permanently
Delete Su Mo TuWe Th Fr Sa
1 2 3
4 3 & 7 & 9 10
Cancel 1 12 13 14 15 16 17
18 19 20 21 22 23 24

Figure 82: Both Types of Retention Policy
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3 Enter values in the form’s fields. Use Table 17 for definitions of fields.

Table 17. Retention Policy Form Fields

Retention Measure Description

(Date or Span)

Description Both Describes the policy. Shows in the list of
retention policies and helps users identify
it.

Retention Policy Both Select a specific date in the future or a
period of time to lapse from a particular
date/event.

Date Specific date The exact date on which the items

associated with this policy can be deleted
from the database. Use DD/MM/YYYY
fields or drop-down calendar (as seen in
Figure 82).

Reference Date Time elapsed The date/event on which the period of
retention time begins.

Retention Unit Time elapsed The unit of time used, as in days or years.

Number of Units Time elapsed The number of units to equal the full time
elapsed (as in 180 for days).

Permanently Delete | Both If checked, the items associated with this
policy are purged from the system and
cannot be retrieved. If left unchecked (the
default), items are removed from the
standard storage but remain available in a
“recycle” storage area.

4 When you have completed the form, click the Save button.

Your new policy is saved to the system, appears in the list of retention
policies, and can be assigned to an IE as shared metadata through, for
example, the Web Editor, under the Metadata tab, or as part of a material
flow.

Working With Retention Policies

The following actions can be undertaken to edit, delete, or assign policies to IEs.
®m Editing a Retention Policy on page 147

B Deleting a Retention Policy on page 147

B Assigning a Retention Policy to an IE on page 148
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Editing a Retention Policy

You can edit any of the retention policies except for the system-created
NO_RETENTION policy.

To edit an existing retention policy:

1 Open the List of Retention Policies page (Producers > Advanced Tools >
Retention Policies).

2 Find the policy you want to change in the list.

NOTE:
If there are many policies and you are having trouble finding the one you
want, perform a quick search in the upper right corner of the page. You
can search by MID if you have the number, or by a case-insensitive search
of the Description field.

3 Click the Edit text corresponding to your policy’s row.
The policy form opens with its existing entries.

4 Make the changes you want on the form. For information on specific fields,
see Table 17.

Deleting a Retention Policy

You can delete any staff-created policies unless they are associated with an IE. If
you attempt to delete a retention policy that is in use, you will receive a notice
telling you the number of IEs to which this policy is attached.

To delete an existing retention policy:

1 Open the List of Retention Policies page (Producers > Advanced Tools >
Retention Policies).

2 Find the policy you want to delete in the list.

NOTE:
If there are many policies and you are having trouble finding the one you
want, perform a quick Find search in the upper right corner of the page.
You can search by MID if you have the number, or by a case-insensitive
search of the Description field.

3 Click the Delete text corresponding to your policy’s row.
A confirmation page opens.
4  Click the Confirm button to continue with the deletion.

The system returns you to the list of retention policies.
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Assigning a Retention Policy to an IE

Data Managers can assign an a retention policy to a particular IE.

To assign a retention policy to an IE:

1 Open the IE in the Web Editor (see Accessing the Web Editor on page 449).

2 Inthe IE Tree pane, make sure the IE object (and not the File, for example) is
highlighted.

3 In the Actions field at the bottom right of the page, select Lock the IE from
the drop-down menu and click the GO button.

The page refreshes. New buttons may appear on the display.
4 Click the Metadata tab.
The page refreshes with several buttons under the Metadata tab (Figure 83).

Home = Data Management *» Search and Manage Queries > Search for Objects > Metadata List

Intellectual Entity PID 1E1029 Created on 28/11/2012 Created by admin1
Updated on 29/11/2012 Updated by admini SIF 1D 8
Version 3
D Lock=d By: M=,
= IE [ IE1029 ) Metadata
= Preservation Master
Revision 1 [ REF1030 | Add Metadata | Assign CMS | Assign AR | Assign AR Exceptions | Assign RF
= File [ FL1031 32Kk )
Name Type Mid
DNX DMNX DMX_IE1025 Edit
Descriptive oc 1007 Ediit
Palicy Access Rights AF_EVERYOME View

" Bk IE Export jm

Figure 83: Assigning a Retention Policy to an IE

5 Click the Assign RP button.
The Retention Policies list opens. Beside each option is a radio button.
6 Select the policy you want to add, then click the Add button.

The IE reopens in the Web editor with the retention policy appearing in the
list under the Metadata tab. The IE now adheres to this retention policy.

To unassign a retention policy of an IE:

1 Search for the IE whose retention policy you want to remove.

2 View the metadata list for the IE and click Remove for the retention policy.
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The retention policy is removed.
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Managing Generic Material Flows

This section contains:

About Generic Material Flows on page 151

Accessing the List of Material Flows Page on page 151
Adding a Material Flow on page 153

Activating and Deactivating Material Flows on page 157
Duplicating a Material Flow on page 158

Updating a Material Flow on page 158

Deleting a Material Flow on page 159

About Generic Material Flows

Deposit Managers can manage generic material flows that exist in the Rosetta
system as a single unit. For example, a Deposit Manager can activate, or change
the name of, a generic material flow. (For general information on material flows,
see Managing Generic Material Flows in the Rosetta Overview Guide.)

Deposit Managers work with generic material flows using the List of Material
Flows page.

Accessing the List of Material Flows Page

The List of Material Flows page enables Deposit Managers to view the existing
generic material flows and create new material flows.

To access the List of Material Flows page, click the following links from the
Rosetta rollover menu: Producers > Deposit Arrangements > Manage Material
Flows.
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Ir:ijé_"' Home = Producers = Deposit Arangements = Material Flow List

Filter: | Genaric LI Find: in: | A ;l Go
Add Material Flow 1 -8 of § Records
Active | Mame E:gﬁrecer Template Created On | Updated on
1 «f  Onetimepubl Viewlist  Manusl 14/0%02010 08/0%2011 View Update Duplicate More.. ¥
14:30:15 10:07.59
z Genzral digitsl  View List  Manual 140%2010 220072012 View Update Duplicat= More... »
14:30:15 17:08:17
3 Periedic public =w List Manual 140%2010 30/01/2011 View Update Duplicate More.. =
14:20:15 09:02:28
4 of arvest Expor View List  Automat 14/0%/2010 10/10/2011 View Update Cuplicate More.. =
Content 14:20:15 18:41.65
5 of  Gensraldigitsl Viewlist  Manuasl 140%2010 07/08/2012 View Updste Duplicate More.. ¥
upl.... 14:30:15 11:39:47
8 ) Unipublished ew List  Manual  205/01/2011 ew  Update Duplicate More.. w

08:58:49

Figure 84: List of Material Flows Page

The list contains the following information for each material flow:

Table 18. List of Material Flows Page Columns

Column Description

Active Indicates the material flow status:
B Yellow - The material flow is active.

B Grey - The material flow is inactive.

Name Displays the name of the material flow.

Producer Profile Displays:

B The name of the Producer profile when the material
flow is associated with only one Producer profile

B The Associated Producer Profiles link when the
material flow is associated with multiple Producer
profiles

Template Displays the type of template on which the material
flow is based:

B Manual - Producer Agents can use the material flow
to deposit content manually.

B Automated - Content is automatically deposited to
the Rosetta system from a remote server or local
computer.
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Table 18. List of Material Flows Page Columns

Column Description

Created On Displays the date on which the material flow status was
created.

Updated On Displays the last date on which the material flow was
updated.

Adding a Material Flow

Deposit Managers can add a new generic material flow to define how Producer
Agents can deposit content.

NOTE:
To add a material flow, the metadata forms, submission formats, access
rights options, retention policy, and content structure must already be
configured. For more information, see Configuring Material Flow
Infrastructure on page 85.

To add a material flow:

1 On the List of Material Flows page, above the material flows list, click Add
Material Flow. The Material Flow Definition page opens.

O o ) ) .
M J Home » Producers = Deposit Arrangements > Manage Material Flows = Add Material Flow ‘@:}' 2

* Name |

= Material Flow templatel,-‘.-_,_tcu-rgt;: d

Figure 85: Material Flow Definition Page

2 Complete the fields as follows:
B In the Name field, enter a name for the material flow.

® In the Material Flow Template drop-down list, select one of the following
options:
B Automated, when you want to enable Producer Agents to deposit

content automatically from a specified location on a server or local
computer

September 2016 153
Ex Libris Confidential



Staff User’s Guide, Part Il: Deposit Managers
Chapter 11: Managing Generic Material Flows

B Manual, when you want to enable Producer Agents to upload content
or specity its location manually

For more information on automated and manual deposit, see Managing
Generic Material Flows in the Rosetta Overview Guide.

3 Click Continue. The Material Flow Details page opens.

= Producers = Deposit Arrangements = Manage Material Flows = Material Flow Details

Material Flow 1D - Created on 08/08/2012 Created by admin
Material Flow Type Automated Update Date 08/38/2012 Updated by admin
IE' Material Floww Definition
* Hame [audiodigitization
Description/Instructions j
Status Active Status Date 08/08/2012
Sampling Rate (%) Material type | Digitisedimag: ~
" Internal o OYes

Assertion of Copyrights | Boilerclate 51 TI Metadata Profile| Test -

IE' Technical Definitions

* Select content structure | coy ,I * Select submission format |FTP Sut|/=

IE' Descriptive Definitions
* Select Metadata form | Qne-0ff vI Preview

IE' Access Right Form

0 items selected Ramove all Lo all
Accessible from institution premises 4 %]
Concurrent AR +
Deliverny Rearession |IPRanas -

IE' Retention Policy Form

0 items selected Remiowe all A all
Backup Until Redo o+
No Retention Policy |
Retain 2 yrs out + =

= Back Cancel m

Figure 86: Material Flow Details Page

4  Complete the fields as described in the following table:
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Table 19. Add Material Flow: Step 2 Page Fields

Field Description

Material Flow Definition pane:

Name The name of the material flow.
Description/ The description of the material flow.
Instructions

Status The material flow’s status:

B Active - The material flow is available to associated
Producer Agents.

B Inactive - The material flow is not available to associated
Producer Agents.

Sampling Rate The percentage of Producer Agent content that needs to be
reviewed by staff users:

B 100% - All deposited content needs to be reviewed by
Assessors and Arrangers.

B Less than 100% - The specified percentage of content needs
to be reviewed by an Approver.

Internal B No - available to all users

B Yes - available to staff users only

Assertion of The copyright boilerplate that must be displayed to Producer

Copyrights Agents.

Status Date Displays the last date on which the material flow was
updated.

Material Type The types of content that Producer Agents can deposit.
NOTE:

This drop-down list contains the material types that
were configured in advance by a Deposit Manager or a
Rosetta Administrator. For more information, see the
Rosetta Configuration Guide.

September 2016 155
Ex Libris Confidential



Staff User’s Guide, Part Il: Deposit Managers
Chapter 11: Managing Generic Material Flows

Table 19. Add Material Flow: Step 2 Page Fields

Field Description

Technical Definitions pane:

Select Content The content structure that is available to associated Producer
Structure Agents when they deposit content automatically.
NOTE:

This drop-down list contains the content structure
templates that were configured in advance by a Deposit
Manager or Back Office Administrator. For more
information, see Configuring Content Structures on

page 99 on page 99.
Select Submission The submission format that Producer Agents can use when
Format they upload files.
NOTE:

This drop-down list contains the submission formats
that were configured in advance by a Deposit Manager
or Back Office Administrator. For more information, see
Configuring Submission Formats on page 86 on

page 86.
Automatically If this check box is selected, the system automatically extracts
extract compressed | submitted compressed files, in accordance with the automatic
files decomposition rules (see Configuring Automatic

Decomposition Rules in the Rosetta Configuration Guide).

NOTE:
For automated material flows, submission format
validation (file max/min number, size, extension.) will
be ignored for compressed files.

Descriptive Definitions pane:

Select Metadata The metadata form that Producer Agents must complete when
Form they deposit content.
NOTE:

This drop-down list contains the metadata forms that
were configured in advance by a Deposit Manager or
Back Office Administrator. For more information, see
Configuring Metadata Forms on page 73.
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Table 19. Add Material Flow: Step 2 Page Fields

Field Description

Upload Source
Metadata files

Select this option to allow a Producer Agent to upload source
metadata files when depositing IEs in metadata structures
other than Dublin Core. This allows your institution to store
complete information for IEs conforming to complex and
custom metadata schemes and to view this data in the Web
editor.

Access Rights Form pane:

Access Rights list

Select the options that must be available to Producer Agents
when they deposit content. Selections are made by double-
clicking a list item or clicking the plus (+) sign beside an item.
To remove an item, double-click it from the selected box or
click the minus sign (-) beside it.

NOTE:
The Access Rights list box contains the options that
were configured by a Data Manager. You cannot update
this list from this page.

Retention Policy Form pane:

Retention Policy list

Select a retention policy from the list of available policies. If
you want the material to be saved indefinitely, select the No
Retention Policy option. Selections are made by double-
clicking a list item or clicking the plus (+) sign beside an item.
To remove an item, double-click it from the selected box or
click the minus sign (-) beside it.

NOTE:
The Retention Policy list contains the options that were
configured by a Data Manager. You cannot update this
list from this page.

5 Click Save.

The List of Material Flows page opens. The list contains the newly added
material flow. The material flow is added to the Rosetta system.

Activating and Deactivating Material Flows

Deposit Managers can deactivate a material flow when they need to finish
configuring the material flow settings, or if they want to temporarily disable the
material flow without deleting it. Deposit Managers can activate an inactive
material flow at any time.
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Deposit Managers cannot deactivate a material flow when a Producer Agent is
using it to deposit content. Deposit Managers can deactivate the material flow
only after the deposit process has been completed and no other Producer Agent
is using the material flow.

On the List of Material Flows page, the material flow’s status is indicated by the
check mark in the Active column:

B Yellow - The material flow is active.

B Grey - The material flow is inactive.

To activate or deactivate a material flow:

1 On the List of Material Flows page (see Accessing the List of Material
Flows Page on page 151), locate the material flow that you want to activate
or deactivate.

2 Inthe Active column, click the check mark. The check mark in the Active
column indicates the new status.

The material flow status is changed from active to inactive, or from inactive to
active.

Duplicating a Material Flow

Deposit Managers can duplicate material flows. This is especially useful when
creating a new material flow. It is often faster to duplicate an existing material
flow and modify it, than to create a new material flow.

To duplicate a material flow:

On the List of Material Flows page (see Accessing the List of Material Flows
Page on page 151), locate the material flow you want to duplicate and click
Duplicate. The Rosetta system creates a copy of the material flow.

An exact copy of the material flow is added to the List of Material Flows page.
The Rosetta system automatically labels the new material flow with the name
Copy of followed by the name of the original material flow.

Updating a Material Flow

Deposit Managers can modify material flow details at any time. For example, a
Deposit Manager can add more submission formats or metadata forms.
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To update a material flow:

1  On the List of Material Flows page (see Accessing the List of Material
Flows Page on page 151), locate the material flow you want to update and
click Update. The Update Material Flow Details page opens.

2 Modify the fields as required.

3 To save your changes and return to the List of Material Flows page, click
Save. The List of Material Flows page opens.

The material flow details are updated.

Deleting a Material Flow

A Deposit Manager can delete a material flow when it is not used by any
Producers and the Deposit Manager does not want to maintain the material
flow.

Deposit Managers cannot delete a material flow while a Producer Agent is using
it to deposit content. Deposit Managers can delete the material flow only after
the deposit process has been completed and no other Deposit Manager is using
the material flow.

To delete a material flow:

1  On the List of Material Flows page (see Accessing the List of Material
Flows Page on page 151), locate the material flow you want to delete and
click More. Additional options are displayed.

2 (lick Delete. The confirmation page opens.
3 Click OK. The material flow is removed from the list.

The material flow is removed from the Rosetta system. Producer Agents can no
longer use it when they deposit content.
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Managing Generic Producer Profiles

This section contains:

About Managing Producer Profiles on page 161

Accessing the List of Producer Profiles Page on page 161
Adding a Producer Profile on page 163

Activating and Deactivating Producer Profiles on page 164
Updating a Producer Profile on page 165

Duplicating a Producer Profile on page 166

Deleting a Producer Profile on page 166

About Managing Producer Profiles

Deposit Managers can manage Producer profiles as a single unit. For example, a
Deposit Manager can activate a Producer profile or add a new profile. (For
general information on Producer profiles, see Understanding Rosetta Users in
the Rosetta Overview Guide.)

Deposit Managers work with Producer profiles using the List of Producer
Profiles page (see Accessing the List of Producer Profiles Page on page 161).

Accessing the List of Producer Profiles Page

The List of Producer Profiles page enables Deposit Managers to work with
Producer profiles and perform activities, such as adding new Producer profiles,
updating Producer profile details, and activating Producer profiles.

To access the Producer Profile List page, from the Rosetta rollover menu, follow
the path Producers > Deposit Arrangements > Manage Producer Profiles. The
Producer Profile List page opens (Figure 87).
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D
Y™ 4 Home = Producers = Deposit Arangements = Producer Profile List
Filter: A ;I Find: in: | Al = Go
Add Producer Profile 1 -4 of 4 Records
Active Hame Type Update Date
1 e Default Generic 110112011 View Update Duplicate More.
17:22:45 v
2 ¥ Ex Libris Demao Generic 14/08/2012 View Update Duplicate More...
Producer Profile 10:31:39 -
Delets
3 A Oemo Internal Personalized 11/08/2012 View Update Duplicate More...
Producer - Default 10:11:08 -
4 v MICA Generic a1/11/2011 View Update Duplicate More...
05:26:08 v

Figure 87: Producer Profile List Page

This page displays columns containing the following information:

Table 20. Producer Profile List Columns

Column Description

Active Indicates the Producer profile status:

B Yellow - The Producer profile is
active.

B Grey - The Producer profile is

inactive.
Name Displays the name of the Producer
profile.
Type Displays the type of the Producer
profile:

B Generic - The Rosetta system
automatically assigns the generic
settings that are defined by a Deposit
Manager.

B Personalized - A Negotiator defines
and assigns personalized settings.

Update Date Displays the last date on which the
Producer profile was updated.
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Adding a Producer Profile

Deposit Managers can add a generic Producer profile to define how the
associated Producer Agents deposit content. When adding a profile, Deposit
Managers configure settings on the following pages:

B On the Producer Profile page, deposit control settings are defined.
B On the Material Flows page, material flows that are associated with the

Producer profile are defined.

To add a generic Producer profile:

1  On the Producer Profile List page (Producers > Deposit Arrangements >
Manage Producer Profiles), above the Producer profiles list, click the Add
Producer Profile button. The Producer Profile page opens.

O

MAy™ 4 Home = Producers > Deposit Amangements > Manage Producer Profiles = Add Producer Profile
Profile 1D - Created by admini Created on 08/08/2012
Profile name - Updated by admin1 Updated on 08/08/2012

Profile Type Generic

Producer Profile

* Hame

Status Date 08/08/2012

= Active Deposits Guota (GB) ® Disk Usage Guota (GB)
= Default Sampling rate {32} Fast Track Enabled false

3

Figure 88: Producer Profile Page, Producer Profile Tab

Status

2 Define the deposit control settings, as described in Configuring Deposit
Control Settings on page 71.

3 Click Save.

The deposit control settings are saved in the Rosetta system.
4 Click the Material Flows tab.

The Material Flow List page opens.
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L'a =>Deposit Arangements >Manage Producer Profiles =Manage Materials Flows [Personalized Producer Profile)
Profile D 38381 Created by admini Created on  25/10/2010
Profile name Demo Internal Updated by admini Updated on  11/08/2012
Profile Type Personalized
Producer Profile Material Flowr List
IE' Preducer Profile: Material Flows Selected
-
Active | Name Type Content S5tr) Acquire Method| Status Date
1 . Automnated Generic METS NF5 28/05/2012 View Perscnalize Remaove
- Bulk Z2:30:35
2 M C5V Loader Generic C5V HDOpSubmissionl  20/05/2011 View Persocnalize Remove
Iaterizl 10:44:
el A M fror Generie RV HMnShmissinnl FANRMN12 View Persnnalire Remnue j
IE' Material Flow pool
Hame Template | Content Structure | Acquire Method Status Status Crate
1 [ Audic - Bul Manual SoF . Complex Web Applet ACTIVE 21/01/20
2 [T Deposit Newspapers MManusl SoF . Simple Http Load ACTIVE 01/11/201
3 [ FTP Depesit Automated METS HDpSubmissicnFormat ACTIVE 11/11/201
4 [0 Harvest Exported Digital Automated METS NF5 ACTIVE 140%2010
5 O Images Manual SoF Simple Http Load ACTIVE 30/01/2011
g [ Images - Bul Manual SoF Complex Web Applet ACTIVE 3230/01/20
Add Selected
<Back

Figure 89: Material Flow List Page

5 Associate material flows with the Producer profile, as described in
Associating Material Flows with a Generic Producer Profile on page 169.
The selected material flows are displayed in the Material Flow Selected

pane.
6 Click Save.

The Producer profile is added to the Rosetta system.

Activating and Deactivating Producer Profiles

Deposit Managers can deactivate a Producer profile when they need to finish
configuring the profile settings, or if they want to temporarily disable the profile
without deleting it. Deposit Managers can activate an inactive profile at any

time.
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Deposit Managers cannot deactivate a profile if it is associated with one or more
Producers.

On the Material Flows List page, the status of the material flow is indicated by
the check mark in the Active column:

B  Yellow - The material flow is active.

B Grey - The material flow is inactive.

To activate or deactivate a Producer profile:

1  On the List of Producer Profiles page (Producers > Deposit Arrangements >
Manage Producer Profiles), locate the Producer profile that you want to
activate or deactivate.

2 Inthe Active column, click the check mark. The check mark in the Active
column indicates the new status.

The Producer profile status is changed from active to inactive, or from inactive
to active.

Updating a Producer Profile

Deposit Managers can update an existing Producer profile when they need to
change the profile settings. When updating a Producer profile, Deposit
Managers can change:

B the way in which the deposit control settings are defined

B the material flows that are associated with the Producer profile

To update a Producer profile:

1  On the List of Producer Profiles page (Producers > Deposit Arrangements >
Manage Producer Profiles), locate the Producer profile that you want to
update and click Update. The Update Producer Profile page opens.

2 Modify the Producer profile details on the following tabs:

B Producer Profile, when you want to modify the deposit quotas and the
default sampling rate. (For more information, see Configuring Deposit
Control Settings on page 71.)

B Material Flows, when you want to associate more material flows with
the profile, delete material flows, or activate and deactivate material
flows. (For more information, see Configuring Material Flow
Infrastructure on page 85.)

3 To save the Producer profile and return to the List of Producer Profiles page,
click Save.
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The Producer profile is updated in the Rosetta system.

Duplicating a Producer Profile

Deposit Managers can duplicate Producer profiles. This is especially helpful
when creating a new Producer profile. It is often faster to duplicate an existing
profile and modify it, than to create a new profile.

To duplicate a Producer profile:

On the List of Producer Profiles page (Producers > Deposit Arrangements >
Manage Producer Profiles), locate the Producer profile you want to duplicate
and click Duplicate. The Rosetta system creates a copy of the profile.

An exact copy of the Producer profile is added to the List of Producer Profiles
page. The Rosetta system automatically labels the new Producer profile with the
name Copy of followed by the name of the original Producer profile.

Deleting a Producer Profile

A Deposit Manager can delete a Producer profile only when it is not associated
with any Producers and the Deposit Manager does not want to maintain the
Producer profile.

To delete a Producer profile:

1  On the List of Producer Profiles page (Producers > Deposit Arrangements >
Manage Producer Profiles), locate the Producer profile that you want to
delete.

2 Click More. Additional options are displayed.
3 Click Delete. The confirmation page opens.
4  Click OK. The profile is removed from the list of the Producer profiles.

The Producer profile is deleted from the Rosetta system.
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Managing Material Flows Associated
with a Producer Profile

This section contains:

About Managing Material Flows on page 167
Accessing the Material Flows List Page on page 167

Associating Material Flows with a Generic Producer Profile on
page 169

Activating and Deactivating Material Flows on page 170

Removing Material Flows from a Producer Profile on page 170

About Managing Material Flows

Deposit Managers manage material flows that are assigned to a generic

Producer profile to define how associated Producer Agents deposit content. For
example, a Deposit Manager can activate a material flow for, or remove a
material flow from, a Producer profile. (For general information on material

flows, see Material Flows in the Rosetta Overview Guide.)

Deposit Managers work with material flows associated with a Producer profile

using the Material Flows List page.

Accessing the Material Flows List Page

The Material Flows List page enables Deposit Managers to control the material

flows that are associated with a generic Producer profile.
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To access the Material Flows List page:

1

From the Rosetta rollover menu, click Producers > Deposit Arrangements >
Manage Producer Profiles.

The Producer Profile List opens.
Locate the Producer profile with which you want to work and click its name.
The View Producer Profile page opens.

Click the Material Flows tab. The Manage Materials Flows (Generic
Producer Profile) page opens.

Home > Producers > Manage Materials Flows (Generic Producer Profile)

Profile 1D 2 Creatad by - Created on U/U172010
Profile name Unpublished Ugredated by zdmind Updated on 070172010
Profile Type GENERIC

'roducer Profile Material Flow List

E Praducer Profile: Unpublished Selacted

Active Name Template Comtent Structure Acquire Method Status Date
| Ganenic Linpuslished Agslet Marosl SoF Complex YWieh Agplet 0712000 14:22008
2 Ganenc. Cneaff Wanuzl 307 Simale Hup Load 072000 142203
3 Ganenc, Ferigdical Warisal SoF Simple Hito Load 07200 14,2008
4 Genenc. Unpulished arisal SoF Complex Hito Load 07200142208
Freservalion complant depo Adomated METS R 07202 14,2208

El Material Flow pool

Hame Template Content Structure  Acguire Method Slatus Dale
I Int Diadasiondmane Auddomated  METS Intemzlkk S UAUT 2000 1422008
24 Int Digdasion, Automated  METS IntemszlKF S 070172070 14: 22:08
3 Inz Digiasion Automated  METS Intemzl KF S 07 /01,2070 14,2208
4 Etaff Mediatad Pub Automated  METS Intamal KFS 070172010 14:22-08
S Etaff Mediated Uspoh Automated  METS Intamzl KFS 070172070 14:22:08

Back

Figure 90: Material Flows List Page

The Material Flows List page consists of two panes:

B The Material Flow Selected pane lists the material flows that are
associated with the Producer profile. This pane displays columns
containing the following information:

Table 21. Material Flow Selected Pane Columns

Column Description

Active Indicates the material flow’s status:

B Yellow - The material flow is active.

B Grey - The material flow is inactive.
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Table 21. Material Flow Selected Pane Columns

Column Description

Name Displays the name of the material flow.

Template Displays the type of template on which the
material flow is based:

B Manual - Producer Agents can use the
material flow to deposit content manually.

B Automatic - Content is automatically
deposited to the Rosetta system from a
remote server or local computer.

Content Structure Displays the material flow content structure.
Acquire Method Indicates how Producer Agents can deposit
content:

B HTTP - Producer Agents deposit content
manually

B FTP or NFS - Content is automatically
deposited to the Rosetta system from a
remote server (through FTP) or local
computer (through NFS)

Status Date Displays the last date on which the material
flow status was changed.

B The Material Flow Pool pane lists all available material flows that you can
associate with the Producer profile. This pane displays the same columns as
the Material Flow Selected pane (see above table).

Associating Material Flows with a Generic
Producer Profile

You can associate material flows with generic Producer profiles to define how
Producer Agents can deposit content.

To associate material flows with a generic Producer profile:

1 On the Material Flows List page (see Accessing the Material Flows List
Page on page 167), in the Material Flow Pool pane, select the material flows
you want to associate with the profile by selecting the appropriate check
boxes.

2 Click Add Selected. The selected material flows are displayed in the
Material Flow Selected pane.
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The Producer Agents associated with the Producer can now deposit content
using the material flows you selected.

Activating and Deactivating Material Flows

Deposit Managers can deactivate a material flow if they need to finish
configuring the material flow settings, or if they want to temporarily disable the
material flow without deleting it. Deposit Managers can activate the inactive
material flow at any time.

NOTE:
Deposit Managers cannot deactivate a material flow when a Producer
Agent is using it to deposit content. Deposit Managers can deactivate the
material flow only after the deposit process is complete and no other
Producer Agent is using the material flow.

On the Material Flows List page, the status of the material flow is indicated by
the check mark in the Active column:

B Yellow - The material flow is active.

B Grey - The material flow is inactive.

To activate or deactivate a material flow:

1 On the Material Flows List page (see Accessing the Material Flows List
Page on page 167), in the Material Flow Selected pane, locate the material
tlow that you want to activate or deactivate.

2 Inthe Active column, click the check mark. The check mark in the Active
column indicates the new status.

The material flow status is changed from active to inactive, or from inactive to
active.

Removing Material Flows from a Producer Profile

Deposit Managers can remove a material flow from a generic Producer profile
when they do not want any Producer Agents to use it for depositing content.

NOTE:
Deposit Managers cannot remove a material flow when a Producer Agent
is using it to deposit content.
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To remove a material flow from a Producer profile:

1  On the Material Flows List page (see Accessing the Material Flows List
Page on page 167), in the Material Flow Selected pane, locate the material
flow you want to remove and click Remove.

2 Click Save. The material flow is removed from the list of material flows
associated with the Producer profile.

Producer Agents associated with the Producer cannot use the material flow to
deposit content.
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SIP Processing, Configuration, and
Routing Rules

This section contains:
B  Understanding SIP Processing on page 173
SIP Routing Rules on page 178

]
B Defining SIP Processing Configuration on page 182
]

Configuring SIP Routing Rules on page 186

Understanding SIP Processing

SIP processing settings define how a submission information package (SIP) is
moved between processing stages on the Staging Server, and how this SIP is
processed at each stage.

The SIP processing workflow begins when a SIP is moved from the Deposit
Server to the Staging Server, and ends when a SIP is moved from the Staging
Server to the Permanent Repository. At each stage, the Rosetta system performs
a series of tasks, as described in the table below.

Table 22. SIP Processing Stages

Stage Description

Pre-Approval After files are uploaded to the Staging Server, the Rosetta
system runs a series of tasks, known as a validation
stack, to identify technical problems, such as viruses or
corrupted files, and extract technical metadata.

For more information, see Pre-Approval Stage on
page 174.
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Table 22. SIP Processing Stages

Stage Description

Approval The SIP is reviewed by Assessors, Arrangers, and
Approvers. These staff users decide whether the SIP
should be approved, returned to the Producer Agent, or
declined.

For more information, see Approval Stage on page 177

For general information on the review of SIPs by staff
users, see Assessors, Arrangers, and Approvers in the
Rosetta Staff User’s Guide.

Enrichment The Rosetta system prepares the SIP for storage in the
Permanent Repository.

For more information, see Enrichment Stage on
page 177.

Move to Permanent The Rosetta system moves the SIP to the Permanent
Repository.

For more information, see Move to Permanent Stage on
page 177.

A Deposit Manager defines the following settings to configure SIP processing;:

B SIP processing configuration, which specifies how the SIP is processed at
each stage. A Deposit Manager can select a task chain for each stage from
the predefined list.

A Deposit Manager can create multiple SIP processing configurations for
different SIPs.

For more information about SIP processing configuration, see Defining SIP
Processing Configuration on page 182.

B SIP routing rules, which specify criteria for choosing the SIP processing
configuration that must be applied to the specific SIP.

When creating SIP routing rules, a Deposit Manager defines input
parameters (such as material type and Producer) and corresponding output
parameters (such as SIP processing configuration that must be applied to
the SIP and approval group that reviews the SIP).

For more information about SIP routing rule configuration, see Configuring
SIP Routing Rules on page 186.

Pre-Approval Stage

At the pre-approval stage, the Rosetta system performs a task chain known as a
validation stack. The validation stack tasks verify that the files uploaded to the
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Staging Server do not have any technical problems such as viruses or
corruption.

The validation stack task chain can contain the following tasks:
Fixity Check on page 175

Virus Check on page 176

Format Check on page 176

Technical Metadata Extraction on page 176
B Risk Extraction on page 177

A Deposit Manager can configure multiple validation stack task chains for
different SIP configurations. For example, one SIP configuration can use a
validation stack that performs all the tasks, while another SIP configuration can
use a validation stack that does not perform a virus check.

The Rosetta system moves only those files that successfully pass the validation
stack checks to the next processing stage.

Otherwise, the Rosetta system marks the failed files as problematic and
forwards them to a Technical Analyst. (For more information on Technical
Analysts, see Technical Analysts in the Staff User’s Guide.)

Fixity Check

The fixity check task verifies that the files uploaded to the Staging Server are not
corrupted. This task generates a checksum, which is stored in the file metadata.
When the file is moved to the Staging Server, the Rosetta system compares the
actual checksum with the original checksum using hash algorithms, such as
CRC32 or MD5.

A fixity check can be run without providing an algorithm as a parameter. In this
case Rosetta simply verifies the file with the expected name exists in storage
without accessing the file to determine its integrity.

Checksums may be provided in the deposited METS. In such cases, Rosetta
validates the checksum values. If the checksum is the same type that Rosetta
runs and the value is found to be valid, Rosetta overwrites the dnx section with
information from the internal outcome. If validation fails, the SIP is routed to the
TA work area with an appropriate error message.

An example of such a checksum value in the deposited METS is as follows:

September 2016 175
Ex Libris Confidential



Staff User’s Guide, Part Il: Deposit Managers
Chapter 14: SIP Processing, Configuration, and Routing Rules

<mets:techMD ID="fidl-1-amd-tech">
<mets:mdWrap MDTYPE="OTHER" OTHERMDTYPE="'dnx''>
<mets:xmlData>
<dnx xmIns="http://www.exlibrisgroup.com/dps/dnx"
xmIns:out="http://www.loc.gov/METS/" xmIns:dc="http://purl_org/dc/
elements/1.1/" xmIns:xlink="http://www.w3.0rg/1999/xlink"
xmIns:xlin="http://www.w3.0rg/1999/xlink">
<section id="fileFixity">
<record>
<key id="agent''>REG_SA JAVA5_FIXITY</key>
<key id="fixityType">MD5</key>
<key
id=""fixityValue'>4179a95cc8635d84690a87e782c3aced</key>
</record>
</section>
</dnx>
</mets:xmlData>
</mets:mdWrap>
</mets:techMD>

Virus Check

The virus check task verifies that the files uploaded to the Staging Server do not
contain any viruses. To perform the virus check, the task runs specialized
software, such as McAfee Virus Scan.

Format Check

The format check task automatically identifies the format of the file by
analyzing its content. If the extension of the file does not correspond to the
format that the task identified, the Rosetta system generates an error.

To perform the format check, the task uses the DROID utility.

Technical Metadata Extraction

The technical metadata generation task produces technical metadata about a file
(such as file size and creation date). The Rosetta system generates this metadata
based on the metadata embedded into the file, as well as on the information that
the system identifies automatically.

To generate technical metadata, the task uses a utility such as JHOVE or the
NLNZ MD Extractor. Each of these utilities generates technical metadata for
different formats. Deposit Managers associate the metadata generation utilities
with formats using the Format to MD Extraction mapping table.

176 September 2016
Ex Libris Confidential



Staff User’s Guide, Part IIl: Deposit Managers
Chapter 14: SIP Processing, Configuration, and Routing Rules

Risk Extraction

As part of the validation stack phase in SIP processing, Rosetta determines
whether the extracted technical metadata has a risk associated with its format. If
it does, the system runs the risk extractor tool and saves the output in the
HDeStreamRef table. The extracted technical metadata is stored in a way that
allows the risk analysis job to gather the information and summarize it in risk
reports.

After a validation stack is performed, the system modifies information about the
SIP in the DNX section of the METS file.

Approval Stage

After a SIP successfully passed the validation stack checks (see Pre-Approval
Stage on page 174), the Rosetta system forwards this SIP to one of the following
routes:

B An Assessor and Arranger

B An Approver. The amount of content to be reviewed by an Approver is
determined by the sampling rate parameter, which is defined at the material
flow level. Staff users can mandate one of the following:

B 100% - All content must be reviewed by an Approver

B Less than 100% - The specified amount of content must be reviewed by
an Approver. The rest of the content is moved to the next processing
stage without an Approver’s review.

Enrichment Stage

At the post-approval stage, the Rosetta system prepares the SIPs for storage in
the Permanent Repository. For example, the Rosetta system can generate
derivative copies and thumbnails for intellectual entities (IEs), as well as
synchronize metadata stored in a collection management system with the IE
metadata.

If a SIP fails to pass the post-approval stage, the Rosetta system forwards this
SIP to a Technical Analyst. (For more information on Technical Analysts, see
Technical Analysts in the Rosetta Staff User’s Guide.)

Move to Permanent Stage

After the Rosetta system performs the enrichment, the SIP is moved to the
Permanent Repository. The Permanent Repository in intended to store Producer
Agent content that was approved by staff users for permanent preservation. As
a result, SIPs that are stored in the Permanent Repository cannot be updated,
deleted, or rearranged.
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For general information on storing the SIPs in the Permanent Repository, see
Storage Components in the Rosetta Overview Guide.

SIP Routing Rules

Deposit Managers can determine how SIP submission errors are handled by the
system. An error in a SIP submission may cause the SIP to be rejected or it may
be routed to a Technical Analyst for further evaluation.

To access the list of SIP routing rules, follow the path from the Rosetta rollover
menu: Submissions > Advanced Tools > SIP Routing Rules.

Hame = Submissio Advanced Tools = Rule List
Filter | & =1 Find in | & =1 | eo
Add Rule 1-1of 1 Records
Enabled Order Name Description| Created Modification Date|
< Back

Figure 91: SIP Rule List

The default rule for error handling appears in the list along with any other SIP
error handling rules your institution has added. You can work with rules in one
of the following ways, all of which take you to the Rule Details page (SIP
Routing Rules - Rule Details on page 179).

B To add a new rule, click the Add Rule button.
B To edit an existing rule, click the Update text of the rule’s row.

B To create a rule based closely on an existing rule, click the Duplicate text of
the rule’s row.

You can also delete a rule by clicking the Delete text of the rule’s row.
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Home = Su

Rule Editor

Name

Description
Created By:
Updated By:

Input General

Cancel

bmissiocns > Advanced Tools > S|P Routing Rules > Rule Details

|GECCiitE"C'—.:l"'G”";:EfSuH

Created on:
Last Update on:

Parameters

=
[Save |

On the Rule Details

Figure 92: SIP Routing Rules - Rule Details

page, you can add or edit the Name or Description fields in

the Rule Editor section.

For the Input General Parameters section, create or edit the conditions for the
input that will cause the rule to take effect. Include the values that define the

parameters.

Input General Parameters

Parameter

Operator

Producer

Producer Group

MaternialFlow 1D C
MaterialFlow | Contains
Error ID In List

List Equals

Figure 93: Operator Options for Error Handling Rules

Refer to the Operators Used in Rule Parameters section for detailed
information on commonly used operators.
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Operators Used in Rule Parameters

The following operators are used for specific types of parameter data.
String Values

String values are words that are not separated by a comma (,), for example, one
Producer name (John Smith), one MIME type (audio/mp3), one error code, one
Format ID). String values use the following operators:

B  Equal - The string and the input value must match exactly.

B Contains — The string and the input value must match partially with the "’

character.
List of Strings
A list of strings is a list of string values separated by a comma (,) sometimes

populated by a widget. Lists of strings use the following operators:

®m List Contains — Used when word order of the items in the list does not need
to match or when there is a match to only part of the list. For example, if the
rule is defined as “Invalid object number in cross-reference stream,” it will
be used if the actual output from JHOVE was — “Invalid page dictionary
object, Invalid object number in cross-reference stream.”

® List Equals - Used when the order of the items in the list and the list itself
should match exactly. For example, a rule defined as “Invalid page
dictionary object, Invalid object number in cross-reference stream” will
match to the actual output from JHOVE - “Invalid page dictionary object,
Invalid object number in cross-reference stream.”

Numeric Fields
Numeric fields (for example, file size) use numbers as matching and comparison

values.

B Greater Than (>) — The input value should be greater than the parameter
value.

B  Less Than (<) - The input value should be less than the parameter value.
B Equal (=) - The input value should be equal to the parameter value.

B Not Equal (! =) - The input value should be not equal to the parameter value.
Date Fields

Date fields (such as Creation Date) compare date values with time operators.
m  After — The input date should be later than the parameter date value.

B Before - The input date should be earlier than the parameter date value.
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B Equal (=) - The input date should be the same as the parameter date value.
B Not Equal (! =) - The input date should not be the same as the date
parameter value.

Any

All fields can use this operator for indicating that any input value will be
accepted by the rule. For example, if the “Any” operator is used in the Producer
Name field, the rule can match all Producers.

The following table summarizes the possibilities for matching between the rule
parameter values and the run-time values:

Table 23. Possible Matches Between Rule Parameter and Run-Time Values

Possible Rule
Values

Run-time Value

Operator

Demo Producer Equal Demo Producer Match
Demo Producer Contains Demo* Match
image/tiff or image/ | In List Image/tiff, image/ Match
bmp bmp
image/tiff, image/ List Equals Image/tiff, image/ Match
bmp bmp
grey or gray In List with Regular grlealy Match
Expression
12345 <, > = 1= 10000 <-No match
> - Match
=- No match
I=- Match
23/11/2011 Before, After, =, = 23/11/2011 Before - No match
After - No match
= - Match
!=- No match

To define Boolean logic when using multiple conditions, select one of the
following options between conditions:

® OR
B AND (default)
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NOTE:

The Boolean connector between different types of attributes (for example,
IE Attributes and File Attributes) is always AND.

Defining SIP Processing Configuration

The SIP processing configuration determines how the SIP is processed at each
stage. Deposit Managers define this on the SIP Processing Configuration List
page.

To access this page, follow the path from the Rosetta rollover menu:
Submissions > Advanced Tools > SIP Processing Configuration List.

W) Home = Submissions * Advanced Tools = SIF Froosssing Configuration List

~|

Add Processing Cenfiguration

Filter A

Active| Mame .« | Description Created O Updated Oia
All Other - Any SIP that does not conform 02/04/2012 View Update Duplicat= Mors,
one of the specific 5IP routing 3:52 h
rules is processing according to
this configuration.
2 eneral  All 5IPs using generic or staff- 02/04/2012 View Update Duplicatz Mors.
-

mediated MF with
unpublished, from pr

group) unpublis

. - 4 o - - - g —— ) | L —
3 | 5IPs using a generic MF 409720 02042012 View Upaate Duplicate  More.
- q - 4 e -
cducer (group) published 4:30:2 3:52:59
4 Nations 01/02/20° 20/020201 =% Update Duplicate  Mors.
[ N 4E-" - q. B b
Archives 5:24:37 :45:5

Figure 94: SIP Processing Configuration List Page

The following actions can be performed on the SIP Processing Configuration
List page:

Adding a SIP Processing Configuration on page 183
Updating a SIP Processing Configuration on page 184
Duplicating a SIP Processing Configuration on page 185
Deleting a SIP Processing Configuration on page 185

Activating and Deactivating a SIP Processing Configuration on page 186

182
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Adding a SIP Processing Configuration
Deposit Managers can add a new SIP processing configuration.
To add a SIP processing configuration:

1  On the List of SIP Processing Configuration page (see Defining SIP
Processing Configuration on page 182), click Configuration. The SIP
Processing Configuration page opens.

Home / Submissions / Advanced Tools / SIP Proc

General Information

* Name |

Description |
Priority Normal '
Validation Stages - Pre-approval Automatic Stage

Validation Stack Routine  ‘/alidation Stack - Full

Approval Stage - Manual Approval/Assessment Stage

Approval Approver v
Allow Split/Merge Yes ® Mo

Enrichment - Post Approval Automatic Stage

Enrichment Routine Enrichment 2 v

Email Notification

Send Motification Yes ® No

Cancel @

Figure 95: SIP Processing Configuration Page
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2 Complete the fields as described in the following table:

Table 24. SIP Processing Configuration Page Fields

Field Description

Name The name of the SIP processing configuration.

Description The description of the SIP processing
configuration.

Priority Select a priority:

B High — Process ASAP
B Normal - SIPs are queued up to 1 hour

B Low - SIPs are queued up to 6 hours

Validation Stack Routine The list of available routines that can be executed
when the SIP enters the validation stage.

Approval The list of available options for the human stage of
the SIP processing (for example, reviewing a SIP
by an Approver). The following options are
available:

B Assessor + Arranger

B Approver

Enrichment Routine The list of available routines that can be executed
when the SIP enters the enrichment stage.

Email Notification Whether you want notification of the results
emailed to the staff user

NOTE:
All fields with an asterisk (*) are mandatory.

3 Click Save.

The new SIP processing configuration is saved in the Rosetta system.

Updating a SIP Processing Configuration

Deposit Managers can update an existing SIP processing configuration. The
parameters that can be changed include the validation stack routine, the human
approval process, and the enrichment routine.

To update a SIP processing configuration:

1  On the List of SIP Processing Configuration page (see Defining SIP
Processing Configuration on page 182), locate the SIP processing
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configuration with which you want to work and click Update. The SIP
Processing Configuration page opens.

2 Modify the fields as described in Table 24.
3 Click Save.

The updated SIP processing configuration is saved in the Rosetta system.

Duplicating a SIP Processing Configuration

Deposit Managers can duplicate an existing SIP processing configuration. This
is especially helpful when creating a new SIP processing configuration. It is
often faster to duplicate an existing SIP processing configuration and then
modify it, than to create a new configuration.

To duplicate a SIP processing configuration:

On the List of SIP Processing Configuration page (see Defining SIP Processing
Configuration on page 182), locate the SIP processing configuration that you
want to duplicate and click Duplicate.

An exact copy of the SIP processing configuration is added to the List of SIP
Processing Configuration page. The Rosetta system automatically labels the
new SIP processing configuration with the name Copy of followed by the name
of the original SIP processing configuration.

Deleting a SIP Processing Configuration

Deposit Managers can delete an existing SIP processing configuration.

NOTE:
Any SIPs in progress that are associated with a deleted SIP processing
configuration will complete their processing according to the deleted
configuration's instructions.

To delete a SIP processing configuration:

1  On the List of SIP Processing Configuration page (see Defining SIP
Processing Configuration on page 182), locate the SIP processing
configuration that you want to delete and click More. Additional options are
displayed.

2 Click Delete. The Delete Confirmation page opens.
3 Click OK.

The system removes the SIP processing configuration from the List of SIP
Processing Configuration page.
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Activating and Deactivating a SIP Processing Configuration

Deposit Managers can activate or deactivate an existing SIP processing
configuration.

On the List of SIP Processing Configuration page, the current status is indicated
by the check mark in the Active column:

B Yellow - The SIP processing configuration is active.

B Grey - The SIP processing configuration is inactive.

NOTE:
Any SIPs in progress that are associated with a deactivated SIP processing
configuration do not get promoted to the next processing stage.

To activate or deactivate a SIP processing configuration:

1  On the List of SIP Processing Configuration page (see Defining SIP
Processing Configuration on page 182), locate the SIP processing
configuration that you want to activate or deactivate.

2 Inthe Active column, click the check mark. The check mark in the Active
column indicates the new status.

The SIP processing configuration is changed from active to inactive or inactive
to active.

Configuring SIP Routing Rules

SIP routing rules define the SIP processing configuration that must be applied to
the specific SIP.

Deposit Managers can define SIP routing rules using the List of SIP Routing
Rules page. To access this page, follow the path from theRosetta rollover menu:
Submissions > Advanced Tools > SIP Routing Rules.
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Figure 96: SIP Routing Rules List Page

The following actions can be performed on the SIP Routing Rules List page:
B  Adding a SIP Routing Rule on page 187

Updating a SIP Routing Rule on page 189

Duplicating a SIP Routing Rule on page 190

Deleting a SIP Routing Rule on page 190

Activating and Deactivating a SIP Routing Rule on page 190

Adding a SIP Routing Rule

Deposit Managers can add a new SIP routing rule. When adding a new SIP
routing rule, Deposit Managers provide information in two panes:

®  In the Input Parameters pane, matching criteria parameters are defined.
B  In the Output Parameters pane, result parameters are defined.

The Rosetta system determines the input and output parameters. Deposit
Managers cannot add or delete these parameters.

The logical relationship between the input parameters or the output parameters

is AND. Deposit Managers cannot change the logical relationship between the
parameters.
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To add a SIP routing rule:

1  On the List of SIP Routing Rules page (see Configuring SIP Routing Rules
on page 186), click Add Routing Rule. The Routing Rule Editor page opens.

O, . . .
,ﬂ.\_.-'“]r Home = Submissions > Advanoced Tools > SIP Routing Rules > Rule Details

Rule Editor
Hame [3ensral digital material
Description |
Created By: Systemn Created on: 31/08/2012 22:42:50
Updated By: Last Update on:

Input General Parameters

Farameter Dperator Value

Materisl Flow . . - - [Generzld v
Material Type - = - - Im
roduoer - m - Im

Faramater Result

Approver Group - |L!r'-cL.:Ii5I"Ec Acc'ﬂ
Department - ||:§*'r: EE"‘EI"I‘TEFTﬂ
Process Configuration - | General Digital Me =]

Figure 97: Routing Rule Editor Page

2 In the Input General Parameters pane, complete the following fields:

Table 25. Input General Parameters Pane Fields

Column Description

Operator The list of available operators.

NOTE:
The operator describes the logical
relationship between the parameter and the
value. The values in the drop-down list
vary according to the type of parameter.
For more details, see Operators Used in
Rule Parameters on page 180.

188 September 2016
Ex Libris Confidential



Staff User’s Guide, Part IIl: Deposit Managers
Chapter 14: SIP Processing, Configuration, and Routing Rules

Table 25. Input General Parameters Pane Fields

Column Description

Value The value for the parameter. For example, the
department output parameter must contain
“Academic.”

NOTE:

The value is either a text input box or a drop-
down list, depending on the type of parameter.

3 Inthe Output Parameters pane, complete the following fields:

Table 26. Output Parameters Pane Fields

Column Description

Approver Group The approver group to which the SIP must be
forwarded.

Department The department to which the SIP is connected.

Process Configuration ID The process configuration ID that is applied to the SIP.

For more information about SIP processing
configuration, see Defining SIP Processing
Configuration on page 182.

4 Click Save.

The new SIP routing rule is saved in the Rosetta system.

Updating a SIP Routing Rule
Deposit Managers can update both the input and output parameter information

of an existing SIP routing rule.

To update a SIP routing rule:

1  On the List of SIP Routing Rules page (see Configuring SIP Routing Rules
on page 186), locate the SIP routing rule with which you want to work and
click Update. The Routing Rule Editor page is displayed.

2 In the Input General Parameters pane, modify the fields that you want to
update.

3 Inthe Output Parameters pane, modify the fields that you want to update.
4  Click Save.

The updated SIP routing rule information is saved in the Rosetta system.
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Duplicating a SIP Routing Rule

Deposit Managers can duplicate an existing SIP routing rule. This is especially
helpful when creating a new SIP routing rule. It is often faster to duplicate an
existing SIP routing rule and then modify it than to create a new SIP routing
rule.

To duplicate a SIP routing rule:

On the List of SIP Routing Rules page (see Configuring SIP Routing Rules on
page 186), locate the SIP routing rule you want to duplicate and click Duplicate.

An exact copy of the SIP routing rule is added to the List of SIP Routing Rules
page. The Rosetta system automatically labels the new SIP routing rule with the
name Copy of followed by the name of the original SIP routing rule.

Deleting a SIP Routing Rule

Deposit Managers can delete an existing SIP routing rule.

To delete a SIP routing rule:

1  On the List of SIP Routing Rules page (see Configuring SIP Routing Rules
on page 186), locate the SIP routing rule you want to delete and click Delete.
The confirmation window is displayed.

2 Click OK.
The SIP routing rule is deleted from the Rosetta system.

Activating and Deactivating a SIP Routing Rule

Deposit Managers can activate or deactivate an existing SIP routing rule. After a
routing rule is deactivated, it is no longer used by the Rosetta system.

On the List of SIP Routing Rules page, the current status is indicated by the
check mark in the Active column:

B Yellow - The SIP routing rule is active.

B Grey - The SIP routing rule is inactive.

To activate or deactivate a SIP routing rule:

1 On the List of SIP Routing Rules page (see Configuring SIP Routing Rules
on page 186), locate the SIP routing rule that you want to activate or
deactivate.

2 Inthe Active column, click the check mark. The check mark in the Active
column indicates the new status.

190
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The SIP routing rule is changed from active to inactive, or inactive to active,
depending on the previous state of the rule.
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OAI-PMH Harvester

The OAI-PMH Harvester allows users to load objects into Rosetta directly from
an OAI-PMH digital repository. It has two modes of operation:

B Loading new objects into Rosetta

B  Updating objects already existing in Rosetta — This mode can be divided in
to two scenarios:

B Content originally created in Rosetta — This typically means that the
metadata was harvested and enriched by an external system and is now
being passed back to Rosetta for harvesting. In this case, the match is on
the Rosetta PID.

®  Content originally created outside of Rosetta —This refers to content that
was loaded previously into Rosetta but continues to be maintained in an
external system. The latter is now sending updates to those previously
loaded records. In this case, the match is on the original system ID, as
stored in the DNX.

Loading New Objects

When loading new objects, the OAI-PMH Harvester job creates SIPs for loading
with a Submission Job (see Submission Jobs on page 249). Users can choose to
create SIPs in either METS or Dublin Core format and schedule harvests to run
at given time intervals. You can use this job for migration purposes, or for
ongoing loading from an external repository into Rosetta (for example, to
preserve data managed by another repository).

Updating Existing Objects

When updating existing objects, indicate if the content being harvested is of
Rosetta origin or an external repository origin. If the content is of external
origin, indicate the material flow to be used when loading new objects. If the
content is of Rosetta origin, you can indicate a qualifier and string with which to
match. Upon matching, the harvester can either create an update MD package
with the new (transformed) metadata or ignore the changes. You can select one
of the existing Update MD jobs for which the harvester creates a package or
select an option to ignore the record.
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Creating the OAI_PMH Harvest Job
This section describes the procedure for creating an OAI-PMH harvest job.

To create an OAI-PMH new harvest job:

1 Under Producers > Advanced Tools, select OAI-PMH Harvester, and click
Add Job.

-
ExLibris Rosetta Management

m Submissions Data Management Preservation

Home > Producers > Advanced Tools = OAI-PMH Harvester = Job Details

* Mame [DAIFPMH Harvester

Hourly

Da Start At
Week Time 11 ¥ 45 v
Monthiy Date i) ¥ | December ¥ | 215 v G -
Advanced
Repeat
s Indefinit:
LUntil
D& ¥ | December ¥ 205 ¥ B -
Perform this task :
Every 1 v | Houris
IE' Job Parameters
* Base URL [
Set v *  Metadata Prefix v
User Name [ Password
Ignore Last Run Time
*  Match External Repository Origin (04l headerid) *
XSL File r
*  Material Flow preservePP + complex ¥ * Update Metadata Job | Metadata Update Job - IES266 v

Back Refresh m

Figure 98: OAI-PMH Harvester

2 Enter a name for your job (for example, Fedora Harvest)

3 Schedule your job.
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NOTE:
Rosetta appends the previously run and current timestamps to OAI-PMH
harvest requests. This is not affected by your scheduling preferences.

4 Enter the OAI-PMH harvesting parameters as described in the following
table:

Table 27. OAI-PMH Harvesting Parameters
Parameter Explanation Mandatory?

Base URL The OAI-PMH server base URL | Yes
(for example: host:port/
oaiprovider/request)

Set The OAI-PMH selective No
harvesting setSpec element

Metadata Prefix The OAI-PMH metadataPrefix Yes
element

User Name Used for OAI-PMH servers that | No
require login. If defined, a basic
authentication header is sent
with the request

Password Used for OAI-PMH servers that | No
require login. If defined, a basic
authentication header is sent
with the request

Ignore Last Run Time Select to disregard the last run No
time.

Match Select from the drop-down list: Yes

B External Repository Origin —
Imported records originate in
an external repository

B Rosetta Origin — Imported
records originate in Rosetta
and are being reimported for
updating

B Do not match — All records
are imported, including
duplicates

Qualifier (Available with Rosetta Origin) No
Identifier of the DC record.
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Parameter

Contains String

Table 27. OAI-PMH Harvesting Parameters

Explanation Mandatory?

(Available with Rosetta Origin) No

The string at the beginning of
the DC record.

XSL File

Transforms OAI-PMH recordsto | No
Rosetta METS/Dublin Core
records. If no XSL file is selected,
the default XSL that transforms
to DC is used.

Material Flow

(Available with External Yes
Repository Origin or Do Not
Match)

The Rosetta Material Flow used
when importing new records,
which is used to generate/
process the SIPs

Update Metadata Job Select the metadata job toupdate | Yes

records or (with external origin)
select to not update.

NOTES:

A key to Rosetta OAI-PMH harvesting is the location of the reference to
the filestreams in the metadata. The OAI-PMH record must provide a
URI that Rosetta can access (either via HTTP or NES) to obtain the files.
Depending on the xs It transformation, these references are either placed
in the METS fileSec or the DC stream source field (defined in the DC
content structure configuration). Rosetta does not harvest the filestreams
during OAI-PMH metadata harvest — this is done during the submission
itself.

The selected material flow and the xslt transformation file must be
aligned. For example, if the material flow uses a METS content structure,
you must select an xslt transformation that produces METS. Rosetta
provides built-in examples for xslt transformation. To add/edit xslt
transformers, go to Producers > Advanced Tools > OAI Transformation
Configuration Files.
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Ok . .
:rx_.f]’ | Home = Producers = Advanced Tools = Configuration Files

Add File

Filename & Dggcriptign Updated by Update Date
1 Cfxslitransformation/oai_d O A] Dublin Core to Rosetta C Ex Libris 11012015 WView  Edit
2 fesltransformation/oai_d O Al Dublin Core to Rosetta L Ex Libris 11012015 WView  Edit
3 fesltransformation/oai_d O A] Dublin Core to Rosetta b Ex Libris 11012015 WView  Edit
4  fesltransformation/osi_d QA Dublin Core to Rosetta b Ex Libris 11012015 “iew  Edit
5 fesltransformation/oai_d QA] Dublin Core to Rosetta C Ex Libris 111012015 View  Edit

Figure 99: OAI Transformation Configuration Files

B To create a dedicated submission job for processing OAI-PMH harvested
records, you must also configure a dedicated material flow for the
harvester and the submission job.

B The OAI-PMH harvester job places a lock file (. locked) in the
submission folders it creates and removes the lock only after the job is
completed. The submission job does not process a folder with a lock file.
See (About Submission Jobs on page 249) for more details.

B Rosetta generates one SIP for every OAI-PMH response. If the OAI-PMH
server returns a resumption token, another request is sent and another
SIP is generated from each subsequent response. The number of IEs
depends on the number of records returned per response. For large IEs, it
is therefore recommended to configure the OAI-PMH server to return
fewer records per response.

B ]tis generally recommended to use a Dublin Core content structure and
material flow for simple objects (IEs with one representation). If you need
to apply more complex logic (for example, map streams to separate
representations) use a METS flow.

B Rosetta stores the OAI identifier header in the IE Original Object
Identifier DNX field. This is done either by direct mapping (in the case of
METS transformation) or indirect mapping. (Rosetta stored this
information in a temporary DC field, which is later mapped to IE
Original Object Identifier.) If you select External Repository Origin,
Rosetta searches the repository for other records (within the same
institution) based on this field and value.

B The harvesting job ignores OAI-PMH records that have a Deleted status.
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Negotiators

This part contains the following sections:

Chapter 16:
Chapter 17:
Chapter 18:
Chapter 19:
Chapter 20:
Chapter 21:
Chapter 22:

Understanding Negotiators on page 201

Managing Producers on page 205

Personalizing Producer Profiles on page 219
Personalizing Material Flows on page 225

Depositing Content on Behalf of a Producer on page 235
Scheduling Producer Reports on page 239

Submission Jobs on page 249
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Understanding Negotiators

Negotiators are responsible for working with Producers and tailoring the
generic deposit configuration of the Rosetta system to the needs of specific
Producers.

Negotiators are assigned by a User Manager who registers Negotiators and
defines their privileges. Negotiators can be assigned one of three types of
permissions: View (no editing of data), Typical (add/edit privileges but no
delete), or Full (add/edit and delete privileges). Their scope is institutional.

Producers are associated with negociators through Producer Groups (not to be
confused with a group-type producer). Negotiators can assign a producer to a
producer group if that group is part of the negotiator's scope (see Table 29).

Producer groups are managed via the Producer Group Code Table, which can
be edited under Producers > Advanced Tools > Producer Groups.
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~
ExLibris Rosetta Management

Submissions

User. John Q. Smith | Insfitution: Demo institufion | Help

Data Management Preservation

=

Ok
D\fj Home = Producers = Advanced Tools = Code

Languages IEI'IgIISh e

El Table Information

Tables

Sub System: PRODUCER_MAMAGEMENT * Table Name: Producer Gruup El
Updated by: Ex Libris (Senicepack 4.0.0.0) Updated on: Sun Odl 08 00:00-00 DT 2013
Table Descripton:  Producer Group Codes i \
Code Table Rows
Export Import
Enabled  Display Order Code |Description |DefaultValue Last Updated
Create a New Code Table Row
Code Description Language Default Value
O Creale

Figure 100: Producer Group Code Table

To assign/unassign a producer group to/from a negotiator, edit the negotiator's

Role Parameters in User Management.
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1 Home = User Roles Details

User D 100
User Name John Smith
Role Name Megotiatar - Full

El Role Information

Scope Dema Institution

Status Active v | Status Date 09/01/2015
Expiry Date DD * MM v ¥YYYY v B~

Motes

El Role Parameters

FPublished
Government
Unpublished
Internal

[sme

Figure 101: Role Parameters

* ProducerGroup

SARAARLANLS
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Managing Producers

This section contains:

B About Managing Producers on page 205

B Accessing the Manage Producers Page on page 205

B Searching, Filtering, and Sorting Producers on page 207
Adding a Producer Account on page 210

Updating a Producer Account on page 216

Activating and Deactivating a Producer Account on page 216

Deleting a Producer Account on page 217

Producer Agent Registration Process on page 217

About Managing Producers

Negotiators manage Producers and the Producer Agents that deposit content in
the Rosetta system.

Negotiators perform this work on the Manage Producers page.

Accessing the Manage Producers Page

The Manage Producers page enables Negotiators to perform tasks such as
adding a new Producer account, updating Producer account details, and
performing other related activities such as linking Producer Agents to
Producers, assigning and personalizing Material Flows for Producers, and
depositing material on behalf of Producers.

To access the Manage Producers page, from the Rosetta rollover menu, follow
the path: Producers > Producers and Agents > Manage Producers.
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P
ExLibris Rosetta management

Producers Submissions

Data Manatement Presends

Producers and Agents Deposit Arrangements

Manage Froducar Profilas
Manage hlaterial Flows
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Run Reports
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Figure 102: Rosetta Rollover Menu, Producers Links

The Manage Producers page opens (Figure 103).

HOme = PROgUcens = Producers and AQents = Producer List
Fiitar | & = Find: n: | a | @
A0 Prodwcsr 1-2 of 2 Reconds
v} fcthve | Names Tips Prosducsr Group' M lator
1 G005 League of Schalars Reglsizl Goemment Jor SmEn View  Uodste
2 10000 Cema imemal Producel  imemal — Published Mo Megallior View  Updae
Producer Agents | Delele | Assign Negotiator

SONEN0E] SEEnchn

53T Medizted Deposh  More -

a7 Medizied Denosh MO o

Figure 103: Manage Producer s Page/Producer List

The page contains information for all Producers and links for actions that
can be taken for each (with the More... options expanded in the final row)
such as updating their information, viewing their details, and creating new

Producer Agents. The columns contain the following information:

Table 28. The Producer List page

Columns

Description

ID The Producer ID (system-generated)
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Table 28. The Producer List page

Columns Description

Active Check mark indicates the Producer account status, active or
inactive.

B Yellow = active.
B Grey =inactive.

Click the check mark to toggle between the two statuses.

Name Displays the name of the Producer.

Type Displays the type of Producer. For more information on the
Producer types, see the Rosetta Overview Guide.

Producer Group | Displays the group to which the Producer belongs.

Negotiator Displays the user name of the Negotiator who is assigned to the
Producer.

Searching, Filtering, and Sorting Producers

Negotiators can search for, filter, and sort Producers using the Manage
Producers page.

To search for Producers:
1  On the Producers List page (Producers > Producers and Agents > Manage
Producers), in the Find field, enter the name or ID of the Producer.

2 In the In drop-down list, select the database field in which the Rosetta
system should search for the Producer.

3 (Click Find.

The results are returned on the Manage Producers page.

To search for Producers using an advanced search:
1 From the Manage Producers page (see Figure 103), click advanced search in
the upper right corner.

2 The simple search is replaced by an advanced search, which includes the
Add Conditions button and the link back to the Simple search.

3 Click from simple search to advanced search.
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Filter: | All | Find: in:l*ﬂﬂII

Home > Producers » Producers and Agents > Manage Producers

ﬂ 6o (advanced searc

Filter: Iﬁ%” 'I

Producer Attributes:

Click on the "Add Conditions" button to define conditions

Home » Producers » Producers and Agents » Manage Producers

Add Conditions Go

imple search

Figure 104: From Simple Search to Advanced Search

4 (Click the Add Conditions button.

An Add Conditions box opens with Producer attributes listed.

e Advanced Search - Add Conditions

Select Attributes of:
vI Producer
Iittributes: | T
F suthoritative Name
T Classification
[T Crazts Date
[ Add Conil P osification Date
I Producer Group
[ Status Date
Add Fields
||Its Found

Figure 105: Add Conditions Box

5 Select the check boxes for one or more attributes you want to search.

6 Click Add Fields.

The conditions box closes and the fields you selected display in the search

area.
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..|_"|

Find:

+) Home > Producers > Producers and Agents > Manage Producers

Filter: | Al 'l

Producer Attributes:

And vI Create Date * IEq.Ja|3 = ’Imj]mﬂly‘ﬂ B~

Classification * [Equals =] "‘l

[
i
i
i

[
i
i
i

Praducer ’|Eq._,a|g j ’||ntema| ﬂ Deliztz | Add Conditions | Go
Group

Unpublished

Fublizhed

Figure 106: Advanced Producer Search, 3 Conditions

Select a relational term from the first drop-down menu in the first row, then
enter a value by whichever means the attribute calls for (free text or drop-
down menu, for example).

If you have subsequent rows, for each row, you can change the logical
operator (And by default) to one of the options from the drop-down menu.

When you have entered all your conditions, click the Go button to conduct
the search.

The system returns Producers that match the terms of your search.

To filter Producers:

On the Manage Producers page (Producers > Producers and Agents > Manage
Producers), in the Filter drop-down list, select one of the following options:

All, when you want to view the unfiltered list of all Producers

My Producers, when you want to view only those Producers that are
assigned to you

My Groups, when you want to view Producers in groups assigned to you

The list of Producers is filtered according to the option you selected.

To sort Producers:

On the Manage Producers page (Producers > Producers and Agents > Manage
Producers), click any column heading to sort the list according to the contents of
the selected column. The column heading is highlighted.

In addition, because both ascending and descending sequences are supported,
the column heading indicates whether the column is sorted in an ascending or
descending order.
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The default sort order is by Producer Name and Status Date.

Adding a Producer Account

Negotiators can add Producer accounts to the Rosetta system using an Add
Producer Account wizard. The wizard guides the Negotiator through adding a
Producer account, individual or group, and entering details about the Producer.
The last page of the wizard allows the Negotiator to add Producer Agents to the
account Once this is done, Producer Agents can register in the system and begin
depositing content on behalf of the Producer with whom they are associated.

Producers can also self-register. For information, see the Rosetta Producer’s Guide.
For more information about accounts, see Individual Versus Group Producers.

To go directly to the adding a Producer account procedure, see Add Producer
Account Process.

Individual Versus Group Producers

Negotiators adding a Producer account must determine if the account will be of
an Individual or Group type.

Individual accounts consist of a single Producer representing themselves and
depositing on their own behalf. The Producer Agent who performs the
depositing is, by default, the same individual. However, additional Producer
Agents can be added to the account.

Group accounts consist of a Producer representing an institution and a number
of Producer Agents depositing material on behalf of the institution. Group
accounts also consist of Contacts of the institution.

Add Producer Account Process

The process of adding a Producer account consists of the following tasks:

B  Deciding whether the account will be an individual or group account and
selecting a choice from the wizard

B Providing information about a Producer group or individual, such as
Producer classification and status, along with general information such as
telephone number and address. For individual accounts, this is the final
required step.

B Adding Producer Agents. For individual accounts, this step is optional
because a Producer Agent has already been assigned (the same individual
as the Producer). Group accounts must assign at least one Producer Agent to
deposit material.

B For group accounts only, adding Contacts.
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To add a Producer account:
1  On the Manage Producers page (Producers > Producers and Agents >
Manage Producers), above the list of Producers, click Add Producer.

Step 1 of the Add Producer wizard, Select Account Type for the Producer,
opens.

2 Select Individual or Group type. See Individual Versus Group Producers
on page 210 for more information.

3 Click Next.

The Producer Details page opens. Some fields vary depending on account
type (individual versus group, selected earlier.).

If you are creating an individual account, the wizard will display three
steps. If you are creating a group account, the wizard will display four steps.
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anage Producers * Producer Details 1 @' S

Ao Home = Producars = Producars and Agents = Man

\ CIWOErs COILCE

10 - Creation Date 03/08/2012 Created by admin?
Mame - Updated on  08/082012 Updated by sdmint
Account Type Group
El General Information
" Authoritative Mame |
Producer Group |"=:--.-§"-~e-t - Producer Type Trusted ﬂ
Classification | Maons ﬂ MNegotiator
Status Active Status Date OB 2012
Local Producer Field 1|h:—"§ ﬂ
* Generic Profile | Default j
El Preducer Information
* Institution = Department |
* Telephone 1 Telephone 2 |
Fax
* Email Send Reports who Oes

© Street

Suburb
City
Country

|
|
|
|
Website URL |
|
|
|
|

&fghanistzn j Postal Code

MNotes :I

< Back Cancel

Figure 107: Adding a Producer for a Group Account

4 In the Producer Information pane, complete the fields as described in the
following table:

Table 29. Producer Information Fields

Field Description

Authoritative Name The name of the Producer.

Producer Group Used to assign several Producers to a Negotiator.
Negotiators can work with Producers in their
assigned groups.
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Table 29. Producer Information Fields

Field Description

Classification

The classification of the Producer. Options (such as
government or publishers) display in a drop-down
list that is populated through the Back Office
Administrator.

Status

The Producer account status:

B Active - Producer Agents can use the Rosetta
system to deposit content.

B Inactive - Producer Agents cannot use the Rosetta
system to deposit content. However, the account is
still saved in the system.

Producer Type

The Producer type that governs how associated
Producer Agents deposit content. The following
options are available:

B Casual
B Registered
B Trusted
B Internal

For more information on Producer types, see the
Rosetta Overview Guide.

Negotiator

The Negotiator who is responsible for managing this
Producer.

Status Date

The last date on which the Producer account details
were changed.

Generic Profile

The generic profile that is used for this Producer.

NOTE:

Back Office Administrators can add up to two additional fields to allow
Negotiators to provide additional information about Producers.

5 In the General Information pane, complete the fields that are required and
any additional fields. Where Institute and Department appear on the form
for a group Producer, First Name and Last Name appear respectively on the
form for an individual Producer.

6 Complete the required fields in the Producer Information pane.

NOTE:

The e-mail address you enter on this form will be used whenever someone
clicks the contact icon beside this name, as shown in the figure below.
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Clicking the e-mail address on the Contact Information card opens a new

blank message in the user’s mail client. Currently this feature is supported

in Microsoft Outlook.

0
&’] Home > Producers > Producers and Agents > Manage Producers > User List

Find
Add User 11 -200
Name - Account Type Job Title Telephone Statu:
11 2 F Janes Elma Internal Froducer Agent 222022 200 Active
12 B T Kenwood Marry Internal oy 2-550-2147 Active
T Mallard Emily Internal Producer Agent 418-565-4714 Active
1_.'_1, E |n|:|rn-:|| Dradinrar Arant AREE_ ST A1 ot ian
5@ res drew {Z Contact Information - Windows Internet Explorer  [jfu]
Hi= N Registrat] g 16 ™ hitkp: fil-dtldev07h, corp. exlibrisgroup.com: 1801 fmngjactionyper. | 5
17 B2 T Sirmon Robert Contact User Mallard Emiby
18 (2 T Smith John
19 T Time Liz Telephone 1: 415-555-3715
20 B2 T Tyler Robin Telephone 2: 0 :
£ Email: Idps_agenﬁ@gmail.cnm I—.'mg?nji;r?ters
« Back

Figure 108: Clicking the Contact Icon Opens the User’s Contact Information

7  For individual accounts, when the form is complete, click the Next button.

The ProducerAgent page opens with the Producer’s information listed as
the sole Producer Agent. (The Producer and the default Producer Agent
share the same user record.) To add other Producer Agents, click the Add
Producer Agent button and select Agents from the list. Click Add, then
Done to complete this procedure.

NOTE:

An individual account will always have the Producer listed as the first
Producer Agent. Others may be added and deleted, but the original
Producer Agent cannot be removed.

For group accounts, when the form is complete, click the Next button. The
Contacts page opens.

Click the Add Contact button.
The User List page opens.
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e

A Home > Producers = Producers and Agents > Manage Producers = User List

Find in Al ;I Go
Add User 1 -3 of 3 Users
Name Job Title | Telephone Status Status Drate
1 [ @@ tsachim 34343 Active 040202011 11:44:50
z O M Malik Circle ERB443287T1 Active 08/08/2012 23:19:685
: D@ wu Ferguscn 54358787854 Active 08/08/2012 22:21:32

e

Figure 109: User List Page for Contacts

9 From the user list, select one or more users to be the Contact for the
Producer and click Add.

NOTE:
If there are no users in the list, or if the user you want is not listed, you
need to add the user as a Contact. Click the Add User button, enter values
in the User Information form that opens, and click Save. TheUser List
page refreshes with your new user. Select check boxes beside the user
names you want as your Contacts. Click the Add button.

The Contacts page refreshes with your new user(s) in the list.
10 Click Next.
The Producer Agents page opens.

1234

-H
]” Home * Producers = Producers and Agents > Manage Producers = Producer Agent List

lIn] - Creation Date Created by admini

Hame - Updated on Updated by admin1

Account Type Group

Add Preducer Agent

Active Hame User Type Status Date | Last Deposit
1 4 B Victoria Staff 08/D8/2012 23:30 View Update Disconnect
Holmes

< Back Cancel m

Figure 110: Producer Agents Page
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11 Click Add Producer Agent. A list of potential Producer Agents opens. Select
one or more to assign to the Producer and click Add.

NOTE:
If the there are no users in the list, or if the user you want is not listed, you
need to add the user as a Producer Agent. Click the Add User button,
enter values in the User Information form that opens, and click Save.
TheUser List page refreshes with your new user. Select check boxes beside
the user names you want as your Producer Agents. Click the Add
button.The Add Producer Agent page refreshes with your Producer Agent
selections

12 Click Done. The new Producer is added to the Producers list.

The Producer Agents associated with this Producer can now deposit content on
behalf of the Producer.

Updating a Producer Account

Negotiators can update Producer account details at any time.

To update a Producer account:

1 On the Manage Producers page (see Accessing the Manage Producers Page
on page 205), locate the Producer whose account details you want to update
and click Update. The Update Producer page opens.

2 Modify the fields that you want to update. See the Producer Information
Fields table for details.

3  When you have finished updating the Producer information, click OK.

The Producer details are updated in the Rosetta system.

Activating and Deactivating a Producer
Account

Negotiators can deactivate a Producer account when they must finish
configuring the Producer account before making it available to Producer
Agents, or if they want to temporarily disable the Producer account without
deleting it. Negotiators can also activate an inactive Producer at any time.

On the Manage Producers page, the status of the Producer account is indicated
by the check mark in the Active column:

B Yellow - The Producer account is active.
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B Grey - The Producer account is inactive.

To activate or deactivate a Producer account:

1 On the Manage Producers page (see Accessing the Manage Producers Page
on page 205), locate the Producer account that you want to activate or
deactivate.

2 Inthe Active column, click the check mark. The check mark in the Active
column indicates the new status.

The Producer account status is changed from active to inactive, or from inactive
to active.

Deleting a Producer Account

Negotiators can delete a Producer account. After a Producer is deleted,
associated Producer Agents cannot deposit content on behalf of this Producer.

To delete a Producer account:

1 On the Manage Producers page (see Accessing the Manage Producers Page
on page 205), locate the Producer account that you want to delete and click
Delete.

The confirmation page opens.
2 Click OK.
The Producer account is removed from the system.

Associated Producer Agents can no longer use the Producer account to deposit
content.

Producer Agent Registration Process

When Producer Agents register in the Rosetta system, they must specify the
type of material they plan to deposit by selecting one of the predefined options.
Administrators can define these options during advanced configuration using
the Registration Reason code table (below).
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- Home = Advanced Configueation = Deposit = Code Tables

Languages Erglezh =

E Table Infarmatiaon

Create a New Code Table How

Suby System: PRODUCER_MAHAGEMENT Talle Meme:  |Registration Reazan =]
Updated by: Ex Likeis Updated pn:  Tun Mew 17 152075 |57 2008
Table DescriptivnjRegisbation Reason Codes
B Code Tabie Rows
Expart Impart
Enabled Display Order Code Desgription Delault Value  Last Updated
1 i fanpublished | plan ta éopesi unpublished matanal ~ By ExLiors  Dalela
z # [puttishee | plan to ¢2pesi published matesdial = e

Cobe Dascriplion Language Default Value

Craata

Figure 111: Registration Reason Code Table

Administrators can add, edit, export, or import rows in the table. For more

information, see Working with Code Tables on page 219.

To access the Registration Reason code table, from the Advanced Configuration

page, click Deposits > 1st-Time Registration Reasons.

NOTE:

These rules affect individual Producers only (depositing content on their
own behalf). Producer agents registering to deposit content on behalf of a
producer require manual approval before they can deposit.
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Personalizing Producer Profiles

This section contains:

B About Personalizing Producer Profiles on page 219
Accessing the Producer Details Page on page 219
Upgrading a Registered Producer Account on page 220

Personalizing a Producer’s Deposit Control Settings on page 222

Assigning Material Flows to a Producer Profile on page 223

About Personalizing Producer Profiles

Negotiators can personalize generic Producer profiles for specific Producers. A
personalized Producer profile is based on one of the existing generic Producer
profiles.

Personalized profiles may include material flows and deposit control settings
that are unavailable in the generic Producer profiles.

Negotiators personalize Producer profiles using the Producer Details page.

Accessing the Producer Details Page

The Producer Details page enables Negotiators to personalize generic Producer
profiles for specific Producers.

1 To access the Producer Details page, from the Rosetta rollover menu, follow
the path Producers > Producers and Agents > Manage Producers. The List
of Producers page opens.

2 Locate the Producer for which you want to personalize the generic profile
and click Update. The Producer Details page opens with the selected
Producer’s information.
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Home > Producers > Producers and Agents » Manage Producers » Producer Details

Iz Creation Date 21/11/2011 Created by =dmini
Mame dICA Updated on  01/11/2011 Updated by sdmini
Account Type Group
El General Information
* Authoritative Name |r..||:,-'_-.

Froducer Group Zoyermmment j Froducer Type [Trustzd ﬂ

Classification |r\:.r; j Megotiator John Smith

Status Active Status Date 01/117:2011

Local Producer Field 1|r\:.r; j

* Generic Profile |'_'|:_..._ j e g s

El Preducer Information

* Institution |r._||:,-';_ * Department |'~\.-I.-l\.'
* Telephone 1 |11111 Telephone 2 |
Fax |
= Email |111@-,,-L-,,-.-,,-.ga|— Send Reports &Moo (Tes
Website URL |
" Strest foraows
Suburb |
City |
Country |.~‘-.";-'5-'st5-' j Postal Code
Motes =]
fod
El Contacts
Primary Mame Job Title Telephonei | Telephone?
m|m m t=3ch 14343 Delete Ema

Add Contact

Figure 112: Producer Details Page

For more information about the fields on this page, see Table 29, Producer
Information Fields on page 212.

Upgrading a Registered Producer Account

Negotiators can make a specific, personalized Producer profile available to a
particular group of Producers. However, to be able to use a personalized profile,
Producers must be defined as trusted Producers.

220 September 2016
Ex Libris Confidential



Staff User’s Guide, Part lll: Negotiators
Chapter 18: Personalizing Producer Profiles

This section describes how to upgrade a registered Producer account to a
trusted Producer account.

To upgrade a Producer account:

1 Onthe Producer Details page for the Producer whose account you want to

upgrade (see Accessing the Producer Details Page on page 219), in the
Producer Information section, select Trusted for the Producer Type field
drop-down menu.

Click the Save button.
The system returns you to the List of Producers page.

Click the Update text link for the Producer whose account you want to
change.

Click the Personalize Profile button.

The Update Producer Profile page opens.

=1 Home > Producers = Update Producer Profile
Profile I 57601 Created by sdimind Created on 197072010
Profile namerdinistry of Economic Upidated byadminl Updated on 2002000

Davalopment - Published
Frofile Type PEREOMALIZED

Producer Profile

* Hame Plinistry of Economic Development - Published

Status Active v] Status Date 19012010

“ Bctive Deposits Quota (GB)NOI000 * Disk Usage Quota (GB)  [100000
“Files Quota (GE) 100000 * Default Sampling rate (5{100

Fast Track Enakbled falge

Cancel m

Figure 113: Update Producer Profile Page

In the Producer Profile tab, enter information about the Producer and limits
for entering information. For information on the fields, see Configuring
Deposit Control Settings on page 71.

Click the Material Flows List tab to make adjustments to material flow
rules.

The tab displays a view the material flows selected for the profile and the
entire pool of material flows. (See figure below.)

Click OK. The Producer is upgraded to trusted.
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Associated Producer Agents now can deposit content using the personalized
Producer profile that is available to trusted Producers.

Personalizing a Producer’s Deposit Control
Settings

Negotiators can personalize deposit control settings for a specific Producer to
enable the associated Producer Agents to deposit larger amounts of content.

To change a Producer’s deposit control settings:

1  On the Producer Details page (see Accessing the Producer Details Page on
page 219), click Personalize Profile. The Producer Profile page opens.

Home = Producers = Deposit Arrangements = Manage Producer Profiles = Update Producer Profile

Profile ID g7308 Created by admin1 Created on 02M0/2012

Profile name Demo Internal  Updated by admin1  Updated on 02M10/2012
Producer - Default

Profile Type Personalized

Producer Profile

* Name ||:|Ef‘.'lcr Internal Preducer - Default

Status m Status Date 02/10/2012
* Active Deposits Quota (GB) 100000 * Disk Usage Quota (GB) (100000
* Default Sampling rate (%) |1|:|,|:; Fast Track Emabled falze

Cancel Save

Figure 114: Producer Profile Page

2 Modify the fields as described previously in this guide. (See Configuring
Deposit Control Settings on page 71.)

3 Click Save. Updated deposit control settings are saved in the Rosetta

system.
Associated Producer Agents can now deposit content using the updated deposit
settings.
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Assigning Material Flows to a Producer Profile

Negotiators can assign additional material flows to a specific Producer to
provide associated Producer Agents with more opportunities to deposit content.

To assign material flows to a Producer profile:

1

On the Producer Details page (see Accessing the Producer Details Page on
page 219), click Personalize Profile. The Producer Profile page opens.

Click the Material Flow List tab. The Manage Material Flows page opens.

[ %]

[E I SR 8]

Frofile |D Created by
Profile name Pr Updated by
Profile Type Ps

Material Flow List

El Proeducer Profile: Material Flows Selected

Active | Hame Type Content Struci | Acquire Method

Hittp Losd

22:43:08
General digital Generic  SoF.Complex eb Applat 21082012
- Bulk upload 22:43:07
El Material Flow pool
Name Template | Content Struct| Acguire Method
T MNew Material Flow-0sY  Manus SoF Simple Http Load
O New Material Flow-gjl ERIE SoF Simple Http Load
T New Materisl Floa-v3 ERIE SoF Simple Http Load
[ Mew Material Flow-f8J ANLE SoF Simple Http Load
O Sslenium Performancs ERIE SoF Complex  Http Losd

Add Selected

<Back

21082012 W

Created on
Updated on

Status Date

2208202
22082012

Status Status Date
ACTIVE 2

ACTIVE 2

ACTIVE  21/08/20

ACTIVE  21/08/2012 23:11:24
ACTIVE  Z208/2012 00:08:35

Figure 115: Manage Material Flows Page

3 Associate material flows as described in Associating Material Flows with a

Generic Producer Profile on page 169.

Associated Producer Agents can now deposit content using the material flows
you selected.
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Personalizing Material Flows

This section contains:

B About Personalizing Material Flows on page 225
Accessing the Material Flow Details Page on page 225
Adding and Deleting CMS IDs on page 232

Personalizing Metadata Forms on page 233

Personalizing Submission Formats on page 234

About Personalizing Material Flows

Negotiators can personalize generic material flows for specific Producers by
personalizing generic metadata forms and submission formats that are
configured by Deposit Managers. For more information on generic metadata
forms and submission formats, see Configuring Material Flow Infrastructure
on page 69.

Negotiators personalize these material flow building blocks using the Edit
Material Flow page (see Accessing the Material Flow Details Page on
page 225).

Accessing the Material Flow Details Page

The Material Flow Details page enables Negotiators to personalize metadata
forms and submission formats that are associated with a generic material flow.

To access the Material Flow Details page:

1 Follow these links from the Home page: Producers > Manage Producers.

2 Click the Update text link in the row of the Producer whose material flow
you want to access.

September 2016 225



Staff User’s Guide, Part lll: Negotiators
Chapter 19: Personalizing Material Flows

El Preducer Information

Ay Home * Producars = Deposit Arrangements > Mansge Producer Profiles = Producer Detsils
10 Creation Date 227082012 Created by admin |
MHame Updated on ZEB20N2 Updated by  dmint
Account Type
El General Information
= Authoritative Name Producer for Testing
Producer Group |E:-','5"'"5"t ;l Producer Type [ Tructed d
Classification |r\:.-5 ;I Hegotiator Jahn Smith
Status Active Status Date 2202012
Leeal Preducer Field 1 |r\:.-5 ;I
= Generic Profile |—'-_ car for Testing - Default j Mznage Material

Flows

Institution |T55t

Department |ts =t

Telephone 1

[pz5245242

Telephone 2 |

Fax |

Email [r@=dinris.co.il

Send Reports % Mo "es

Website LURL |

Street frest

Suburb |

City

|
|.~‘-.";".=" stzn

Country

;I Fostal Code

Notes

El Contacts

Add Contact

Cancel

Figure 116: Manage Producers/Producer Details Page

3 Click the Manage Material Flows button.

The Producer Profile/Material Flow List page opens with information for
the Producer you selected.

In the top pane, with the Material Flow List tab selected, find the row
containing the material flow you want to personalize and click the
Personalize text link in the same row.

The page refreshes with the following changes to the item you personalized
(see Figure 117):
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B The Name [“MF name”] has changed to “My [MF name]”
B The Type has changed from Generic to Personalized

B  The link Personalize is replaced by a link to Update

Material Flow List

El Producer Profile: Material Flows Selected

Active| Name Type Content 5truct| Acquire Method | Status Date
FTF + cop complex Genseric SoF Complex  HDpSubmissionF 22/08/2012 View Personalize
02:30:28
z Genarsl digital materisl Generic SoF Complex  Http Load 21/08/2012 View Personalize
22:43:08
2 5"5'; digits Personslzed SoF . Complex Web Applet 220082012 E
eaterial - Bulk wplosd 030245

El Material Flow pool

Figure 117: Material Flow Selected for Personalization

5 Click the Update link corresponding to the material flow you are
personalizing.

The Material Flow Details page opens.
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f'w.t::xl' Home = Producers = Deposit Arrangements = Manage Producer Profiles =
Material Flow ID 104317757 Created on ZZ/08/2012 Created by -
Material Flow Type Manus Update Date Z208/2012 Updated by -

El Material Flow Definition

* Mame |r._|}-

Description/Instructions | Mew

Status Active Status Diate 221082012

Sampling Rate (%) |1:|:| Material type |:§-:.:3 j
* Internal o CYes

Assertion of Copyrights [ gqilzrolzte Statzmaent 1 d Metadata Profile |5 SstionErofiztas ﬂ

El Technical Definitions

* Select content structure | SoF Simp

ﬂ 'EEIE:tEubmissil}nfl}rmatl:d:.5-53_35—5-5 ﬂ

El Descriptive Definitions

" Select Metadata form | Wy Periodic ﬂ

e lie] Pravisw Edit MD Torm
CM5 System ID

assign CME ID
[T Upload Source Mets

El Access Right Form

Remows all
o il
Accessinie from nstRution premises + =
Emba ] T +
MB=d 3E0ES ICCONING 50 CODRIGRT w4 *l
El Retention Policy Form
0 ttems sslected Ramowva all
Add sl
o Fetention Poliy }

Cancel m

Figure 118: Material Flow Details Page

The top section contains basic read-only information (such as ID number
and date created) about the material flow itself.

All other sections contain editable text and drop-down menu fields. Fields
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marked with asterisks are required.

The Material Flow Definition section contains the following fields:

Table 30. Material Flow Definition Fields

Field Description

Name

The name of the material flow.

Description/Instructions

The description of the material flow.

Status

The material flow’s status:

B Active - The material flow is available toProducer
Agents depositing for the Producer.

B Inactive - The material flow is not available to
Producer Agents depositing for the Producer.

Status Date

Displays the last date on which the status of the material
flow was updated.

Sampling Rate

B The percentage of deposits from this material flow
that will be automatically redirected to staffusers for
review.

NOTE:
This requires SIP processing Approval to be set to
Approver.

Material Type

The types of content that Producer Agents can deposit.

NOTE:
This drop-down list contains the material types
that were configured in advance by a Deposit
Manager or Back Office Administrator. For more
information, see Configuring User Static Lists in
the Rosetta Configuration Guide.

Assertion of Copyrights

The copyright statement to which the Producer Agent
must agree in order to deposit material using this
material flow definition.

The Technical Definitions section of the page contains the following fields:
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Table 31. Technical Definitions

Field Description

Select Content Structure | A drop-down list of content structures from which the
Negotiator chooses one for the Producer.. The selected
content structure is set at the material flow definition
level and is fixed for this material flow.

NOTE:
This drop-down list contains the content
structure templates that were configured in
advance by a Deposit Manager or Back Office
Administrator. For more information, see
Configuring Content Structures on page 82

Select Submission The submission format that the Producer uses when
Format uploading files. The format is set by the Negotiator and
fixed for this material flow at the material flow definition
level.
NOTE:

This drop-down list contains the submission
formats that were configured in advance by a
Deposit Manager or Back Office
Administrator. For more information, see
Configuring Submission Formats on page 70.

The Descriptive Definitions section contains the following fields and
buttons.

El Descriptive Definitions

" Select Metadata form | uhy My Unpublished d Praview Edit MD form

CM5 System ID qar Z2midb 45628 Lesign CM3 ID Dsilsta CM 3 ID

[T Upkoad Source Metadata files

Figure 119: Descriptive Definitions section of the Material Flow Details page
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Table 32. Descriptive Definitions

Name Description

Select Metadata Form The metadata form that Producer Agents must
complete when they deposit content.

NOTE:
This drop-down list contains the metadata
forms that were configured in advance by a
Deposit Manager or Back Office
Administrator. For more information, see
Configuring Metadata Forms on page 57.

Preview Shows a preview of the form/fields for the selected
Select Metadata form.
Edit MD Form Opens a page with a Design tab and a Field tab where

a user can edit information for either aspect of this
material flow’s metadata.

CMS System ID The Content Management System ID (CMS ID)
assigned to this material flow definition. The field is
comprised of two values, a CMS system value and a
CMS ID within that system. The ID is saved to the
system when the Negotiator clicks the Assign CMS ID
button and completes the ensuing wizard.

Assign CMS ID Opens a short wizard that allows the Negotiator to
select a CMS system value and to assign a CMS ID
from that system by entering the value directly or by
conducting a search for the value and selecting it from
the results list. Both system value and ID are copied to
the material flow when the Negotiator clicks the Link
button.

Delete CMS ID Only available when a CMS ID has been assigned.
Removes the association of the CMS ID with its
previously assigned material flow. The CMS ID can no
longer be assigned to IEs deposited with this material
flow, but IEs already deposited with the material flow
will retain the existing CMS ID.

Upload Source Metadata Allows a Producer Agent to upload source metadata
Files files when depositing IEs in metadata structures other
than Dublin Core. This allows your institution to store
complete information for IEs conforming to complex
and custom metadata schemes and to view this data in
the Web editor.

The Access Rights Form section contains a list of available access rights and
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a list of those access rights the Negotiator can assign to this material flow.
Arrow buttons allow items to be moved back and forth from one box to the
other.

Adding and Deleting CMS IDs

Negotiators can add or delete CMS IDs at any point during the adding or
editing of material flows. Buttons to assign CMS IDs display on the Material
Flows Details page. When a CMS ID has already been assigned, an additional
button for deleting the existing CMS ID displays in the Descriptive Definitions
section of the page.

To assign a CMS ID to a material flow:

1

Access the Manage Producers page by clicking from the Management Home
page to the Producers page to the Manage Producers page.

Click the Update text link in the row corresponding to the name of the
Producer whose material flow you want to alter by adding or deleting a
CMS ID. (If you need to add a new Producer, see Adding a Producer
Account on page 172.)

Under the Producer Profile information section, click the Manage Material
Flows button.

The Producer Profile/Material Flow List page opens.

With the Material Flow List tab selected, find the name of the material flow
you want to alter and select the text link Personalize or Update in its row. (If
the flow has already by personalized, only Update will show. If it has not

been personalized yet, you must do so by clicking the Personalize text link.)

The Material Flow Details page opens.

To add a CMS ID, click the Assign CMS ID button and do one of the
following:

a If you know the CMS ID, enter it on the first page. When you click Next,
the CMS ID is assigned.

b If you want to search a database for an existing CMS ID, click the Search
in external DBs option, click Next, and follow the prompts provided by
the wizard:

B Enter a partial or full search string in the Find field.

B Select a search category from the drop-down field.

®m Click Go.

Select an ID from the list of results and click the Link button.
The CMS ID is assigned to the material flow.
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6 To delete a CMS ID, click the Delete CMS ID button and click Confirm on
the confirmation page.

The Descriptive Definitions section of the material flow definition reflects
the assignment or deletion of the CMS ID.

Personalizing Metadata Forms

Negotiators can personalize a generic metadata form for a specific Producer by
adding new fields or editing existing ones.

To personalize a metadata form:

1 On the Material Flow Editor page (see Accessing the Material Flow Details
Page on page 225), in the Material Flow Definition pane, click Personalize
Metadata Form. The Metadata Form Editor page opens.

r?r'%' Hoame = Praducers = Metadata Form Details

De_sign Information tah

Type PERSOHALZED Created on BIZ2010 Creates 'Ll:.g'_l,".:-L‘l’.il'l.-
Ipdated nn¥2A010 Updated by Ex Likriz
= b= Infarma Fields Information tab
aslyn Information Flelds nlonation ] 2
~ Hamn My Urpooished e
Descriptinn rl:l Torm for unpublisked depcaica. ;l i
A
Firlis Infosmation
Farm Layuvut |1 Col
Select a flall to viewiedis Froperties fos Crrator
Add Mew Field “Lakel .':“‘T “DE Tag lm
100 ™ | Crestor Deleta r mandatory Eyes cooe T Tpe TeznFisld v
A0« = Tille Jelets
Slagle Ling  ¢©yes & Valldator [Nevaldalee =
30 = = Descaplon Delete Dol Vall Ll
A7 L= ] (=] Type Deleta TL TT S Jx
S = = @EM Delete ookl Krestor
BT = = Owne Delete  DeEstripion Erestor =l
TE - ules Delete =]
Delete Fields  Duplicate Field Save Field

Back Fisese

Figure 120: Metadata Form Editor Page

2 Update the fields as described in Configuring Metadata Forms on page 57.

3 Click Save Form. The personalized metadata form is saved in the Rosetta

system.

Associated Producer Agents can now use the metadata form that was created
specifically for their Producer when providing descriptive information about
deposited content.
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Personalizing Submission Formats

Negotiators can personalize a generic submission format for a specific Producer
to provide associated Producer Agents with more options to deposit content.
Personalized submission formats are based on one of the existing generic
formats.

To personalize a generic submission format:

1 On the Material Flow Editor page (see Accessing the Material Flow Details
Page on page 225), in the Material Flow Definition pane, click Personalize
Submission Format Form. The Edit Submission Format page opens.

2 Edit the fields as described in Configuring Submission Formats on page 70.

3 Click Save. The personalized submission format is saved in the Rosetta
system.

Associated Producer Agents can now use the submission format settings that
were created specifically for their Producer when uploading files.
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Depositing Content on Behalf of a
Producer

The Rosetta system enables Negotiators to deposit content on behalf of a
Producer. Negotiators who deposit content are considered Producer Agents.
The Rosetta system automatically creates Producer Agent accounts associated
with the appropriate Producer for these Negotiators.

Like other Producer Agents, Negotiators can deposit content and manage
deposit activities using the Deposit Activities page. In addition, Negotiators can
use both manual and automated material flows associated with the Producer for
which they are depositing content.

To deposit content on behalf of a Producer:

1 From the Rosetta drop-down menu, follow the path: Producers > Producers
and Agents > Manage Producers.

2 The List of Producers page opens.
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Home = Producers » Producers and Agents = Producer List
Filter: | A ;I Find: in: | A ;I Go | advanced search
Add Producer 1 -4 of 4 Records
Active Hame Type Prod Group Hegotiator
1 FlowAutormatedAssig Trusted Gowvernment John Staff More... -
Smith View Update Mediated
Deposit
2 Producer for Testing Trusted Government John Staff Moe... -
Smith View Update Mediated
Deposit
3 Oemo Internal Produ Internal  Published Mo Staff More... -
Megotiator View Update Mediated
Deposit
< seleniumPerformanor Trusted Government John Staff More -
Smith View Update Mediated
Deposit
Producer Agents | Delete | Historny

Figure 121: List of Producers Page

3 Locate the Producer on whose behalf you want to deposit content and click
Staff Mediated Deposit. The Deposit Activities page opens.

Deposit Activities

1] Find: im: Al ;I Go

Add Deposit Activity 1= &y Heevse

c)
in} Title Material Flow Type| Crested On| Subrnitted
@) :
1 2841 BSB Unpublished 01/09/2012 Wew  Bdit Hotes b
August 173512
) 2012
i Delete | History | Submit

Figure 122: Deposit Activities Page

NOTE:
If you want to deposit content on behalf of a Producer that is not
registered in the Rosetta system, you must create a new Producer account
as described in Adding a Producer Account on page 210.

The Rosetta system creates a Producer Agent account associated with the
selected Producer. Negotiators can now use this account to deposit content and
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manage deposit activities. For more information on depositing content, see
Depositing Content in the Rosetta Producer’s Guide.
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Scheduling Producer Reports

This section contains:

About Producer Reports on page 239

Managing the Producer Report Job on page 242
Modifying the Producer Report Job on page 243
Cancelling the Producer Report Job on page 244
Configuring Advanced Job Schedules on page 245

About Producer Reports

Two Producer reports are available for viewing;:
B Data related to Producer deposit activity/history

B Intellectual Entity views (which and how many times)

Deposit History Report

A Deposit History report is available from the Home > Producers > Producers
and Agents > Manage Producers: Producer List page. It contains the following
information for each Producer:

B General information about Producers: Producer ID and name, Producer
creation date, Institution, Account status and Producer group

B Information about the report period.

B The following information for each deposit activity in the period:
B Deposit Activity ID

SIP ID

Title

Date of Deposit

Name of the Depositor (Producer Agent)
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B Status of the SIP and a problem description if rejected or declined.

Possible Status values are Draft, Submitted, Rejected, Declined and
Approved. A deposit that has been partially approved and partially
declined will have a status of Approved. A deposit that has been
partially rejected will have a status of Rejected.

The Deposit History Report can be generated and e-mailed periodically to
Producers that have elected to receive e-mail notifications (see figure below).

Hzme = Producers > Producers and Agents > Manage Producers > Producer Details
In} 10000 Creation Date 25/08/2013 Created by -
Demo
Name Internal Updated on  25/08/2013 Updated by -
Producer (2
Account Type Group
IE' General Information
* Authoritative Name |DE!ITII:I Intemal Producer
Producer Group |F'ub|i5hE::| ;I Producer Type Internal ,I
Classification | null {not listed) ;I Negotiator Mo Megotiator
Status Active Status Date 250802013
Local Producer Field 1 |N:}I‘IE ;I
* Generic Profile | Default ;I Personalize
Profile
IE' Producer Information
* Institution ||NS|}|} * Department |NZ Department
* Telephone 1 [123-123123 Telephone 2 |
Fax |
= Email |mseﬁa_ge|enium@gmai|_ 5end Reports {oves Mo
Website URL [ —
" Street [Jerusalem 1
Suburk [
City |
Country Afghanistan ;I Postal Code |
Hotes |D|=r5_54"g.

Figure 123: E-mail Confirmation Parameter in the Producer’s Module

The report is sent to the primary contact e-mail entered on the Producer’s
record. If an e-mail address is not listed for the primary contact, the report is
sent to the Producer's e-mail address.

The system generates a single report for each Producer at each institution. This
means that Producers who deposit to many institutions will receive one report
for each institution to which they deposit material.
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NOTE:
If there are no deposit activities in the current period, an e-mail
notification will be sent to the Producer, but it will not include the report.

To e-mail these reports to Producers, Negotiators must schedule the Producer
Report job to run periodically or execute the job manually. For more
information, see Managing the Producer Report Job on page 242.

Intellectual Entity Views Report

This report provides information about which IEs were viewed and how many
times each was viewed. The number of views is counted since the last time the
Producer report was run, but a cumulative count for each IE is provided as well.

Viewing Producer Reports

Staff users can generate and view Producer reports on the Rosetta Management
interface.

To view a Producer’s reports:

1 Follow the Rosetta drop-down menu path: Producers > Producers and
Agents > Manage Producers.

The Producer List page opens (see Figure 124).

Filter: | & ;l Find: in:| & ;l Go | advanced search

Add Producer

Fa
Fa
A
1
r)
]
i

Active  Mame Type Prder Grp Negotiator
INDIY Producer Registered Gowvemnmen.John Smith  View Update Staff Mediate
Cemo Producer  Interna Published John Sm =% Update Sts

Figure 124: Producer List Page

2 Click the More link for the Producer to display more action links.
3  Click the History link for the Producer.
The Report page opens for the selected Producer.
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Reports List

Report Hame

Description
Link to the Report of the W

Vhale History of Deposits

Cn the fly up to date Report

[ Y o}

A
']
]

Link to the Report of Deposit Activities for 8 given date range

5|5

nfigurable date range)

4  Select one of the following links to display the BIRT report:

History — Displays a report for the all of the Producer’s deposit
activities.

Deposit Activities (Up to Date) — Displays an up-to-date report for the
Producer’s depost activities. Note that it may be different from the last
report that was sent to the Producer.

Deposit Activities (Last period) — Displays the last report that was sent
to the Producer, if such exists.

Intellectual Entity Views — Number of IE Views

Uploads Report (configurable date range) — Displays a report
containing the Producer’s deposit activities for a specified date range.

Managing the Producer Report Job

The Manage Scheduled Jobs page allows Negotiators to manage the scheduling
of the job that generates and e-mails the Producer Reports to Producers.

To access the Manage Scheduled Jobs page:

Follow the Rosetta drop-down menu path: Producers > Advanced Tools >
Producers Reports Job.

Current Time ZX0E/2012 18:18:37

Previous Fire Time Mext Fire Time Freguency State

Refresh

Figure 125: Manage Scheduled Job (Producers Report)
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NOTE:
If the job has expired or has not been scheduled, the State column will
display Not Running.

The Manage Scheduled Jobs page enables Negotiators to monitor the status of
the Producer Report job and perform the following tasks:

B View the job’s details — Click the View link to display the job’s details.

B Modify the job — For more information, see Modifying the Producer
Report Job on page 243.

®  Execute the job — Click the Run Now link to run the job manually.

In addition, you can cancel the job. For more information, see Cancelling the
Producer Report Job on page 244.

Modifying the Producer Report Job

This task allows Negotiators to modify the details for the Producer Report job.

To schedule the Producer Report job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the job.
The Job Details page displays the status of the job.

Home = Producers * Advanced To Producers Reports Job = Job Dt
Name Producer Report Frequeney Cron: 010 °  Previous Fire Time: 22708 0558
Role Repositony From Date - MNext Fire Time
State Mot Running Until Date

Start At
Time |:: dl a0 ﬂ
Date [z =Jos 2z 7|Em .
Repeat
i Indefinitshy
[ Unt
2z H B2
Back Refresh

Figure 126: Job Details Page (Producer Report Job)

2 Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.
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3 To configure hourly, daily, weekly, and monthly intervals:

a  Use the following table to configure the common interval fields:

Table 33. Common Interval Fields

Section Field Description
Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely | Select this option to run the job indefinitely.
Until Select the month, day, and year from the drop-down

fields to specify the date at which to stop running the
job.

NOTE:
After this date, the state of the job will change
from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 34. Interval-Specific Fields

Type of Perform Description

Interval  this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

4  Click the Apply button to schedule the job.

Cancelling the Producer Report Job

Cancelling a job allows the Negotiator to postpone the execution of job
indefinitely without deleting it from the system.
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NOTE:
The Unschedule option will not be available when the state of the job is
Not Running.

To cancel the Producer Report job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the Producer
Report job.
The Job Details page opens.

2 Click the Unschedule button.

The state of the job should change to Not Running.

Configuring Advanced Job Schedules

CronTrigger expressions allow users to define more advanced intervals for job
scheduling. This option displays on the Job Details page when the user clicks the

Advanced link.
Hourly Please enter firing schedule using the CronTrigger;
Daily
Weekly I
honthly CronTrigger Example 1 - an expression to create a trigger that simply fires
Advanced  every 5 minutes
DoS5===2

CronTrigger Example 2 - an expression to create a trigger that fires every
5 minutes, at 10 seconds after the minute {i.e. 10:00:10 am, 10:05:10 am,
atc.)

mo5===?

CronTrigger Example 3 - an expression to create a trigger that fires at
10:30, 11:30, 1230, and 13:30, on every Wednesday and Friday.
030 1013 7 = WED,FRI

CronTrigger Example 4 - an expression to create a trigger that fires every
half hour between the hours of @ am and 10 am on the 5th and 20th of
every maonth, Mote that the trigger will NOT fire at 10:00 arm, just at 8:00,
8:30, 9:00 and 9:30

0030895207

Figure 127: Job Details Page (Interval Pane)
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To configure CronTrigger expressions:

1 Select the Advanced interval on the Job Details page.

2 Enter an expression in the CronTrigger box, using the following format:

<Seconds> <Minutes> <Hours> <Day of Month> <Month>
<Day of Week> <Year>

Refer to the following tables for more information on writing expressions:

Parameter

Table 35. CronTrigger Parameters

Special Characters

Allowed

<Seconds> 0-59 =%
<Minutes> 0-59 =%
<Hours>" 0-23 =%

<Day of Month>" 1-31 ,-*2 /LW
<Month> 1-12 or JAN - DEC ,-%2)
<DayofWeek>* 1-7or SUN - SAT -2 /L
<Year> 1970 - 2099 -

*.Required parameter.

Special

Character

Table 36. Using Special Characters

Description

Indicates that all values within a parameter are used.

Indicates that no specific value within a parameter is used.

Used to specify a range of values. For example — if you
enter 10-12 for <Hours> — hours 10, 11, and 12 are used.

Used to specify additional values. For example — if you
enter 10,12 for <Hours> — hours 10 and 12 are used.

Used to specify increments. For example, if you specify 0/15
for <Seconds>, seconds 0, 15, 30, and 45 are used.
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Table 36. Using Special Characters

Special Description

Character

L Used as follows per parameter:

B <Day of Month> — Indicates the last day of the month,
such as 31 for January, 30 for November, and so forth.

B <Day of Week>— When used alone, it indicates the last
day of the week Saturday.

When used after another value (such <x>L), it indicates
the last <x> day of the month. For example, if you enter
5L, the last Thursday of the month is used.

When used with a hyphen, it specifies an offset from the
last day of the month. For example, if you enter L-2, the
second-to-last day of the month is used.

NOTE:
To prevent unexpected results when using the L
option, it is important not to specify lists or use
ranges.

W Used to specify the nearest weekday (Monday - Friday) to
the specified day. For example, if you enter 15W and the
15th falls on a Saturday, the system will use Friday the 14th.
If the 15th is on a Sunday, the system will use Monday the
16th.

NOTE:
If the closest weekday falls in the previous or next
month, the closest weekday in the current month is
used.

The L and W options can be combined to specify the last
weekday of the month.

# Used to specify the nth day of the month. For example, if
you enter 5#3, the third Thursday of the month is used.

NOTE:

If there is no match, the job will not be executed.
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Table 37. CronTrigger Examples

Expression Description

0 0/5 * ** 2 Executes the job every five minutes.

10 0/5 * * * ? Executes the job every five minutes, at 10
seconds after the minute (such as 10:00:10 am,
10:05:10 am, and so forth).

0 30 10-13 ? * WED,FRI | Executes the job at 10:30 am, 11:30 am, 12:30
pm, and 1:30 pm every Wednesday and Friday.

0 0/30 8-9 5,20 * ? Executes the job every half hour between the
hours of 8:00 am and 10:00 am on the 5th and
20th of the month. Note that the job will execute
only at 8:00 am, 8:30 am, 9:00 am, and 9:30 am.
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Submission Jobs

This section contains:

B About Submission Jobs on page 249
Managing Submission Jobs on page 250
Adding a Submission Job on page 253
Modifying a Submission Job on page 255

Cancelling a Submission Job on page 257

About Submission Jobs

Submission jobs are used to submit Producer content (per material flow) at
specified intervals to the Deposit server for automated deposits.

NOTES:

B You can prevent the submission job from processing a folder. (This can be
useful if you do not want it to be loaded prematurely.) To do so, create an
empty file in the submission job folder and name it locked (or . locked).

While processing a folder, the submission job adds a locked file.

After a folder has been successfully processed, the submission job adds a
done file. Folders with done files are not processed by the submission job.
You can create a cron job to clean up these folders.

B After a folder has been unsuccessfully processed, the submission job
adds an error file. Folders with error files are reprocessed by the
submission job (and should not be deleted). Users can use this file to
identify problematic submission folders.

September 2016 249
Ex Libris Confidential



Staff User’s Guide, Part lll: Negotiators
Chapter 22: Submission Jobs

Managing Submission Jobs

The Manage Scheduled Jobs page enables Negotiators to schedule submission
jobs. To access this page, follow the Rosetta drop-down menu path: Producers >
Advanced Tools > Submission Job.

The Manage Scheduled Jobs page opens to existing submission jobs
(Figure 128).

Current Time  07/08/2016 15:05:07

06/08/2020 16:11:00 Every 1 hous/s Hormal History  Update :""l More AcTions-
R
[

O7/DB/2016 145105 06/08/2020 11:19:00 Every 1 hows/s Histary  Update

Every Sunday a1 1:00 Not Running Demo ntemal Producer Rosetta Dublin Core deposit History Update " More Actions=

Back Refresh Restart Scheduler

Figure 128: Manage Scheduled Jobs (Submission Jobs List)

The following information appears on this page:

Name — the name of the submission job

Previous Fire Time — the last time the job ran

Next Fire Time — the next time the job is scheduled to run
Frequency — the frequency with which the job runs

State — the state of the job, for example, Normal, Not Running, etc.

Producer — the Producer who created the job

Material Flow — the material flow with which the job is associated

This page enables Negotiators to monitor the status of each submission job and
perform the following tasks:

B Add a new job - For more information, see Adding a Submission Job on
page 253.

B View ajob’s history — Click the History link to display a list of times the job
ran. For more information, see Viewing Submission Job History on
page 251

B  Modify a job — For more information, see Modifying a Submission Job on
page 255.

®  Execute a job — Click the Run Now link to run a job manually.
B Duplicate a job — Click Duplicate to create a copy of the job.

In addition, you can cancel a job. For more information, see Cancelling a
Submission Job on page 257.
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Viewing Submission Job History

You can view the history of submission jobs.

To view the history of submission jobs:

From the Manage Scheduled Jobs page, click the History link for a job. The
Submission Job History page opens:

o N
SUELNIEN Rosetta Management

Deposits = Submissions « Data Management = Preservation =

#& / Deposits: Submission Job / Details

Mame  Submission Job3uS  Frequency Every 1 hour/s Previous Fire Time 13/09/201619:56:19

Role Repository From Date - Next Fire Time
State Mot Running Until Date
Job Parameters v
Producer Agent User Name: adminl Producer Agent Password: Firkik
Producer. Producer for Testing  Material Flow: 69347 (not listed)

Filter: all -

1-1 of 1 Runs

I U N I

Success 13/09/201619:56:19 Omin, 2sec  ViewlLog Download SIPs

1-1 of 1 Runs

Refresh

Figure 129: Submission Job History

A list of times the job ran is displayed. The following actions are available:
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B Click View Log to see the log of the job. For example:

Tue Sep 13 19;
Tue Sep 13 19:
Tue Sep 13 19:
Tue Sep 13 19:
Tue Sep 13 19:

o

;2@ IDT 2816 INFO  Started Processing Deposit For: Test_Plan-1473785662231

121 IDT 2816 INFQ Deposit successful for Test Plan-1473785662231 ,Deposit Activity ID: 157, SIP 157
:21 IDT 2816 INFO  Finished Processing Deposit For: Test_Plan-1473785662231

121 IDT 2@16  INFO  Submission Job finished

:21 IDT 2816  INFO  Job completed Successfully

@

@

MR En R ]
@

@

Figure 130: Submission Job History Log

®  Click Download to download the job log.
®m  Click SIPs to display a report of SIPs generated by the job.
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Adding a Submission Job

This task allows Negotiators to create a new submission job for a material flow.

To add a submission job:

1 Click the Add job button on the Manage Scheduled Jobs page.
The Job Details page opens.

Home > Producers = Advanced Tools » Submission Job > Job Details
“Hame Subrmission Job
Hourly
_— Start At
= Time |E: j|5-1 ﬂ
Monthiy Date |22 == fzo  zlEE~
Agduznces Repeat
@ |ndefinitehy
0 Unt
[z= ez = ][ 2004 | 5 -
Perform this task :
Every | i j Houris
El Job Parameters
"F'FGEIIJGEF.PLQEI'Itl ;I "F'ru:}duu:erﬂgent|
User Hame: Passwaord:

* Producer: | ;I *Material Flow: TI

Back Refresh Apply

Figure 131: Job Details (Submission Job)

2 Enter a name for the submission job in the Name field.

3  Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.

4  To configure hourly, daily, weekly, and monthly intervals:
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a  Use the following table to configure the common interval fields:
Table 38. Common Interval Fields

Section Field Description

Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely Select this option to run the job indefinitely.

Until Select the month, day, and year from the drop-down
fields to specify the date at which to stop running the
job.

NOTE:

After this date, the state of the job will change
from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 39. Interval-Specific Fields

Type of Perform Description

Interval = this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

5 Complete the required fields in the Job Parameters pane.

NOTE:
The list of available material flows will be populated based on the selected

producer's profile. (See below.)
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IE Job Parameters

*Producer Agent |E|::|n'|in'1 ;I *Producer Agent [sssssses
User Name: Password:
|"F'r-:}|:|uu:er: |D5m::- Internal F"r_;l " Material Flow: | LI

"“-'—-—-_)_ General digital material

General digital material - Bulk upload
One time publications

Pericdic publications

Rosetta MET S deposit

Figure 132: Producer Profile Determines Material Flow Options

6 Click the Apply button to add the job to the list of submission jobs.

Modifying a Submission Job

This task allows Negotiators to modify the details for an existing submission
job.

To modify a submission job:
1  On the Manage Scheduled Jobs page, click the Update link next to the job

that you want to modify.
The Job Details page opens.
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x Home = Producers = Advanced Tools > Submission Job = Job Details
FrequencyEvery 1 hour's  Previous 22082012 04:47:58
From Date - MNext Fire Time
Until Date -
Start At

Time |:.1 dlq? ﬂ

Date [zz Bl e =] 2014 = .
Repeat

@ Indefinitehy

1 Unt

[22 =]lo= ][ 2014 | .

Perform this task :

Every | : j Heourls
El Job Parameters
"F'ruducerﬂgentl admini ;I *Producer Agent |ll|l-|lnlu“ul
User Hame: Password:
* Producer: | Demo Internal Pr:};l *Material Flow: Eperindicpublicsti::d
Back Refresh Apply

Figure 133: Job Details Page (Submission Job)

2 Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.

3 To configure hourly, daily, weekly, and monthly intervals:
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a  Use the following table to configure the common interval fields:
Table 40. Common Interval Fields

Section Field Description

Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely Select this option to run the job indefinitely.

Until Select the month, day, and year from the drop-down
fields to specify the date at which to stop running the
job.

NOTE:

After this date, the state of the job will change
from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 41. Interval-Specific Fields

Type of Perform Description

Interval  this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

4 Complete the required fields in the Job Parameters pane.

5 Click the Apply button to add the job to the list of submission jobs.

Cancelling a Submission Job

Cancelling a job allows the Negotiator to postpone the execution of job
indefinitely without deleting it from the system.
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NOTE:
The Unschedule option will not be available when the state of the job is
Not Running.

To cancel a submission job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the job that
you want to modify.
The Job Details page opens.

2 Click the Unschedule button.
The state of the job should change to Not Running.
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Assessors, Arrangers,
and Approvers

This part contains the following sections:

B Chapter 23: Understanding Assessors, Arrangers, and Approvers on
page 261

B Chapter 24: Working with SIPs on page 263

B Chapter 25: Integration with External Collection Management Systems on
page 283
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Understanding Assessors, Arrangers, and

Approvers

Assessors, Arrangers, and Approvers are responsible for reviewing content that
Producer Agents deposit.

The table below shows the responsibilities of Assessors, Arrangers, and

Approvers:

Table 42. Responsibilities of Assessors, Arrangers, and Approvers

Responsibility Assessor Arranger Approver

Approving, returning, Yes Yes Yes

or declining SIPs

Approving, returning, Yes Yes No

or declining intellectual

entities (IEs)

Rearranging IEs No Yes Yes

Assigning a collection Yes Yes No

management system (can assigna CMS | (can assign a CMS

(CMS) ID ID to one ID to multiple
intellectual entity) | intellectual entities

simultaneously)

Replacing an Yes Yes No

incompatible file with a | (if also has TA or | (if also has TA or

copy that is accessible Editor privileges) | Editor privileges)

to the library system

For more information about SIPs and IEs, see the Rosetta Overview Guide.

Each Assessor is associated with an approval group. A Back Office
Administrator defines content that should be reviewed by each approval group.

Assessors, Arrangers, and Approvers can work only with the content that is

defined for their approval group.
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Assessors, Arrangers, and Approvers are assighed by a User Manager, who
registers them and defines their privileges. Privileges can be either View,
Typical, or Full. Their scope is institutional.
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Working with SIPs

This section contains:

B About Working with SIPs on page 263

B Viewing SIPs to Be Reviewed on page 263

B Accessing the SIP Content List Page on page 265
Viewing SIP Information on page 267
Approving a SIP on page 272

Declining or Rejecting a SIP on page 272
Forwarding a SIP or an IE on page 273

Organizing IEs on page 274

About Working with SIPs

Assessors, Arrangers, and Approvers can view information about deposited
submission information packages (SIPs) and decide whether this content should
be approved, rejected, or declined.

Viewing SIPs to Be Reviewed

The Rosetta system enables Assessors, Arrangers, and Approvers to view a list
of SIPs that require review. Each reviewer can view only those SIPs that are
assigned to their approval group by a Back Office Administrator. (For more
information, see Understanding Assessors, Arrangers, and Approvers on
page 261.)
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To view SIPs to be reviewed:

NOTE:
If you are working as an Arranger or Assessor, you may be able to access
the SIPs page by clicking a text link in the Quick Launch section in the

upper right header. (If you do this, you do not need to follow the steps
below.)

1 From the Rosetta menu, roll your cursor over the Submissions tab, then,
from the drop-down menu, select the link that corresponds to your role or
task.

T e
m Producers . _Sibmissions Drata Management Presenvation

Technical Issues / Approval % Adheanced Tools
Manage l=ues in SIF F‘I‘l'.'IGEI‘SEII"IQ Aazezz SIFs % Rumn Repors
|
Manage Issues in Add Repr'n sentation Arange SIPs Format identification auto corection mles
Approwe Sampled SIPs /  Files exdension mismateh rules

Metadata extraction emor handling mles
— SIF Submizsion emor handling mles

SIF Frooessing Configuration

SIF Routing Rulas

Approval Group

A reject 12 asons

34 decling reasons

TA rajact re asons

TA decline raazons

TA lgnoie reasons

Figure 134: Submissions Page

The SIPs List for your selected role or task opens.

Haome = Submissions = &pproval = SIPs List

Fitter A 3 Find in Al B[ o
1-20of 2 Recaords

I- SIF 10 Alert | Title Ig2=ue #| Producer | Type Submitted On | Assigned To

10 ez ZelTitle Demo Inter  OneCff 220082012 admind Wartk Update
Producer On

27 18z SelTitle Dema Inter OneCff 220082012 admind Warde Update
Producer On

Figure 135: Assessor SIPs List
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The page contains the following columns:

Table 43. Assessor SIPs List Columns

Column Description

SIP check boxes Selecting these enables Assessors, Arrangers, and
Approvers to perform an action on multiple SIPs.

SIP ID Displays the unique ID number assigned to the SIP.

Alert Displays a warning icon when a Technical Analyst
has marked the SIP to draw the attention of an
Assessor, Arranger, or Approver.

Title Displays the SIP’s title.

Issue # Links to the bibliographic citation.

Producer Displays the SIP’s Producer.

Type Displays the SIP’s type.

Submitted On Displays the SIP’s submission date.

Assigned To Displays the staff user who is exclusively assigned to
work on the SIP. If the SIP is assigned to a specific
staff user, other staff users can only view the SIP but
not review it.

Accessing the SIP Content List Page

The SIP Content List page enables Assessors, Arrangers, and Approvers to view
SIP objects that make up the SIP and to perform various actions, including
approving, rejecting, or declining SIPs, as well as merging and splitting IEs.

To access the SIP Content List page:

1 From the Rosetta drop-down menu, click Submissions, then click the link
corresponding to your role’s SIP list (below the Approval heading).

2 From the SIP list, locate the SIP with which you want to work and, under
Actions, click Work On. The SIP Content List page opens.
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Home = Submissions = Approval = SIP Content List

SIP ID a2 Producer Demo Internal Producer Producer Agent
Deposit ID 462 Material Flow Hame Onetime publications  Material Type OneOff
Title selenium Selected AccRights Mo restrictions Submitted On 22052012
Issue & Title Assign To admin’

Content List Metzd=ts Motes Histary

View L=t Wiew ;I

Filter | &l - I 1 -2 of 15 Records

123
r Title FIO &« | Ststus | CMSID | #of Files | Actions
1 [0 myv_mp3_0 IE1605 1
Export Assign AR Policy
2 [ my_mp3_1 |E1806 1 Wiew Edit IE Assign CMS I More.. =

= Back hdove To Mext Stage jm

Figure 136: SIP Content List Page - List View

The page contains the following columns:

Table 44. SIP Content List Page Columns

Column Description

Title Displays the name of the SIP object.

PID Displays the permanent unique identifier of the intellectual
entity (IE).

Status Displays the status of the IE.

CMS ID Displays the identifier of the IE in the collection management

system (CMS).

# of Files Displays the number of files in the master copies of the IE.
Clicking the number opens the list of all the files in the IE,
including access copies.

Actions Provides links to actions that can be performed on the item (for
example, View or Export). Clicking More... shows additional
actions such as assigning CMSIDs and access rights.

Arrangers and Assessors can view the IEs in a list view (as shown above) or as a
Gallery (or thumbnail) display (see below). Thumbnails are generated on
demand. If the system is unable to generate a thumbnail for a specific object, it
uses a default image set up in the administrative module of Rosetta. (See
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Generic Thumbnail Creation in the Rosetta Configuratrion Guide for instructions/

details.)
Home = Submizzions = Approval = SIP Cortert List
SIP 1D = Producer Demo Internal Frodu Producer Agent
Deposit ID 462 Material Flow Hame 0One time publication Material Type OneOff
Title =elenium Selected AccRights Mo restrictions Submitted On 220572012
Izzue # il As=ign To admin
Content List Metadata Notes History
Filter | Al =] View  Gallery Yiew| =]
" select all IEs ~ Sort By | Title ;I |Ascending ;I Sore | 1-100f 11 Records
12 :

M osc_za7s r psc_ssda M osc_zaea r psC_gss0

PID: [E1E£59 PID: [E1EE2 PID: [E1EES PID: IE1EES

Status: CMSID: Status: CMSID: Status: CMS ID: Status: CMS ID:
Actions: [View] [Edit Actions: [View] [Edit Actions: [View] [Edit Actions: [View] [Edit

IE] [Aszign CMS D] 1E] [Assign CMS ID]  IE] [Assign CMS D] IE] [Assign CHS (D]

[Expor] [Assign AR [Expor] [Assign AR [Expor] [Assign AR [Expor] [Assign AR

Falicy] Falicy] Falicy] Falicy]

=

= Back | hdave To Mext Stage jm

Figure 137: Gallery View for IEs in SIP

The Gallery view provides a count of the IEs and the option for sorting on one
field, ascending or descending.

Viewing SIP Information

The Rosetta system enables Assessors, Arrangers, and Approvers to view
information about SIPs. Assessors, Arrangers, and Approvers can view the
following items:

m  SIP History on page 268

®m  SIP Problem Notes on page 269
B AnIEin a SIP on page 270
B [E Structure and Metadata on page 270
B Tree View on page 279
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SIP History

Assessors, Arrangers, and Approvers can view the history of a SIP. For example,
an Assessor can see when the content was deposited by the Producer Agent and
when the SIP was moved from the Deposit Server to the Staging Server.

To view SIP history:

1  Access the SIP Content List page by using a Quick Launch text link or
clicking Submissions from the Home page and selecting a role/task from
the Approval section. (See Accessing the SIP Content List Page on
page 265 for details.)

2 Click the History tab. The SIP History page opens.

Home = Submissions = Approval = Assess SIPs = Assessor - History

SIPID g2 Producer Dema Internal Producer Producer Agent
Deposit ID 462 Material Flow Hame One time publications Material Type  CneQff
Title Selenium Selected Access Rights Mo restrictions Submitted On 220532012
Issue s  1ME Assign To acmir
Contert List Metadats Hotes History
Filter | &l - I 1 -3 of 3 Evernts
Event Type Description Module Submitted On

1 Completed Validation Stack Stage  Finished Validstion Stack Stag ... STAGIMNG 0552012 00:49
2 SIP submitted to Staging Server Deposit Activity 92 was subme.. DEPOSIT 082012 00:45
3 Generate SIP_|D SIP D 92 weas genersted STAGING 0502012 0045

= Back fdove To Mext Stage le

Figure 138: SIP History Page

The page contains the following columns:

Table 45. SIP History Page Columns

Column Description

Event Type Displays the SIP’s event type.
Description Displays a description of the event.
Module Displays the module in which the event took place. For
example, Deposit Server or Staging Server.
Submitted On Displays the date on which the SIP was submitted.
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3 Locate the event you want to view and click its event type. The Event Details

page opens.

Event Description
Event IO

Event Type
Created on
Event Severity
Event Category
Event Type
Machine Address
Event Values
Event Context
User Name

User Group
Session ID
Event Duraticn
Sub Module
Module

< Back

o

n
[}
5]

Figure 139: Event Details Page

The Event Details page displays several fields that contain information
about the selected event.

SIP Problem Notes

Assessors, Arrangers, and Approvers can view problem-related notes of a SIP
that have been entered by staff users who previously worked with the SIP.

To view the SIP notes:

On the SIP Content List page (see Accessing the SIP Content List Page on
page 265), click the Notes tab. The SIP Notes page opens.
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Home = Submizsions = Approval = Azsess SIPs = SIP Content Maotes

SIF 1D az Producer Demo Internal Fred  Producer Agent
Deposit ID 462 Material Flow Hame One time publicatic  Material Type  Cnedff
Title Selenium  Selected Rights Mo restrictions Submitted On 220821
Issue # Title Assign To admin

Hotes

Updated on  23/08/2012 01:56:34 Updated by  admind
Internal Hotes Should consider this SIP for preservation test
Updated on 230272012 M543 Updated by admin
Internal Hotes SIF approved by TR, Green

Add Internal Hote

AddNote

= Back |M|:uve To Mext Stage jm

Figure 140: SIP Notes Page

Notes display below the tabs.

Users can add their own notes by typing information in the Add Internal Note
field and clicking the Add Note button.

An IE in a SIP

Assessors, Arrangers, and Approvers can view a SIP IE in a Web browser using
the Delivery option.

To view a SIP’s IE:

On the SIP Content List page (see Accessing the SIP Content List Page on
page 265), locate the SIP object you want to view and click View. The selected IE
opens in a separate browser window.

|[E Structure and Metadata

Assessors, Arrangers, and Approvers can view metadata about an IE as a unit,
its representations, and its files. The metadata provides the following types of
information:

B Descriptive metadata, which contains information provided by Producer
Agents, such as content creator, title, category, and subject. Specific
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information that Producer Agents must provide is defined by Deposit
Managers, Negotiators, and Administrators.

B Administrative metadata, which contains information that is automatically
generated by the Rosetta system. This information includes technical (such
as file size, format, location, and unique identifier), provenance (such as
Producer and Producer Agent’s name), and access rights metadata. Specific
information that the Rosetta system generates is defined by an
Administrator during the configuration of the DNX profile.

Assessors, Arrangers, and Approvers can view IE metadata using the Web
Editor.

To view I[E metadata:

1 On the SIP Content List page (see Accessing the SIP Content List Page on
page 265), locate the IE for which you want to view the metadata and click
Edit IE.

The IE opens in theWeb Editor.

Intellectual Entity FID IE1852 Created on Z3/08/2012 Created by =admin?
Updated on LN 2012 Updated by - SIP 1D o7

32
Version

= |E [ IE1662 )
=l Preservation Master Rev
[ REP16E3 | ~ i
= File | FL1664 ,EMb | View Object
FID Ei682
SIP 1D o2
Created on 230
Created by admini
Updated on 2082012 004
Updated by sdmini
Entity Type
Humber of Reps
Status AC

Object Summary

[

[

X1
I

[

(X1
£

= Back Actions |IE Export jm

Figure 141: Web Editor

For more information on the Web Editor, see Section 44: Web Editor on
page 449.
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Approving a SIP

Assessors, Arrangers, and Approvers can approve a SIP when the SIP content is
found appropriate for storage in the Rosetta system. After a SIP is approved, it is
moved to the next stage, as defined by a Back Office Administrator. (For more
information about SIP processing, see Configuring SIP Processing in the Rosetta
Configuration Guide.) A notification e-mail may be sent to the Producer Agent if
such an action has been set up by the System Administrator (see Adding an E-
mail Confirmation in the Rosetta Configuration Guide).

To approve a SIP:

1 On the SIP Content List page (see Accessing the SIP Content List Page on
page 265), in the Action drop-down list, select Move to Next Stage.
2 Click Execute.

The SIP is moved to the next stage, as defined by a Back Office Administrator.

Declining or Rejecting a SIP

Assessors, Arrangers, and Approvers can decline or reject a SIP when the SIP
content is found to be inappropriate for storage in the Rosetta system, or when
the SIP content contains problems that the Producer Agent must repair (such as
viruses or corrupted files).

When the content is rejected, the Producer Agent receives a notification of the
rejection and the reason for the rejection as specified by theAssessor, Arranger,
or Approver. The Producer Agent must repair the issues and resubmit the
content.

When the content is declined, the Producer Agent who deposited it cannot
resubmit the content.

To decline or reject a SIP:
1  On the SIP Content List page (see Accessing the SIP Content List Page on
page 265), do one of the following:

B To decline or reject specific IEs, select their check boxes and, from the
drop-down list in the bottom right of the page, select Decline IEs or
Reject IEs.

B To decline or reject the entire SIP, from the drop-down list, select
Decline SIP or Reject SIP.

2 Click the Execute button. The Reason page opens.
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4
5

Home = Producers = Action Reason

You have chosen to decline IE(s) no. IET409. Please provide a reason.

Reason |Inapprupriate content lor =

WETNTE NG (nappropriate content long T8
Mot suitable for preservation
Other

Cancel

Figure 142: Action Reason Form for Declining an IE

In the Reason drop-down list, select the reason why you are declining or

rejecting the content.

In the Optional Note field, enter notes for the Producer Agent, if necessary.

Click OK. The SIP or IEs are removed from the page.

The Rosetta system sends an e-mail notification to the Producer Agent that the
content was rejected or declined.

Forwarding a SIP or an IE

Assessors, Arrangers, and Approvers can forward a SIP or specific IEs to

another staff user when it is necessary to get a second opinion.

To forward a SIP or an |E to another staff user:

1  On the SIP Content List page (see Accessing the SIP Content List Page on

page 265), do one of the following:

®m  To forward specific IEs, select their check boxes and, in the Action drop-
down list, select either Move to Specific Assessor (when you want to

move the SIP to a specific Assessor) or Move to Assessor (when you

want to move the SIP to a group of Assessors, Arrangers, or Approvers).

®m  To forward the entire SIP or multiple SIPs, in the Action drop-down list,
select either Assign To to assign a SIP to a specific user within the same
work area, or Move SIP(s) to Assessor /Arranger/Approver Pool when

you want to move the SIP between 3A work areas.
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NOTE:
You cannot move SIPs that are assigned to another user.

2 Click Execute.

The SIP or IEs are forwarded to staff users, as specified.

Organizing IEs

Both Arrangers and Assessors have privileges to:
B Rearrange the Structure Map of an IE

B Merge Single IEs

B Splitan IE

Rearrange the Structure Map of an IE
To make changes to the IE’s structure map, do the following:
1 On the Submissions page, click the Arrange SIPs link.
The SIPs List page opens.
2 Click the Work On link of the SIP that contains the IE you want to rearrange.
The SIP Content List page opens.
3  Click the Edit IE link of the IE.
The Intellectual Entity page opens in the Web Editor.
4 In the left column of Web Editor, click the Representation line below the IE.
5 Click the Metadata tab.
6 Click the Edit link of the row whose type equals Structure Map.
The Edit Structure Map page opens.
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"'-:" Subumission = Aranger = Edit Structure r.‘.up
L
IE PIL E3101 Created on 2008-09-25125335  Created by admind
Updated on 2002-09-25 125335 Updated by adminl SIP 1D 3
Versien sl
Struciure Map Type
Raot . Label | |
Oiralen File Hame  Path Lahel
b File 1 SDirzctory1zebdirectory 11712 1.doc labeld
- i File 2 SDirzctory 1Zebdirectory 1.10Filz 2.doc
- b File 3 SDirzciory IfSebdirtectory 1 20Filz 1.doc lakel0l
- File 1 ADirsciomy 1S ebditectory 1 20File £ doc labelld

Figure 143: Edit Structure Map Page

7 Do the following, as required:
B To re-order the files that comprise the IE, use the arrow buttons in the
Order column.
B To assign a label to the root of the structure, type it in the Root - Label
field.
B To assign labels to the files, type them in the Label column.
8 Click the Save button.

The system commits the rearrangement of the structure map to memory.

Merge Single IEs

To merge a number of single IEs into one IE

1  On the Submissions page, click the Arrange SIPs link.
The SIPs List page opens.
2 Click the Work On link of the SIP you want to change.
The SIP Content List page opens.
September 2016
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Home * Submissions * SIP Content List

SIP ID 30 Producer Demo Intemal
Material Ganenc

Deposit 222 Flow Mame Unpublizhed

Activity 1D Selected through Applet
Access i restrictions

Title 111 Rights

lssue & - Assign To adrmind

Content List Metadata Hotes Histomy

Filter [ Al "| 1-6ofb Records

I Title FID Staiuz CMS ID # of Files Actions
I Fopl.gif  1E2280  xcfsdi 3 “iew Edit IE Expon '1-'1; Ore
Besign AR Policy  Agsgn CWME D Split

2P p3af  IE2XEZ  wcisdi 1 Yigw Edit |E Expoit Mora.. =
3 Fid.gif  IE1280  sciedi 1 “igw Edit IE Export More.. =

Merge Selected |IEs

Producer Ackarl Ahie 02
Anent

Flaterial LNF

Type

Submitted 20122009
On 11:21:27

Wiew List View ﬂ

Figure 144: SIP Content List Page

3 Select the check boxes of the IEs that you want to merge.

NOTE:

Only IEs that contain one file can be merged. The number of files in each
IE is indicated in the # of Files column of the SIP Content list.

4 In the drop-down list in the lower right corner of the page, select Merge

Selected IEs and click the Execute button.

A warning page explains that the existing logical structure maps will be lost
as a result of the merge, and any access copies of the IEs will be lost.

5 Click Cancel to stop the merging process, click Merge to proceed.

The following page opens.
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’:.», Home = Submissions = Merge IEs @. z
L

You have selected to merge the following IEs.

Merged IE Template Tithe FID CRSID
1 o Cartogn E1175
2 I 20 Kay E1175
3 I LOTR 11 E1181

Cancsl =1

Figure 145: Merge [Es - Select the Main I[E

6 Choose a main IE of the group (to which other IEs will be added and which
will determine the template of the merged IE). Select the radio button of this
IE and click Next.

The following page opens.

lome * Submissions = f_1_—'_hr.:'4|:-_ IEs 1 @

Enter Information for the new IE.

4

Title [Canoon Merged

Figure 146: Merge IEs - Merged IE’s Title

7 Enter a title for the merged IE and click Finish.

The Edit Structure Map page opens.
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s > Subimssions > Edit Soroecture Magp
Min REP1173-1 Metadata Type mels_section: siruciidag Description
Craatad by Aatka Creation Date
Updated by Updats Data
Structure Map Type
PHYSICAL |
HRaoot . Labe| [Table of Contenis
Order File Nams Path Label
- rartoan 1 TIF |:‘.1r.cc'|'
- - 20 ey 08 jpg [0 My
= L TR peemiene 11.g LoTR 11
< Back [sae

Figure 147: Edit Structure Map Page
8 If required, edit the structure map of the merged IE as described in
Rearrange the Structure Map of an IE on page 274.
9 Click Save.

The SIP Content List page opens again. The new IE appears in the list
instead of the IEs that were merged. Note that its PID is that of the main IE
selected in Step 6.

Split an IE

To split complex IEs into single IEs:

1 On the Submissions page, click the Arrange SIPs link.
The SIPs List page opens.

2 Click the Work On link of the SIP you want to rearrange.
The SIP Content List page opens.
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(=]
&‘.‘ﬁ Home » Submissions * SIF Cortent List

SiF 1D b Producar Camn fviemal Producar Producer Agent  Ackail Abje 2
Depasit Levivity 10123 Matasial Flowe Mame  Generiz Ungublished Hatesial Type LHP

Title: fran winw 2 Selected Access Rights Azceseitye from institulion Submitied On 951172004
Issine & Begign To acdnint

| Content List Metadata | Motes || History

';ﬁ(:u,rEUS’.'\'iEln'r T|

Fillkar | EH "'I 1.1 of 1 Recads
- Tite 2 Smms  CMSID 2ofFiles  Actions
1 [ Tesld [l 3 Wiz Edit IE Exgurt [dome .
Asgign AR Polity  fesign CME 10 Split
Back [2zve Ta Hent Stage =l

Figure 148: SIP Content List Page

3 Click the More... link of the row containing the IE you want to split.

If more than one file exists in the IE, the option to Split will display in the
More... actions. Click this text link.

A confirmation form opens.
4 Click Cancel to stop the splitting process, click Split to proceed.
The SIP Content List page opens again. New one-file IEs appear in the list.

[:%‘"J Home » Submissions * SIP Content List

HiF 1D bk Producar Damo ftemal Producar Praducer Agent  Ackarl Abie 12
Depasit Aebivity 100133 Materlal Flowr Hame  Generic Ungublished Haterial Type LEP

Title: fran winw 2 Selecled Aecess Rights Acceseilee from irstitalion Submilied On 191172008
Isse & Besign Ta admint

| Content List Metzdata || Motes || Hiztarey

Uiy | Lisd ey o

Fiftey |48 B 1- 3ot 3 Rocords
I~ Lifle P Statup CMSIG SaiFiles  Antiams
1 Gegor 1 TIF IE552 1 o EditIE Expet s
Aasign AR Polley  Aseign RIS ID
2 D0 may 6d.jx 1 Wiewr EditIE Bt lfare__=
- LOTR momame 11.gil IE2554 1 Wi EditIE Exprwt Iare =
Back [ Ta liam Stage B

Figure 149: SIP Content List

Tree View

You can view the IEs in a SIP in a hierarchical tree view if you have Arranger or
Assessor privileges. To view the IEs in a tree view, select Tree View from the
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View drop-down list. The tree view opens in the left pane while the list view
opens in the right pane. The figure below shows these views.

1)
&‘{3 Home * Submissions » SIP Content List

P 1D 12 Producar Cama feiemal Producar Hroducer Afgent  Ackail Anle
Oepasit Betiwity 10133 Material Flow Home  Geseric Ungublished Haterial Type LBP

Title: fran winw B Selected Aecess Hights Scceseilds o institalion  Submilied On 1911172009
Iszre & Besign To admint

[ ContentList || metzdata || Motes || History

Wiewr TrepWew x|

| Display all |Es Filter |51l =l O wiew Sub-Folders =710 51 Regands v23 s
Lt Exammplaal Teas_viaw_axi.., 5 I~ Ilte [ 1] Stabzs CMSED A ofFiles Actions
= HaiHnad places 1 psc d66EPE  FIvEs 1 Vigw Bt Swpart  Mer -
DEL_15ES SR 7 CEsd 49754P0a  Eavs 1 Wigw BdLE  Sxpart o -
%’gg;gj:g 3 [est 39PEIPn  Eas 1 wign E4LES  Sipat Mar -
L TR 4 Cpst 986 e RUA 1 Wien Edti®  Swpot  Mom -
= Lacemotiad & [ eamljm B2 1 Vign ERE  Swpat Mo -
= Hhary 5 FCosc 9667 pg  IESINM 1 Wigw EdIiE Swpart  Mop -
1B 2467 B rF e pRRAPE RIS 1 Vign Edtis  Expan  dom -
" ps & Fosciuip IFwis I Vi ESUE Ser .-
E.m_,—“ : = 1e [ iimiewares jpa  F176D 1 Wivw E4UIE  Swpart  Mons -
DEC_I965.4PG {10 Fese TarG  iEiRes 1 Vign EdLE  Sxpart Lo -
puchagiel - o -
LISCI9T0 4PG [ Move T oot Stzgo = e
DA AT ARG = - &

Back

Figure 150: Tree View, Filters and Sub-folder View Options
The tree view option will be available only when the system is able to
reconstruct the original tree structure.

There are three ways in which information about the original path to the files
can be passed to the server when a user deposits material.

B From the Deposit API, given a directory structure and multiple IE.xml files.
B From the Web interface, loading multiple files through the applet.

B  From a submitter application (for example, Indigo), if the original path is
provided as part of the METS file.

Selecting a node of the tree applies a filter to the IE list. Only IEs that have files
in the selected node are displayed.

NOTE:
Rosetta displays only Master Copy files in the tree. If any of the IEs
contain Access Copies, Rosetta does not display the files in the tree.

Selecting a file from the tree displays the IE containing the file.

Clicking the Display all IEs button when the list is filtered restores the whole
list of IEs for the SIP.
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Selecting the View sub-folders check box displays all IEs in the selected folder
plus all IEs in the inclusive sub-folders. De-selecting the box removes the IEs in
the sub-folders from view.

The list of IEs can be filtered using the regular filter drop-down list. The filter
through the tree nodes takes precedence. Choosing a node in the tree resets any
existing filter and creates a new list of IEs for the selected node.

If you select a filter from the drop-down list, it is applied to the already filtered
list of IEs that are displayed as a result of the selection in the tree node.

Changing the filter in the drop-down list does not affect the selection in the tree
node.

Note that filtering can lead to empty results due to the combination of the two
filters (the tree and the drop-down list). These empty results may not always be
intuitive.

If the tree cannot be reconstructed the tree view contains a non-hierarchical list
of the IEs.

[
&‘P Home * Submizsions » 5P Content List

i D 1 Producar Damo ftemal Producar Producer Agent  Ackarl Abie T2
Depasit Aebivity 10193 Materlal Flow Hame  Generic Ungublished Haterial Type LBIP

Title: fran wipw 2 Selecied Aecess FRights Acceseilte from irstitalion Submitied On T 172000
Isse & Besign Ta adnint

| Content List Metadata || Motes || History

Display aiil |Es Filtnr m O isw Sub-Foldars e 1 al1 Reconds
| Raot [ae structural Bdformation) 2 Thtle EID Stacue CRISID # ofFiles  Actions
| DG 1926 PG 1 T bres view 2 IET1E5 2 Wiew EfRKIE  Exped  More -

sazahlzncaastscrne. pif

Back

Figure 151: Unstructured Tree View
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Integration with External Collection
Management Systems

This section contains:
B Assigning a CMS ID to an Intellectual Entity on page 283
B  Unassigning a CMS ID to an Intellectual Entity on page 285

Assigning a CMS ID to an Intellectual Entity

The Rosetta system supports integration with external collection management
systems (CMS), such as Voyager, in order to establish a relationship between IEs
stored in the Rosetta system and their metadata stored in a CMS.

Assessors and Arrangers can link metadata from an external CMS to IEs by
assigning a collection management system identifier (CMS ID) to an IE. In
addition, Arrangers can assign a CMS ID to multiple IEs simultaneously.

To assign a CMS ID to an IE:

1 From the Rosetta Submissions drop-down menu, under the Approval
heading, click Assess SIPs or Arrange SIPs, depending on your role.
The SIPs List page for your role opens.

2 Locate the SIP that contains the IE to which you want to assign a CMS ID
and click Work On.

The SIP Content List page opens.
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Content List

View | Lst View ;I

Filter | Al | 1 -1 of 1 Recaords

™ nte FID Status | CMSID | Actions

1 [ aa IE1015 VWiew Edit IE (Assign CMS5 D ) hlore... a

Export Assign AR Policy

= Back EMwe To Mext Stage ﬂm

Figure 152: SIP Content List Page

3 Locate the IE to which you want to assign a CMS ID and click the Assign
CMS ID text link.

NOTE:
If the Assign CMS ID text link does not appear in the Actions section of
the table, click the More... link to vew additional items.

The search page for assigning CMS IDs to IEs opens (see Figure 153).

Home = Submissions * Approval = Assesz S1Ps = Search External Repositories 1 @
SSEEQSE: qari. - I Refreshindexes
Find: |
gztaers:ry: ttle j’
GO
Cancel

Figure 153: Assign CMS ID Search Page

4 Optional: Click the Refresh Indexes button to update the database with the
latest IEs.

5 Search for an ID using the Search Database drop-down list, the Find text
box, and the Search Category (search fields) drop-down list. Click GO.

The results show in a table below the search fields.
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Home = Submissions = Approval » Assess 5IPs = Search External Repositaries 1 @
5 h =
D:tazrage qare "I Refreshinderes
Find: [train
Search lﬁ
Category: titls =
GO
1-40 of 16 Records 2
10 | Title Creator Created on
1 {7 23444 Howto raise and train a skunk. Hume, Charles, 1922... [1967]
2 0 24802 Howto select, train, and use wolunteers Harris, Rosa Alexan... 1985,
2 {0 aga3z | travel by train & Browen, Rolla Wralter... 1929,
4 {7 37TEI6 Inthe face of dangerf Mixon, Joan Love ny. 1985,
5 179032 Lasttrain from Berlin f Smith, Howard K. (H... 1942,
6 {7 53149 Official document book : Mew Yok Stat Mew Yo State Libr.. o950,
Cancel

Figure 154: Assign CMS ID Results Page

6 Locate the ID you want to assign to the IE and click the Link button.
The CMS ID is assigned to the IE.

The Rosetta system can now synchronize the metadata stored in an external
CMS with the IE.

Unassigning a CMS ID to an Intellectual Entity

There are two methods to unassign a CMS record — manually and automatically:

To unassign a CMS record manually:

1 Search for the IE whose CMS record you want to remove.

2 View the metadata list for the IE. For example:
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/ 'I. Home = Producers = Producers and Agents = Manage Producers = Metadata List

Intellectual Entity PID 1E3283 Created on 23/03/2016 06:58:38 Created by
Committed on 23/03/2016 06:59:.00  Committed by admin1 SIP 1D
Version 1

O Locked By: Me

= |E (IE3283) bject Summary Metadata Services
= Preservation Master Revision 1 ( REP3284 ) '
= File ( FL3285 ,1Mb )

Add Metadata | | Assign AR Assign AR Exceptions Assign RP

Name Type Mid

CMS oc 1933 e Remove
DNX DNX DNX_IE3283 Edit

Descriptive DC 1931 Edit

Policy Access Rights AR_EVERYONE View

Policy retention 2205 View Remove

< Back Actions: |E Export v m

Figure 155: Metadata List - CMS ID
3 C(lick Remove for CMS.
The CMS record is removed.
To unassign a CMS record automatically:

1 From the list of tasks (Data Management > Manage Sets and Processes >
Add Process), select Unassign CMS.

2 Click Next. The following appears:
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I:"\_J\I Home = Data Management > Manage Sets and Processes = Manage Processes > Complete Parameters

General Info

* Process Name [
Priority Naormal v

Parameters
EI Unassign CMS - Unassign CMS record from an IE

Move CMS to IE DC

Email Notification

Send email? Mo

< Back Cancel m

Figure 156: Unassign CMS Task

3 Fill in the fields. To copy CMS metadata to the IE's descriptive metadata,
select the Move CMS to IE DC checkbox.

4 Click Next.
5 Complete the steps for configuring the job.

NOTE:
CMS records that are no longer assigned to any IE are removed by the
Metadata Orphan Handler job as described in the System, Background,
and Operational Jobs section of the Rosetta System Administration Guide.
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Technical Analysts

This part contains the following section:

Chapter 27:
Chapter 28:
Chapter 29:
Chapter 30:
Chapter 31:
Chapter 32:

Understanding Technical Analysts on page 291
Understanding Technical Issues on page 293

Viewing Problematic SIP Content on page 295
Resolving SIP Technical Issues on page 307

Viewing and Resolving Repository Issues on page 321

Validation Stack Rules on page 327
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Understanding Technical Analysts

Technical Analysts (TAs) handle problems that may occur when the Rosetta
system processes Producer Agents’ content.

These problems can occur with deposit activities, submission information
packages (SIPs), representations, access copies, and individual files in SIPs. (For
more information, see Understanding Technical Issues on page 293.)

When the Rosetta system identifies a technical problem, it sends a notification to_
the appropriate TA by e-mail. The TA uses the Rosetta system tools to resolve
the issue.

The actions that TAs can perform depend on the processing stage in which the
error occurred.

Technical Analysts are assigned by a User Manager, who registers them and
defines their privileges. Two types of TAs exist in Rosetta:

B A SIP-processing TA (SIP TA), who works on the issues that occur during
SIP loading

B A Repository TA, who works on errors impacting files in the permanent
repository

Each type of TA is one role, with one set of privileges. Their privileges are
always Full, and their scope is institutional.
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Understanding Technical Issues

Technical issues that are dealt with by SIP or Repository TAs comprise the
following :

For SIP TAs, problems occur with deposit activities and submission
information packages (SIPs):

B A deposit activity or a set of files uploaded by a Producer Agent to the
Deposit Server.

B A SIP automatically generated by the Rosetta system when it moves deposit
activities from the Deposit Server to the Staging Server.

For more information on the Deposit Server and Staging Server, see the Rosetta
Overview Guide.

For Repository TAs, issues arise when running validation stacks on files in the
permanent repository.

The following table shows content processing stages in which errors may occur
and explains which objects can contain errors.

Table 46. Content Processing Errors

Errors May Occur When... Errors May Occur With...

Deposit Producer Agents’ content is Entire deposit activities
uploaded to the Deposit Server

Loading Producer Agents’ content is Entire SIPs
moved from the Deposit Server
to the Staging Server

Validation Rosetta runs a validation check Individual files
on files

Enrichment Rosetta enriches the content Individual files

before moving it to the
Permanent Repository

Move to Permanent Rosetta moves the content from Individual files
the Staging Server to the
Permanent Repository

September 2016 293
Ex Libris Confidential



Staff User’s Guide, Part V: Technical Analysts
Chapter 28: Understanding Technical Issues

294 September 2016
Ex Libris Confidential



29

Viewing Problematic SIP Content

This section contains:
B About Viewing Problematic Content on page 295
B Accessing the “Manage Issues in SIP Processing” Page on page 295

m  SIP Issues - Tabs and Details on page 296

About Viewing Problematic Content

The Rosetta system displays problematic content in tabs according to the stage
in which the problem occurred. The following tabs are available:

B Deposit (For more information, see Deposit on page 297.)
Loading (For more information, see Loading on page 298.)
Validation (For more information, see Validation on page 299.)
Bytestream (For more information, see Bytestream on page 301.)

Enrichment (For more information, see Enrichment on page 303.)

Move to the Permanent Repository (For more information, see To
Permanent on page 305.)

B System errors (For more information, see System Error on page 305.)

Technical Analysts work with problematic deposit activities, SIPs, and
individual files using the Manage Issues in SIP Processing / SIPs List page.

Accessing the “Manage Issues in SIP
Processing” Page

The Manage Issues in SIP Processing page enables Technical Analysts to work
with problematic content.
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To access the Manage Issues in SIP Processing page:

From the Submissions page of the Management module, click Manage Issues in
SIP Processing below the Technical Issues heading. The SIPs list opens.

Hiome = Sumissions > Technikcal ssues > Valldation - SPs List
Valldation [21)
Fifter | A =] Find n & =1[2=]
11 - 20 of 21 Reconds 123
O SIP ID |Depostt ID | Tiis Prosduosr Typs Problems |Assipned To |Actions
O 15 15 selenion TA valkdat D 3l UNE ResuRs e fvark On - Updsie U Assign
12 |:| 16 16 selerilum TA Valkdat eral UNP Resulis» svark Om Updale Ui Asslgn
O 17 17 selerilum TA Valkdat ezl UNP Resuls ~ svark Om Updale Ui Asslgn
i O 18 18 selerilum TA Valkdat ezl UNP Resuls ~ svark Om Updale Ui Asslgn
O 13 19 saleniom TA vValkiat semal LUNP ResuRs v fvark On - Updsle U Assign
At [Mowe Ta \Er.S'E:u. m

Figure 157: Manage Issues in SIP Processing Page

The page consists of the following segments:

B The tabs along the top of the page show the type of issue and the
number of items that exist for that type of problem.

B The table below the tabs displays the problematic objects that are stored
in each tab. The columns vary from tab to tab.

SIP Issues - Tabs and Details

The following sections describe the tabs and columns on the SIPs list as well
as the actions that Technical Analysts can perform in each tab:

Deposit on page 297
Loading on page 298
Validation on page 299
Bytestream on page 301
Enrichment on page 303

To Permanent on page 305

System Error on page 305
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Deposit

The Deposit tab contains problematic deposit activities that failed when the
Rosetta system was uploading them to the Deposit Server. (For more
information, see Understanding Technical Issues on page 293.)

Home = Submissions = Tesdnical lssues = Marage ssues 0 5P Processing = Deposk - SPs List

mare
sz
—

MEME

Depostt (22) || Loading
Filitar | A2 : I

0| |tethiyiD Producss
O i5 Do

D z 45 Cermna

D 3 47 Ceemo Infe
O+ 4= Dema

D 5 43 Cemd Imema
b Ex Libricsd 2014

t Eytscetracaim E mnt T Permanant (15) || Fystem Emmor
Find nfan [=]|oe
1 - 10 af 22 Records 23
Title Type | Submitted On | Problsm Count | Assky Actions

=] PRD 2042014 195508 Teormbcalreasoms 1 Waork On  Update  UnAssign
3 PRD 220472014 1955510 Technkcalrezsoms 1 Work On  Update  UnAssign
- PRD Z2042014 195511 Teomkalressoms 1 Work On  Update  UnAssign
2 PRD 14195512 Technlcslressons 1 Work On - Update  Un Assign
2 PRD 14195514 Tecwlealressons 1 Work On Update  Un Assign

Action

Assign To
Un Assign

Fject Deposl
Cecline Depask

Figure 158: SIPs List - Deposit Tab

The Deposit tab contains the following columns:

Table 47. SIPs List - Deposit Tab Columns

Column Description

Check boxes Selecting these enables Technical Analysts to perform an action
on multiple deposit activities simultaneously. Toggle selecting
all and deselecting all by clicking the check box in the header
TOW.

Activity ID The unique ID number assigned to the deposit.

Producer The Producer that provided content.

Title The deposit activity title.

Type The deposit activity type.

Submitted On The deposit activity submission date.

Problem The description of the problem as generated by the Rosetta
system.

Count The number of times the deposit activity has been sent to the
Technical Analyst due to the current problem.
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Table 47. SIPs List - Deposit Tab Columns

Column Description

Assigned To The name of the Technical Analyst who is exclusively assigned
to work on the activity. If the activity is assigned to a specific
Technical Analyst, other Technical Analysts can only view the
activity but not review it.

Actions Provides links to actions that can be performed on the SIP such
as View, Update, and Work On, all of which take the user to a
detailed page for the SIP. Additional actions can be selected
from the drop-down list below the table.

In the Deposit tab, Technical Analysts can perform the following actions:
B Moving a SIP to the Next Stage on page 307

B Rejecting and Declining Problematic Content on page 308

B  Resubmitting or Reloading Problematic Content on page 310
n

Viewing a Problematic SIP or File on page 311

Loading

The Loading tab contains problematic SIPs that failed when being moved from
the Deposit Server to the Staging Server. (For more information, see
Understanding Technical Issues on page 293.)

Home = Submissions = Technieal kssuss = Marage lssues In SIP Processing = Loading - 51Ps L

Deposit (22) || Loading {18} ([vaBdation (37) || Bytestream (14) | Enrichment (15) || To Permanent (15) || System Emor (2)

1- 100716 Records =

EIP ID | Depost 10 Tibe Pro-ducsr Probism LEsigned To

1 2% 2] sedenium un 3s5l]  Demo Inema Wark On Update Un Assign

. i i 200 sedenium TALoad  Demo intema Wark On Update Un Assign
Wark On Update Un Assign

‘Wark On Update UnAssign

O

O

O

o @ = | seileniium TA Load  Demno intena
|:| i 2B 12 sedenilum TA Load  Dema infera
O 203 205

salenilum TALoad  Demo Inema Work On Lipdste Un Assign

Figure 159: SIPs List - Loading Tab
The Loading tab contains the following columns:
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Table 48. SIPs List - Loading Tab Columns

Column Description

Check boxes Selecting these enables Technical Analysts to perform
an action on multiple deposit activities simultaneously.
Toggle selecting all and deselecting all by clicking the
check box in the header row.

SIP ID The unique ID number assigned to the problem. Click
the SIP ID to view the Deposit Activity Problem View
page.

Deposit ID The ID of the deposit activity that contains the

problematic file. Assigned to the deposit before the SIP
ID has been implemented.

Title The IE title that the user entered on the metadata form.
Producer The SIP’s Producer.

Number of Files The number of files in the SIP.

Problem The description of the problem.

Assigned To The name of the Technical Analyst who is exclusively

assigned to work on the SIP. If the SIP is assigned to a
specific Technical Analyst, other Technical Analysts can
view the SIP but not alter it.

In the Loading tab, Technical Analysts can perform the following actions on
problematic SIPs:

B Rejecting and Declining Problematic Content on page 308

B Resubmitting or Reloading Problematic Content on page 310

B Replacing a Problematic SIP or File on page 311

B Viewing a Problematic SIP or File on page 311

B Handling a Problematic SIP or File on page 313
Validation

The Validation tab contains problematic files that failed during the validation
check. (For more information, see Understanding Technical Issues on
page 293.)
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Home = Submisslons = Technical lssues = Valldation - 51Ps List

Deeosit (22) Loading (1&) | Vallidatlon (3%} || Bytestream [15) | Enrichment [17) To Permansnt [15) fystem Error [3)
Fi tar|\ : Find n IN—E
11 - 20 of 38 Fecords 123
[0 | &PID | Depost il Tis Prosduscar Type | Problsms Assigned To | Actions

LA | 15 15 selenium TA Valkdal Demoimemal UNP - Resulls - WorkOn  Update  Un Assign
Producer

iz 0O 16 16 selenium TA Validal Demo imlemal UNP - Fesulls v WorkOn  Updste  Un Assign
Producer

0O 17 17 selenium TA Validal Demo imlemal UNP - Fesulls WorkOn  Updste  Un Assign
Producer

L | 18 18 selenium TA Validal Demo imlemal UNP - Fesulls WorkOn  Updste  Un Assign
Producer

B0 12 19 seleniium TA Validst Demoimemal UNP Resufs v Work On  Updste  Un Assign

Action

Assign Ta
Un Assign

Renn
Rejedt 5P
Decline 5P

Figure 160: SIPs List - Validation Tab, Action List Expanded

The Validation tab contains the following columns:

Table 49. SIPs List - Validation Tab Columns

Column Description

Check boxes Selecting these enables Technical Analysts to perform an
action on multiple deposit activities simultaneously. Toggle
selecting all and deselecting all by clicking the check box in
the header row.

SIP ID The unique ID number assigned to the problem.

Deposit ID The ID of the deposit activity that contains the problematic
file.

Title The deposit activity title.

Producer The SIP’s Producer.

Type The SIP’s type.

Number of Files The number of files in the SIP.

Problems The number of files that failed the validation check. To see

the number of files that failed each type of check, click the
triangle link.
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Table 49. SIPs List - Validation Tab Columns

Description

Assigned To The name of the Technical Analyst who is exclusively

assigned to work on the SIP. If the SIP is assigned to a
specific Technical Analyst, other Technical Analysts can
view the SIP but not review it.

In the Validation tab, Technical Analysts can perform the following actions on
problematic files:

B Replacing a Problematic SIP or File on page 311

B Viewing a Problematic SIP or File on page 311

B  Handling a Problematic SIP or File on page 313

B Rechecking a File on page 317

B  Rerunning Validation on page 319
Bytestream

The Bytestream tab displays SIPs with bytestreams (containers) that failed
during the bitstream extraction stage due to one of the following;:

Error encountered while trying to extract bitstreams

Error encountered when running validation stack on bitstream

For more information on bytestreams and bitstream extractions, see Bitstream
Extraction Rules in the Rosetta Configuration Guide.

The following figure shows the Bytestream tab with a single entry.

Home = Sunmisskons = Tedikeal lssuss = Marage ssues 0 5P Protessing = ByteSireams List

Bytastraam [15)

Filthar | :I Find n [ :I

1-10af 15 Recards 2

| SPID | DeposttiD |Tiis Producer Actions
1 D o] =] milm 2t (Demio inermaEl Producsr “iew Errars  Skip Rerun Reles
2 D =l a1 TA Eytestream selenium el Demo Imermal Producer “iew Errars  Sklip Renon Reled
3 D oz =F) I nlum iest  (Demo imermal Producer ViewEmors Sklp Renn Rejed
4 D Ek] k] nlum et (Demo inemaEl Producer ViewErmors Sklp Renn Rejed
5 D a4 =1 TA Byiestream selenium tes!  Demo Infarmal Producer ‘iewEmmors Sy Renn Rejed

Figure 161: SIPs List - Bytestream Tab

The Filter and Find fields provide the means to narrow and focus results when
there are several entries on a page.
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For each entry, the following actions are available:

Table 50. SIPs List - Bytestream tab

Column Description

View Errors Link to the Bitstream Extraction Error Details page

Skip Skip the bitstream extraction for the selected
bytestream (container). bytestream will be processed as
a regular file with no bitstream information

Rerun Rerun Bitstream Extraction task for the selected
bytestream (container). Rerun will skip VS at the
bytestream level and will rerun VS for each of the
extracted bitstreams

Reject Reject the bytestream (container)

Download Download the bytestream (container) to the TA’s PC

To view error details for the SIP, click the SIP’s ID number or click the View
Errors text link of the row containing the SIP you want to view. The following

Ppage opens.
~ 1 Home * Submissions pprovsl = Assess 5IPs = Technical Anshyst - History
SIP 1D ) Producer Cemo Internzl  Producer Agent
Deposit D Material Flow Name Cne tims Material Type
Title Z=lz Selected Access Mo restrictions Submitted On
Title Rights
lssue # - Assign To

< Back

Descripticn Module Submitted Cn
File |dentification rat STAGING 237082012 Z2:1T:53 Download
file  The Validation Stack... STAGING 23/08/2012 Z2:1T:53

Figure 162: View Bytestream Errors

To view further details, click the Event Type text for the failure event you want
to see. To view the bytestream content, click the Download text of the row you

want to view.

Details for the event type you select look like the following:
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Ewent Description
Ewvent 1D

Event Type
Created on
Ewent Severity
Ewvent Category
Event Type
Machine Address
Ewvent Values
Ewvent Context
User Name

User Group
Session ID
Ewent Duration
Sub Module
Module

= Back

ta m

T ki
(]

For more information on bytestreams, bitstreams, and SIPs, see Bitstream

Figure 163: Details for a Failed Bytestream Event

Extraction Rules in the Rosetta Configuration Guide.

Enrichment

The Enrichment tab contains problematic files that failed when the Rosetta

system was enriching the content. (For more information, see Understanding
Technical Issues in the Rosetta Configuration Guide.)
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oooooao

= Lioris Lid, 2014

Hiome = Submissions > Technlcal lEsues - Marege lssues In 5P Processing = Enrichment - 51Ps List

‘alldation [33) || Bytestream (15) | Enmchment (17} | To Permansnt (15) System Emor (3)
Find nfan ]
1- 10 of 17 Recards 2
2P0 | Producsr Typs |Assigned To |Actions

saleniumEnTichmeniPTodUCEnEuD ] WorkOn Update  Un Assign
g o g (e e e ] Waork On Update  Un Assign
saleniumE N mEn P OdUC N Z oD e WorkOn  Updste  UnAssign
saleniumEnTichmeniPToducanZug ] WorkOn Updatle  Un Assign
saleniumEnTichmeniPTodUcENEuD ] WorkOn Updatle  Un Assign

Action

Figure 164: SIPs List - Enrichment Tab

The Enrichment tab contains the following columns:

Table 51. SIPs List - Enrichment Tab Columns

Column Description

Check boxes Selecting these enables you to perform an action on multiple
SIPs simultaneously (using the Action drop-down menu
below). Toggle selecting all and deselecting all by clicking
the check box in the header row.

SIP ID The unique ID number assigned to the problem.

Producer The SIP’s Producer.

Type The SIP’s publication type.

Total IEs The number of IEs in the SIP.

Assigned To The name of the Technical Analyst who is exclusively
assigned to work on the SIP. If the SIP is assigned to a
Technical Analyst, other users can only view the SIP but not
review it.

Actions Actions available for you to perform on the SIP.

In the Enrichment tab, Technical Analysts can perform the following actions on

problematic files:

B Handling a Problematic SIP or File on page 313

B  Rerunning Enrichment on page 319
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To Permanent

The To Permanent tab contains problematic files that failed when the Rosetta
system was moving them from the Staging Server to the Permanent Repository.
(For more information, see Understanding Technical Issues on page 293.)

Home = Submissions = Technical kssues = Marage kssues I SIP Processing = To Penmanent - SIPs List

To Permanant [15]

Fitsr[a [=] Find nfan =]
1 - 10 af 15 Feconds <
Il SPID  |Producsr Tips Assigned To | Actions
O 12 Dena Imerral Producer e fvark On Lindate Lin Assign
2 O 121 Cema Infermal Producer Uk iark O Lpdste Uin Asslgn
O 122 Dema Inermal Producer e fwark O Lindate Uin Assign
{0 123 Cemna Interral Producer LiP vark On Lindate Lin Asssikgn

i k| Exscuts |

Figure 165: SIPs List - To Permanent Tab

The To Permanent tab contains the same columns as described in the SIPs List -
Enrichment Tab Columns.

In the To Permanent tab, Technical Analysts can perform the following action
on problematic files:

B Handling a Problematic SIP or File on page 313

System Error

When a SIP fails, the system rolls back the complete stage and attempts to rerun
the SIP processing. The system will attempt to rerun the SIP processing up to
five times.

The System Error tab contains SIPs that fail to complete the processing after
such repeated attempts. Typically, these SIPs have failed processing due to
environmental issues (e.g. network, storage, database). The expectation is that
such situations are temporary and readily addressed, and re-running these SIPs
once the issues have been resolved will allow them to be properly processed. In
the event this is not the case, please contact Ex Libris Support.
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Hiome = Submisslons = Technlcal kbsues = Marage lssues In 5P Processing = System Ernor List

yhesireamm (15) || Enrichment [17] || To Permanent (15) || System Emor (3}

1-30f3 Reconds

O | seo Excaption Date SOUnca QusLs Description
1 O &1 TEN0A204 200G DERCSIT_MESSAGES UELE
2 O i} Z02014 T4 DEPOSIT_MESSAGES QUELE
3 O i} ZROAR04 24T SP_LOADING WORK_QUEUE
Acton | Executs |
Foanun All
Declime 22

Figure 166: SIPs List - System Error Tab
The System Error tab contains the following columns:

Table 52. SIPs List - System Error Tab Columns

Column Description

Check boxes Selecting these enables you to perform an action on
multiple SIPs simultaneously (using the Action drop-
down menu below). Toggle selecting all and
deselecting all by clicking the check box in the header

TOW.
SIP ID The unique ID number assigned to the problem.
Exception Date The date the exception occurred.
Source Queue The last station of the SIP.
Description A description of the problem.

In the System Error tab, Technical Analysts can perform the following actions

on files:
B Rerun
E Rerun All

B Decline SIP
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Resolving SIP Technical Issues

This section contains:

About Resolving Issues on page 307

Moving a SIP to the Next Stage on page 307

Rejecting and Declining Problematic Content on page 308
Resubmitting or Reloading Problematic Content on page 310
Replacing a Problematic SIP or File on page 311

Viewing a Problematic SIP or File on page 311

Validation Stack Error Codes on page 312

Handling a Problematic SIP or File on page 313

Rerunning Processes on page 317

Derivative Copy Representations on page 435

About Resolving Issues

The Rosetta system enables Technical Analysts to resolve technical issues that
occur with deposit activities, SIPs, and files.

Moving a SIP to the Next Stage

After handling the technical issues of a SIP, the TA should move the SIP to its
next stage as defined by an Administrator. (For more information on content
processing, see Configuring SIP Processing in the Rosetta Configuration Guide.)

NOTE:
If the SIP TA has overwritten the automatic output of the validation stack,
the SIP's next stage is to be approved by the Assessor before it continues to
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the Permanent repository. If the TA has solved the issue without changing
the IE's metadata, the SIP will continue to its next stage based on the SIP
processing configuration.

To move a SIP to the next stage:

1 On the SIPs List - Loading page (see Accessing the “Manage Issues in SIP
Processing” Page on page 295), select the SIPs you want to move to the next
stage. To select all theSIPs, select the check box in the header.

2 In the Action drop-down list, select Move to Next Stage.
3 Click Execute.
The SIP is moved to the next stage.

If the next stage includes approval of the SIP, an e-mail may be generated by the
system and sent to the Producer Agent who initially submitted the material. See
Adding an E-mail Confirmation in the Rosetta Configuration Guide.

Rejecting and Declining Problematic Content

Technical Analysts can return or decline deposit activities or SIPs when the
content contains technical problems.

NOTE:
Rejected content can be revised and resubmitted; declined content cannot
be resubmitted.

To reject or decline problematic content:

1  On the SIPs List page (Submissions > Technical Issues > Manage Issues in
SIP Processing), click the folder containing the deposit activities or SIPs that
you want to reject or decline.

2 Select the check box(es) of the SIP(s) you want to reject or decline.

NOTE:
Multiple selections must share the same reason for rejection or decline. If
one SIP is rejected for failing a virus check and another for containing an
invalid file format, these must be processed separately.

3 Inthe Action drop-down list, select one of the following;:
B Reject, when you want to reject the file or SIP

B  Decline, when you want to decline the file or SIP
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4  Click Execute. The Action Reason page opens for the selected files (see
Figure 167).

Home = Submissions * Action Reason

You have chosen to reject IR no. 24 25 Please provide 2 raason
Reason [File technical problem |
Optional Hote =]

En

Figure 167: Action Reason Page

5 Inthe Reason drop-down list, select the reason for decline or rejection.
6 Inthe Note field, enter a note (optional).
7  Click the Save button.
The file status changes to Rejected or Declined.
8 Do one of the following:

B If there are other files in the SIP that need to be handled, resolve their
issues before continuing.

B If there are no more files in the SIP, click Move to next stage, then
Execute.

The objects are removed from the folder. A new e-mail template opens for
sending information to the Producer Agent.

The information displayed on the e-mail template is configurable by a
Rosetta Administrator. The following figure shows an e-mail response with
minimal information. To add or customize fields, see Customizing Display
Fields in the Rosetta Configuration Guide.
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= Hame > Submissions > Preview E-mail
The e-mail below will be sent 10 the Producer Agent
Dear John Smith,
Please find the details for your deposit activity
1] 102 Tile: Prezasation set Deposit Date 07 A 22009
Status  Reject
Your deposits can be reviewsd by clicking the following link: hitp:dtserverpod fdaposit
Si' .:"—.i.f_
Deposit Review Stafl
Add meszage ;I
CC e-mail to me r
Send

Figure 168: Decline/Reject E-mail Template

9 Inthe Add message text box, enter additional information about the

problem and how it can be resolved.

10 To have a copy of the e-mail sent to your inbox, click the CC e-mail to me

check box.
11 Click the Send button.

The Producer Agent who submitted the deposit activity receives a notification
by e-mail that the content was rejected or declined. If you requested a CC, you

will receive a copy of the same e-mail.

Resubmitting or Reloading Problematic Content

Technical Analysts can request that the Rosetta system resubmit the deposit
activity to the Deposit Server or reload a SIP to the Staging Server. The system
automatically identifies the part of the deposit activity or SIP that failed during

the initial upload process and reloads only this part.

To resubmit or reload problematic content:

1  On the SIPs List page page (Submissions > Technical Issues > Manage
Issues in SIP Processing), select the deposit activities or SIPs that you want

to resubmit or reload.

2 Inthe Action drop-down list, select Resubmit or Reload.

3 C(Click Execute.

The Rosetta system resubmits the failed part of the deposit process.
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Replacing a Problematic SIP or File

After Technical Analysts repair a problematic SIP or file on a local computer,
they can replace the SIP or file with the repaired one.

NOTE:
The original ID, name, and path will reflect the original deposited file
details. (The TA replacement will not be reflected in the DNX.) Return
should be preferred if a DNX update is required.

To replace a problematic SIP or file:

1  On the SIPs List page (Submissions > Technical Issues > Manage Issues in
SIP Processing), do one of the following:
B To replace a SIP in the Loading folder, click the SIP ID number.

B To replace a file in the Validation folder, locate the SIP, click Work On,
and then, on the SIP Content List page, click the Replace text in the row
that corresponds to the file.

2 On Step 1 of the Replace File wizard, update the File Label and enter a File
Note as needed. Click the Next button to proceed to the next step, the
Replace Local File page.

3 If you are uploading from a local file, remain on the Insert From Local PC
tab. If you are uploading from a file on the server, click the Choose From
Server tab to switch to the Replace Server File page.

4 Browse to or select the file you want and click the Upload button.

The system uploads your replacement file and produces a confirmation
page, Replaced File, with the details of the replacement. Assessors,
Arrangers, and Approvers will see an alert if a file was replaced.

After the SIP is replaced, it must be reloaded on the Rosetta system.

Viewing a Problematic SIP or File

Technical Analysts can view a problematic SIP or file in a Web browser using
the View option.

To view a SIP:

1 On the SIPs List page (Submissions > Technical Issues > Manage Issues in
SIP Processing), do one of the following;:

B To view a deposit activity in the Deposit folder, select the deposit
Activity ID.
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®  To view a SIP from the Loading or Validation folder, click the SIP ID or
click the Work On text link in the SIP’s row.

B To view a file in the Validation folder, locate the SIP, click Work On, and
then, on the SIP Content List page, click More, then View in the row
corresponding to the file.

The deposit activity, SIP, or file opens.

Validation Stack Error Codes

The following errors can occur when running a validation stack on a SIP or file.

Table 53. Validation Stack Error Codes

Stage Error Description Error ID
Format No matching format identification vs_Error.3
Identification
Multiple matching format identification vs_Error.5
signature
Tentatively matching format vs_Error.9
identification
File Extension Mismatch vs_Error.17
File Fixity Fixity Check Failed vs_Error.32
Conflict between original checksum and | vs_Error.96
populate checksum
MD Extraction Default error during MD extraction, used | vs_Error.256
to catch all unexpected errors
MD Extraction Plug-in error - Can't vs_Error.768
process extraction tool output
Mapping error - Extractor property type vs_Error.2304
is not compatible with its value
Failed to get the MD Extraction plug-in vs_Error.8448
(can't be found in the plug-in directory)
MD Extraction plugin encounter vs_Error.524544
unexpected error - No properties
extracted
Virus Check Virus check unknown error vs_Error.32768
Risk Analysis Exception occurred during risk analysis vs_Error.262144
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Handling a Problematic SIP or File

Technical Analysts can handle the following cases by performing the actions
described below. See:

B  Format Problems on page 313
®m  File Extension Issues on page 314
B Metadata Errors on page 315

For each of these actions, the TA can create an auto-correction rule that records
the decision and performs these actions automatically the next time the same
thing happens. (See Automating Corrections on page 327.)

Format Problems

When DROID cannot match a file to a single format (based on its unique file
signature), the TA must manually choose a format ID and assign it to the file.

To do this, click the More > Format link that corresponds to the file you want to
assign a format to (Figure 169).

Home = Submissions = Technical Issues » Manage Issuesin 5IP Processing = SIP - Content List

SIF 1D 420 Producer Demo Intemal Producer  Producer Sgernt
Deposit Activity |0 3637 Material Flow Name Automated - Bulk Material Type Unpublished
Title - Selected Access No restrictions Submitted On 190752012
Izsue # - Assign To admin-
Contert List

Filter |21l =]

™ File Hame FID Status | Problems Artions
1 I_ FA0EG460 jpg F L1955 1 Tasks failed * Download  Replace Recheck fulore...

E-:I'rtlf at:?'dew History

s o

Fixity Check:Fas=s
Wirus ChedcPass
File Format:Fail - Multiple farmats found for file fws_Errors)

= Back [Move ToNewt Step = | Bl

Figure 169: Link to Choosing a Format

The Format ID page opens (Figure 170).
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Home = Submissions = Technical lssues » Manage lssues in 5IP Processing * Format 1D

The format Ik of the file:other tertative.zoo will be updated. Please choose the new
format I and add user notes (optional).

Format 1D Format Mime Type Format Mame
- =fmbi2E8 wfmtrZ6a
0 unknown

O

3

I- Remember my decision concerning the chosen format

Reason

Froblem not relevant for presencation

Optional Hote

Cancel

Figure 170: Assign Format Manually

File Extension Issues

After DROID has identified a format (or the TA has done it manually), the

system matches the file's extension to the list of valid extensions as they are
stored in the format library.

Content List

Filter al b

O File Hame PID . Status  Problems

Aclions
1 win Ed logo.doe FL1g200 1 Tasksralled »  Download Replace ?I?L'hlzil«. Mo, s

Enit .'r"lﬂ'u"u".:{{'..| i |:1\ Hiztaony
Fiaty CheckPass .

Virus CheckPass

File FornatFail - File extension 2 incompatinle with identified formmat («s_Error f)
Technical MD ExtraciPass

Hisk Analysis Pass

< Back

Move To Next Step

Figure 171: Incompatible File Extension
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If there is a mismatch, the TA can ignore this problem and add a comment to the
file's DNX.

p "I". Horma = Submmissions = Technical 1ssues = Manage 13sues in SIP Processing = Action Beason

There iz a mismatch between the farmat ID of the file: Min Ed logo.doc and its file extension.
Toignore this mismatch press Ok,

Format ID Allowed File Extensions (as registered in the Format Library) File Extension
i1 11 doe

Ol remember rmy decision concerning this combination of format and error message

Reason Froblem not relevant for presernvation b
Optional Note

Figure 172: Action Reason for Ignoring Mismatched Extension

Metadata Errors

If the metadata extraction tool (for example, JHOVE, NLNZ MD Extractor) fails
to extract technical MD, the file waits for the TA to evaluate the problem. The
TA can handle this issue by clicking the MD Error link. This allows the file to
continue processing without the technical MD.
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Home = Submissions » Technical lssues > Manage Issues in 5IP Processing » TA - Content List

SIF 1D 475 Producer Demo Irtemal Producer  Producer Agerit
Deposit Actiwvity ID 3633 Material Flow MName Futomated - Bulk Material Type  Unpubl
Tithe - Selected Access Rights Mo restrictions Submitted On 19070
Izsue # - Assign To admin-

Content List

Fitter & =]

[T Eile Name EID St=tu= Problems | Actions
1 I_ autopaorrait-de-wan- FL195739 1Tasksl_ Lowunload Replace Recheck hore...
gogh-emile... failed a — -

Bdit  ‘Aew :'KMD Echukr\] History
Fizity Check Pass S

Wirus Check Pass

Filz Format: Pass

Technical MD Extract: Fail - Ervorrs returned during metadata extraction (JFIF APPO marker not
at beginning of file Expected marker byte 255; got 165 Failed ta retrieve extractar properties)

Rizk Analysiz Pass
< Back [Mave ToNestStep = | R et el

Figure 173: Technical Metadata Extraction - Failure

After clicking the MD Error link, the Technical Analyst can enter information in
the Action Reason form (Figure 174).
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Home = Submissions = Technical lssues = Manage lssuesin SIP Processing = Action Reason

The following ML Extraction toal ermar will be ignored: JFIF APPO marker not at beginning of file,
Expected marker byte 255; got 165, Failed to retrieve extractor properies

I- Remember my decision zoncermning this combination of format and error message

Rez=on Other ;I
Optional Hote

Figure 174: Action Reason for MD Extraction Error Handling

Rerunning Processes

Technical Analysts can re-run processes that fail to produce successful results.
The following processes can be performed to this end:

Rechecking a File on page 317
Rerunning Validation on page 319
Rerunning Enrichment on page 319

Rerunning System Errors on page 319

Rechecking a File

Technical Analysts can rerun validation checks on the files.

To recheck a file:

1

On the SIPs List page (see Accessing the “Manage Issues in SIP
Processing” Page on page 295), click the Validation folder.

Find the SIP that contains the file you want to recheck and click Work On in
its row.

The SIP details open with the Content List tab displaying the files contained
in the SIP.
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To recheck only one file, click the Recheck text link in the file’s row. To

recheck multiple files, select the check boxes of the files that you want to
recheck and select Recheck from the actions drop-down list, then click

Execute. (See Figure 175).

[i.-%'l'“] Home = Submissions = Manaage Issues in 5IP Processing > SIP Content List
SIP 10 293 Producer selenivmHumanStager Producer Agent
Deposit ActivitylD 297 Material Flow NHame G5V MF selenium Material Type Penodic
Title Test Field Selected Access Righis Mo restrictions Submitted On 1211072011
Issue # Assign To admuni
Content List Metadata Hotes History
1-2of 2 Records
Filter Al =]
T File Name FID « | Status Problems Actions
1 FE ta_1.conf FLZT3 1 Tasks failed * DOownlosd Replace Rechedd
2 T ta_2.conf FLZ2T34 1 Tasks failed * Download Replace Reched
Edit Format View History
= Back Move To Next Step ﬂ
Move Te Hext Step |
ror | Assign | TR
o o e g o R

Un Assign
File

Dechkne File

lgnore File

Actions an the 51F

FHern

Dacling SIP

Figure 175: RecheckSIP Files

The Rosetta system runs the validation check again.

During a recheck, Rosetta exhibits the following behavior:

A message: "Rechecking file(s) \ {pids\}" is displayed
Files are not displayed in the list

If the recheck fails, an error message: "Recheck failed, please contact your
system administrator” is displayed

When the task is complete, the "Rechecking file(s) pid" message disappears,
and files with errors (after recheck), if they exists, are displayed in the list
again

All file-level operations are available.
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B During the recheck, all SIP level operations are available, including Move to
next stage.

B Trying to execute actions other than Assign and Un-Assign will display a
message: "SIP(s) \{ids\} is being rechecked - please try again later.”

Rerunning Validation

If validation stack tasks fail to process a file, Technical Analysts can rerun the
validation process for problematic files.

To rerun validation for problematic files:
1 On the SIPs List page (see Accessing the “Manage Issues in SIP
Processing” Page on page 295), in the Folders pane, click Validation.

2 Select the check box(es) beside the file(s) for which you want to rerun the
validation process.

3 Inthe Action drop-down list, select Rerun.
4 Click Execute.

The Rosetta system runs the validation process again. If validation is
successfully completed, the file is removed from the SIPs List page.

Rerunning Enrichment

If the enrichment process fails for technical reasons, Technical Analysts can
rerun the enrichment process for problematic SIPs.

To rerun the enrichment for problematic SIPs:
1  On the SIPs List page (see Accessing the “Manage Issues in SIP
Processing” Page on page 295), in the Folders pane, click Enrichment.

2 Select the check box(es) beside the SIP(s) for which you want to rerun the
enrichment process. To rerun the enrichment process on particular files
within a SIP, click Work On in the SIP’s row and then select the check box(es)
beside the file(s).

3 Inthe Action drop-down list, select Rerun.
4  Click Execute.

The Rosetta system runs the enrichment process again. If enrichment is
successfully completed, the file is removed from the SIPs List page.

Rerunning System Errors

When SIP processing fails continuously (up to five times), SIPs are placed in the
System Error folder. TAs can attempt to fix the system problems, which may be
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caused by lack of memory or an Oracle disconnect or something else. If
rerunning the SIP still fails, the TA or System Administrator should look at the
log and attempt to solve the problem.

To rerun a SIP with a system error:

1 On the SIPs List page (see Accessing the “Manage Issues in SIP
Processing” Page on page 295), in the Folders pane, click System Error.

2 Select the check box(es) for the SIP(s) you want to rerun.

3 Select Rerun from the Actions drop-down menu.

NOTE:
To rerun all of the SIPs in the System Error list, skip step 2 above and,
instead of selecting Rerun (step 3), select Rerun All from the Actions
drop-down menu.

4 Click the Execute button.

The Rosetta system runs the SIP process again on the SIPs you selected.
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Viewing and Resolving Repository Issues

This section contains:
B Technical Analyst Issues in the Repository on page 321
B Identifying Repository TA issues on page 321

B Correcting Problems on page 323

Technical Analyst Issues in the Repository

Technical Analysts (TAs) who work with issues arising from maintenance on
the permanent repository are referred to as Repository TAs. Their tasks involve
solving problems that are identified when validation stacks are run on parts or
all of the repository.

Repository TAs perform actions similar to those of SIP TAs, although
Repository TAs work with data that already exists in the repository, not with
submission packages.

Repository TAs also address technical issues related to adding or updating a
representation. (For more information on representations, see the chapter for
Editors, Adding Representations on page 479.)

ldentifying Repository TA issues

Typically, repository TA issues are identified when validation stacks are run at
regular intervals by Data Managers. When results of the validation checks show
problems with format identification, virus checks, technical metadata extraction,
tixity, and/or risk extraction, Data Managers can view the problematic files on
the Monitor Process History page (a status of Waiting... indicates a file for the
Repository TA to handle). They can also configure the process to send an email
notification to the TA when an object has been flagged.
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Repository TAs can also access flagged issues by following the menu path:
Rosetta > Data Management > Manage Technical Issues and viewing any items
that exist there.

After running a validation stack on part or all of the permanent repository, the
TA can determine which items require further manual processing.

IEs containing files that fail the validation stack appear on the Validation tab of
the Data Management > Manage Sets and Processes > Manage Technical
Issues path.

Home = Data Management > Manage Sets and Processes = Validation

Validation (5}

Filter | Al -

1 - 5 of & Records

[T | Mode IE PID | Title | ProcID ProcOw Problems| Asd To Actions
1 Update Rep IE1340 Seleni 5346 admin1 100% failedw Work On Ignore  Un Assign
2 [ Taskchain  IE2478 Sunse 9879  admin1 100% failedw Work On Ignore  Un Assign
3 [ Update Rep IE1334 Seleni 5325 admin1 100% failedw Work On Ignore  Un Assign
4 [T Taskchain [E2933 Seleni 1801 admini 100% failedw Weork On Ignore  LPn Assign
& [ Taskchain [E2935 Seleni 1601 admin1 100% failedw Work On Ignore  Un Assign

Figure 176: Permanent Repository TA Work Area

From here, you can Work On, Ignore, or Unassign a failed IE. Or you can use the
check boxes and options from the drop-down box at the bottom of the page and
click Execute to perform an action on more than one object at a time.

To view a breakdown of problematic files on the various checks comprising the
validation stack, click the blue arrow in the Problems column.
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Guick L h
Home = Data Management = Manage Sets and Processes = Validation Hie baune

Validation (6}

Filter | AN =]

1 - 6 of 6 Records

[T | Mode IE PID | Title Proc ID Proc Ow Problems | Assignlo .« Actions
1 [ Taskchain [E2425 Sunset 9700 admin  100% admin Work On Ignore Un
faile Assign

AN

Wirus Check: 1 files
Fixity Check: 0 files
Format “alidation: O file

Technical MD Extract: 0 fileg

z [ Update E1295 Selenium 5224 admin % failed™  admini " g Un
Rep Title Assign

3 [ Taskchain [E2880 Selenium 1657 admin % failed™ admin1 Wesk On  Ignore Un
Title Assign

Figure 177: Breakdown of Problem Files

To dismiss an IE that you determine cannot or will not be fixed in the near
future, click the Ignore action of the corresponding row. This removes the IE
from the TA work area and sends it to the process exception list, which indicates
to the Data Manager that the IE did not pass the tasks contained in the process.
The object is rolled back to a previous version.

If an object is assigned to someone and you want to assign it to a different TA or
to yourself, use the Unassign action on the far right of the page.

Correcting Problems

To address problems with a failed object, click the Work On link of the row
containing the item. Details and options for the IE open in the Content List tab.
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Home = Data Management = Manage Sets and Processes = Manage Processes = Content List

IE PID [E3235 Process Owner admini
Process Excecution ID 175472 Submitted On 31/05/2014

Content List

1 -1 of 1 Records

["| Eile Hame | PID Problems Actions
[ Sunsetjpg FL3237 Tasksfailed+ Download Replace Rechedk Info View Fixity Events
< Back Continue || SR

Discard
Recheck
As=ign To
IIn As=sign

Figure 178: Working On in the TA Repository List

Each file belonging to the IE is listed on the Content List tab.

Problematic files can be handled individually using the Actions links for each
row or in groups of two or more (by selecting the check boxes followed by an
action from the Execute drop-down menu below). Available actions vary
according to the file type and the task chain performed. The following actions
are available either on the Actions for individual files or in the drop-down
Execute actions list:

Download allows you to copy the file to a local or network drive, open it,
and work on it, then replace the failed file in the repository with the one you
repaired.

Replace provides a 2-step wizard for uploading your repaired file from a
network or local drive to Rosetta. This file replaces the existing failed file.

On selecting a file, the user sees a list with the original filename in
strikethrough text and the replacement file name. Clicking Continue
triggers an Update Representation process. The TA is returned to the IE list
and the IE appears with no row actions and a "replacing file(s)" indication. If
Rosetta encounters technical issues with the replacement, the IE appears in
Update Rep mode for further analysis (see Managing issues with file
replacements on page 325).
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NOTE:
The TA will need to resolve all non-replace issues (ignores, rules) before
replacing a file.

B Recheck reruns a validation check on the file(s).

B Info links to the item in the Web Editor, where you can make any necessary
changes to repair the file or IE. When Edit appears as an action, it has the
same function.

B View displays the file associated with the IE and its metadata.

B Error-driven actions such as Fixity and File Ext depend on the type of
error(s) that the validation stack returns. See Table 53 for details.

B Events opens a log of significant events that have occurred in relation to the
object. Each event lists an Event ID that links to more details (see figure
below).

Managing issues with file replacements

The Update Rep mode indicates a problem with a new or replacement file,
provided either using the Add/Update Representation function in the Web
Editor, the corresponding APIs, or the Replace function in the Repository TA
(task chain mode).

The TA can fix the problem using the same tools as in Task chain mode.
Replacing a file in Update Rep mode deletes the original replacement file
(similar to SIP TA replacement) and not generate an additional Update
Representation process (since the replacement file was never committed to the
permanent repository).

If the Update Representation process was triggered by the Repository TA (in
task chain mode), aborting the process returns the IE to task chain mode.
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Validation Stack Rules

This section contains:

B Automating Corrections on page 327

® Configuring Validation Stack Rules on page 328
Adding a Rule on page 330

Updating a Rule on page 334

Re-Ordering Rules on page 334

Duplicating a Rule on page 335

Activating and Deactivating a Rule on page 335
Exporting a Rule on page 335

Deleting a Rule on page 336

Automating Corrections

Auto-correction rules are created, edited, and implemented by Technical
Analysts (TAs) during the validation of SIPs. When the validation process
encounters errors, the TA can manually correct the error and assign the same
correction to subsequent matching errors. For instance, when a file fails
validation because DROID cannot match the file’s extension to a known format,
the TA can decide that, for example, a . j123 will always be read as a . jpg. This
rule can be automated to apply to all occurrences of . j123.

For more information on handling errors and creating rules, see Adding a Rule
on page 330.

The three types of validation stack errors that a TA may configure are:

B Format identification auto-correction rules: If the DROID format check
fails to associate a file with one and only one format (based on the file
signature), Technical Analysts can add an auto-correction rule to define the
specific format to be assigned when this format is encountered again.
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®  Files extension mismatch rules: If the DROID check detects a mismatch
between valid extensions for a file and the actual extension of a file (for
example, if DROID detects a PDF format ending in .xyz), the TA can instruct
the system to ignore the mismatch whenever the system encounters it.

B Metadata extraction error handling rules: If the JHOVE tool fails to extract
technical metadata, JHOVE may declare the file invalid or not well-formed.
TAs can define rules that ignore the JHOVE result under specific
circumstances or that direct the system to handle the file another way.

Rosetta adds an event with rule parameters to the file when a rule is applied.
These events can be searched under the following fields:

B Format Identification Auto Correction Criteria
B Metadata Extraction Error Ignore Criteria
m File Extension Mismatch Ignore Criteria

When a rule is triggered, a provenance event is generated with the rule
parameter details.

Configuring Validation Stack Rules

Technical Analysts can configure validation rules from the Management Home
page, Submissions menu, under the Rules heading. The three types of
validation stack rules display in the list. (For information on the types, see the
bulleted list in the above section, Automating Corrections.) To add, edit, or
delete a rule, click the link (see Figure 179) that describes the type of error on
which the rule is based.
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Deposits + Submissions~  Data Management~  Preservation -

f ' Subsd _
Technical Issues Approval

Filter| 2 Manage Issues in SIP Processing  Assess SIFs

Arrange SIPs

e Approve SIPs
Format Identification Correction
.I Files Extension Mismatch Advanced Tools
1 & || Metadata Extraction Error Run Reports
2 Virus Check Error Schedule Reports

SIP Processing Configuration
SIP Routing Rules

Approval Group

.

Figure 179: Advanced Tools for Submissions, Validation Stack Iltems

Clicking the Format Identification Correction, for example, opens a list of rules
related to format identification errors (see Figure 180).
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Deposits » Subm 5" Data Management »  Preservation = Quick Launch+  Site Map

L tldentification Comection

Filter a1l = Find inall * | Go
m Fxport Hules - 10 of 18 Records. 1 2

Order | Name Description Creation Date Modification Date

1 @ ~  Muimple Text Files file formats  Define a single definite file format for text files 14/08/2016 20 03.03 Update  Duplicate Delete
2 0 & ¥ Tentative MP3 Files file format — Define the file fermat of MP2 files as definite and not tentative 14/08/2016 20:03:03 Update  Duplicate  Delete
3 @ = ~ muliple Excel Flles file formats  Define a single definite file formar for Excel files 14/08/2016 20.03.03 Update Duplicate Delere
4 0 & ¥ Multiple Tiff Files fil s Deefine a single definite file fonmt fos Tif files 14/08/2016 20:03:03 Update  Duplicate Delete
5 @ & ¥ nuliple RTF Files file formars Define & zingle definive file farmar for RTF files 14/08/2016 20:03:03 Update Duplicate Delere
[ 0 & ¥ Multi Word doc Matches BIFF and MS word, match on ext to make sure its a DOC 14/08/2016 20:03:03 Update  Duplicate  Delete
7 @ ~ ¥ Tematve JPZFlles Map tentative Jpeg2o00 files 14/08/2016 20:03:03 Update Duplicate Delete
8 0 a = Tentative LOG files Map tentative LOG files 14/08/2016 20.03.03 Update Duplicate Delete
9 @ = ¥ Temauve ARC file format ARC format comection rule 14/08/2016 20:03:03 Update Duplicate Delete
10 0 & ¥ Multiple POF file format POF format correction rule 14/08/2016 200303 Update Duplicate Delete

1-10of 18 Records 1 2

Figure 180: List of Rules Page

The following actions can be performed on the List of Auto-Correction Rules
page:

Adding a Rule on page 330

Updating a Rule on page 334

Re-Ordering Rules on page 334

Duplicating a Rule on page 335

Activating and Deactivating a Rule on page 335

Exporting a Rule on page 335

Deleting a Rule on page 336

Adding a Rule

To add a rule to one of the validation stack error types, Technical Analysts
define one or more parameters on the Rule Details page (Figure 181). (To omit
one or more of the parameters, leave the operator as Any.)

B Input parameters:
B Producer name, if matching by Producer
B Format name to which the format of a problematic file is compared

B File extensions to which the file extension of a problematic file is
compared (add the extension manually if the extension does not appear
in the Format Library list)
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B Mime type, if comparing a file on the basis of its MIME type

m File size and creation date, for comparison on those data

B Additional fields specific to the type of rule being added or edited
B Output parameters (one of the below):

B The file format that must be applied to the file if its file format and
extension match the input parameters

B The reason for ignoring errors that match the input parameters

I 1 1 rrecl TUIE Fule Dalzils
Rule Editor
Hama Mulipli Ted Files ile larmaks
Description Deedine & single dedinite file fornat for text files
Created By: Syslem Created on: 120302 31711
Updated By: Last Update on:
Input General Parameters
" Producer Name Ay j 0 iterns salacted Remaoue all Add all
Doz b raal Procdoias
* Format Hams List I:I.'|I.J:'|$j 4 items selacted Remaue all | Al all
T it A Pz Usiclb Viakaes il ExL-Fid-21 (Firvda piolalion Foral —
¥ s imii 3 (Tab-Debsbed Taod Fis) El-Fril-23 (EMIGHA Traraporable Fig
¥ x-imibH 30 (M5-DOS Tesd File with :I. Exl-Frmi-241 (Cpreilocyy GEDOOM Filg) -
* File Extention Ay = E——— hemoue al | Jeckl il
Jokp Dl b Dy Bl jpale B &
Pt rasiesss blee B bl Jgm W
Chi Fil GED RO Jivd B W -
T Mime Type Amy =1 [ iterns salected Remaue al | Add al
mplicaliondingle  spplcalioniis  spplslisr &
agpbcaliordbvp, aosicaliondsnad olus-w
Bl e o =
" File Sire(KH) Ariy |
" Create Date Arty =| oo = YT = K -|
 Plugin Instance Name P«rr_\.r ......... j = j
* Identification Method [amy =] [esenzion =|
Ourtpurt Parametars;
© bormat Hame wfrf] B (Unicode Test Fils)
Cancel m

Figure 181: Rule Details Page for Format ID Correction
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To add a validation stack error rule:
1 From the Submissions rollover menu, Advanced Tools column, click the
type of error to which you want your new rule to apply:
B Format identification auto correction rules
B Files extension mismatch rules
B Metadata extraction error handling rules
The Rule List page for that error opens.
2 Click the Add Rule button.

The Rule Details page opens (see, for example, Figure 182, Rule Details for
MD Extraction Error). Parameters vary slightly based on the rule type.

332 September 2016
Ex Libris Confidential



Staff User’s Guide, Part V: Technical Analysts

Chapter 32: Validation Stack Rules

tracion error har

dliF

les = Rule Details

Created on:
Last Update on:

140372012 01:24:1
180372012 01 :24:1

o

o

Home = Submissions » Metadat

Rule Editor

Maime

Description

Created By:  John Senitl

Updated By: Ex Libns
Input General Parameters
T Producer Nami | Apy j
* Format Hame | fny j
" File Extention Ay j
* Mime Type Ay 3
" File Size(lB) [ any ﬂ
* Create Date Ay ﬂ
= Agemnt Ay El
" Error Message [Any =)
Output Parameters:
* lgynore Reason

Cancel

| 0 items selected Remowe all | Auddd all
| Desmo infemal Produser
| 0 teme selected Bemowe all l Aud all
| B Frt2t Finale Notstion Fermat) i’
| EsL-Fent-22 (GO File Format)
| Esl-Fent-247 [Geneslogy GEDCOM F -
[4] | :
|'Di:ﬁm selected Reemowe all | Al all
| Sob bk Dply  bEe jiy Dl EI
| pabe mic plet reciesor e #1
| davs WB HC LHG Unknown ;|
| 0 iteme selected Remowe all | Add all
| spplcationfinils  applicationrifs -

v =y ==

Froblem not relevant lor preseralion

| sfiphcationiiistraisr  appicatoniay i

| mpindarartinnfvew smrdie mbann b Boks ek =
4

Add Remove

Figure 182: Rule Details for MD Extraction Error

3 Enter aname and description for the rule in the corresponding fields.

4  Select an operator and one or more value(s) for the input parameters you
want the rule to use. If, for example, you want to narrow the rule to apply
only to work deposited on behalf of a particular Producer, then for the
Producer parameter, select List Equals and the particular Producer(s) from

the right-side list box.
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NOTES:

B The format value list uses the format identifiers taken from the format
library.

B For detailed information about operators and parameters, see Operators
Used in Rule Parameters on page 180.

5 Click Save.

The Rosetta system saves the new validation stack rule and can use it to identify
a specific action to be taken.

Updating a Rule

Technical Analysts can update a rule to modify its input or output parameters.

To update an auto-correction rule:

1  On the List of Rules page (see Figure 180), locate the auto-correction rule
that you want to update and click Update. The Rule Details page opens.

2 Modify the fields that you want to update, and then click Save.

The Rosetta system now uses the updated parameters.

Re-Ordering Rules

To determine the rule that must be used for a specific file, the Rosetta system
compares the input parameters defined in a rule with the parameters of the file.

Rules are analyzed in the same order as they are displayed on the List of Rules
page. The Rosetta system uses the first auto-correction rule found that match the
parameters of the file.

Technical Analysts can change the order of rules.

To re-order auto-correction rules:

1  On the List of Rules page (see Figure 180), in the Set Order column, use the
up and down arrows to change the order of the rules.

2 C(Click Save.

The Rosetta system now processes the rules in the newly defined order.
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Duplicating a Rule

Technical Analysts can duplicate an existing rule. This is especially helpful
when creating a new auto-correction rule. It is often faster to duplicate an
existing auto-correction rule and then modity it, than to create a new rule.

To duplicate a rule:
On the List of Rules page (see Figure 180), locate the auto-correction rule that
you want to duplicate, and click Duplicate in its row.

An exact copy of the rule is added to the List of Rules page. The Rosetta system
automatically labels the new rule with the name Copy of followed by the name
of the original rule.

Activating and Deactivating a Rule

Technical Analysts can activate or deactivate a rule. After an auto-correction
rule is deactivated, it is no longer available to the Rosetta system for matching.

On the List of Rules page, the status of the rule is indicated by the check mark in
the Active column:

B Yellow — The auto-correction rule is active.

B Grey — The auto-correction rule is inactive.

To activate or deactivate an auto-correction rule:

1 On the List of Rules page (see Figure 180), locate the auto-correction rule
you want to activate or deactivate.
2 Inthe Active column, click the check mark.

The page refreshes, and the check mark in the Active column indicates the
new status. (The rule is changed from active to inactive, or from inactive to
active.)

Exporting a Rule

Technical Analysts can export rules to share them with other institutions.

To export rules, on the List of Rules page (see Figure 180), click Export Rules.
Rosetta generates a CSV with all the rules' details.
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Deleting a Rule

Technical Analysts can delete an existing rule. After a rule is deleted, it is no
longer available to the Rosetta system for matching.

To delete a rule:

1 On the List of Rules page (see Figure 180), locate the rule you want to delete
and click Delete. The confirmation page opens.
2 Click OK.

The rule is deleted from the Rosetta system.
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This part contains the following sections:
B Chapter 33: Understanding Editors on page 339
B Chapter 34: Working with Shared Metadata on page 341
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Understanding Editors

Editors work with IE content and shared metadata in the department,
institution, or consortium to which they are assigned.

They are responsible for editing individual IEs in their assigned scope, for
example:

®m Editing descriptive metadata of the content deposited by Producer Agents
B Adding new representations

Editors are assisted in their work by the Data Management > Search and
Queries section of the Management module, which includes the following links:

m  Search for Objects
B Search for Metadata
B Saved Queries

The search features allow the Editor to find IEs and metadata, while queries
allow the Editor to save searches for future reference and research.

NOTE:
Queries cannot be used as the basis for sets. Only set creation wizards as
executed by Data and Preservation Managers can be used for sets.

Editor permissions can be View, Typical, or Full. Editors’ scope can be either
department, institution, or consortium. Scope can be set on a metadata type
level. For example, the following configuration allows descriptive metadata
editing and prohibits editing DNX, structmaps, and assigning an access rights

policy.
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E| Role Parameters

* MetadataType DMX

i DC
Source Rights
Source Copyrights
Struct Map
Access Rights
Source Other
Source Dc
Source Mods
Source EAD
Source Marc

4%

RN NL RN

Figure 183: Role Parameters
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Working with Shared Metadata

This section contains:
B About Shared Metadata on page 341
B Search Metadata on page 341

About Shared Metadata

Shared metadata is the metadata that can be assigned to multiple intellectual
entities (IEs). The following metadata can be shared in the Rosetta system:

B Access rights policies
B Content Management System (CMS) records
For information on working with access rights, see Access Rights on page 125.

To integrate CMS records from Voyager or another ILS in your system so that
they can be shared, contact your Ex Libris Implementation or Professional
Services Consultant.

NOTE:
The Search for Metadata link on the Rosetta menu only applies if you
have set up Rosetta to search your ILS or CMS.

Search Metadata

The Metadata Search page enables Editors to search and view metadata shared
from a CMS.
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To access the Metadata Search page and perform a search of shared
metadata:

1 From the Rosetta drop-down menu, click Data Management > Search and
Manage Queries > Search for Metadata.

The Metadata Search page opens. Currently, only CMS metadata is
searchable from this page (Figure 184).

Home = Data Management » Search and Manage Queries = CMS Metadata Search
Metadata Type: CM5 DC Find: in: | am ;I Go
1-6 of 6 Records
# Mid Description | Metadata Type | Format | Created by | Creation Date
1 1003  undefined dc CHMS admin 6M10M3 View
2 1171 undefined de CHMS SYSTEM G103 View
3 1352  undefined dc CMS admin GM10M3 View
4 1353  undefined dc CMS md load job 611013 View
5 1508  undefined dc CMS admin GM10M3 View
6 1539  undefined dc CHMS admin 6M10M3 View
< Back

Figure 184: Metadata Search Page

2 In the Find field, enter a search term(s).

3  From the in: drop-down list, select the metadata field you want to search.
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Home = Data Management » Search and Manage Queries = CMS Metadata Search

Metadata Type: CMS DC i . A";l o

Subject
1-60f6 Records iRalaton

Publcation Date

# Mid Description | Metadata Type | Format | Created bCentent Type
Subject_LCSH

1 1083  undefined dc CM5 admin1  |yRL s

2 1171 undefined dc CHMS SYSTEM [Crestor ew

- Publisher !

3 1352  undefined dc CMS admin1  Tie =

4 1353 undefined  dec CMS  md Ioad jcgz:f;:“*q”'*"“

5 15308  undefined dc CMS admin1  {Contnbutor =
—

§ 1539 undefined dc CMS admint o
|zsue Number/Date
Language

= Back ISMM
|ldentfier
Figure 185: Metadata Fields
4 Click Go.

The system returns items from your library catalog that match the terms and
restrictions specified by the metadata search parameters.

Metadata Type: |Reqisin Pronom

=l Fine:n in: [verslan = e

1-5%of 11 Racards

# Hid Desecription Metadata Type Format | Created by | Creation Date
| REG_FL_ZE AutoTAD Esich Plot File pronam regisiy  SYSETER e LS =
Z REG_FLL 4=z VWardperfect Secondzry File pronam registry  SYETEM 2402 =1
3 REG_FLLED AutoCAD Flol Corfigurstion pronarm regisly  SYSTER 214405 =
1 REG_FLI_52 Freelance Fila pronam regisiry  SYETEM rd0E B
&  REG_FLLIZZ 3 Macromadia Flagh proaam regislyy  SYSTEM 24408 =L
< Back
Figure 186: Metadata Search Results
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Part VII

Data Managers

This part contains the following sections:

Chapter 35:
Chapter 36:
Chapter 37:
Chapter 38:
Chapter 39:
Chapter 40:
Chapter 41:
Chapter 42:

Understanding Data Managers on page 347
Working with Sets on page 349

Working with Processes on page 363

Publishing on page 375

Delete, Restore, Move, and Purge IEs on page 383
Fixity, Provenance, and Storage on page 401
Scheduling Metadata Update Jobs on page 407
Collections on page 415
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Understanding Data Managers

Data Managers schedule processes, manage sets, and run activities that affect
multiple IEs.

Data Managers are responsible for:
B  Managing sets

B Scheduling and monitoring processes

Publishing configurations, and
B  managing the recycle bin.

Data Managers can also work with individual IEs, but their primary role is to
work on groups of data at an institutional level.

Permissions for Data Managers differ slightly from those of most other roles.
Data Managers can have Typical permissions, which include adding/editing
and deleting IEs or they can have Full permissions, which include all the
abilities of the Typical permissions as well as the ability to purge items that have
been deleted.

Data Managers’ scope can be either institutional or consortial.

NOTE:
For information on Access Rights Policies and Retention Rights Policies,
see Access Rights on page 125 and Retention Policies on page 143.
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Working with Sets

This section contains:

B About Sets on page 349

Accessing the Manage Sets Page on page 350
Creating Sets on page 351

Viewing Sets on page 360

Deleting a Set on page 361

About Sets

To facilitate searching and accessing intellectual entities (IEs) that are stored in
the Rosetta repository, Data Managers can create sets of IEs. A set is a group of
objects (complete IEs, representations, or individual files) that satisfies criteria
defined by Data Managers, such as matching on the creation date or the
Producer’s name.

Data Managers can include in sets those objects that are frequently accessed.
Then, instead of running a search every time such objects are required, a Data
Manager accesses the appropriate set.

Data Managers can create an itemized set or a logical set.

B Anitemized set contains a static group of objects that satisfies certain
criteria. Data Managers manually select the objects to be stored in the set
from the results of the search.

For example, if a Data Manager runs a search for Monet artworks and 25
objects are found, the Data Manager can select 10 paintings and save them
as an itemized set. The Data Manager can then access this set and work with
the objects without having to search for these paintings again.

The itemized set is static—that is, even if new objects that satisfy the criteria
are moved to the Rosetta repository, the itemized set does not change.
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However, Data Managers can manually add new objects to an existing
itemized set.

B A logical set contains:
B A search request defined by a Data Manager
B All objects that satisfy the search request

For example, if a Data Manager runs a search for Monet artworks painted in
1890-1900, all objects that satisfy these criteria are automatically included in
the set.

The logical set is dynamic—that is, it is updated every time Data Managers
access the set and run the search request. New objects that satisfy the search
criteria are automatically added to the set.

Data Managers can manage both itemized and logical sets using the Manage
Sets page.

Accessing the Manage Sets Page

The Manage Sets page enables Data Managers to create and manage both
itemized and logical sets.

To access the Manage Sets page:

From the Management Home page, click the Data Management link in the
header or on the main pane. From the Data Management page, click Manage
Sets under the Manage Sets and Processes heading. The Manage Sets (Set List)
page opens.

350
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Hame = Data Management * Manage Sets and Processes = Seat List

(]
-]

Filter: | & B Find: in: | A hd

Add Set 1- 6 of & Records

Active Name Set Type Object Type Created By Crin Date

e == al = 3 o) i W Raals =hslz LEiEis

5 — ritellertins] Entit S ” rd=te  Baculic Calata
2 L = Elle =1 = = L Upssia masults Lelate
- rtellertins] Entib i O - nd=ta barhare Delars

BEME Elie =1 = = HL Upzats amibars  Lelelz

T = L l=miE=a ==L =MZas == = a i W Raals =hslz LEiEis
CIP 979 itarmirad o= L — =1 En — - ” nd=te barhere Delats

= [emiE=d s2 EMEZE Elle E S L Upzats =mibers Lelete

SR 84 itarmirad oo . — =1 En — = O - nd=ta barhare Delars

= &% Il2mEad =2 BEME Elie E = = L L P Upzats amibars  Lelelz

= Back

Figure 187: Manage Sets - Set List Page

Creating Sets

Data Managers can create the following types of sets:

B Logical sets to store search queries that result in dynamically updated
groups of objects

B [temized sets to store static groups of objects

Creating a Logical Set

Logical sets function as queries or filters that select a new set of IEs each time
they are run.
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To create a logical set:

1 On the Data Management main menu (see Accessing the Manage Sets Page
on page 350), above the sets list, click Add Set. The Add Set page opens, step
1 of the Add Set wizard.

Cancel

Figure 188: Add Set Page

2 Select Logical - Based on a search query, and click Next.
The Set Details page opens.
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El General Infermation

= Set Name |

Description |

Hote j

Status Status Date 400872012

Private feMo ©'es

< Back Cancel

Figure 189: Set Details Page

3 Complete the fields as described in the following table:

Table 54. Set Details Page Fields

Field Description

Name The name of the set as you want it to
appear in Set List pages and applicable
lists of sets.

Description A brief description of the set’s content or
parameters.
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Table 54. Set Details Page Fields

Field Description

Notes Any notes associated with the set.

Status The status of the set:

B Active - The set is processed by the
Rosetta system.

B Inactive - The set is not processed.

Status Date The date that the status was last set.

Private The permissions that define who can
access the set:

B Yes - The set is accessible to other
Data Managers.

B No - The set is accessible only to the
Data Manager who created the set.

4 Click Next.
Step 3 of the wizard opens.

Logical sets display the Simple Search page with the option to switch to the
Advanced Search page.

rch 1=23)

z'\-‘:r'\J Home > Data Management = N
Logical 5et: 3-g
Search Conditions Sort Columns

Search level: ®| Intellectual Entity - Representation | File
B 2dd conditions

Matd = of the following conditions: —T T

Search

= Back Cancel

Figure 190: Simple Search for Adding a Logical Set

5 Create the query for your search using the search form.
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6 Click the Go button to run the search.

The system returns results. For an explanation of results columns, see
Table 55.

7  If the results are appropriate for the purposes of your query, save the query.
If the results are not adequate, alter some or all of your query and rerun the
search.

8 Save the query/logical set.

NOTE:

When you save the logical set, you are saving only the query, not the items
returned in this particular search. When the database changes, your query
may return different IEs.

Logical Sets - Updating

Data Managers can change both the general information of a set as well as the
query criteria.

To update the general information for a logical set:

1

On the Manage Sets > Set List page(see Accessing the Manage Sets Page on
page 350), locate the set you want to change and click Update.

The Set Details page opens.

Modify the fields as described in Table 54, Set Details Page Fields on
page 352, and click Save.

To update a query for a logical set:

1

On the Manage Sets > Set List page, locate the set you want to change and
click Results in the corresponding row.

Edit the search conditions as needed and click Search.
The updated query results show on the Results section of the page.

Once you are satisfied with the query results, click Save to update the
logical set query.

Creating an Itemized Set

Itemized sets are comprised of a group of IEs that have been selected through a
simple or advanced Rosetta search or through a text file of PIDs prepared by
your institution. Both methods are described in the procedure below.

354
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To create an itemized set:

1 Onthe Data Management main menu (see Accessing the Manage Sets Page
on page 350), above the sets list, click Add Set. The Add Set page opens, step
1 of the Add Set wizard.

Choose the type of set you would like to create

Cancel

Figure 191: Add Set Page

2 Select Itemized - based on selected objects, and click Next.

The Set Details page opens.

El General Information

* Set Hame

Description

Note

Status m Status Dated3/11/20

Private £ MNo " Yes

Get IEs from File {upload a simple text file -| Browse I

with a list of PIDs and PID in each line)

RS

< Back Cancel

Figure 192: Set Details Page for Itemized Set

3 Complete the fields as described in the Set Details table on page 352.
4 To use a simple or advanced search to create set items:

a  Click the Next button and enter search terms and parameters in the
available fields.

b Click the Go button.

The system returns matches to your search.
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' aome * Dats Manasgement * Manage Sets and Propesses » Mansge Ssts » Ssarch -2 @
ltemized Set:  Awgust 2012 HNumber of 5et Members:
Search Conditions Sort Colurmns

Search level: /| Intellzctual Entity i Representation | File
B sdd conditions

Mt ﬂ of the following conditions: 9%
[Title (0C) * [ Contains K] * fthe* Q0%
zaarnch
El Results
2 of 2 Reconds
# 7| Title (DC)| Type (DC)| IE PID | SIP ID | Authoritative Name | JE Creation Date
1 [ Winter E1059 18 Cremo Interna Q3052012 View Info Export
2 [0 Winter [E1085 20 Dema Internz 03082012 View Info  Export

Agd 3slactsd

= Back Cancel m

Figure 193: Set Members Page (Itemized Set)

The page displays a simple search row above the sort fields for searching for IEs
with the option to switch to an advanced search. The table contains the
following columns:

Table 55. Add Set Page Columns

Column Description

Check boxes Selecting these enables Data Managers to
(relevant only for itemized sets, and | perform an action on multiple items.

not present for view-only member
sets as in Figure 193)

Title Displays the title of the set member.

Type Displays the type of the content object: IE,
representation, or file.

PID Displays the unique deposit number
assigned to the set member.

SIP ID Displays the unique SIP number assigned to
the set member.

Producer Displays the name of the set member’s
Producer.
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Table 55. Add Set Page Columns

Column Description

Creation Date Displays the creation date of the set member.

View

Enables viewing the member using the
Rosetta Delivery module.

Info

Enables viewing the member using a Web
browser.

Export

Exports the IE to a zip file.

C

If the system returns results you want for your set, select the check
boxes beside the IEs, and then click the Add Selected button. If the
system returns no items you want for your set, try different search
parameters.

Repeat searches and add selections as necessary.
When you have your set, click the Save button.

The system saves your set and returns you to the Set List page.

To upload a text file containing the PIDs you want to include in your set, do
the following;:

a

b

Create a . txt file with one PID per line. PIDs should take the form of
1E[n], where n is the multi-digit ID. For example, 1E2984.

Click the Browse button of the Get IEs from File field.
Browse to the PID text file on your computer, select it, and click Open.
Click the Next button.

The text file loads, and the system checks for matches in the database. It
returns a status message at the top of the Set Members page, as shown in
the image below.
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Home = Data Management > Manage Sets and Processes » Manage Sets » Set Members
ltemized Set:  Items for Doc2332

Add Members

Primary su}rt:l Mons ;”As:c;l Secondary sort: | Mone ;”As:c ;I Sort | 1-40of 4 Records

Title Type PIDF | SIP ID | Preducer | Creation Date| Modifen Date
1 |- 23 IE IE1008 3 admin1 28/10/2012 28/10/2012 View Info More... «
2 I_ Sunset IE IE1027 ] admin 28/M10/2012 258/M10/2012 View Info More.. o
3 I_ Selenium |E IE1052 16 admin1 28/10/2012 258/10/2012 View Info More.. a
Title
R |_ Winter IE IE1052 18 admin 28/10/2012 258/10/2012 View Info Mo, .

Delete Selected

< Back

Figure 194: Set Members Page

e You can remove any items by selecting their check boxes and clicking
the Delete Selected button.

f  To complete the set, click the Add Members button to open the Simple
Search page. From here you can conduct a search for more IEs or, if you
are satisfied with your set, conduct a mock search that will take you to
the next page where you can save your set.

5 After you save your itemized set, the system returns you to the Set List page,
where the new set appears in the list.

NOTE:
Sets can be created and updated using APIs. For more information, see the

SDK documentation.

ltemized Sets - Adding Members

Data Managers can add members to the itemized set by manually selecting the
members.
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To add members to an itemized set:;

1 From the Set Members page of a new or existing set (see Creating Sets on
page 351), click the Add Members button.
Hame = Diats Mansgement = Mansge Ssts and Processes » Manage Sstz » 5=t Members
ltemized Set: 5IP 171 itemized sat13487 18862035
Primany sart: |La‘:hr.-| ﬂ I.I'I\SI:I".'HHIHII "J Sncondary sort: [Lahnl _'J I.r\.."I: ending :J sort 1-8 ol 56 [Ragods 123 &
Title Typz FID 2P ID Producer Creation Date Madification Date
1 T 000573937 Ireellecivs! Entty  IEI0E0 B adminl 28012009 1310:E9  ZEM1/2005 129058 View Infl bom, .
2 ™ 0JosE243 Irtellecival Entty  IEIDE3 B adminl 2G40 023091211:07 B2 View Infn Bowe e
3 02_fullsize Irtelleches’ Enlty  IETOF 4 adminl 19092008 1719.00  1801/2007 1709000 View Infl b, . o
4 rm_r-.-llsize Irtellzclies’ Enlty  IETO0ED 4 sdminl 12008 171901 18003 179000 Yiew Infa Boee, o
& I 200 yearzal  Iefellelus! Enbty  IEDIZ0 13 siminl  ORI22009054002 OO0 20005 0904402 Wiew Infn Mars e
Evelutian -
Delete Selected DERERE
= Back
Figure 195: Member List Page
The Search page opens.
Home = Data Management > | Manage Sets = Saarch
ltemized Set: Selected Books Number of Set Members: 4
Search Conditions
Search level: M| ntellectual Entity ) Representation O File
El Add Conditions
._.;:m of the following sonditions a :_;.l':'|.
Title {0C [ Contzing + x| 7|z ao%
Zaarch
El Results
1-3af3 Reconds
# 1 Tile Type PID SIFID Praducer Creation Date
e o] = . Dema lnteraal 2001140005 oo
1 [ Elue hills Irtellzctual Erdity 1E1000 1 Progucer (192308 = Info Export
- . i g Bl ~ Dema latemal 2000400058 a0 =
2 F  Eluehls Irnellzctual Entily  1E1003 R ey e Info Expo
- _— et iaa| B gq  Demalnlemal V0102 3 po |pre Sorer
3 F EBEilSwearms  Intellectual Erdily IE1D48 s — 155117 Info Expo
Ldd Salected
< Back Cancel m
Figure 196: Search Page
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4
5

Perform a simple or advanced search in the row above the sort selection
tields. For details on simple and advanced searching, see Searching and
Reporting For All Staff on page 23.

From the results of the search, select the members that you want to add to
the set by clicking the members’ check boxes. (See Figure 196.)

Click Add Selected.
Click Save.

New members are added to the itemized set. Data Managers can access the
members at any time.

Viewing Sets

Data Managers can view itemized and logical sets to see objects that are
included in a set as well as general information.

To view a set:

1

On the Set Members page (Data Management > Manage Sets > Set List)
locate the set that you want to view.

Do one of the following;:
B To view an itemized set, click Members.
B To view alogical set, click Results.

The Set Members page opens.
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ltemized Set:

Items for Doc2332

Add Members

Title
1 I_ a3
2 [ Sunset
3 I_ Selenium

Title

4 |- Winter

< Back

Primary sort: | Maone

Type
IE
IE

IE

IE

Delete Selected

PID
IE1DDE
IE1027
IE1052

IE1052

SIP 1D

9

]

16

18

;”Asc;l Secondary sort: | Mone

Producer
admini
admini

admini

admini

Creation Date| Medifcn Date

28/10/2012 28M10/2012  View
2810/2012 28M10/2012  View

28/10/2012 28M0/2012  View

2001072012 26001072012 View

Home = Data Management = Manage Sets and Processes = Manage Sets = Set Members

;”Asc;l Sort | 1 -4 of 4 Records

Figure 197: Set Members Page

For a description of the columns on this page, see Table 55.

Deleting a Set

Data Managers can delete a set. However, the Rosetta system does not enable
Data Managers to delete a set that is scheduled for, or is being used in, a task.

To delete a set:

1 On the Manage Sets > Set List page (see Accessing the Manage Sets Page on
page 350), locate the set that you want to delete and click Delete. The
confirmation page opens.

2 C(Click OK.

The set is deleted from the Rosetta system.
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Working with Processes

This section contains:

B About Working with Processes on page 363
Viewing All Existing Processes on page 363
Viewing Process Information on page 365

Running a Process on page 369

Aborting a Process on page 373

About Working with Processes

Data Managers can view processes that are executed in the Rosetta system.
Processes consist of:

B Tasks, which are programs that perform operations on an object in the
system. For example, a task may create a thumbnail of an image file.
Similarly, a task may extract metadata from a file. Tasks are the basic
building blocks of operations in the system.

B Task chains, which are ordered lists of tasks. For example, a task chain may
contain the following tasks:

®  Creating thumbnails
B Adding metadata from the collection management system (CMS)

B Adding Oracle text (used for better indexing in the Permanent
Repository)

Viewing All Existing Processes

Data Managers can view a list of all existing processes.
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To view all existing processes:

From the Data Management main menu, select Manage Processes. The Process
List page opens.

Haome > Diata Management > Manage Sets and Processes * Process List

Filter [#0 = Find in [AT > [==]

1 -5 of 5 Records
i} Name = Task Chain Name Task Chain Grps Scheduling Status Dat
42432 FastTrack (Valids Validation Stack- Validation Stac  As Soon As 5313 Dup Update Update More
Stack- Multiple Vi Multiple Virus Webeditor - Possible B:21 PM Schedule St -
CheckscOU, IE1{ ChecksciU Staging , Wek
2 o 43376 FastTrack (Valid: Validation Stack- Validation 5tac As Soon As 5/3/13 Dup Update Update More
Stack- Multiple Vi Multiple Virus Wisheditor - Fossible 221 PM Schedule Sst -
CheckshDM, |IE1{ CheckshiM Staging
3 o 41503 FastTrack replacelMC Webeditor - As Soon As  5/3/13  Dup Update Update More
{replacel:C, IE1Q Staging . 821 Passible B:21 PM Schedule 5at -
- Permanent
4 o 4Z27E Process for set: PoplETestTC Maintenance As Soon As 5/3113  Dup Update Update More
& logical Possible 821 PM Schedule 5=t A
Process

1357801445084

n

42262 Process for set: PoplETestTC Maintenance As Soon As 5
& logical Possible B
set136TE014320(

31  Dup Update
=T Schedule 5=t

Update Parameters History Delete

< Back

Figure 198: List of Processes Page

The page contains the following columns:

Table 56. List of Processes Page Columns

Column Description

Active Indicates the process status:
B Yellow - The process is active.
B Grey - The process is inactive.
ID The process ID generated by the Rosetta system.
Name The name of the process.
Task Chain The associated task chain.
Name
Task Chain The name(s) of the group that can access the process.
Groups
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Table 56. List of Processes Page Columns

Column Description

Scheduling Displays the day, date, and/or frequency of the running of the

process.

Status Date Displays the last date on which the process status was changed.

Actions available for the process list items appear to the right of the information
columns and expand when you click the More... text with the down arrow.
These actions include:

Duplicate: Duplicates the values for this or any other process listed in the
task chain. Sends you through the process creation wizard.

Update Schedule: Allows you to change the values for the scheduling of this
process. (Takes you to the scheduling page.)

Update Set: Opens the set slection page, where you can choose a different
set for this process.

Update Parameters: Takes you to the Complete Parameters page, where you
can can change parameter values for this process.

History: Takes you to the Monitor Process History > Summary page, where
you can view information such as status and run-time for the process.

Delete: Deletes the process from the system and the table.

Viewing Process Information

Data Managers can view various details about the processes, including a list of
processes that are currently running and a summary of completed processes.
Data Managers view process information by Accessing the Process Execution
History Page (see page 365). The following activities can be performed from this

page:

Viewing Completed Processes (see page 367)
Viewing Process Executions (see page 367)
Viewing Summarized Execution History for a Process (see page 367)

Viewing the History of Execution Exceptions for a Process (see page 368)

Accessing the Process Execution History Page

The Process Execution History page enables Data Managers to view the list of
processes that have been executed in the Rosetta system.
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To access the Process Execution History page:

On the List of Processes page (see Viewing All Existing Processes on page 363),
locate the process you want to view and click History. The Process Execution

HiStOI‘y page opens.
Home > Data Management > Manage Sets and Processes » List of Process Executions
Filter: |All siatuses Find in [An =[]
- & of 19 Records 220
10 | Hame Tack Chain | Start Diat| Finished On Status Progres: Est. Rem
1 TTT73Process for UnassignAR 016 MA Summany Renn Delete

BHESNETZ2 Re
TT825 Process for AssignARto
SIP 1367600 Task -Test

P

(=]
3

MA Summarny Rern Delete

3 55448 Fastcheck checkURMS 573413 313 846 MA Summany Rerun Delete
: :k.l :H.l
4 42231 Process for PoplETestTC 503013 B3 BAT MA& Summany Rerun Delete
set136TED1 BATPM PM
5 BE549 FastTrack Validation 313 W33 91T NA  Exceptions Summary Delete
[Wal[E1108) Stack- Fu ST PM PM With Emor

< Back

Figure 199: Execution History page

The Execution History page contains the following columns:

Table 57. Execution History Page Columns

Column Description

ID The process ID

Name The name of the process

Status The status of the last execution

Started On The start date of the last execution

Finished On The end date of the last execution

Successes The count of successful executions of the process
Failures The count of failed executions of the process

Failure Note Displays a description of the last failure

Exceptions Enables viewing the execution history exceptions.

Summary Enables viewing a summarized execution history of a process.
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Viewing Completed Processes

Data Managers can view whether a process completed normally, or experienced
a problem during execution.

To view completed processes:

On the History Execution page (see Accessing the Process Execution History
Page on page 365), in the Filter drop-down list, select Completed. Only
completed processes are displayed.

Viewing Process Executions

Data Managers can view a list of all processes that are currently executing.

To view process executions:

On the History Execution page (see Accessing the Process Execution History
Page on page 365), in the Filter drop-down list, select Running. Only those
processes currently executing are displayed.

Viewing Summarized Execution History for a Process

Data Managers can view a summarized execution history of a process. This
enables them to see a summary snapshot of the process’s last execution.

To view a summarized execution history for a process:

On the History Execution page (see Accessing the Process Execution History
Page on page 365), locate the process you want to view and click Summary. The
Execution History Summary page opens.

Home = Data Management = Manage Setz and Processes = Monitor Process History = Summary

Id 225312 Hame Copy of large Tazk Chain Metadata Validation Set Id 194311
Created On 23/05/2013 Created by admin1 Started On Z3/05/2013 Finizshed On
Status RUNMING Status Date 23/05/2013 Total Run Time

General Information

Total IEs Processed
Total committed IEs

Figure 200: Execution History Summary Page

Total IEs with exceptions 17
4 Total IEs sent to commit 54

= r I =]
=

The Execution History Summary page displays the following fields:
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Table 58. Execution History Summary Page Fields

Field Description

ID The process ID

Name The name of the process

Task Chain The name of the task chain

Set ID The ID of the set that is using the process

Created On The creation date of the process

Created By The name of the user who created the process
Started On The start date and time of the execution

Finished On The end date and time of the execution

Status The status of the execution

Status Date The date and time of the Status field’s last update
Total Run The total run time of the execution. This is based on the Started On
Time and Finished On fields.

Total Records | The total number of objects processed
Processed

Total Records | The total number of processed objects with exceptions

with

Exceptions

Total The actual number of records committed to the database over the
committed course of this procedire’

records

Total records The total number of records sent to be committed to the database.

sent to commit

Click Back to return to the previous page.

Viewing the History of Execution Exceptions for a Process
Data Managers can view the history of exceptions for a process.
To view the history of execution exceptions for a process:

On the History Execution page (see Accessing the Process Execution History
Page on page 365), locate the process for which you want to view exceptions
and click Exceptions. The Execution History Exceptions page opens.
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Home = Data Management » Manage Sets and Processes = Monitor Process History = Exceptions

1 -1 of 1 Records

PIDv Title Exception

1 IE1038 Sunset VIRUSCHECK_FAIL:vs_Error 1838  View Info

-

Figure 201: Execution History Exceptions Page

The Execution History Exceptions page contains the following columns:

Table 59. Execution History Exceptions Page Columns

Column Description

PID Displays the ID of the SIP to which the object belongs.

Title Displays the SIP name.

Exception Displays a description of the exception.

View Displays the IE that failed during the initial delivery
process.

Info Opens the object in the Web editor.

You can rerun the process on the items in the exception list by clicking the
Rerun Process button.

You can create a set for further use of the exceptions by clicking the Create Set
button.

Running a Process

Data Managers can run jobs based on processes and task chains that have been
set up in the system. The processes are applied to IEs, representations, or files,
as specified in the Level column of the Choose Task Chain page (see below).

To set up a process:

1 From the Process List page (Data Management > Manage Sets and Processes
> Manage Processes), click the Add Process button.

The first step of the Add Process wizard opens, Choose Task Chain.
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2
agement::-r.mnageSetsandF‘ruu:esses::-r.1anageF‘ruu:&sses}EhuuseTaskChain@}2 3-4-5

Name Group Lewel Status Status Date
1 % Metadata Validation Maintenance , Webeditor INTELL_ENTITY Active 16/06/2013
Staging , Webeditor - 111523
Permanent
2 {° Create Operational Maintenance , Webeditor INTELL_ENTITY Active 16/06/2013
Thumbnails Staging , Webeditor - 111523
Permanent

3 { Create Persistent ldentifier Maintenance , Webeditor INTELL_ENTITY Active 16/06/2013

(Handle} Staging 111523
4 ' Rebuid Repository Search Maintenance , Workbenc INTELL_ENTITY Active 16/06/2013
Indexes Webeditor - Staging , 11:15:23
Webeditor - Permanent
5 € REPLevelTC Walidation Stack | Mainten REPRESENTAT Active 17/06/2013
, Webeditor - Staging , 09:21:39
Webeditor - Permanent
& {7 File Level TC “alidation Stack , Mainter FILE Active 171062013
, Webeditor - Staging , 09:24:10

Webeditor - Permanent

coce x|

Figure 202: Choose Task Chain

2 From the list of task chains, select the one that suits your purpose.

NOTE:
The Status should be Active and the Level should match the level of
object (IE, representation, or file) that you want the process to encompass.

3 Click Next.

Step two of the wizard, entering parameters, opens.
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Home = Data Manaaement = Manaae Sets and Processes =
Manage Processes = Complete Parameters

General Info

* Process Name |
Priority Narmal -

Parameters

E| MetadataValidationTask - MetadataValidationTask

Mo Parameters

Email Motification

Send email? Yeg v

*  Email |

= Back Cancel

Figure 203: Parameters Page for Process

4  Enter a name for this particular process. The name will be used to identify
this process in a list of all processes.

5 Select the priority for this process.

NOTE:
Fasttrack processes (processes initiated via the Web Editor) are set to high
priority by default.

6 Enter any required parameters and enter optional ones, as needed. (Some
processes require no parameter specifications, others require several.)

7 Set the email notification level to receive an email notification when the
process completes, only when it fails, or never. (Your registered email
address will be added automatically; recipient addresses can be added,
separated by semicolons.) When you are finished, click Next .

Step three of the wizard, defining the set, opens (Figure 204).
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NOTE:

Only objects of the type specified in your initial process selection appear
in this list. For example, this process acts on files, so the available sets are
limited to those with an Object Type of File.

1-20Gm4-5

Data Management = Manage Sets and Processes = Manage Processes = Define Set

1-4 of 4 Records

Hame Set Type | Object Type | Created By Creation Date
1 % File level set 81310 Logical File adrmin1 170672013 10:28:17
2 {0 MissinglES_SET_ShZ  Logical File admin1 18/068/2013 23:13:30
3 {0 SIPDNG logical =et137  Logical File adrmin1 1710672013 09:23:20
4 { SIP521 logical set1371 Logical File admin1 17/06/2013 09:25:58

I Exclude objects that have already been processed (only objects that have been updated since
the last processing day will be included)

Figure 204: Define Set for Process

8 Select the set to which you want to apply the process. Select the check box

below the list if you want to apply the process only to new objects. When
you are finished, click Next .

The scheduling step of the wizard opens (Figure 205).

1-2-3-@m5

Data Management = Manage Sets and Processes = Manage Processes = Scheduling Once

Start At
@ Time |2|;| L" 10 j
Weekly Date | 21 ;" June ;" 2013 ;I il

Meonthly

Advanced

Figure 205: Scheduling the Process (Once Option)
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9 Select the type of schedule you want the process to follow from the left side
of the page, then enter details on the main part of the page. When you are
finished, click Next .

The Review and Confirm step of the process wizard opens (Figure 206).

ht = Manage Sets and Processes = Manage Processes = Review and Confirm 1-2-3-4 @

General Information

Hame File Proc 1.2
Parameters For Tasks

uze_general_paramater
Fixity List MD5,SHA1 CRC32
Format ldentification Method FFCroididentifier

Set Information

Setid 2013925

Name File level 2et 81310
Scheduling

Once At: 21/06/2013 at 20:10:00

Figure 206: Review, Correct, Confirm, Submit

10 Review the information regarding the process you just created. If there are
errors, click the Back link until you arrive on the page containing the error,
and make any necessary changes. When the process is completed to your
satisfaction, click the Submit button.

The process is set to run as you specified in this procedure.\

Aborting a Process

To abort a running process, click Abort. Rosetta removes all waiting bulks of IEs

from the process queue and the process ends after the current bulk of IEs is
completed.
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Publishing

This section contains:

B About Publishing on page 375

B Configuring Publishing on page 376
B Converter Types on page 381
n

Target Types on page 381

About Publishing

The Publishing module in Rosetta accommodates the increasing demand for
libraries to provide their users with integrated Web-based OPACs and instant
retrieval of all available resources based on a user’s search and access rights.

The Rosetta Publishing module integrates the following components in a
hierarchical system, where the Publishing configuration is the highest-level
entity that organizes the sub-entities, set and profile, as follows:

B Publishing configuration — a logical definition for a group of IEs (a set)
bound to converters and targets using certain rules and having attributes
such as name and status.

B Publishing set —a group of conditions applied to IEs” DNX and
descriptive metadata (indexed fields) that defines the IEs that will be
processed

B Publishing profile — the technical definitions for the Publishing module.
These consist of two parts:

B Converter — the type of conversion used on the IEs.
B Target — the physical location where the IEs are published.

The converter and target make up the publishing profile, which, together with
the publishing set, make up the publishing configuration.
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Configuring Publishing

The Web pages and their associated tasks for configuring Rosetta publishing are
described below.

Opening Page: Publishing Configuration List

To begin configuring the Publishing module in Rosetta, follow the path: Home >
Data Management > Publishing Configuration List.

Home = Data Management > Manage Sets and Processes > Publishing Configuration List
Filter a1 =] Find in [ A =l Go
Add Configuration 1 -1 of 1 configurations
Active | | Mame Description | Update Date
1 All 12011:2012 Update Cuwplicate  Delets More... a
20:57:18
Sync C 1
< Back

Figure 207: Publishing Configuration List Page

The following viewing options are available from the Publishing Configuration

List page:

B Filtering the list by Active, Inactive, or All

B Searching the list using the Find field, entering a keyword, specifying search
fields, and clicking Go

B Sorting the list by date, description (alpha), or name (alpha) by clicking the

corresponding column header

Actions that can be launched from this page are:

Adding a new configuration (Add Configuration button)
Updating an existing configuration (Update text link)
Duplicating an existing configuration (Duplicate text link)
Deleting a configuration (Delete text link)

Synchronizing configuration (Sync Configuration text link): runs the task
that checks if there is an update that needs to be published, and, if there is,
publishes it.

376
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Adding/Updating Configurations

The Publishing Configuration Details page opens when you click the option to
add, duplicate, or update from the Publishing Configuration List page.

The page contains three tabs and opens to the General Details tab.

General Details Tab

The General Details tab provides a name for the configuration and an optional
description. The Name and Description values appear on the Publishing

Configuration List page.

Configuration Id
Created On
Updated On

General Details

lanage Sets and Processes = Publishing Configuration = Publishing Configuration Details

184030
041142013 08:3917
041142013 08:3917

admin
admin

Created By
Updated By

* Name Inew pu

Description

Republish ]

< Back

blishing job

| Sync ] Save | Apply

Figure 208: Publishing Configuration - General Details

Selecting the Republish check box republishes all records in the set whether or
not they have been updated since the last publishing job. This option can be
used if you have changed your job's profile details (for example, changes to an
xsl file). The check box remains checked until the next (successful) publishing
job, after which it is automatically cleared.

Sets Tab

The Sets tab of the Publishing Configuration Details page allows you to create a
set through a short wizard and add that set to a configuration.

For information on creating sets, see Creating Sets on page 351.

When you have created at least one set, you can click the Add Sets button from
the Publishing Sets page. In Figure 207 on page 376, only one set has been
saved. Select it and click the Add Selected button to make this your set for the

publishing configuration.
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NOTE:
Ex Libris recommends that you limit your set selection and your profile
selection to one each for each publishing configuration.

Profiles Tab

Profiles consist of converters and targets that process the sets created for
publishing. Profile information is accessed by clicking the Profile tab from the
Publishing Configuration List page (Data Management > Manage Sets and
Processes > Publishing Configuration > [Add or Update Configuration] >
Publishing Configuration Details).

Home = Data Management = Manage Sets and Processes = Publishing Configuration * Publishing Profiles

Profiles

Mo Profiles

Figure 209: Publishing Configuration - Profiles

Any existing profiles are listed. (None are shown in Figure 209.)

To add a profile:

1 Click the Add Profile button.
Step 1 of the profile wizard opens.

2 Enter a name for the publishing profile in the Name field (required) and a
description in the Description field (optional).

3 Select the Preservation Type from the right pane to move your selection to
the left pane. You can select multiple preservation types.

4  The Status field defaults to Active. To change the profile to inactive, use the
drop down selection.

5 Select a Converter Type and a Target Type from the drop-down fields
(defaults are selected, as shown in Figure 210).
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Home / Data Management /| Manage Sets and Processes / Publishing Configuration / A4

* Name Status | Active -
Description
o
Preservation Type 0 items selected Remove all Add all

Preservation Master
Modified Master

Derivative Copy

* Converter Type OaiCollectionConverterPlugin ~ ~  Include CMS

* Target Type NFSPublisherPlugin -~ Include Access Rights

Figure 210: Add Publishing Profile - Step 1

NOTE:
The converter and target types are required. For more information on
converters, see Converter Types on page 381. For information on targets,
see Target Types on page 381.

6 Use the check boxes (Include CMS and Include Access Rights) to include
the relevant metadata in the profile.

7 Click Next.

Step 2 of the wizard opens. Selections and entries you made in Step 1 show
in the header and body sections of the form. Any parameters required for
converter and target types must be entered on this page.
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Dats Management > Manage Sets and Processes = Publishing Configuration = Add Publishing Profile - Step 2 1 @

MName Publishing\Wems Created By
Description Created On
Include CM5 Include Access Rights (|

El IEToOAl-converter Converter Parameters

El OAl-Publisher Publisher Parameters

* Data Source Namejava:/jdbc/Rossettals
* Set Spec |
* Metadata Format |api3|_r

< Back Cancel m

Figure 211: Add Publishing Profile - Step 2

8 Enter any required parameters and click Save.

The Profile Page refreshes with the new profile listed under the Profiles tab

(Figure 212).

> Data Management = Manage Sets and Processes = Publishing Configuration > Publishing Profiles
Configuration |d M TFTE
Created On 20/07/2013 18:58:18 Created By  admini
Updated On 20/07/2013 18:59:07 Updated By  admini

Profiles
Add Profile 1-1of 1 profiles
BActive Hame Converter Target Update Date

1 Publishing |IEToOAl-converter OAl-Publisher 20/07/2013 View  Duplicate Delete

with CMS 16:54:08
< sl Apply

Figure 212: Publishing Profile for Configuration

Once you have created a profile, you can synchronize it with the general

configuration, save it to the system, or apply it (saving while remaining on the
same page) to the profile.
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Converter Types

Converters take the relevant information from the IE and prepare it for
publication. Different converters take different fields from the IE (descriptive
metadata, DNX, source metadata) and create different structures of XML files
(OAI DC, Xepicur).

The following plug-in converters are supported by Rosetta:
B CMS: Converts the metadata fields of the IE into fields published to Aleph.

B OAL Takes the descriptive metadata fields of the IE and creates an XML in
OAI-DC format.

B Xepicur: Converts the fields of the IE published to the DNB (German
National Library).

B XSL: Allows libraries to use any kind of XSL file that converts the metadata
fields of the IE (in DC format) to any other XML format.

NOTE:
Several XSL examples are located under /exlibris/dps/d4_1/
system.dir/xsl/, and they will be overwritten by Rosetta service packs.
If you customize these files, rename them or move them to an alternative
location.

Target Types

A target is the physical location where the published metadata is sent as part of
the publishing process. Targets are available for external systems to harvest.

The currently supported targets are:

B OALI According to the protocol OAI-PMH, the published metadata is stored
in database tables and can be harvested by external systems.

For more information regarding OAI-PMH see http://
www.openarchives.org/pmh/.

B NFS: Used when the published metadata should be stored in the file system
to which the system that harvests the data has access.

The target types, NFS and OAI, are configured with the converters according to
the specifications required by the converters.

Figure 213 and Figure 214 below are examples of converter-target
combinations.

September 2016 381
Ex Libris Confidential



Staff User’s Guide, Part VII: Data Managers
Chapter 38: Publishing

E| XSL-converter Converter Parameters

* X5L File |

El NFS-Publisher Publisher Parameters

* Folder |

* Humber Of Sub-directories |

* File Extension |

Figure 213: XSLConverterPlugin

E| XEpicur-converter Converter Parameters

* Status Type LN FE

ELIFE e

B 0Al-Publisher Hurl_insert
url_update_general

* Data Source Namejava /jdbc/PUBDS

* Set Spec |

* Metadata Format |epi|:l.|r

Figure 214: XEpicurConverterPlugin

NOTE:
The forms differ for each converter type.
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Delete, Restore, Move, and Purge IEs

This section contains:
B Deleting, Restoring, and Purging an IE on page 383
B Moving IEs on page 393

B Restoring IEs from the Permanent Repository on page 398

Deleting, Restoring, and Purging an IE

The section includes the following information:

About Deleting, Restoring, and Purging an IE on page 383
Deleting an IE from the Web Editor on page 384

Deleting IEs in Bulk on page 386

Recovering an IE from the Recycling Bin on page 391
Purging an IE from the System on page 393

About Deleting, Restoring, and Purging an IE

When IEs are deleted from the system, they are sent to the recycling bin, and
their status changes to Deleted. From the recycling bin, they can either be
restored to their original status or purged from the system.

NOTE:
IEs in the recycle bin retain their CMS information, and the Metadata
Orphan Handler does not update the CMS system until the IEs are

purged.
When an IE has been purged, only provenance events remain on record in the
system.
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Deleting and restoring can be performed by a user with the role of Editor - Full.
Purging an IE from the system can only be performed by a user with the role of
Data Manager.

NOTE:

Deleting and Purging an IE are assigned to different roles in order to
avoid accidental and permanent deletion of an IE.

The following table describes user actions and system behavior related to
deleting, restoring, and purging IEs.

User Action

Delete IE(s) (from
the Web Editor or
using a system
process

Table 60. Deleting, Restoring, and Purging IEs

System Actions

Changes the IE status to Deleted
without any other actions

Resulting IE Status

Deleted — cannot be viewed,
edited, published or searched
for (but can be recovered).

Recover IE (from

Changes the IE status to In Permanent.

In Permanent

provenance events that remain for
audit and logging.

the recycling bin)

Purge IE Deletes the streams and the Deleted — cannot be viewed,
permanently (from | operational data, all the metadata edited, published, or searched
the recycling bin) from the METS file except the for (and cannot be recovered)

Deleting an IE from the Web Editor

When a user deletes an IE, the IE becomes unavailable for standard actions in
the Web Editor.

To delete an IE:

1 Perform a search on the database (through Data Management > Search for
Objects, for example) to find the IE you want to delete.

2 Click Info in the row of the object you want to delete.

The object opens in the Web Editor (Figure 215).
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Home = Dada Managemaent = Seacch_and Sets = Seacch_for Ohjects = Intellectual Entity

Intelleciual Cntity PIDIE! 4074 Creatgd on 200C-1005 12 12:24 Created by acaval
Upidatesd an 200210405 190733 Updated Iy admenl SIP 1 153
Wersion 1
O Locked By: Ma.
- IE |: .E“ﬂ?‘l:‘ Ohject Summany Flesdad ata BRrdices Wetimians
= Pieservation Elaster, Hewvision 1 [IlEPi-tn?{';]
= File (FLOF?, G1HE b PID IE127074
= Modified Master, Revision 1 (REP448190) SIP 1D a5
- File [FLABZ0, 191ER ) Created an A00E-10-05 15.13:24
Craatad hy admini
Updated an AJE-10-05 19 13:24
Upel ated by adminl
Entity Type Defautic
Humbar of Reps ?
< Back actigne: [Dolels 12 -
IE Expoad

= Ex Likiis L1, 2000 Corarnit Changas Temns of Lisg

Rallkack Chamges

Add Rearesenlalian

Figure 215: Deleting an IE
3  Click the IE in the lower left box of the Web Editor so that it displays a
yellow highlight.

4 In the bottom pane, click the down arrow of the Actions drop-down field
and click the Delete IE option.

NOTE:
The Delete IE option does not appear in the drop-down list if you have not
locked the object. All objects must be locked before action can be taken on
them. (This prevents two users from interfering with each other’s work.) If
you see an option to lock the object, select that and click the GO button.
When the page refreshes, you should see several options in the drop-
down list, including Delete IE.

5 Click the GO button.
The Deletion Reason and Note Page opens (Figure 216).
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Home > Data Management = Search and Seis = Search for Ohjects > Deletion Heason and Hotle

You have requested Lo dalele an |E o the peomanznt reposilory, please enter a reason and a nole (optional).

* Reasan [Duplicats =

Optional Note This informecion will remain a3 provensnce informacion |
even i che object is pueged from che Syscem.

Figure 216: Deletion Reason and Note Page

6 Use the drop-down menu to select a reason for the deletion.

7  Enter a note in the text field if you want more information to be recorded
with this action.

8 Click the Save button to complete the deletion of the IE.

Deleting IEs in Bulk

The bulk delete process deletes IEs by removing them from the permanent
repository to the recycle bin area. Users schedule the process using two input
parameters:

B Task chain - created using the task chain UL
B Set of IEs — created using the set management UI. To create a set of IEs (an

itemized set), see Creating an Itemized Set on page 354 of this guide.

To create a process that deletes multiple IEs:

1 From the Management Home page, click Data Management > Manage
Processes.

The Process List page opens to existing processes.
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1

&w.l: v = [t Llnaeeneat = Prodaess Lizl

Fiiger |-'"-'| > Femet im [ #2 = G

Akl Paotes 10 e 22 Raemands L2 i

I Home -~ Tosk<haln Hamg

w# G0 Bsnan docags Assign ALCess Duplicate Update  Llale Licce
Rghils Pty Faras Pooy Srhedde Sl a

Uplate Faiameters  Histay  Deete

Cupleate Updale  Updale Lo
Sohedule Ser -

8 32075 FasiTrack fWatcation '
Fuegly il IESFLEY - Pty O
IE 3738

Hogsie 4

2

Figure 217: Process List Page

Click the Add Process button.

The list of task chains opens. This is the first step of a 5-step wizard that
guides you through the creation of the process.

[

o

=)
r?r:nl".'l Home = Data Management = Manage Processes * Choose Task Chain @ 2 3 k! 5

Mamienagnoe Actre QAri1g011 22: 2755
£ tiznzl Thumbnails Ensichment , Maintenance |, W Acine QU011 230420
- Slaging . Webeditor - Permg
10 ¢ Risk dentficatan Maintenance Actie Q401103011 222356

Name Group« Status Status Date

= umTaskChain =neichment |, Meve to Permanent , Aclive 051102011 034603

daintenance | Weabeditor - Siagin

¢ Rebuild Repasitary Search Indewxes Acine Q43T 222745

& Create Dormeatres Copy Representabicn M;

Aot Q412019 2227 55

¢ Creste Operaticnal Thumbnails Maintenance beditor - 3taging | Aol Q112011 22:27:55
Wabeditor - Permanent

¢ Create Parsistent [dentifiers Maintenance . Webeditor - Staging Aclie Q413011 22:2T:455

= Publish Intellaciual Eatity Mamtenance | Wabeditor - S1agmng At Q40113011 222145

Mamienance | Waebehtor

Aot Q42019 2227 55

el Emtity

(e

3

Figure 218: Delete IE in the List of Task Chains

Select the Delete IE task chain and click the Next button.

The Complete Parameters (step 2) of the wizard opens.
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no. Home = Data Management > Manage Processes
% D@ 3

Ln

* Complete Parameters

General Info

* Process Name

Parameters

E' RollBacklETask - RollBackIET ask
Ho Parameters

:E] Cms Update - Cms Update
HNo Parameters

IEJ AddProvenanceTask - Add Provenance Task

* Reason | Copynights Violation |
Optional Note =]

El Move To Permanent Task - Move To Permanent Task
No Parameters

[ OBJECT INDEX TASK - Object Index Task
No Parameters

IEI DeletelETask - Move Entities To Recycle Bin Task

Delete Permanently [~

< Back Cancel MNext

Figure 219: Complete Parameters - Step 2

Enter a process name and a reason for deleting the IE set.

Enter an optional note to be retained as provenance material even if the IE
set is purged from the system.

To purge the IE set immediately from the system, select the Delete
Permanently check box. (This is equivalent to purging the IEs in the recycle
bin.)

Click the Next button.
The Define Set step (3) of the wizard opens.
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Name =

-t

= lemized Set for Sip 47

2 eHMemized Set for Sip 140

Lad

o Hemized Sel for Sip 141

4 eitemired_set for_create

Fis]

citemized_sel_for_regress

oh

cilemized_sel test 19506
T eilemized set test 95440
& «Logical Set for Sip 388

10« pagination set test

e ncludad)

< Back Cancel

o8 .
r-.,-_"\i’-‘: Home = Data Management = Manage Processes = Dafine Set 1

2@4

1 - 10 of 35 Records

| Set Type . Chjact Type

ltemized
lkemized
ltemized
kemized
lkemized
ltemized
ltemized

Legical

9 elogical_set_for_tesi_<3212  Logcal

Lagical

Intellectual
Intellectual
Intellectual
Intellectual
Irtedleciual
Intedlectual
Intellectual
Intellectual
Imtedleciual

Inteflectual

Entity
Entity
Entity
Entity
Entity
Entity
Entity
Entiby
Entity
Entity

Created By

admini
admini
admini
admini
admini
admini
admini
admini
admini

admini

Craation Date
04112011 23:33:12
05/11/2011 00:27:038
05112011 00:29:15
05M14/2011 0258414
05/14/2011 00:33:19
Q4192011 22:56:12
Q41142011 228314
05/14/2011 02-36:17
05/11/2011 09:-32:09
051172011 02:11:44

[T Exclude sbjects that have already been processed (only chjeets that have been updated since Lhe last

MNext

5

Figure 220: Define Set - Step 3

8 Select the itemized set you created for this process and click Next.

NOTE:

Select the Exclude... check box to avoid objects that have already been

processed.

The scheduling step (4) opens.
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&TJ Home = Data Management > Manage Protesses = No Scheduling 1 2 3 @

w

Mo Scheduling Mo Scheduling

Once

Srhanced

<Back Cancel MNext

Figure 221: Scheduling - Step 4

9 Select the interval in the left column of the page and enter values in the right
column as they display. To run the process right away, leave the default
value, No Scheduling. Then, from the process list, click Run Now for your
process.

10 Click Next.

The Review and Confirm step (5) opens.
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Ata Management = Manage Sets and Processes = Manage Processes = Review and Confirm

123~ 4-(5)

General Information

Hame Creating Replicas

Parameters For Tasks

Representation Code MEDHLIM
Preservation Type PRESERVATION_MASTER
Task Id Jp2000

Set Information

Setld 185002

Hame itemized_set_for_regression_test26840
Scheduling

Hot Scheduled Mot Scheduled

Figure 222: Review and Confirm - Step 5

11 Review the information. To change any information or parameters, use the
Back button(s) to take you to the necessary page.

12 When the process is complete, click the Submit button.

The system adds your process to the Process List page and carries out the
process to your specifications.

Recovering an IE from the Recycling Bin

IEs that have been deleted through the Web Editor can be recovered from the
Recycling Bin. Retrieving an IE from the Recycling Bin restores it to its previous
location in the database.

NOTE:
If you have moved the IE from one instutition to another, the restoration
will move it back to the earlier institution.
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To recover an IE from the Recycling Bin:

1 From the Home page, roll your cursor over the Data Management tab, then
select Recycle Bin under the Delete From Permanent heading.

Proghscers Submissions (:'-Ddtu Ildnagullur-l':} Praservation

Search and Manage Oueries Collection Mandqunum_ Manag_e Sets and Processes  Delete From Permanent  Acheanc

Saaieh faf Objacts Collection Managemanl Manage Piocesses He el i_"--""-\._ Run Rep
Search for Metadata sdanitor Process Histony o .q i__.-"' Users Lis]
Saved Quanes Manage Sels

Fublishing Condiguiatior

List of Accez Rights Excepbons

Figure 223: Recycle Bin Link on the Data Management Page

The Recycle Bin page opens. Any IEs that have been deleted but not purged
from the system are listed with identification information and information
on their deletion. Items can be sorted by clicking the column headers you
want to sort by and filtered by selecting an option from the Filter drop-
down list.

A7 Home > Data Management > Delete From Permanent > Deleted IEs List
Filter | Al v Find: in: Cmsid ¥ || Go
1-20f2 records
# | Title PID CMS ID | Deleted By Delete Date Status

Selenium Tite IE1198 Bulk Delete Process  15/03/2016 21:27:10 Deleted viewMETS Recover Delete Permanently More.. -

(50698)
2 SeleniumTite [E1201 Bulk Delete Process 15/03/2016 21:26:57 Deleted viewMETS Recover Delete Permanently More.. -

(50602
Back Action:| Recover v m

Figure 224: Recycle Bin Page

Action items are also listed in each IE row:

®m  view METS displays the METS XML for the IE

B Recover restores the IE from the Recycle Bin to the repository
B Delete Permanently deletes the IE permanently
n

Retry attempts to delete an IE after a previous attempt failed. This option
only appears for IEs with status Fai led.

B More opens a third link, View Reason and Note, which, when clicked,
displays the PID, Delete Date, and the reason and note explaining why the
IE was deleted.

2 To restore a single IE, click Recover on the corresponding row. To restore
more than one IE, select the check box to the left of the title for each IE you

392
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want to restore, then select Recover from the Action field and click the
Submit button.

The system restores the IE or IEs you selected and refreshes the page with a
message that it successfully restored the IE. The items that were restored no
longer appear on the Recycle Bin page.

Purging an IE from the System

Users with the role of Repository Manager can permanently delete IEs from the
system.

To purge an IE from the system:

1 Log on in the capacity of a Data Manager.

2 Open the Recycle Bin page by clicking through Home > Data Management
> Delete From Permanent/Recycle Bin.

3 Do one of the following:

B Click the check boxes beside the names of the IEs that you want to delete
permanently, from the Action drop-down list select Delete
Permanently, and click Submit.

B Select Delete Permanently in the row of the IEs that you want to delete.

To delete all of the IEs in the Recycle Bin, select Delete ALL Permanently
from the Action drop-down list and click Submit.

If the deletion is successful, the system sends a confirmation message to the
user, permanently deletes the IEs, and saves provenance information.

If an IE fails to be deleted, it is given the status Fai led. You can retry to delete
failed IEs by clicking Retry in the row of a failed IE, or select Delete ALL
Permanently from the Action drop-down list and click Submit.

Moving IEs

In the course of managing a consortium with several institutional and
departmental members, libraries may want to move some or all of the IEs from
one location to another. A task chain accessed from the Data Management
module of Rosetta provides the steps for carrying out the transfer of IEs.

The following rules and conditions apply when transferring IEs:

B The initiating member needs to own the IEs being moved (but does not need
permissions for the target institution)

B Moving IEs between institutions/departments generates a provenance
event.
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®m If an IE is assigned to a collection, and the institution changes when the IE is

moved, the collection will be unassigned.

®m If an IE's source and target departments are identical, the IE will be ignored

by the task.

To move IEs:

1 From the Process List page (Data Management > Manage Sets and
Processes > Process List), click the Add Process button (see Figure 225).

Home = Data Management = Manage Sets and Processes = Process List

Filter | AN =

[[n] Hame Task Chain Name | Task Chain Gro
[ 110164  Assign Access Rights Maintenance
Palicy
[ 28948 Process for set: Preservation PopRepChars Maintenance

Medified Master logical set

Figure 225: Add Process Button on Process List Page

The Choose Task Chain page opens (Figure 226).

ts Management > Manage Sets and Processes » Manage Processes » Choose Task Chain @" 23
Name Group Level Status Status Date
() Rebuild Repository Search e , Work INTELLECT_ENTITY Active 120272014 21:00

- Staging

2 () Export Intllectual Entities , Work INTELLECT_ENTITY Active 1202/2014 21:00
3 lebs INTELLECT_EMNTITY Active 120272014 21:00
- INTELLECT_ENTITY Active 12022014 21:00
5 , Webs INTELLECT_EMNTITY Active 120272014 21:00
i INTELLECTIENTITY Active 12022014 20:54
T % INTELLECTI_ENTITY Active 12/02/2014 21:00

Cancel et

Figure 226: Choose Task Chain Page
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2 Find the task chain named Move IE to Another Institution/Department and
select it. Then click Next at the bottom of the page.

The Complete Parameters page opens for the task chain you selected

ata Mansgement > Manage Sets and Processes * Manage Processes » Complete Parameters ':é:" 3-4-5
General Info
* Process Mame Move [Es XYZ from h to m
Parameters
E MoveleTask - Move |E to Another Institution/Department
* Institution to Move |E to: Demo Institution - Demo Department
< Back Cancel et

Figure 227: Complete Parameters Page of Move [E Wizard

3 Provide a name for the new process in the Process Name field. This will
identify the process for anyone who wants to use it. The name appears on
the Process List page and is searchable using the quick-find box on that
page.

4  From the Move IE to drop-down list, select the institution and department
to which you want to move the objects.

5 Click the Next button.

The Define Set page of the wizard opens. All available sets for this wizard
are listed on this page.
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Hame &
1 % Wig=inglES_SET g3l
" SIP 10 logical set1371230738529

3

ra

SIP 59 logical set137 1237662581

< Back Cancel

gement = Manage Sets and Processes » Manage Proceszes = Define Set 12 {:3} 435

1 -3 of 3 Records

Set Type Object Type Created By | Creation Date
Logical Intellectual Entity  admin1 14/06/2013
Logical Intellectual Entity admini 14062013
Logical Intellectual Entity  admin1 14/06/2013

Ir Exclude objects that have already been processed (only objects that have been updated
since the last processing day will be included)

Mext

Figure 228: Define Set Step of Wizard

6 Select the set containing the IEs you want to transfer, then click the Next

button.

The Scheduling step of the wizard opens (Figure 229). The schedule defaults
to No Scheduling. Also available are once, daily, weekly, monthly, and an
advanced option that allows you to enter a firing schedule using a Cron
Trigger (with samples provided).

2 {::..
it = Manage Sets and Processes = Manage Processes > Scheduling Weekly 1+2+3 3
Hz Scheduling Start At
Once Time |23 Rd |
Daily Date |17 =] June x| 2013 - | & -
Weelkly Repeat
Maonthly ¥ Indefinitely
Advanced " Until
[17 =lune =201z #]EE~
Week days
v Monday - Tuesday
[T wednesday [T Thursday
[T Friday [T Saturday
[T =Sunday
< Back Cancel Mt
Figure 229: Process Scheduling - Weekly
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7  Enter a schedule for

the process and click Next.

The system returns a summary of the process on the Review and Confirm

page (Figure 230).

General Information

Name

Parameters For Tasks

Set Information

Set I1d
Name

Scheduling

Once At:

< Back Cancel

Institution to Move |E to:

Diata Management > Manage Sets and Processes » Manage Processes » Review and Confirm 1-2H3-4 @
Move |Es XYZ from h tom
CRS00.|NS00. DPROD
5 temized ==t1352231533017
T/02/2014 at 01:30:00
Submit

Figure 230: Summary of Process Entries

Review the information on step 5 of the wizard. If you need to make

changes, use the < Back link until you reach the page where you want to

make changes. To cancel the process, click the Cancel button. To submit
process to the system, click the Submit button.

the

If you submitted the process, Rosetta runs it or queues it for running. The

Process List page opens with the new process appearing there.

(]

Home > Data Management > Manage Sets and Processes = Process List
Filter |4 ] Find
jin] Name Task Chain Mame Task Chain Groups|Scheduling Status Date
Assign Access Rights Maintznance Mat 211214  Run His]
Palicy Scheduled 0:Z3 PM Now

Figure 231: New Entry in Process List
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Restoring IEs from the Permanent Repository

Library staff who want to view previous versions of an IE and possibly restore
those versions can do so through the Web Editor. A tab on the Web Editor called
Versions displays a list of current and older versions of an IE. Staff with
sufficient authorization can retrieve an older version of an IE from the
permanent repository and store it as the new and latest version of itself.

Rosetta uses the IE’s METS file, which consists of the preserved representation
only. When the restoration is complete, the IE in the operational repository will
match the version in the permanent repository.

NOTE:
Although the IE to be overridden will take on the content and metadata of
the restored object, access copies and access rights exceptions attached to
the IE will migrate with the IE being restored and remain in the database.

To view or restore an IE from the permanent repository:

1 Find the object you want to restore by searching the repository for an object
or for metadata (Home > Data Management > Search for Objects | Search for
Metadata).

When you find the object, the Web Editor displays its details in a tabbed
pane.

2 Click the Versions tab in the pane.

Information on the versions of this IE display under the tab.

398
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Home = Data Banagement = Search and Sets » Search for Objects = Yersions

Intellectual Entity PIDIE1457% Created un?jt%_,:ll:&' Created byadmin
Updated on ?I’E"'_f‘_'lrﬂ"':' Upclated byadrmin] SIPID 140
Yersion S
& Locked By: Wa.
= IE [1E14519) Object Summany Metadata Senvices Vergions
= Preservation Master, Hevision 1
{REP14520) Title Version Commit Date Croator
= File (FL14921, 374Kh ) Post-gchool choices

well does acadamic

achievemend pradict 2 240552008 094725 var Wiew

teiary aducation

of schoal leavers?/

Post-sehool choices

will does acadaemic

achigemeant pradict 1 SANDEOAENTAT0 war Miew  Restore
1ettiary education

of school leavers? S

Actions: [|E Exporl j

Figure 232: Version Tab of the Web Editor

3 Find the version you want to view or restore and click the text link
corresponding to that IE.

If you are viewing, the METS information will open in a separate window. If
you are restoring, Rosetta will open a confirmation page.

4 To restore, click the Confirm button.

The system restores the IE and refreshes the Versions tab with messages
regarding the IE status and instructions for verification (Figure 233). The
Restore text link is no longer available for that version you restored.
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Hotme = Data Banagement » Search and Sets » Search for Objects » Yersions

Intellectual Entity PIDIE14579 Created url?jll%_,%t:' Created byadmin
Uprdated an i‘i”j‘_'lrd"'s' Updated byadmin] SIFID 140
Wersion o

2

£ Curnd e Bealeg Fralied Brack: By W, la refrash page elick hom

O ThelE iz being regtarad. 24 |E recoeds including SIS receidz ars being raztorad, pleses werilfy comecinzas.
Flozae nate: DeulyAly= Coples gra ned raslared stamabeslly, pleage verly cemeciceee apd Randl= mans b,

= IE [1E14379) Dhject Su Metads Versions
= Preservation Master, Rev 1
(REP14520) Title Yarsion Commit Date Creato

= File (FL14521, 374Kh ) Post-school choices how
well does academic
achizement predict the 2 2052008 094725 var Wiew
1etiary education choices
of school leavers? /4
Post-school choices how
will does academic
achievernent predict the | DAA0ZOENT27:10 var Wiew
1etiary education choices
of school leavers? S

Actions: [IE Exporl ::J

Figure 233: Versions Page After Restoring IE
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Fixity, Provenance, and Storage

This section contains:

®m  Fixity in Rosetta with an External Storage Layer on page 401

B Managing Fixity Reports on page 402

Fixity in Rosetta with an External Storage Layer

Fixity checks occur as part of validating files as they are deposited, ingested, or
otherwise altered within Rosetta. If an institution using Rosetta wants to store
files in one or more storage locations outside of the Rosetta repository, fixity
checks and events from this external storage layer can be integrated into Rosetta
records.

As part of this process, provenance events are performed in Rosetta before an
object or IE is returned to the external storage layer. Rosetta performs its part of
the equation through its Data Management module and the use of an APIL

As part of maintaining the preserved file copies, a fixity check is performed on
each of the copies wherever they are stored. In order to record all the
information about these checks in Rosetta, the library must run an API that
updates Rosetta after a fixity check. This allows reports to be generated in
Rosetta and provide the fixity status for all files.

The process includes the addition of an event that can be either a statistical event
(not provenance) or a provenance event.

NOTE:
A provenance event is recorded in the IE METS file, and it requires a new
version of the METS file to be written.

The provenance event functions as follows:

B The event itself is written to the database whenever it is generated, whether
it succeeds or fails.
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B The event is written to the DNX as provenance when the check result is
different from the current status:

B first time it runs (success/failure)
B success after failure
m failure after success

In addition, this event does the following:

B Captures the information about a fixity check that was performed in the
storage layer on any of the file copies

B Is added to Rosetta by an API

B When triggered externally, is written to the database as if it had been
triggered internally

Managing Fixity Reports

Fixity reports are set up as Event Reports in the Data Management section of the
Management module (see Figure 234)

Home = Data Management = Advanced Tools = Fixity Reports

Add Event Report 1-1of 1 records
HName Description Creation Date | Modification Date
More
1 MissingES_QSr - 0810/2012  08M0/2012 View Edit Delete adions

Back

Figure 234: Fixity Reports Page
Access the page by following the path Home > Data Management > Advanced
Tools > Fixity Reports. From this page you can
B Add anew report
B View, edit, or delete an existing report

B Open or generate an existing report

402
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To add a new report:

1 From the Fixity Reports page (Home > Data Management > Advanced
Tools > Fixity Reports), click the Add Event Report button.

The Add Event Report page opens.
2 Enter values in the fields as described in Table 61.

Table 61. Event Report Page Fields

Field Description

Name Provide a name for the report to appear on the Fixity
Reports page.

Description Describe the report (not required).

Time Period Specify the number of days, weeks, months, or years

for the report to cover.

Number of copies and To select a specific number of copies and/or fixity
fixity events per copy events per copy to capture in the report, select the
check boxes and specify the numbers in the fields.

3 To create or add a set to be included in the report, click the corresponding
button and specify a new set (Create Set button) or select a set that has
already been defined (Add Set button).

NOTE:
To create a new set with search conditions, see Creating a Logical Set on
page 351.

When you have created a new set or added an existing one to the event, the
Event Report Details page refreshes with the selected set shown beside an
Unlink set option (see Figure 235).
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Home = Data Management > Advanced Tools = Fixity Reports = Event Report Details

*Hame |24

Description

*Time Period l?_ dEvI

¥ Files should have [{ file copies
[T Files should have fity events (per copy)

Cancel hDDP‘f

Figure 235: Set Selection for Event Report

To change the set, click Unlink set and repeat from the beginning of the
previous step in this procedure. To keep the set, select Apply. To keep the set
and continue with the procedure, click Save.

Rosetta returns you to the Fixity Reports page, where the new event report
appears in the list of fixity reports.

To view, edit, or delete a fixity report:

1

From the Fixity Reports page (Home > Data Management > Advanced Tools
> Fixity Reports), find the report you want to work with and, in its row, click

B Delete to delete the report (then click Confirm to continue the deletion)
B View to view the report details (click Back to return to this page)
m  Edit to make changes to the report details

To edit any aspects or parameters of your report, use the definitions for
adding a new report (To add a new report: on page 403), including Creating
a Logical Set on page 351 if needed.

Click Save to save changes or Cancel to return to the report list page
without saving changes.

404
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To generate a report or open one that has already been generated:

1 From the Fixity Reports page (Home > Data Management > Advanced
Tools > Fixity Reports), find the report you want to view or run and, in its
row, click More Actions.

The options for generating a new report or viewing/opening one that has
already been run show below the dotted line for the row.

Home = Data Management = Advanced Tools = Fixity Reports = Fixity Reports

Add Event Report 1-3 of 3 records
Name Description | Creation Date | Meodification Date

1 MWissinglES_ES%a - 09102012 082012

2 ress - 0802012 082012 View Edil Delete aon-

3 24 - 0802012 102012 View Edil Delete LI;I;:_

Figure 236: Fixity Reports: More Actions

2 To open the most recently run report, click Open Report. To generate a new
report using the same parameters, click Generate Report.

The report opens.
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Home = Data Management = Advanced Tools = Fixity Reports = Fixity Reports

PID: File Name No. of Copies| Copy Id Fixity Events
] ::Elj:ffc REP1529 LZw_TFFtif 2 someCopy 1
. :Eﬂf:"j? RER1S32Y winter.jpg 3 somelnetlze 0
1 ::Eﬂfl RER1S32/ Blue hilsjpg 1 - 2

Export Fixity Reporl o Excel

Back

Figure 237: Fixity Report

3 To export the report to an Excel spreadsheet, click the Export Fixity Report
to Excel button.

The report is downloaded to your local drive.
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Scheduling Metadata Update Jobs

This section contains:

B About Metadata Update Jobs on page 407
Managing Metadata Update Jobs on page 407
Adding a Metadata Update Job on page 409
Modifying a Metadata Update Job on page 411

Cancelling a Metadata Update Job on page 412

About Metadata Update Jobs

Metadata update jobs are used to metadata update for existing IEs.

Managing Metadata Update Jobs

The Manage Scheduled Jobs page enables Data Managers to schedule metadata
Update jobs. To access this page, follow the Rosetta drop-down menu path:
Data Manager > Advanced Tools > Update Metadata.

The Manage Scheduled Jobs page opens to existing metadata update jobs
(Figure 238).
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O™
ExLibris Rosetta Management

Home Producers Submissions Data Management Preservation

Add Job

Name Previous Fire Time | Next Fire Time Frequency State
1 Metadata Update Job - 02122015 22:55:06 Every 1 hour/s Mormal View Edit Delete
2 Metadata Update Job - Every 1 hour/s  Mormal View Edit Delete
3 Metadata Update Job - Every 1 hour/s Mormal View Edit Delete
4 Metadata Update Job - Every 1 hour/s  Mormal View Edit Delete
5 Metadata Update JobGac 03122015 051013 Every 1 hour/s Mormal View Edit Delete

Home = Data Management = Advanced Tools = Manage Scheduled Jobs

Current Time 06/12/2015 08:25:42

Back Refresh Restart Scheduler

Figure 238: Manage Scheduled Jobs (Metadata Update Jobs List)

This page enables Data Managers to monitor the status of each metadata update
job and perform the following tasks:

Add a new job — For more information, see Adding a Metadata Update Job
on page 409.

View a job’s details — Click the View link next to the job you want to view.

Modify a job — For more information, see Modifying a Metadata Update
Job on page 411.

Execute a job — Click the Run Now link to run a job manually.

In addition, you can cancel a job. For more information, see Cancelling a
Metadata Update Job on page 412.
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Adding a Metadata Update Job

This task allows Data Managers to create a new metadata update job.

To add a Metadata Update job:

1 Click the Add job button on the Manage Scheduled Jobs page.

The Job Details page opens.

TN
ExLibris Rosetta Management

Home Producers Submissions Data Management Preservation

Home = Data Management = Advanced Tools = Update Metadata = Job Details

* Mame [Metadata Update Job

Hourly
Daily Start At
Weekly Time ] ¥ 35 v
Monthby Date 06 ¥ December ¥ | 2015 v -
Advanced

Repeat

*  |ndefinitely
Lintil
06 ¥ | December ¥ 2015 v B~

Perform this task :
Every | 4 » | Hour's

El Job Parameters

* UserlD *  User Password |
* NFS Path L'exlil:uris.-'dps.?dci_‘h'prnﬂleh:uperatil:unal_shared!md_update!INSDD

¥ Ignore differences in field sequence

Back Refresh m

Figure 239: Job Details (Metadata Update Job)
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2 Enter a name for the metadata update job in the Name field.

3 Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.

4  To configure hourly, daily, weekly, and monthly intervals:
a  Use the following table to configure the common interval fields:
Table 62. Common Interval Fields
Section Field Description

Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely Select this option to run the job indefinitely.

Until Select the month, day, and year from the drop-down
fields to specify the date at which to stop running the
job.

NOTE:

After this date, the state of the job will change
from Normal to Not Running.

b Use the following table to configure the interval-specific fields:

Table 63. Interval-Specific Fields

Type of Perform Description

Interval this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

5 Complete the required fields in the Job Parameters pane.

6 Click the Apply button to add the job to the list of metadata update jobs.

410 September 2016
Ex Libris Confidential



Staff User’s Guide, Part VII: Negotiators
Chapter 41: Scheduling Metadata Update Jobs

Modifying a Metadata Update Job

This task allows Data Managers to modify the details for an existing metadata
update job.

To modify a Metadata Update job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the job that
you want to modify.

The Job Details page opens.

A
ExLibris Rosetta Management

Home Producers Submissions Data Management Preservation

Home = Data Management = Advanced Tools = Update Metadata = Job Details

Name  Wetadata Update Job - IEG286 Frequency Every 1 houris Previous Fire Time  p2/12/2015 235508
Role Repository From Date 02/12/2020 23:55:00 MNext Fire Time 0201242020 23:55:00
State MNormal Until Date
Hourly s A
tart At
Dz
o Time 23 v &5
VWeek I
Manth Date 02 ¥ | December v | 2020 v B -
Advanced
- Repeat
= |ndefinitely
Until
D& ¥ | December ¥ | 2015 ¥ B -
Perform this task :
Every 1 ¥ Hourls
El Job Parameters
* UserlD [admin1 * User Password [messwess

* NFS Path [lexlibris/dps/d4_1iprofile/operational_shared/md_update

# |gnore differences in field sequence

Back Refresh Unschedule mm

Figure 240: Job Details Page (Metadata Update Job)

2 Select the interval at which to execute the job: Hourly, Daily, Weekly,
Monthly, and Advanced.

3 To configure hourly, daily, weekly, and monthly intervals:
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a  Use the following table to configure the common interval fields:
Table 64. Common Interval Fields

Section Field Description

Start At Time Select the hour and minutes from the drop-down fields
to specify the time at which to run the job.

Date Use the calendar tool or select the month, day, and year
from the drop-down fields to select the date at which to
start running the job.

Repeat Indefinitely Select this option to run the job indefinitely.

Until Select the month, day, and year from the drop-down
fields to specify the date at which to stop running the
job.

NOTE:

After this date, the state of the job will change
from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 65. Interval-Specific Fields

Type of Perform Description

Interval = this task:

Hourly Every Select the hourly interval from the Hours drop-down
field.

Weekly Week days Select which days of the week to run this job.

Monthly | Monthly At | Select the day of the month to run this job.

For information on how to configure advanced intervals, see Configuring
Advanced Job Schedules on page 245.

4 Complete the required fields in the Job Parameters pane.

5 Click the Apply button to add the job to the list of metadata update jobs.

Cancelling a Metadata Update Job

Cancelling a job allows the Data Manager to postpone the execution of job
indefinitely without deleting it from the system.
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NOTE:
The Unschedule option will not be available when the state of the job is
Not Running.

To cancel a Metadata Update job:

1 On the Manage Scheduled Jobs page, click the Edit link next to the job that
you want to modify.
The Job Details page opens.

2 Click the Unschedule button.
The state of the job should change to Not Running.
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Collections

This section contains:

B Collections in Rosetta on page 415
B  Managing Collections on page 416
B Collection Delivery on page 431

Collections in Rosetta

Collections in Rosetta enable users to aggregate IEs so that they can be

p
E

reserved according to their original hierarchy.

ditors (Typical and Full) and Data Managers (Typical and Full) have access to

collections from the Data Management > Collection Management menu. These
authorized users can create, update, and delete collections under the correct
circumstances.

Collections contain:

B one or more associated IEs (and the IEs contain the associated Collection ID
in their records)
B aunique path (including collection/sub-collection)
B metadata in DC format—stored as shared metadata in the database and in
the permanent repository
B optional source metadata in any format other than DC (such as EAD or
MARC)
B optional sub-collections
NOTE:
Collections are not sets. Process automation tasks cannot work directly
with collections. In order for Process automation tasks to work with
collections, sets need to be created with the collection name as a criterion
for the search query.
September 2016 415

Ex Libris Confidential



Staff User’s Guide, Part VII: Editors
Chapter 42: Collections

Managing Collections

Collections can be managed from the Collections Management page (see
Figure 241, Collections Management).

# / Data Management: Collection Management

[ = g’ A
SEeE
Collection Name  Israeli Collection Collection Description
- Collection ID 50432 Creation Date 8/14/16
¥ lJ First Levelb3T Modification Date  8/14/16 Publish No
4J Second Levelb3T External System - External Id

» L] First Leveln7Q Allow Navigation  No
iy Update collectionX7c
iy uniqueléry

Uy Update collectiongis Contents Metadata History

View Collection

» Uy Title
Uy Collection INS002kC
il Israeli Collection

» ] csvCollectionGrandfather 1-7of 7 Records
T N
1 |[Cities 1 1E1200 View | Info
2 | Cities 2 IE1203 View | Info
3 |Cities 3 IE1206 View | Info
4 | Cities 4 1E1209 View | Info
5 |Cities5 IE1212 View | Info
6 | Cities 6 IE1217 View | Info
7 | Cities 7 1E1220 View | Info

1-7 of 7 Records

Figure 241: Collections Management

The Collections Management page includes a hierarchical navigation bar (left
column of the page) and a main window with the Contents, Metadata, and
History tabs.

The Contents tab (see Figure 242, Collections Management Page, Contents Tab
Views) displays the contents of the collection in terms of its IEs. IEs can be
viewed in a list format or as thumbnails.
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List wiew
Contents Metadata *
1-10 of 28 Records 1 2 3 ==
Tide BID
Lrties 1 IET1050 View Info
2 Ciies 2 IE1053  View Info o
3 Citiee 3 IE1DS8 View Info Thumbnall view ===
4 Cities 4 IE1 Comlents  Peisdais
5 Cities 5 IE1
B  Cities b IE1
7 Cities 7 IE1
2] Crties 1 IE1
| Crties 2 IE1
10 Cities 3 IE1

Figure 242: Collections Management Page, Contents Tab Views

The Metadata tab provides an interface for users to edit the collection’s
metadata. Users can edit DC records online or upload metadata from external
XML file. Import formats can be either DC or source metadata in any format
(such as MARC or EAD).

Contents  Metadata History

Add Metadata

Descriptive 1102 | Edit

Collection mets | 1103 | View

Figure 243: Collections Management Page, Metadata Tab

In the permanent repository, the descriptive metadata of the collection is stored
in a METS XML document along with some control information.

The History tab displays a list of the actions performed on the collection:
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Contents Metadata History

1-8 of 8 Events

IE has been added to collection | IE1206 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08
IE has been added to collection | IE1220 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08
IE has been added to collection | IE1212 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08
IE has been added to collection | IE1200 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08
IE has been added to collection | IE1217 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08
IE has been added to collection | IE1203 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08
IE has been added to collection | IE1209 has been added to collection:Israeli Collection (collection id:50432) | 14/08/2016 21:29:08

b =T B R U L)

Figure 244: History Tab

Adding a New Collection
Adding a new collection can be accomplished in two ways:
B Manually, through the Ul

B Automatically, when associating IEs with a collection. (See Associating IEs
with Collections on page 424)

To add a collection manually:

First determine where, in the existing hierarchy, you want to position your
collection. In the example below, Adding a New Collection, the user wants to
create a collection that is a sub-collection of the existing Modern collection.

1 To create a sub-collection of an existing collection, click that collection in the
collection hierarchy.

The system highlights the collection you clicked.
2 Click the green button with the plus sign.

A new collection form opens in a light box. The Selected parent field
provides you the option of creating a first-level collection or a sub-collection
of the parent collection you selected in step 1.

3  Click the first-level option or the parent option.

4  Enter a name for the collection. This name will appear as the collection’s
label in the hierarchy and will be used as part of the path when the system
needs to locate the collection.
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You are about to add a collection

Selected parent
Add first level collection
= From Collection infoSxQ

*Collection Name |

Collection Description |

External System |
External Id |

Publish
Allow Navigation

Add Remove

[Ad

Figure 245: Adding a New Collection

5 Enter a description for the collection. The description will appear in the
basic properties information for the collection.

6 Select Publish to publish the collection to Primo.

7  Select Allow Navigation to display linked breadcrumbs to this collection in
the collection viewer.

8 Click Add under the generic thumbnail image to add a thumbnail to the
collection.

NOTES:
B The image must be in jpg format with a maximum size of 100K.
B Itis recommended that square (1:1) images be used.

B Images should be not less than 400x400px.

9 C(lick Add to save the collection.

The collection name appears in the hierarchy where you specified in the
Selected parent field.

You can change the order and level of the collection by dragging and
dropping it where you want it in the hierarchy:.
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eQEe

= [ Music

- () 19th century

= ._:j 18th century
] conrerins &
[ = vinlin'
] walkzes
- () piano ,/
L. () violin/

- (] Israel Photos

Figure 246: Collection Drag-n-Drop

Click the Sort icon to alphabetize the list of collections.

To create collections automatically while associating IEs with them, see
Associating IEs with Collections on page 424.

Editing a Collection

To rename a collection, right-click over the folder in the left column and select
Rename collection.

To update the collection description, right-click over the folder in the left
column and select Edit collection, then update the necessary fields.
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Home = Data Management = Collection Management = Collections Management

SEF =

I

- [ Collection Publish
- () csvCollectionGran
- (O] selenium collectio

Add collection

Edit collection
Rename collection
Delete collection

)

You are about to edit collection

“Collection  |selenium ct

Hame

Collection |selenium collection
Description

External

System
External Id
Publish [

Figure 247: Edit Collection

Updating Collection Metadata

Collection metadata can be updated from the Metadata tab on the Collection

Management page. Users can add metadata elements and assign values from
this tab.
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Metadata button.

To add a new metadata type to a collection:

1 From the Metadata tab of the collection you want to edit, click the Add

Deposits = Submissions «

Data Management =

Freservation =

# / Data Management: Collection Management

SEx=Y

» ] First Levelb3T
44 Second Levelb3T
4 ||| First Level
4 ] Second Level
L] Third Level
U7 aSecond Level2n7Q
) Update collectionX7c

Collection Name
Collection ID
Madification Date
External System

Allow Navigation

Contents Metadata History

Israeli Collection
50432
8/14/16

No

Collection Description
Creation Date  8/14/16
Publish No
External Id

View Collection

422

4 uniguelery Add Metadata

4 Update collectionSis
e S N N

» ujbyDc Descriptive | DC Edit

4] Collection INS002KC Collection | mets View

..] 1sraeli Collection
» U] csvCollectionGrandfather

Figure 248: Add Metadata Button for Collection
The Choose metadata type form opens in a light box.
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Choose Metadata type:  |MARC

¢ Insert new (empty)
¢ Insert from PC

IMAGE MISO
Video

Audio
Copyrights
Rights

Other

Figure 249: Add Metadata Light Box

2 From the drop-down list of metadata types, select the type you want to add.
If you do not see your type in the list, select Other.

Choose Metadata type iOther

" Insert new (empty)
¢ Insert from PC

Add metadata record

Figure 250: Selected Metadata Type: Other
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3 Select the source of the metadata: Insert new to copy the source into a text
tield, Insert from PC to browse to the metadata file on your PC and select
that.

Choose Metadata type Oither j

& Insert new (empty)
¢ Inser fram PC

Choose Metadata type |Dther j

™ Insert new (empty)

| Browse... |
[

Add metadata record

Figure 251: Two Methods for Inserting Metadata
4  Use the Validate button to check the metadata before loading it. Any errors
will display in red text as the form refreshes.

5 Correct any errors and re-check the validation. When no red text displays
after clicking Validate, the XML is valid.

6 Click the Add metadata record button to complete the addition.

The system returns you to the Collections Management page. The new
metadata appears in the Metadata tab under the existing metadata types.

NOTE:
For information on editing digital collections, see Editing Digital
Collections on page 460.

Associating IEs with Collections

Users can associate IEs with collections even if the collection doesn’t exist yet.
Collections in this case are created during the association of IEs with collections.
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After a collection has been created, users can edit it and add metadata (DC or
source MD).

Users can associate IEs with collections in one of two ways, both of which add a
section to the IE’s DNX.

In case of failure (for example, the IE is already locked by another user or
process), the Process Monitoring UI allows the user to see the details of the IEs
that failed. The user can then resolve the problem.

NOTE:
These tasks can be configured as part of SIP processing or, after the IEs are
in the permanent repository, as a maintenance process (bulk) or through
the Collection tab in the Web editor (manual).

Tasks and Task Chains

Associating IEs with collections involves, in part, running the correct task chain
from the Advanced Configuration > Repository > Task Chains page or creating
a chain if the one you want doesn’t exist.

Two methods for associating IEs with collections are available out-of-the-box as
tasks:

B The task Assign Collection by Name should be used when the collection
already exists in Rosetta and the ID is known. The task verifies that the
collection exists in Rosetta and assigns the IEs to this collection. The
parameter for this task is the collection ID, selected by the user who
schedules the process.

B The task Assign Collection by DC can be used for the following cases:

B When assigning IEs to an existing collection, identifiable by Rosetta or
external ID in a specified DC field

B When assigning IEs to a collection, identifiable by a full path in a
specified DC field

For each field occurrence, if the field contains a colon, Rosetta tries to match
by Rosetta ID, then by external ID. Match by ID is case sensitive. If no match
is found, the task fails. If the field does not contain a colon, Rosetta tries to
match by path.

The expected syntax for assignment by Rosetta ID is
rosetta:{rosetta_id}. The expected syntax for assignment by external ID
is {external_system}:{external_id}. The expected syntax for
assignment by path is the full collection path, delimited by a specified
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delimiter. The list of delimiters is configurable in the Collection Task
Separators code table.

The task supports auto-generating new collections based on a collection
path only.

The task supports recursive generation, that is, if the value in the DC field is
a/b/c (with the delimiter being /) and root collection a does not exist,
Rosetta creates collections a, b and ¢ (and assigns the IE to c). When a
collection is generated by the task, the collection's creation event the task
details.

NOTE:
Colon (:) is reserved and cannot be used in this task either as a collection
name or a delimiter.
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# | Repository | Task Chaina | Detaila

Task Chain It 58 Created By SYSTEM Created On: 16/08/2016 23:05:56
Updated By Updatad On:
General Information
* Mame Azgign Collestion by DC
* Description Thig taex chain will azsign collection to IE by DC
P
* Stgiug Active Status Dete 16/08/2016

*Task Chain Lewel IE >

* Groups; Frezervation

Maintensnce

Velidetion Stack - Use file level teaka only

Workbench

Webeditor - Staging

Enrichment

Move To Permanent

Metadeta Validation

Webeditor - Permanent

Taak Lizt Tazk Parameters
Add Taek
I N, _
Aszaign Collection By DC  Aasign Cellection By DC INTELLECTUAL_ENTITY Delete

Figure 252: Customer-Configured Task Chain—Assign by DC

The following parameters are available for this task:
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Task List Task Parameters

* DCField | Is Part Of (DCTERMS) | * Delimiter , +  Delete on Assigment
Generate New Collections

Publish Navigate Sort

Figure 253: Task Chain - Task Parameters Tab View
DC Field - the field that contains the path or external ID by which
Rosetta assigns the IEs to a collection.
Delimeter — the delimeter used for the collection path.

Delete on Assignment — used when the DC field exists solely for
collection assignment. Select to have the field deleted after a successful
collection assignment based on a match for the given field.

NOTE:

This DC update does not generate a metadata update event. The field
deletion is noted in the IE's collection assignment event as
DCSourceDeleted=true.

Generate New Collections — select to have Rosetta generate a new
collection according to the value in the DC field and the specified
delimiter if no match by path is found. The following options are only
available if Generate New Collections is selected.

Publish - select to have the generated collections published to Primo.

Navigate — select to display linked breadcrumbs to this collection in the
collection viewer.

Sort — select to have the generated collection's parent re-sorted (0-9A-z)
after the collection is generated in order to maintain its order.

NOTE:

Generated collections' descriptions are not auto-populated.

Both tasks are available with Rosetta installation, but only the Assign Collection
by Name has a corresponding out-of-the-box task chain. You must configure a
new task chain if you want to use the Assign Collection by DC task.
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Disassociating IEs from Collections

Disassociating IEs from a collection can be done using a process (bulk) or
through the Web editor (manual). The action performs the following;:

1 Locks the IE.

2 Creates a new version of the IE without the collection DNX section that held
the collection ID.

3 Commits the new version of the IE to the permanent repository.

The task and task chain for this procedure, Unassign Collection, are available on
installation. In case of failure (for example, the IE is already locked by another
user or process), the Process Monitoring Ul allows the user to see the details of
the IEs that failed. The user can then resolve the problem.

Searching IEs Within Collections

In the Data Management area, IEs can be searched based on their collection
information. The user can open the list of collections, find a particular collection/
sub-collection name, and review all the IEs that are associated with the
collection.

# / Data Management: Collection Management

SHE#F=E
Collection Name  Israeli Collection Collection Description
- Collection ID 50432 Creation Date 8/14/16
» ] First Levelb3T Modification Date  8/14/16 Publish No
llJ second Levelb3T External System External Id

» ] First Leveln7Q
U] Update collectionX7c
4 uniquelsery

————- Allow Navigation  No

View Collection
U Update collectiongis Contents Metadata History

» Uy Title
Uy Collection INS002kC =
1 1sraeli Collection

» 1] esvCollectionGrandfather 1-7of 7 Records
1 | Cities1 IE1200 View | Info
2 |Cities 2 IE1203 View | Info
3 |Cities 3 IE1206 View | Info
4 | Cities 4 IE1209 View | Info
5 | Cities 5 IE1212 View | Info
6 |Cities 6 IE1217 View | Info
T | Cities 7 IE1220 View | Info
1-7 of 7 Records

Figure 254: |Es in a Collection
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Searching Collections

Users can search the list of collections by collection name. For a sub-collection,
the search should start at the collection level. For example, to search for Spring
semester under 2011 under Course catalogue, the user should start with Course
catalogue and then 2011. In searches for 2011 or Spring semester, all the sub-
collections with this name will be highlighted in the list.

Publishing Collections

Collections can be published using the OAI-PMH protocol, similar to IEs, so that
they can be harvested by an OAI-PMH harvester. A published collection's
metadata will appear in the OAI set.

NOTE:
For additional information on setting up harvesting Rosetta collections in
Primo, see the Rosetta - Primo Integration Guide.

To mark a collection for publishing, right-click over the collection icon in the
collection tree, select Edit and check the Publish check box. Uncheck the box to
unpublish the collection. The collection will be published or unpublished
during the next Publishing Sync Job.

NOTES:

B The Collections are converted to OAI format using the (institution-level)
collection2DC.xsl configuration file. To edit this file, go to Data
Management > Collection Management > Collection Publishing. Only a
single xsl configuration per institution is supported for collection
publishing.

B The set_spec value will be \{institution code\}-collections.

B Publishing is determined by the collection's publish dnx field (boolean,
default=false) and can also be set by collection APIs, CSV collection
deposit, and the Assign to Collection by DC task.

Deleting Collections and IEs

Collections or sub-collections can be deleted from the list of collections only if
there are no IEs associated with them.

The system does not allow the deletion of collections that have associated IEs.

When an IE is deleted, it does not appear as part of any collection to which it
once belonged.
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To delete a collection that has associated IEs (or sub-collections with associated
IEs), run an Unassign Collection process, using the relevant collection(s) as both
IE search criteria and task parameter.

Restoring an IE’s Previous Version

When a user restores the previous version of an IE, the system determines
whether the associated collection still exists. If it does, the system re-associates
the IE with the collection.

If the collection does not exist, the IE is not re-associated with this collection.
The system generates an event displaying the details of the IE and the collection
so the case can be tracked and managed.

Collection Delivery

Rosetta allows viewing collections from outside of Rosetta by external patrons.
It also allows managing collections by external applications using APlIs.

The collection viewer is displayed in a separate browser tab or window, as
shown in Figure 255.

Israeli Collection (Y i
1-7 of 7 Records
Title PID

1 == Cities 1 IE5096 View

2 =) Cities 2 IE5099 View

3 == Cities 3 IE5102 View

- =) Cities 4 IE5105 View

5 == Cities 5 IE5108 View

6 == Cities & IE5113 View

i =H Cities 7 IES5116 View

Figure 255: Collection Viewer with One Sub-folder
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The collection viewer has the following characteristics:
B Access rights are not enforced at the collection level, only at the IE level.

m  AllIE titles are displayed with thumbnails (see the Thumbnail Creation
Rules section in the Rosetta Configuration Guide).

B Browsing among IEs within a collection can only occur within the same
collection or its sub-collection(s). In Figure 255, this includes all IEs in the
Israeli Collection and any IEs in the Israeli Subcollection folder, once that
folder is open.

B Breadcrumbs to parent collections (up to three levels) are available
depending on each collections' Allow Navigation setting (see Adding a
New Collection on page 418).

Collection Metadata

Users can view the descriptive metadata of a collection by clicking the
information (i) button. The metadata for the collection appears in a light box
(see Figure 256).

ExLTDﬁa Rosetta

Descriptive Data - Collection DC

title: Cities
created: 2012-11-27 22:24:1

Close

Figure 256: Collection Viewer with Metadata Light Box

Collection Delivery Requests

There are two possible scenarios for how a delivery request for a collection can
be initiated by an external resource discovery system:

B Rosetta Collection ID: The collection ID can be published as part of the IE
and extracted by the resource discovery system.
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B External System ID: The ID can be stored in Rosetta as part of the collection
entity (for example, a DOI). The delivery URL can use the combination of
the external system name (such as Aleph) and the external system ID to
deliver the collection.

The collection delivery request can include, respectively, either the parameter
col_id= with the Rosetta collection ID or the parameters
external_system_name and external_system_id that hold the external
system name and ID of the collection.

See Collection Viewer URL on page 433 for more information on requests and
viewer parameters.

Collection Viewer URL
The collection can be retrieved based on:

B Rosetta Collection ID — For example, http://{server-name}:{port}/
delivery/ action/
collectionViewer._.do?operation=viewCollection&col pid=83542

B External System Details — For example, http://{server-name}:{port}/
delivery/ action/
collectionViewer.do?operation=viewCol lection&external System=A
LEPH&external 1d=83542

Currently, the only way to populate the external system name/ID in the
collection record is through the collection API.

URL Parameters

To control the collection viewer features, users can use the following
parameters:

m  displayType — As a default, the collection viewer opens in list view.
However, users calling the viewer externally can control the view mode by
adding the following parameter to the URL: displayType=thumbnails.

B pageNum — The default number of objects in the viewer are defined in a
general parameter. However, users can control the number of objects by
setting the following parameter: pageNum=20 (which sets the number of
objects on a page to a maximum of 20)
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Derivative Copy Representations

This section contains:
B  Manually Adding a Derivative Copy Representation on page 435

B  Adding a Derivative Copy Representation with a Service on
page 441

B  Adding a Derivative Copy Representation with a Job on page 442

Creating and adding representations in general and derivative copies in
particular can be performed by staff users with the Technical Analyst (TA) or
Data Manager roles. A user who has both a TA role and an Assessor or Arranger
role can add derivative copies from the Assessor or Arranger interface.

There are three methods for adding derivative copies:

B Manually — see Manually Adding a Derivative Copy Representation on
page 435

B With a service — see Adding a Derivative Copy Representation with a
Service on page 441

B With a job — see Adding a Derivative Copy Representation with a Job on
page 442

Manually Adding a Derivative Copy
Representation

You can manually add a derivative copy from the Web Editor. Use this method
when you have the derivative copy files.
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To manually add a derivative copy representation:

1 Open an IE in the Web Editor and lock it.

# | Data Management: Search for Objects / Details

Intellectual Entity PID IE1003 Created on 21/08/2016 22:43:15  Created by admin1
Committed on 21/08/2016 22:43:37 Committed by admin1 SIP ID 2
Version 1
= IE(IET003
( ) Object Summary Metadata Services Collections Versions

= Preservation Master Revision 1 ( REP1004 )
= File (FL1005,1Mb )
= File (FL1006,1Mb)

View Object
PID IET1003
SIPID 2
Created on 21/08/2016 22:43:15
Created by admin1
Updated on 21/08/2016 22:43:15
Updated by admin1
Entity Type
Number of Reps 1
Status ACTIVE

Figure 257: Web Editor Displaying IE Information

2 From the Actions drop-down menu, click Add Representation, and then
click the Go button. The Add Representation - Details page opens:
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# / Data Management: Search for Objects / Details + +

|IE General Information

Intellectual Entity PID  IE1003 Created on 21/08/2016 22:43:15  Createdby adminl
Committed on 21/08/2016 22:43:37 Committedby adminl SIP ID 2
Version 1
Please provide details on the representation you are adding
Label
* Preservation Type Derivative Copy M
Representation Entity Type  pone > Representation Code .. >
Access Rights Policy -

Cancel Next

Figure 258: Add Representation - Details Page

3 Enter information in the fields:
B Label
B Preservation Entity Type
B Representation Code
]

Access Rights Policy

NOTE:
Only one derivative copy representation with given code and entity type
values can be added to any given IE. To add multiple derivative copies to
an IE, use different codes or entity type values.

4  Click the Next button.
The Load Page opens. There are two options for uploading files:

B Insert from Local PC - the interface that appears depends on your
configuration:

B if you are a licensed Aurigma user, the following interface appears:
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Intellectual Entity PID IE3399 Created on 20/08/2016 19:21:25 Created by adminl

Committed on + Committed by - SIP ID 520
Version
Please select file(s) to upload
Insert from Local PC Choose From Server

I nar the files manually

Files for upload
Add more files, add folder or remove all files

Change view: Thumbnails -

+Add more files

Drop files here...

Mo files to upload Upload

Selected Files

e e Ty

Figure 259: Derivative Copy Load Page - Aurigma Users

You can:
B drag and drop files onto the page

B click Add more files and select the files
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B click Add folder and select the folder

To use the manual interface instead (Figure 260), click Load Files
Manually.

B if you are not using Aurigma, the following interface appears:

A | Submissions: Assess SIPs /| Details

|E General Information

Intellectual Entity PID 1E3399 Created on 20/08/201619:21:25 Created by admin]

Committed on - Committed by - SIPID 520
Version :
Please select file(s) to upload
Insert from Local PC Choose From Server
Select File Load the files using the applet
Label

* Physical Structmap Label

Notes

Add Selected File

Selected Files

I e ey
= = -

Figure 260: Manual Upload Interface
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Browse to the file you want to upload and click Add Selected File.
Repeat for each file you want to upload.

Uploaded files are listed in the Selected Files portion of the page:

Selected Files
I e M_MMI-

¥  African Buffalojpg African Buffalo African Buffalo Jexlibris/dps/d4_1/profile/operati 38342 22/08/2016 Edit Remove
2 4 ¥ polphins.jpg Dolphins Dolphins Jexlibris/dps/d4_1/profile/operati..  123.43 22/08/2016 Edit Remove
3 4  Lionjpg Lion Lion Jexlibris/dps/d4_1/profile/operati.. 245.65 22/08/2016 Edit Remove

m Cance‘ m

Figure 261: Selected Files Order

The Selected Files pane displays the selected files as described in the
following table:

Table 66. Selected Files Pane

Column Description

# The selected files” deposit activity priority.

Set Order Use the Up and Down arrows to change the selected files’
order in the IE.

File Name Displays the name of the selected file.

Label Provides a field for a label to be shown when the IE is

viewed in Delivery (optional).

Source Displays the source of the selected file. This is either Local or
URL.

Size Displays the size of the selected file.

Date Displays the date on which the selected file was deposited.

For multiple files, to change the order of the files, click the arrows of the
rows you want to change. When you have the files in the correct order,
click the Done button.

B Choose from Server — To load files from a location on the server instead,
tirst place the files you want to upload under the home directory on the
server. Then click the Choose From Server tab on this page and enter the
directory path in the Import Directory field. Rosetta takes all of the files
under that directory and uploads them to the system.

5 When you are finished, click Done.

Rosetta creates the derivative copies.
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Adding a Derivative Copy Representation with a
Service

You can create a derivative copy representation with a service. Use the service
when you want Rosetta to generate the files for you, either one-off (via the Web
editor) or in bulk (as a task).

To create a derivative copy representation with a service:

1 Display an IE in the Web Editor.
2 On the IE level, select the Services tab.

3  Select the Create Derivative Copy Representation service. The following
appears:

# / Data Management: Search for Objects / Details

General Info

* Process Name FastTrack (Create Derivative Copy Representation, IE1003)

Priority High -

Create Derivative Copy Representation - Create Derivative Copy Representation

* Preservation Type * Representation Entity Type (Input)

Derivative Copy - None ~
File Extension Filter 0 items selected Remove all Add all
& -
qct
apt
qxp
s1Ep
stp
wav T
Copy other extensions
Plug-in Type Transformation JP2 Thumbnails -
Profile
@ Stream Handler Jp2000 .
* Representation Code Medium - Access Rights Policy .
* Representation Entity Type (Output) None -

Email Notification

Send email? NO -

Figure 262: Create Derivative Copy Representation Service

4  Fill in the fields:
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B Priority — select the priority of the service
B Preservation Type — select Derivative Copy

B Representation Entity Type (Input) — select the representation entity
type for the input

B File Extension Filter — select the file extensions on which to run the
service

B Copy other extensions — copy the files with extensions not included in
the filter

B Plug-in Type — select one of the following;:
B Transform Profile, and select a profile from the list
B Stream Handler, and select a stream handler from the list

(For more information, see Stream Handlers (Deprecated) and
Transformation Profiles in the Rosetta Configuration Guide.)

B Representation Code — select a representation code
B Access rights policy — select an access rights policy

B Representation Entity Type (Output) — select an representation entity
type for the output

B Send Email? — enter an email address t be notified when the service is
completed

The Create Derivative Copy Representation service creates the derivative copy.

NOTE:
Only one derivative copy representation with given code and entity type
values can be added to any given IE. To add multiple derivative copies to
an IE, use different codes or entity type values.

5 Click Submit.

Adding a Derivative Copy Representation with a
Job

You can create a derivative copy representation with a job. Use the job when
you have files and want to run in bulk.
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To create a derivative copy representation with a job:

1 Select Derivative Copy Job (Data Management > Manage Sets and
Processes).

2 Click Add Job. The following appears:

Hourly
Daily
Weekly

Maonthly

Advanced

# / Data Management: Derivative Copy Job

* Name

Time

Date

Job Parameters

* UserID

* NFS Path

Add Derivative Copy Representations

Auto-Generate Logical Structmap

Details

Start At

19 M 15 M

18/08/2016 (i
Repeat
@ Indefinitely
Until
18/08/2016 (i

Perform this task :

Every 1 ~ Hour/s

* User Password

Apply

Refresh

September 2016

Figure 263: Derivative Copies Job
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Fill in the fields to schedule the job. For more information, see Submission
Jobs on page 249.

In the Job Parameters section, enter your user ID and password and the path
of the folder that contains the files to be used to create the derivative copy
representations.

The NFS path you indicate should be built in the following format:

Each folder in the NFS path indicates a separate IE.

Each IE folder should contains a METS file that contains the information to
create one or more derivative copy representations. The METS file must
contain:

B Anie-amd with PID internalldentifier (only). For example:

<mets:amdSec ID=""ie-amd"'>
<mets:techMD ID="ie-amd-tech'>
<mets:mdWrap MDTYPE="OTHER"™ OTHERMDTYPE="'dnx"'>
<mets:xmlData>
<dnx xmIns="http://www.exlibrisgroup.com/dps/dnx'>
<section id="internalldentifier' >
<record>
<key id="internalldentifierType'>PID</key>
<key id="internalldentifierValue">I1E13660</key>
</record>
</section>
</dnx>
</mets:xmlData>
</mets:mdWrap>
</mets:techMD>
</mets:amdSec>

B A generalRepCharacteristics section (for each REP), specifying
preservation type (must be DERIVATIVE_COPY), representation entity
type, and representation code. For example:

444
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<mets:amdSec ID="repl-amd'>
<mets:techMD ID="repl-amd-tech">
<mets:mdWrap MDTYPE="OTHER"™ OTHERMDTYPE="'dnx"">
<mets:xmlData>
<dnx xmlns="http://www.exlibrisgroup.com/dps/dnx"'>
<section id="generalRepCharacteristics">
<record>
<key id="preservationType'>DERIVATIVE_COPY</key>
<key i1d="representationEntityType"”>JPEG Images</
key>
<key id=""RepresentationCode">MEDIUM</key> (for
some reason this is uppercase - fix?)
</record>
</section>
</dnx>
</mets:xmlData>
</mets:mdWrap>
</mets:techMD>
</mets:amdSec>

B A generalFileCharacteristics section (for each file), containing any field
that is supported when submitting as part of a SIP. For example:

<mets:amdSec ID="FL1-1-amd">
<mets:techMD ID="FL1-1-amd-tech">
<mets:mdWrap MDTYPE="OTHER™ OTHERMDTYPE="'dnx"'>
<mets:xmlData>
<dnx xmIns="http://www.exlibrisgroup.com/dps/dnx"'>
<section id="generalFileCharacteristics">
<record>
<key id="label""></key>
<key id="note'></key>
<key id="FileEntityType'></key>

</record>
</section>
</dnx>
</mets:xmlData>
</mets:mdWrap>
</mets:techMD>
</mets:amdSec>

B A fileSec, + a fileGrp(s) for each REP.

The METS file may contain:

m File level descriptive (DC, source) metadata sections
B Representation level source metadata sections

B Representation level access rights policy
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B Physical structmaps. If none are provided, and no other SM is provided
(and flag is false), Rosetta will generate physical structmap.

B Logical (EXL/custom) structmaps

B The NFS path should contain a Streams folder that contains the files of the
derivative copy representations. (Absolute NFS paths and HTTP references
are also supported.)

NOTE:
Rosetta allows only one derivative copy with a given entity type and
representation code per IE. Adding a derivative copy to an IE that has a
derivative copy with the same entity type and code with this job
overwrites the representation.

NOTES:

B You can prevent the job from processing a folder. (This can be useful if
you do not want it to be loaded prematurely.) To do so, create an empty
file in the submission job folder and name it locked (or . locked).

B While processing a folder, the submission job adds a locked file.

B After a folder has been successfully processed, the submission job adds a
done file. Folders with done files are not processed by the submission job.
You can create a cron job to clean up these folders.

B After a folder has been unsuccessfully processed, the submission job
adds an error file. Folders with error files are reprocessed by the
submission job (and should not be deleted). Users can use this file to
identify problematic submission folders.
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Web Editor

This part contains the following sections:
B Chapter 44: Web Editor on page 449
B Chapter 45: Adding Representations on page 479
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Web Editor

This section contains:

B About the Web Editor on page 449

B Accessing the Web Editor on page 449

B Viewing Digital Objects in the Web Editor on page 451
m Editing Digital Objects on page 460

About the Web Editor

When Rosetta moves files from the Deposit Server to the Staging Server, a METS
file containing descriptive and administrative metadata is generated for each
intellectual entity (IE). This metadata can describe an IE as a whole, its
individual representations, and its files. (For more information about METS
files, see the Rosetta Overview Guide.)

The Web Editor allows staff users to access repository objects at various stages
of their ingestion and maintenance. Staff users can access different types and
levels of metadata and make changes, where necessary, to the metadata.

Accessing the Web Editor

Staff users can view descriptive and administrative metadata in the Web Editor
from a search on a home page, from any of the search fields that appear near the
top of most pages, through a link on the Data Management main page, or from a
search link related to a list of sets (see below, for example).

September 2016 449
Ex Libris Confidential



Staff User’s Guide, Part VIII: Editors
Chapter 44: Web Editor

Through a Search

1 Perform a search for the object you want to edit using the Rosetta Search in
the right column of any main page.

2 When the results include an object you want to work with, click the Info text
link corresponding to the row of that object.

3  The object opens in the Web Editor (see Figure 264).

Through a List of Sets

1 Follow the path from Data Management > Manage Sets and Processes >
Manage Sets to the Set List page.

2 Click Members (for itemized sets) or Results (for logical sets) on the row of
the set containing the object you want to access.

3  Click the Info text link beside the object whose metadata you want to view

in the Web Editor.
The Web Editor opens to the object whose Info link you clicked (see
Figure 264).

Hamea = Subm n Appro As=z=ss BIF Intzllzztual Entit
Intellectual Entity PID |IE1332 Created on 23/08/2012 Created by =admin?
Updated on LR 012 Updated by - SIF 1D
Version
= [E [IE1862 ) Ohject Summary

=l Preservation Master Rev

[ REP1663 | TP

= File [ FL1664 ,8Mb ) View Ohject
FID Ei
SIF 1D 92
Created on 23082012 00:48:58
Created by admini
Updated on 2082012 00:48.58
Updated by adimin: |
Entity Type
Number of Reps
Status ACTIVE

< Back Antions |IE Export j m

Figure 264: Web Editor

The Intellectual Entity page of the Web Editor contains two panes:

B The tree pane on the left contains the tree view of the representations
and files that make up the IE.
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The content pane on the right contains summary information about the
object selected in the tree pane.

Viewing Digital Objects in the Web Editor

To view digital objects:

1 Inthe tree pane, select the object level (IE, representation, or file) you want
to view. The object opens in the content pane to the default tab, Object
Summary.

2 In the content pane, click one of the following tabs:

Object Summary, to view summary data and administrative metadata.
(For more information, see The Object Summary Tab on page 451.)

Metadata, to view descriptive metadata and perform several actions
available from this tab. (For more information, see Metadata Tab on
page 453.)

Services, to view a list of available services that can be run for the
specific IE, representation, or file you have isolated. (For more
information, see Services Tab on page 455.)

Versions (IE only), to view information about previous versions of an IE
and possibly restore those versions. (See Versions Tab on page 457.)

Collections (IE Only): to view details about collections to which the IE
belongs. (See Collections Tab on page 456.)

Bitstreams (file only), to view information about file bitstreams. (See
Bitstreams Tab on page 459.)

File Summary (file only), when you want to view technical information
about a file that is a part of the IE. (For more information, see File
Summary Tab on page 458.)

The Object Summary Tab

The Object Summary tab (see figure below) displays general metadata about
the object. It is the default tab when a user selects any of the items in the IE tree
(IE, Representation, or File).
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Home = Submissions * Approval *» Assess 5IPs = Intzllectual Entit
Intellectual Entity PID |[ETEE2 Created on 23/08/2012 Created by zdmini
Updated on FIA0E012 Updated by - SIP ID a2
Version
= IE [IE18EZ | Chject Summary

=l Preservation Master Rev
[ REP1663 ) : :
= File [ FL1664 .8Mb ) Miew Objock
PID Ef662
SIP 1D 32
Created on 23082012 455
Created by adinnin 1
Updated on 23/08/2012 O0:45:58
Updated by adinnin 1
Entity Type
Number of Reps
Status ACTIVE
< Back Actions |IE Export

R o

Figure 265: Web Editor - Object Summary Tab

For IEs, the View Object button shows on the Object Summary tab. Clicking this
button opens the object in the Delivery viewer with which it is associated.

Fields displayed on the Object Summary tab are defined in the DNX profile
configured by your Administrator. (For more information about DNX profiles,
see the Rosetta Overview Guide.) Fields generally include PID, SIP ID, Created by,
dates for creation and update, and other administrative and technical metadata,
depending on the type of object selected in the tree pane. Representations, for
example, include Preservation Type and Usage Type, while Files list values like

MIME Type (see Figure 266).
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Home = File
Intellectual Entity PIDIE1145 Created on 26/06/2013 Created by admin1
Updated on 26/06/2013 Updated by admin1 SIP 1D 32
Version 1
IE [ IE1149 ) Object Summary

Preservation Master

Revision 1 { REP1150 )  PID FL1151
File { FL1151 ,AMb } SIP 1D 32
Created on 26/06/2013
20:52:21
Created by admin1
Updated on 26/06/2013
20:52:23
Updated by admin
Entity Type -
Original Hame LZW_TIFF.tif
Original Path -

File Extension tif
File MIME type imagefiff
File Size 14515580

< Back ;:xcticns:EFiIe Du:rwnlu:ral:ﬁﬂ

Figure 266: Object Summary Fields for File

Metadata Tab

The Metadata tab displays the list of metadata associated with the IE,
representation, or file that is selected.
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Q. -
vy Metadata List

= IE [ IE1023 } Metadata
= Freservation Master
Revision 1 [ REP103D Add Metadata | Assign CM5 | Assign AR || Assign AR Exceptions | Assign RF
= File [ FL1031 ,32Kb )
Name Type Mid
NX DNX DNX_IE1028  Edit

Ttelle cisral Emmigy PIGIZ100 Created an i 340272011 Creatgd Ly 2dmini
Updated on TR0 Updated byadmini S ID 4
Wersian i

& Locked Ey: Me.

DG 1007 Edit

L= e e R - |
il
=)
m

%]
L]
L

Access Rights AR_EVERYONE View

......

= Back IE Export jm

Figure 267: Web Editor - Metadata Tab

Depending on whether the Metadata tab is open to an IE, a representation, or a
file, one or more buttons appear above the information table and allow the user
to perform the following tasks:

Add MD: Add source metadata to ensure no metadata is lost from the
original object. The source can be any of the following types: MARC, MODS,
DC, NISO, copyrights, rights. Source metadata can be added even if there is
already source metadata associated with the IE, representation, or file. For
information on adding and editing source metadata, see Editing Metadata
through the Web Editor Interface on page 465.

Assign CMS: Assign a collection management system ID to the item to allow
the integration of an external system (for more information, see Editing
Digital Objects on page 460)

Assign AR (Editors only): Assign access rights to the IE or representation to
limit its availability (see Assigning an Access Rights Policy on page 132)

Assign AR Exceptions (Editors only): For specified IEs, provide additional
access that expands the rights already defined for a group of users (see
Access Rights Exceptions on page 134)

Assign RP: Assign a retention policy to limit the duration of the IE’s storage
period

All buttons, when clicked, open prompts and in some cases wizards for the user
to complete a task.

Additional actions can be performed on the object by making a selection from
the Actions drop-down menu in the bottom right corner of the page. This menu

454
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changes according to the object selected in the tree view of the Web Editor, its
qualities, and whether the IE has been locked or not.

NOTE:
When an action is being performed on an IE or other object, the system
creates a working copy for the user performing the action. Any views of
the object by other users will maintain the previous data for the object and

will not be editable. Once the object is saved, the new version replaces the
old.

Services Tab

The Services tab shows all the available services for the IE, representation, or
file. Services consist of actions that can be performed on the data, such as those
that appear in the figure below.

Home = [ata Management = Search and Manage Queries * Search for Objects » Senrices

Intellectual Ertity FID 1E1044
Updated on 2082012

Crested an 260252012 Crested by admind

Upd=ated by  admin SIPID 15
“arsion z2
= [E[ [E1043 ] Services
= Preservation Master Rewvision
REF1030 ] Fesign Collection by OC Plo
= File [ FL1051 1Mb ] . .
= File [ FL1052 ,1Mb | Unfesign Collectionhd?x

Enrichment selenium failed

Enrichment - hiinimal

Export Intellectual Entities

hietadata “alidation

Re-Create Derwvative Copy FRepresentation
‘Alidation Stach- holtiple Fixity ChechsF7o

= Back Auctions: | IE Export = I m

Figure 268: Web Editor, Services Tab

Users can run services from this tab by selecting the IE, representation, or file on
the left and clicking the available service on the right.

The System Administrator can take task chains, classify them as maintenance,
and they will appear here.

Editors with the necessary privileges (typical or full) can perform these services
(see descriptions below).
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Table 67. Out-of-the-Box Services

Name Description

Enrichment - Minimal

Includes only the minimal tasks performed as part of
the enrichment phase (such as indexing

Validation Stack - Fixity
Only

Runs the checksum of the files and compares it to the
value stored in the METS file.

Validation Stack - Full

The full validation stack including the fixity, virus
check, format identification and validation, and risk
identification.

Metadata Validation

Validates the metadata against the metadata profile.

Create Operational
Thumbnails

Creates a thumbnail from a file using a dedicated
utility.

Rebuild Repository Search
Indexes

Re-indexes the IE in the repository search index

Create Derivative Copy
Representation

Creates a lighter version of an existing preserved
representation copy, for example, a lower-resolution
image (tiff to jpg).

Re-Create Derivative
Copy Representation

Overrides existing derivative copies (when, for
example, they are of poor quality).

Collections Tab

If there are collections associated with the IEs, the Web editor displays the
Collections tab (see figure below).
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Home = Collections

Intellectual Entity PID IE37E4 Created on 07/08/2014 Created by sdmin1
Committed on 07082014 Committed by admini S5IP 1D 512
Version 1
IE { IE3TE4 } Collections
= Preservation Master
Rewvision 1 [ REP3TE5 ) Assign To Collection By Name Assign To Collection By DC

=| File { FL3786 ,252Kb )

= File { FL3TET 253Kb | Collection I | Collection Hame
= File [ FL3T88 ,221Kb )

=| File { FL3783 ,98Kb } 200113 Csv_collection2 Metzdata =, Unassign
=| File { FL37%0 ,328Kb } {B3E1T RZw Metadata -, Unassign
< Back Actions: | |E BExport =

Figure 269: Web Editor Collections Tab

The Assign to Collection buttons always appear if the IE is locked. Collections
to which the IE is already assigned are listed in the collection table. Click the
Metadata text link to view the collection in the collection management interface.
Click View to view the collection in the collection viewer. Click Unassign to
detach the IE from the collection.

Versions Tab

If more than one version of an IE exists in the database, the Web editor displays
a Versions tab. This tab displays a list of current and older versions of an IE.
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Home = Producers > Producers and Agents » Manage Producers = Versions

. Y 30/08/2014 A
Intellectual Entity PID IE2558 Createdon  _. .- 5., Created by admin1
. 30/068/2014 .
Committed on 799049 Committed by sdmini SIF 1D 334
Version 1
- |E [ IE265E | Versions
= Preservation Master Is
REP!EE_E Title Version| Commit Date] Created
= File { FLZT0D ,1Mb }
= Derivative C REP 30/08:2 .
ernvative Lopy | } Seleniu 1 ;3_3=_¢31¢ adminl Events View METS Downlosd

= File { FLZT04 511Kb }

< Back ﬁ.:ticr's.:||E Export vlm

Figure 270: Web Editor, Versions Tab

Staff with sufficient authorization can retrieve an older version of an IE from the
permanent repository and store it as the new and latest version.

Click Events to view a list of events pertinent to a given IE version.

File Summary Tab

The File Summary tab (see figure below) displays the validation stack report.
The report contains information about tasks that the Rosetta system performed
on the file. (For more information about validation stacks, see Configuring SIP
Processing in the Rosetta Configuration Guide.) The File Summary tab is visible
only when a file component is highlighted in the tree view of the Web editor.
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j“ Home = Data Management > Search for Objects = File Summary
. =aran o 031172011 .

Intellectual Entity PID 1220498 Created on; . 2, Created by admind
Updated on '3_ ?;13' Updated byadmind SIPID 256
Version 1

IE [ [E2053 ) Object Summany Metadata Services File Sumrmary
= Madilied Master Hevision 1
{ REP2100 )
- File { FL2101 ) Agent Dker Type Resull Result Details
3 = Wed MNov
REG_SA_JAH U9 2 Checksum  Passed
ST 20117
“Wed Mov
4 HEG_5A_DP 8 1402600 MVirus Check Passed
ST 20117
"Wed b
1 REG_SA_DR.. 0% 1426 Paszed
IST 2011
“Wed MNov
JHOVE , JPE.. 0% 142617
IST 20117
“Wed MNov
3 REG_Sa_DP 0% 14261 7Risk Analysis Pasgse
IST2011
m Actions: |File Download vi m
Figure 271: Web Editor Page - File Summary Tab
Bitstreams Tab

E":%ll Filiz Sumnan
(A : ¥

The Bitstreams tab displays in the Web Editor when the IE includes file streams.

Intellectnal Emtity PIDIETSS
Updated on

Created on 20057 2-71 Created byadruni
m0e-12-21 Updatad byadmini SIP 1D 32
Version 1
= |E {IE1323) Object Sunmary Metailata Services File Suinmany BitStreanrs
= Presevvation Master Bewl
(REP1324)
= Flla (FL1325, 3Kl ) Il Hame

. Mime F i
Path Extention Tﬁ::ﬂ; Format fd 200
1 BEINA0 This_is_realls, | fexlibrigfdn: . doc

Hama
fret 111

£t

Figure 272: Web Editor - Bitstreams Tab
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The Bitstreams tab displays information for each of the bitstreams extracted
from the IE. The information includes identification, location, and file type.

Editing Digital Objects

Editors can view and edit metadata for all three object types (IE, representation,
file) using the Web Editor interface. When you make changes to data in the
repository, the system creates a working copy and locks the IE so that it is read-
only to other users and cannot be opened for editing. Only after you have
completed edits is the edited IE regenerated by the system and unlocked. The
exception to this rule is when a staff user is editing access rights. Access rights
are implemented immediately with no working copy generated. For more
information, see Access Rights on page 125.

For information on adding and editing representations, see Adding
Representations on page 479.

Editing Digital Collections

To add or edit a collection metadata element:

1 From the Metadata tab of the collection you want to edit, click Edit in the
row of the metadata type.

Home = Data Management = Collection Management = Collections Management
o L Collection Name: Cities Collection Created by AssignCollection
Description: ByDCTask (DC source: 'Cities’)
_ Creation Date: 32112 Modification Date: 3/21/12
- ) Renaissance
= ) Contemporary Metadata
. Israel Photos
= Add Metadata
i = Photos - New
#- ) Medieval >
! - . NHame Type Mid Edit Remove
H- ) Modermn
Descriptive s 2013
Collection rriats 2014 “Wiew

Figure 273: Editing Existing Metadata for a Collection

The Add Tag page opens.
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Home > Data Management > Collection Management > Add Tag

# ™ Tag Code Tag Name
1 ™ deiaodience Audience
2 ™ de:contributor Caontributar
3 ™ dccoverage Coverage

4 ™ decreator Creatar

5 LI doodate Date

] ™ deidescription Description
7 ™ deoextent Extent

0 ™ deformat Forrmat

g ™ deidentifier Identifier

Taygy Description
Audience
Contributar
Coverage

Creator

Date

Description
Extent

Format

Identifier
hd

Figure 274: Add Metadata Tag

2 Click one or more elements from the list to add to your collection’s

metadata.

3 Click Select.

The Full View page for the metadata type you selected opens. It contains the
element(s) that you entered.
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MID 2013 Metadata Type
Created hy Creation Date
Updated by Update Date
u Tag
r v Title
- = Created
C 1s
Add Tag Delete

Error Message Report

<Cancel

,_5.“' Home > Data Management > Collection Management = DC Full View

descriptive: de Description undefined

22032012 191415
220032012 19:14:.15

Qualifier Data

Contemporary
2012-03-22 19:14:15

Display Option

Save

Figure 275: DC Full View Page

4 To enter data in the new field, click the text of the new field (in the above

image, Date).

The DC Field page opens.
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Home > Data Management > Collection Management > DC Field

MID 2013 Metadata Type descriptive:de Description undefinad
Created hy Creation Date 220372012 191415
Updated by Update Date 2032012 19:14:15

Current Field Date

Update Value
Qualifier Value
Languane ﬂ
Errar ‘.-‘fl-'.'..ll]l' Feport |1E|FI
Date

Definition: A date of an event in the lifecycle of the resource.

Commeant: Typically, Date wall be associated with the creation or availability of the
resource. Recommended best practice far encoding the date value is defined in a
profile of IS0 8801 [W3CDOTF] and includes (among others) dates of the form

Y Y Y Y-bM-CD

Cancel aave Field

Figure 276: DC Field Page

A definition for the field and comments about its usage appear at the bottom
section of the page (under the Help tab).

5 Enter a value for the field in the Update Value field.
6 Enter a qualifier value, if relevant.
7 To save the new value(s), click the Save Field button.

The DC (or other metadata) Full View page opens with the new field and
value(s) in the list of tags.
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Home » Data Management > Collection Management > DC Full View

MID 2013 Metadata Type descrptivede Description undefinad
Created by Creation Date 200302012 191415
Updated by Update Date 22032012 19:14:15
r Tag Qualifier Data
] = Title Contemporary
r = > Created 2012-03-22 19:14:15
L] = Date Language="English" 2012-03-23
Add Tag Delete Display Option

<Canco el

Figure 277: DC Full View, Element Added

NOTE:

The metadata profile assigned to the material flow that was used to create
the IE continues to be enforced.

From this page, you can:
B Repeat the procedure and add another tag (click Add Tag)

B Delete any tags (by selecting their check boxes and clicking the Delete
button

B Change the display of tags from tag name (“text”) to tag code or the reverse
(click the Display Option button and select the code or name display)

Home > Data Management > Collection Management = Display Option

Tag Option

FDisplay Code
 Dizplay Text

Figure 278: Code Versus Text for Metadata Elements
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View any error messages (Error Message Report tab)
Cancel your edits (click Cancel)

Validate the metadata changes you made (click the Validate button)

® ®H E N

When you have finished with your edits, click the Save button.

The system saves your edits to the collection metadata.

Editing Metadata through the Web Editor Interface

To edit metadata from the Web Editor:

1  Access the object whose metadata you want to edit by running a search and
selecting Info in the object’s row.
The Web Editor opens to your object.

2 If the object is not an IE, click the IE object level in the left pane.

3 Click the Actions drop-down menu in the lower right corner. If the option to
Lock Object appears, select it and click the GO button. (If the object is
already locked, move to the next step.)

Home = [rata Management » Search and Manage Queries » Search for Objects = Intellectual Entity
Intellectusl Ertity PID IE1049 Crested on  2608/2012 23:05:50 Crested by admind
Updated on ZENOS2012  Updsted by admind EIF 10 15
“arsion 2

= IE[ [E1043 ] Object Surmmary
= Preservation Master Rewvision 1
REF1030 ] Wiew Object
= File [ FL1051 1hb )
= File [ FL1052 b FiD IE1042
SIF 10 15
Created on 26082012 23:05:50
Created by admin
Updated an 2600202012 22:06:068
Updated by admin-
Ertity Type -
Number of Reps 1
Status ACTIVE
< Back m
IE Export
Ex Libiris Ltd., 2012 < Lock Object | ">Terms of Use

Figure 279: Web Editor Page, Locking an Object

The page refreshes with a note in red informing you that the object is locked
to your ID.
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NOTE:

If Lock Object does not appear in the Actions drop-down menu, you (or

another user) have already locked it for use or you are not authorized to
edit the IE.

4 In the content pane, click the Metadata tab.

r—‘-'-{" Metadata List

litellectseal Eiminy PIGIZ1700 Cogated on 134022011 Created by adimind
D atend oo TR0 Updatesl hyadaini SIFID 4
WVersian i

O Locked Ey: Me.

= IE [ IE1029 } Metadata
= Preservation Master
Revision 1 [ REP1030 ) Add Metadata | Assign CMS | Assign AR || Assign AR Exceptions | Assign RP
= File [ FL1031 32Kk )
Type Mid
DX DMX_IE1025 Edit
= D 1067 Edit
Access Rights AR_EVERYOME View
< Back -

IE Export - E3

Figure 280: Web Editor - Metadata Tab
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Editing Descriptive Metadata

To edit descriptive metadata:

1 In the Descriptive row, click Edit. The following appears:

Deposits~  Submissions~  Data Management~  Preservation -

Home / Data Management / Search and Manage Queries / Search for Objects / DC Full View

MID 1000 Metadata Type descriptive:dc Description
Created by admin Creation Date 10/08/2016 09:09:14
Updated bv Ubdate Date 10/08/2016 09:09:15
o :
¥  dc:creator Selenium

a v dcidentifier
& ¥ dcidentifier ISBN 1-56389-668-0

a v dcidentifier

Add Tag Delete Display Option

Cancel

validate | save |

Figure 281: Tag List

2 To edit a tag, click the tag. The following appears, for example:
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Deposits - Submissions - Data Management = Preservation -

Home / DC Field

MID 1000 Metadata Type descriptive:dc Description
Createdby  adminl Creation Date 10/08/2016 09:09:14
Updated by Update Date 10/08/2016.09:09:15

Current Field dc:creator

Update Value |Se|enium

L

xml:lang

Error Message Report Help

Creator
Definition: An entity primarily responsible for making the content of the resource.

Comment: Examples of Creator include a person, an organization, or a service.
Typically, the name of a Creator should be used to indicate the entity.

Cancel Save Field

Figure 282: Edit Tag

Enter a value and click Save Field.

4 Toadd anew tag, select Add Tag. The following appears:
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Deposits»  Submissions~  Data Management~  Preservation «|

Advanced Configuration / Add Tag

o

dc:contributor  Contributor Contributor
2 dc:coverage Coverage Coverage
3 dc:creator Creator Creator
4 dc.date Date Date
5 dcdescription  Description Description
6 dc-format Format Format
7 dc:identifier Identifier Identifier
8 dc:language Language Language
9 dc:publisher Publisher Publisher

5 Select a tag and click Select. The new tag is added to the list of tags.

Adding or Editing Source Metadata

The Rosetta Web editor allows you to add and edit metadata from original IEs,
representations, or files when the metadata format does not conform to the
standard Dublin Core used in most parts of the Rosetta system. This protects the
integrity of the original metadata, which can be compromised when mapping to
an often simpler DC format.

To add and edit source metadata:

1 From the Metadata tab of the Web editor, click the Add Metadata button.
The first step of the Add Source Metadata wizard opens.
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Home = Data Management > Add Metadata Wizard {j:)- 2

Choose operation:

' Insert new (empty)
' Insert from PG

Cancel Hext

Figure 283: Add Source Metadata Wizard - Step 1
2 Toinsert new metadata by entering text, select the Insert new (empty)
option. To upload an existing metadata xml file, select Insert from PC.

The wizard prompts you to select your metadata type from a drop-down
list.

Home / Data Management /| Search and Manage Queries /| Add Metadata Wizard

Insert new (empty)

Choose Metadd source - MARC W
Source - MARC
Source -DC

Source - MODS
Back Ci{ Source - Copyrights
Source - Rights
Source - EAD
Source - article

Edit matadata

Figure 284: Step 2 of the Add Source MD Wizard

If you selected the option of inserting an existing XML file from your PC,
there will be an additional field for you to browse to the file on your PC and

upload it.
3  For either selection, click the Edit Metadata button. The page opens to Text
View.
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Search and Manage Queries

Search for Objects

Home / Data Management
MID Metadata Type SoUrce:marc Description
Created by Creation Date 8/16/16
Updated by Update Date 8/1R/1A
Fdit Select Insert Text Grid
1~ gmarc:record xmlns:marc="http:// www.loc.gov/MARC21/51im"
2 xmlns:xsi="http:/ www.w3.org/2001/XMLSchema-instance”
=, xsi:schemalocation="http://www. loc.gov/MARC21/51im

http://www.loc.gov/standards/marcxml/schema/MARC21s1im. xsd™

Text Full View

desc

Add Subelement
marc:leader
marc:controlfield
marc:datafield
Add Attribute
marc:type
marc:id
Add Nodes
Add Top Element
marc:leader

marc:controlfield

marc:datafield

Figure 285: Text View

To display Grid View, click Grid.
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# / Data Management: Search for Objects / Details

MID Metadata Type sourcemarc  Description desc
Created by Creation Date  8/18/16
Updated by Update Date 8/18/16

Edit Select Insert Text Grid fd Subelement

marc:leader

marc:controlfield

marc:datafield

Add Attribute
marc:type
marc:id

Add Nodes

Add Element
Add Attribute
Add CDATA

Add comment
Add Top Element
marc:leader
marc:controlfield

marc:datafield

Figure 286: Grid View

4  You can add tags by clicking the tag types on the right side of the page. Add
or edit the text. When you are finished, you can click the Validate button to
check the XML. Rosetta displays any errors under the Error Message Report

tab.
5 Click Save.

The source metadata is saved to the Rosetta repository. From there, it can be:
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B viewed through the Delivery module after an administrative user has
edited the relevant XSL file(s); see the Delivery XSL section of the
Configuring Delivery chapter of the Rosetta Configuration Guide.

B published using a converter installed as a plug-in. Rosetta supplies one
that converts source metadata in MARC XML format. This converter is
available through the Developer's Network and Rosetta staff can use it
to develop their own plug-in.

Adding a Logical Structmap

You can use the Rosetta Web Editor to add logical structmaps to
representations.

To add a logical structmap to a representation:

1 Inthe Web Editor, select the representation to which you want to add the
structmap.

2 Select the Metadata tab and click Add Metadata.

3 To insert new metadata by entering text, select the Insert new (empty)
option. To upload an existing metadata xml file, select Insert from PC.

If you selected the option of inserting an existing XML file from your PC,
there is an additional field for you to browse to the file on your PC and
upload it.

4  Select Structmap from the drop-down list, and click Edit Metadata. The
page opens to Text View.

Rosetta displays the physical structmap as a template for you to create a
logical structmap.
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# / Data Management: Search for Objects / Details
MID Metadata Type mets_section:structMap  Description desc
Created by Creation Date 8/18/16
Updated by Update Date 8/18/16
Edit Select Insert Text Grid Add Subelement

1~ kKmets:structMap xmlns:mets="http://www.loc.gov/METS/"

<mets:div LABEL="Table of Contents">
<mets:div LABEL="door.jpg" TYPE="FILE">»

<mets:fptr FILEID="FL1@85" />

2 ID="" TYPE="LOGICAL">
3 ¢mets:div LABEL="Preservation Master”»
4~
S
B
7 </mets:idive
8 </mets :div>
9 </mets:div>
18 </mets:structMap>

Validate|

mets:div

Add Attribute

mets:|D

mets TYPE

Add Nodes

Add Top Element

mets:div

Cancel Save

Figure 287: Add Structmap - Text View

To display Grid View, click Grid.

Home / Data Management / Search and Manage Queries / Search for Objects / Text Full View
MID Metadata Type mets_section:structMDescription desc
Created by Creation Date 8/15/16
Updated by Update Date 8/15/16
Edit Select Insert Text | Grid | Add Subelement
mets:div
Add Attribute
() mets:ID L OmetsTYPE | ogicar ] (=D
metsTYPE
mets:div - T[x addiiodes
i Add Element
() mets:L ABEL Preservation Master A Add Attribute
A A
mets:div - X Add CDATA
Add comment
() mets:LABEL | Taple of cantents 4 Add Top Element
mets:div = metsdiv
() mets:LABEL | g0 ,  (metsTYPE | FILE M
mets:fptr = X
() mets:FILEID | £ 1002 P

Figure 288: Add Structmap - Grid View

5 You can add tags by clicking the tag types on the right side of the page. Add
or edit the text. When you are finished, you can click the Validate button to
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check the XML. Rosetta displays any errors under the Error Message Report
tab.

6 Click Save.
The structmap is added.

DNX_REP1004 Edit
METS Section Structure Map| REP1004-1 Edit Remove
METS Section Structure Map REP1004-2 Edit Remove

Figure 289: Added Sructmap

Click Edit to edit the structmap and Remove to remove it.

Generating a Logical StructMap

A logical <structMap> can be generated for a representation using the Generate
Logical Structmap task. The generated structMap will be based on the content of
each file's FileOriginalPath DNX value, with a forward or backward slash as
a delimiter (the file name is ignored).

The tasks parameters are as follows:

Table 68. Task Parameters

Parameter Description

Preservation Type The preservation type of the representation for which
(required) the structMap is to be generated.
Replace existing Replace existing logical structMap(s) with the newly-

generated structMap(s).

(Default = no; if yes, all existing logical structMaps in
the representation are replaced.)

NOTES:

B Objects will be tarred or flat based on the export_flat general
parameter value. Refer to the General Parameters section in the System
Administration Guide for further information.

B This task can be added to an enrichment task chain.

September 2016 475
Ex Libris Confidential



Staff User’s Guide, Part VIII: Editors
Chapter 44: Web Editor

If the folder of streams is flat (that is, if all files in the representation have the
same FileOriginalPath), no logical structMap will be generated since this is
the equivalent of a physical structMap.

Editing a Physical Structmap

You can use the Rosetta Web Editor to edit physical structmaps of
representations.

To edit a physical structmap:

1 Inthe Web Editor, select the representation whose structmap you want to
edit.

2 Select the Metadata tab and click Edit for the METS Section.

# / Data Management: Search for Objects / Details

MID REP1004-1 Metadata Type  mets_section:structiMap Description
Created by admin1 Creation Date 8/21/16
Updated by Update Date 8/21/16
Structmap Type  PHYSICAL A
Structmap - Label Preservation Master Root-Label | Table of Contents
o sk
¥  LZW_TIFF.tif LZW_TIFF.tif LZW_TIFF

A  Copy of LZW_TIFFtif Copy of LZW_TIFF.tif Copy of LZW_TIFF

Figure 290: Edit Physical Structmap

3 Edit the Structmap Label, Root Label, and file label.

The edited labels now appear in the viewer.
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Exporting Objects

Objects can be exported out of the Rosetta system to expedite their editing or
review. The export function copies information as described in the following
table:

Table 69. Export Rules

Object Type Objects to Export

IE All representations and files in the IE are
exported to an exports directory on the
server.

Representation The representation and all of its files are
exported to an exports directory on the
server.

The export function exports the linked
IEs and representations, but does not
export any other representations in the
IE.

File The file is exported to the user’s hard
drive or to an exports directory on the
server.

NOTE:
The exported files are structured according to their initial structure when
they were ingested into Rosetta. (This information is saved in the
fileOriginalPath DNX field.)

To export an object:
1 Find the IE, representation, or file you want to export by conducting a
search of the system.

2 Open the object in the Web Editor. (See Accessing the Web Editor on
page 449.)

Select the IE, representation, or file in the tree view of the Web Editor.

4  Click the down arrow of the Actions drop-down field and select IE Export,
Representation Export, or File Download, depending on your object type.
Then click Go.

The system generates an export process and prompts the user for an export
path and other export task-related parameters.
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NOTE:
If the enforce_ar_export general parameter is set to true, Access Rights
will be enforced during export. Certain representations, or the entire IE,
may not be exported, in accordance with the IE/REP AR policies.

5 Log on to the server (if necessary) and locate the exported item in the
directory specified.

Commit or Rollback Changes

When you have made changes to an object, you must indicate to the system that
you want to save (commit) those changes or discard (roll back) them. Once you
commit, the object will be saved as you determined and unlocked, and the object
will be returned to the permanent repository.

To commit or roll back changes to an object:

1 From the Web Editor page of your object, select the object (IE,
Representation, or File) in the tree view.

2 In the Actions drop-down menu, select Commit Changes to save the
changes you have made or Rollback Changes to save the previous version
of the object (without the changes you just made).

NOTE:
If you do not see the options for commit or roll back, click Lock Object
from the Actions drop-down menu, then click Go and wait for the page to
reload.

3 Click the Go button.

The system commits or rolls back your changes. The Web page reloads with
the following message appearing in red text:

“Currently Being Committed/Rolled Back By: Me. Refresh Page.”
4 Click Refresh Page to continue working on this IE.
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Adding Representations

This section contains:
B Introducing Representation Functions on page 479
B Managing Representations on page 479

B Adding a Representation: Process and Steps on page 480

Introducing Representation Functions

Representation functionality extends the life of intellectual entities (IEs) that
require modifications for the following reasons:

B The library does not possess the technical resources or applications to
render the IEs.

B The library possesses collections of objects in soon-to-be obsolete digital
formats.

B Some objects in the library exist in a format that contains a problematic
attribute that will not be supported in the future.

Rosetta offers preservation functionalities such as

B adding single or multi-file representations

B ordering files in multi-file representations

B adding representation metadata and provenance information

B updating the file content of a representation in permanent storage.

Managing Representations

Rosetta breaks down representations into the following types:

B Preservation Master (PM): the system’s preservation copy of an object's files.
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B Modified Master (MM): a copy of a PM that has been manually modified.

B Access Copy (AC): a derivative of a PM or MM that has been created (by
Rosetta or by an external system) to support greater access (for example, a
low-resolution Web browser copy).

NOTES:
B  The Preservation Master is mandatory and there can only be one
B The Modified Master is optional and there can only be one
B Derivative copies are not preserved
u

Custom preservation types, defined in the Preservation Type code table,
are optional and repeatable

The following table describes representation-level activities and the situations in
which they are used.

Table 70. Representation Activities in Rosetta

Activity When to Use

SIP Processing During the Enrichment task chain, derivative copies are
created and added as new representations.

Preservation Action Running a preservation action involves creating a new
representation (or representations) for each IE in the
preservation set.

Derivative Copies Functionality supports adding an access copy as a new
representation through the Web Editor. (See Derivative
Copy Representations on page 435].)

Ongoing Maintenance The Editor can add a new representation to a specific IE
when:

B Higher quality representations of digitized material
(PMs and MMs) need to be added to existing IEs

B New representations of digitized material need to
be added to existing IEs.

Preparing the material and processing the representation vary according to the
user’s context in the system and the needs of the IE or preservation set. The add
representation component receives the material for the new representation and
launches the proper process according to the source of the call.

Adding a Representation: Process and Steps

Three stages comprise the process flow for adding a representation:
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B Locking the Intellectual Entity on page 481
B  Adding the Representation on page 482

B Processing the Representation on page 486

Locking the Intellectual Entity

The Editor must lock the IE before adding a new representation. This is done
through the Web Editor Object Summary page for the selected IE (follow the
path from SIPs List > Edit IE so the Web Editor opens, or conduct a search of IEs
and then open one for editing).

= |E { IE1062 } Object Summary
= Preservation Master Rew
[ REP1063 }
= File [ FL1064 103Kb } View Ohject
PICr IE1082
SIP 1D 19
Created on 28/08/2012
23 a0
Created by admini
Updated on 28/08/2012
23:11:00
Updated by admini
Entity Type
Number of Reps
Status ACTIVE
< Back

Figure 291: Locking the IE

Select Lock Object from the Actions drop-down list, then click Go.

The IE locks, the page is refreshed, and the Actions drop-down menu contains
relevant options.

When a representation is added through the Web Editor, the system creates the
descriptor file with information about the IE. In this case, a new representation
is added to the IE with no relationship to existing representations. Thus there is
no source representation.

Users can load files for the first time using the Choose From Server tab in the
Web Editor (Add Representation - Load File stage). In this case, the user places
tiles under the home directory. The system is responsible for copying the files to
the general Import directory.
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Adding the Representation

To add a representation from the Web Editor, access the page containing the
object summary for your IE. Make sure the object is locked.

Configuration Files = Intellectual Entity

Intellectual Entity PID IE108
Updated on 28/08
Version 1

=l IE [ IE1062 }
= Preservation Master Rew
[ REP1063 }
= File [ FL1064 103Kb } View Object

PID

51P 1D
Created on
Created by
Updated on
Updated by

Entity Type

Status

= Back

2 Created on 2ANA/N12
2012 Updated by sdmin1

Object Summary

m
[=
“n
[t

=]
=]
K3
(=)

oo ofowm
?
3

m k1 W pRa
3

(=
tooa
[i8]
[}

Number of Reps 1

ACTIVE

Actions m

Created by admin1
51P 1Dy 19

Figure 292: |IE Locked by the User

Follow these steps to complete the Add Representation wizard:

1 Select Add Representation from the Actions menu and click Go to launch

the Add Representation Wizard.
Step 1 of the wizard opens.
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Label

* Preservation Type
Usage Type
BAccess Rights Policy

Cancel

@ Home = Data Management = Intellectual Entity = Add Representation - Details @

IE General Informaticn

Intellectual Entity PID IE10E2 Created on 2/08/20172 Created by admini
Updated on 25/08/2012 Updated by admin1 SIP 1D 19
Version 1

Please provide details on the Representaticn you are adding

|F'raaar'..'atiar Waster
Alto Representation Code [High

[ [<]

Figure 293: Add Representation - Details

2 Enter values in the fields using Table 71 as a guide.

Table 71. Add Representation - Step 1

Field Description

Label

A name for the new representation

Preservation Type

Select the Preservation Type. This field is mapped to the
field —
DNX.generalRepCharacteristics.preservationTy
pe.

NOTE:
IEs must contain one preservation master and may
contain up to one modified master. Other types are
unlimited.

Usage Type

Mapped to the field
DNX.generalRepCharacteristics.usageType. The
default type (and currently the only supported type) is
View.

Representation Code

Applies only when the Preservation Type is Derivative
Copy. (System ignores entries for master copies.) Default
value is None.

Access Rights Policy | Select an Access Rights Policy from the drop-down list of
available policies. This policy applies exclusively to this
representation.
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3

Click the Next button.

If you selected Derivative Copy for your Preservation Type, the system
moves you to the final step (2) in the wizard. (Skip the next step of this
procedure and the accompanying figure.) If you selected Preservation

Master or Modified Master, the Additional Information page opens as Step 2

of the wizard. (See the following figure and accompanying step.)

. f Home = Data Management = Search and Manage Queries > Intellectual —
b Entity = Add Representation - Details i 2)
LY
e

IE General Information

Intellectual Entity PID IE1082 Created on 2/&MR/2N12 Created by admini
Updated on 28/08/2012 Updated by admin1 S5IP 1D 19
Version 1

Additienal Informaticn

Preservation

Property
Relaticnship Type

= Add

Prowvenance Information

Submission Reason

Back Cancel m

Figure 294: Add Representation - Additional Information for Master Copies

Enter the following information in the available fields:

B For the Additional Information section, enter values for as many of the
available Preservation Properties as you want. Select the property from

the drop-down menu, enter a value in the field, then click the Add
button. Repeat as needed.

B For the Provenance Information section, enter information that explains

why a new representation is needed.

Click the Next button to move to the next step in the wizard. (To return to a

previous step or cancel the procedure, click the Back or Cancel button.)

The Load File page opens.
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A D Home >

lanagemsant = Intellectual Entity » Add Representation - Load File 1 2 (3)

IE General Infermation

Intellectual Entity PID FL1822 Created on 26/07/2012 14:46° Created by admin1
Updated on 28/07/2012 14:45  Updated by - SIP 1D 123
Version -

Please select file|s) for new Representation Cheoose max File size for upload no more 1000 MB

Insert from Local PC Choose From Serwver
IEI Select File
Load the files manually
B 3.0 Check all | Unicheck al | Send
- 3m
:J 3rd-Party Products [T & buttons [ ¥ jpegCrinLsh. PG

- Configuration

-~ FL_11.8

- MexbGenSearch

- Preservation

| Preservation ore o

[T "= Callections suppart - FL[ # jpegCtsyCtDg, PG
[T ® ColMgmtlinkSequence. [~ & jpegFleacrs, PG
[T =% Configuration_users.pc [ 8 jpegFINEFRdWn, JPG
[T “ 9 FL Audit Trail - Functior [ 8] jpegGromwcimn, PG

Rl | b

IE' S5elected Files

Set Order | File Hame | Label Note Source Size Date

Back Cancel m

Figure 295: Add Representation - Load File

6 In the Select File section, use the Insert from Local PC or the Choose from
Server tab to browse to the local or server-based source of the file(s) you
want to select for preservation.

NOTES:

B If you are unable to use the applet, you can load the files manually. To do
this, click the link to Load the files manually at the top of the Select File
section and load the files through your Windows-based file selection.

B When the Preservation Type value is Derivative Copy, this step will be
Step 2 (out of two steps) rather than Step 3 (as pictured here).

7 When you have selected the file(s) for your preservation copy, click the
Done button to finish.

The system copies the files under the general Import Directory root.
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Processing the Representation

When the Add Representation is called, the system loads the files into Rosetta,
runs the Validation Stack, performs Enrichment tasks, and moves the IE to the
permanent repository.

While the Add Representation process is running, the system displays status
messages indicating the task is in-progress or complete. Any problems
identified during the process are sent to the Technical Analyst (TA) Inbox
(similar to problems found during SIP processing). This is noted in a message to
the Editor, as are any notices of the IE being committed or rolled back. When the
Commit or Rollback action is complete, the system unlocks the IE and removes
the Import Directory and all of its contents.

NOTES:

B Add Representation is an asynchronous process. Once the Add
Representation process is launched, the Editor does not interact with the
process. When Add Representation has finished, the system displays a
message on the Web Editor page so that the Editor knows to commit or
roll back the action.

m If the Editor performed a number of actions on the IE without
committing and then Add Representation fails, the following scenarios
are possible:

If the Editor selects Commit, all of the actions on the IE except the failed
Add Representation are committed.

If the Editor selects Rollback, all of the actions on the IE performed after
the last commit are rolled back.

When the system completes the Add Representation process, it notifies the
Editor by e-mail.

Updating a Representation

Rosetta allows you to update existing representations with minimal impact on
the AIP and associated objects. Revised representations can replace existing
representations without performing enrichment, without copying all related
files, and without a preservation plan. Instead, the representation

B  maintains its place in the structural map of the object
B updates the content and structure of the representation (not its metadata)

B references related files rather than uploading those same files that are
already uploaded with the previous version of the representation
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Revisions can be performed on a single representation through the UI (see
Adding the Representation on page 482) or as a batch process through one or
more APIs. (Information on APIs can be found on the Developer's Network
(https://developers.exlibrisgroup.com/rosetta/apis/IEWebServices)

Replacing Files Within a Representation

A single new representation can replace an existing one through a manual
procedure in the Web editor. This revised version should be ready for upload
when you begin this procedure.

To revise a single representation:

1 Locate the representation or the IE to which the representation belongs. You
can use any of the Rosetta search functions that access the permanent
repository. (For example, from the Data Management menu, go to the Search
and Manage Queries heading and select Search for Objects, then perform a
search for the representation you are going to revise or replace.)

2 Open the object in the Web editor and lock the IE (see Open and Lock

Object on page 487

£ N
ExLibrisRosetta
Home Producers Submissions Data Management Preservation

Home = Data Management = Search and Manage Queries = Search for Objects = Intellectual Entity
Intellectual Entity PID IE1006 Created on 23/11/2015 10:43:20 Created by admin1
Committed on 23/11/2015 10:43:52 Committed by admin1 SIPID 1
Version 1

=/ IE ( IE1006 ) Object Summary

=l Preservation Master Revision 1 { REP1007 )
= File ( FL1008 ,1Mb )

View Object
PID IE1006
SIPID 1
Created on 23M1/201510:43:20
Created by admin
Updated on 23/11/2015 10:43:20
Updated by admin
Entity Type -
Mumber of Reps
Status ACTIVE
< Back Actions:| IE Export ¥ m
) [IE Export |
Figure 296: Open and Lock Object
3 Select the representation you want to revise.
The Actions menu changes to provide relevant actions.
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Actions: | Update Representation - |

Fepresentation Export
lUpdate Representation

Figure 297: Representation Update Action

4  Select Update Representation and click Go.
The first step of the update wizard opens (Figure 298).

F A"
ExLibris Rosetta
Home Producers Submissions Data Management Preservation

&~ Home > Data Management > Search and Manage Queries > Intellectual Entity > Update Representation - Details

IE General Information

Intellectual Entity PID [E1006 Created on 23/11/2015 10:43:20 Created by admini
Committed on 23112015 10:43:52 Committed by admin SIP ID
Version 1

Please explain the need to add/update representation without a preservation plan
Submission Reason

Add New File
# | File Name | Label Structmap Label Size PID Actions
LZW TIFF&if LZW TIFF LZW TIFF 1417 54 FL1008 Edit Remove Replace
Cancel Submit

Figure 298: Update Representation Page

5 Add a Submission Reason for the update (for example, see Figure 299).

6 Click the Add New File button to add a new file. To replace an existing file,
click the Replace Action beside the file you want to revise (see Figure 299).

488 September 2016
Ex Libris Confidential



Staff User’s Guide, Part VIII: Editors
Chapter 45: Adding Representations

™%
ExLibris Rosetta

Home Producers Submissions Data Management Preservation

-y Home > Data Management > Search and Manage Queries > Intellectual Entity > Update Representation - Details

IE General Information

Intellectual Entity PID |E1006 Created on 23112015 10:43:20 Created by admini
Committed on 23M1/2015 10:43:52 Committed by admin SIP ID 1
Version 1

Flease explain the need to add/update representation without a preservation plan
Submission Reason

Tadd New File >

# | File Name | Label Structmap Label Size PID Actions
LZW TIFFfif  LZW TIFF LZW TIFF 1417 54 FL1008 Edit Remmr
Cancel Submit

Figure 299: Update Representation Page, Reason and Next Step

A lightbox for the update representation opens.

Please select a file to upload

L Insert from Local FC
Choose From Server

* File Choose File | No file chosen
Label |
* Structmap Label |
MNotes
A
Cancel Submit

Figure 300: Light Box Form for Updating a Representation

7  Click the Browse button and select the file you want to upload from a local
or network drive.
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8 Enter a Label and a Structmap Label for the file and any additional
information in the Note field of the form. The Structmap label and Notes
fields will be displayed in the Delivery module of Rosetta.

NOTES:
B New files are appended to the end of the structmap.

B Only physical structmap labels can be edited. Logical structmap labels
are added automatically for new files based on the file name and can be
edited separately.

9 C(lick the Add Selected File button.

The lightbox closes and the new representation displays in the list of files on
the Add Representation page.

exLibris Rosetta

Home Producers Submissions Data Management Preservation

Home > Data Management > Search and Manage Queries > Intellectual Entity > Update Representation - Details

IE General Information

Intellectual Entity PID IE1006 Created on 23/11/2015 10:43:20 Created by admin1
Committed on 23M11/2015 10:43:52  Committed by  admin? SIPID 1
Version 1

Please explain the need to add/update representation without a preservation plan
Submission Reason

Add New File
# File Name Label Structmap Label Size PID Actions
LZW, TIFF tif LZW. TIFF LAW.TIFF 1417.54 FL1008  Edit Remove Replace
2 CZEZJEa.jpg Koala Koala ?52.531::} Edit Remove Replace
Cancel

Figure 301: Update Representation Details Summary

10 Enter a Submission Reason (optional) and click the Submit button.

Rosetta reloads the IE in the Web editor. The new IE version appears in the
object tree in the left column of the page (Figure 302).
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exLibris Rosetta

Home Producers Submissions Data Management Preservation

n?'f.::‘- Home = Data Management = Search and Manage Queries > Search for Objects = Intellectual Entity

Intellectual Entity PID IE1008 Created on 23/11/2015 10:43:20 Created by i;ldmm’
Committed on 23/11/2015 10:43:52 Committedby  admini SIPID
Version 1

O Locksd By: M=

= IE (IE1006 ) Object Summary Met Services e 1S Ver =

=/ Preservation Master Revision 1 { REP1007 )
=l File ( FL1008 ,11Mb )
= File { FL1220 ,762Kb )

View Object
PID IE1006
SIPID 1
Created on 23M11/2015 10:43:20
Created by admini
Updated on 14/12/2015 13:08:14
Updated by admin1
Entity Type -
Number of Reps
Status ACTIVE
< Back Actions: E

Commit Changes
Rollback Changes
Delete |E

Add Representstion

Figure 302: Representation Updated in Web Editor
11 Select Commit Changes from the Actions drop-down menu and click the
Go button.

The page reloads with a status update and a link for refreshing the page.
The object is locked again.
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1st-time registration reasons, 217

A

access rights
exceptions, 134
assign, 138
setting up, 135
Web editor, 140
Metadata Search page, 126
policies, 126
adding, 127
deleting expressions, 131
editing, 130
Add Set page, 356
adding representations, 479, 482
advanced search, 28
conditions, 29
Advanced Search page, 29
approval group, 261
Arranger, 274
merge single IE, 275
rearrange |E structure map, 274
splitan IE, 278
Assessor, 274
Assessors, Arrangers, and Approvers, 261, 263
approving SIPs, 272
declining SIPs, 272
forwarding SIPs and IEs, 273
rejecting SIPs, 272
responsibilities, 261
viewing SIPs, 264
history, 268
IE metadata, 270
information, 267
notes, 269
objects, 270
tree view, 279
auto-completion
column names, 37
sort elements, 35
Auto-correction rules, 327

B
bulk delete IEs, 386
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C

CMS, 283
ID, 231, 283
link to multiple IEs, 283
link metadata to IE, 283
Collection Management
disassociating IEs, 429
collection management systems
see CMS
collection metadata, 421
add type, 422
DC Full View Page, 462
edit element, 460
edit field, 463
collections, 415
with IEs, 424
configuration
files, 110
content structure, 100
configuring, 99
material flows, 109
copyright boilerplate statements, 113
creating an itemized set, 354

D

Data Manager, 347
assign access rights, 132
processes, 363
History Execution page, 365
viewing, 365
decline content, 308
Delete IE task chain, 387
delivery
copyright statements, 112
XSL files, 112
Delivery Copyrights Statements, 112
Delivery XSLs page, 112
Deposit Activities page, 235
deposit activity, 307
deposit control settings, 222
Deposit Manager, 69
adding lists of values, 78
adding metadata forms, 75
content structures, 99
control settings, 71
copyright boilerplate statements, 113
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duplicating Producer profile, 166

generic material flows, 151

managing Producer profiles, 161

material flow components, 124

material flows, 85, 167

metadata forms, 73

Producer profile, 164

submission formats, 86
Depositor e-mail, 115

E

editing metadata, 465
Editor, 339

content management, 347
e-mail

configuration files, 118

display fields, 115

notification, 118

SIPs, 115

Producer confirmation, 240
email_to_depositor.xsl, 118
error codes, 312
exporting objects, 477
external storage

fixity, 401

F

Find a SIP report, 63
fixity, 401
check, 401
reports, 402

G

generic material flows, 151
adding, 153

H
Home page, 24

IE, 349, 460
access rights policy, 132
deleting, 384
export, 477
locking, 481
metadata, 449

viewing, 449

permanent repository, 398
purging, 393
recovering, 391
representations, 479
restoring, 398
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sets, 349
adding members, 358
creating, 351, 353
deleting, 361
itemized, 349
logical, 350
searching, 32
viewing, 360
IEs
delete multiple, 386
intellectual entity
see IE
itemized set, 349, 354

L

List of Material Flows page, 151
List of Metadata Forms page, 74
List of Metadata Profiles, 120
accessing, 121
List of Producer Profiles Page, 161
logical set, 354
query, 354

M

Manage Issues in SIP Processing page, 295

Manage Producers page, 205
accessing, 205
filter Producers, 209
sort Producers, 209
Manage Sets page, 350
Material Flow Details page, 225
material flows, 85
activating, 157, 170
assign to Producer, 223

associating with Producer profiles, 169

components, 124
deactivating, 157, 170
deleting, 159
duplicating, 158
generic, 151

adding, 153
list, 151
personalize, 225

removing from Producer profile, 170

updating, 158
Material Flows List page, 167
metadata
forms, 73, 82
adding, 75
duplicating, 82
generic lists of values, 81
lists of values, 78
material flows, 84
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previewing, 82 trusted, 220
updating, 83 Producer Agent, 216
profile default e-mail, 115
deleting, 124 e-mail, 115
editing or duplicating, 122 registration, 217
new, 122 Producer Details page, 219, 221
shared, 321 Producer Profile List page, 161
source, 469
> provenance, 401
Metadata Search page, 126, 341 publishing, 375
configuring, 376
N converter types, 381
Negotiator, 201 Farget types, 381
adding Producer accounts, 210 purging IEs, 383
depositing Producer content, 235
managing Producers, 205 Q
personalizing material flows, 225 uick search. 25
updating Producer accounts, 216 q ’
P R
heck
personalize - ZCIP files, 318
material flows, 225 , lin biI; 391
metadata forms, 233 e_cyc & b, 3
Producer profiles, 219 reject content, 308
submission formats, 234 report
PID list. 357 Producer, 239
S 42
blemat tent, 295 reports, 42
iigce:;: 1 content, available in Rosetta, 50
tasks/task chains, 363 reprerggrrl’lcg?i’of
viewing, 364 .
. . adding, 482
Iy;ro;essmg representations, 486 functions, 479
ro ;C‘;irums locking IE, 481
L ing, 47
activating, 216 managmfgl;, i
adding, 210 process OV\Z 80
deactivating, 216 rerm;:rocessmg, 86
SEIJ};R?Q 221 176 enrichment, 319
. > SIP with system error, 320
cancelling reports job, 244 Wit Sy ?
Contacts. 215 validation, 319
individual versus group, 210 reftm;ng IEsli 3,83
managing reports job, 242 reten bontpf 4130es
modifying reports job, 243 about,
profile, 161 creatl_ng, 14.14
ar;tivating 164 working with, 146
adding generic, 163 retention policy, 143
associating material flows, 169 Rule D.etaﬂs page, 333
deactivating, 164 Rule List page, 332
deleting, 166 rules
duplicating, 166 auto-correction, 327
personalize, 219 file extension mismatch, 328
updating, 165 format identification, 327
reports, 239, 241 match, 181
configuring job schedules, 245 metadata extraction error handling, 328
search, 207 operators, 180
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validation adding, 330
stack, 328 deactivating, 335
deleting, 336
S duplicating, 335

scheduled job, 44, 250, 408
search
advanced, 28
metadata, 126, 341
Producers, 207
quick, 25
search elements
nested, 31
operators, 32
searching for objects, 23
sets
itemized, 354, 358
logical, 353, 354
shared metadata, 341
Metadata Search page, 341
SIP, 263
bitstream extraction, 301
errors, 302
failure, 305
files
recheck, 318
process flow, 65
repair and replace, 311
reports, 62
status and stage, 59
view Enrichment errors, 303
SIP Content List page, 265
accessing, 265
SIP detail report, 63
SIP processing, 173, 182
activate a configuration, 186
adding a configuration, 183
approval, 177
auto-correction rules
re-ordering, 334
deactivate a configuration, 186
deleting a configuration, 185
duplicating a configuration, 185
enrichment, 177
permanent, 177
pre-approval, 174
process flow diagram, 65
routing rules, 186
activating, 190
adding, 187
deactivating, 190
deleting, 190
duplicating, 190
updating, 189
rules
activating, 335

496

updating, 334
stages, 173
updating a configuration, 184
validation stack rules, 328
workflow, 173

SIP Processing Configuration List page, 182

SIPs Dashboard report, 62
SIPs List page, 295
source metadata, 469
staff
reports, 23
user
overview, 21, 22
submission
formats, 86
jobs, 249
submission information package
see SIP
System Error folder, 305, 306

T

task chains
collections, 425
associating IEs, 425
task parameters, 428
Delete IE, 387
tasks
assigning collections, 425
Technical Analyst, 291
advancing deposit activity, 308
delivering problematic SIP, 311
deposit activity
return or decline, 308
deposit error resolution, 293
problematic content, 295
replace repaired SIP, 311
re-running
processes, 317
rerunning
enrichment process, 319
system errors, 319
validation, 319
resubmit problematic content, 310
validation recheck, 317
text file upload, 357
To Permanent folder, 305
trusted Producers, 220

U
User Manager, 201, 262
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validation
recheck, 317
stack, 174, 328
rules, 328
validation stack
error codes, 312
viewing metadata, 451

W

Web editor, 449
accessing, 449
commit/roll back, 478
deleting IEs, 383
editing metadata, 465
exporting objects, 477
Metadata tab, 453
Object Summary tab, 451
Services tab, 455
Versions tab, 457
viewing metadata, 451

wildcard, 33

X
XSL converter, 103
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